
Help topics for Corel VENTURA are divided into eight categories represented by the icons 
below. 
To select a category with the mouse, point to its icon and click. With the keyboard, press the 
Tab key to highlight the category you want, and press ENTER. For more information about 
using Windows Help press F1. Click Using Corel Help to learn about other Help features 
available in Corel VENTURA. To return to this screen, select the Contents button at the top of 
the Help window.

   

   

How to...
Create a publication
Work with text
Work with styles
Work with frames
Work with imported graphics
Draw and edit objects in Corel VENTURA
Work with color
Work with tables
Manage publications
Create indexes and tables of contents
Create cross references
Use the Quick Format Roll-Up
Work with other applications
Use right-mouse-button menus
Print your documents
Change links to files using CVPFIX
Include fonts that are not on your system
Install a foreign-language dictionary



Use the appropriate hyphenation dictionary
Install a foreign-language thesaurus



Use the appropriate hyphenation dictionary for previous versions of 
VENTURA
Previous versions of VENTURA (3.x - 4.x) did not store the hyphenation dictionary with the 
file. Therefore, chapters created using a previous version must choose the default 
hyphenation in the Preferences dialog box that corresponds to the language of the chapter.
To use the default hyphenation:

1. Choose Preferences from the Tools menu. The Preferences, General dialog box appears.
2. Choose a default hyphenation from the Default Hyphenation drop-down list box. 



Including fonts that are not on your system
If your document is to be sent to a service bureau for output on an imagesetter, you may 
wish to have access to the additional typefaces, or fonts, available at the source bureau 
without having to purchase each font. This can be done by using the PostScript font metric 
(.PFM) files. PFM files can be freely distributed (.PFB files which contain the binary 
information cannot be distributed).
When installed and applied to text in your document, these font metrics allow you to use 
fonts for which you do not have corresponding printer fonts. The correct font will not be 
displayed on the screen or printed on a desktop laser printer unless the corresponding 
printer font is installed. However, the line endings and alignment for the correct font will be 
maintained. When the document using the .PFM files is printed to a file and sent to a service 
bureau for output on an imagesetter, the correct font will be printed.
You must inform the service bureau of all typefaces used in your document to ensure that 
the font will be loaded into the imagesetter memory when your document is printed.
To include fonts in your file that are not on your system:

1. Acquire the .PFM file of the font you want to use in your document.
The font will appear in your font list in Corel VENTURA 5.0. 

2. Create a directory on your hard drive for .PFM files or use an existing one.
3. Open the WIN.INI file using a text editor such as Notepad.
4. In the [PostScript, portname] (examples of portnames are: LPT1, LPT2 or FILE) section 

of the WIN.INI, enter the directory where the .PFM file is located and the names of 
the .PFM files. 
softfont1=d:\directory\0140a____.pfm
softfont2=d:\directory\rvb____.pfm
Note:    If you already have entries for fonts in the WIN.INI, enter the new font after the
last one in the list and number it consecutively. For example, if the last entry is 
softfont116, enter softfont117.

5. Tag the paragraphs with the font. The text is displayed in the widths of the soft font, 
but the font displayed on the screen is a substitute (e.g. Times Roman).

6. Print the file to a PostScript file by selecting Print to File in the Print dialog box.
7. Take the file to a Service Bureau and tell them which font has to be resident for 

printing.

Shortcut:
If you have Adobe Type Manager, double click the ATM program icon and deselect Auto-
Download to PS driver.



Change links to files using CVPFIX
CVPFIX, a utility provided with Corel VENTURA replacing the DOS FIXCHP command, relinks 
Ventura publication files moved using DOS or Windows copying operations. Where possible, 
use the Publication Manager to move and copy files to avoid the extra step. See also 
Copying and moving files, chapters and publications
To change links to files:

1. Click Extensions from the Tools menu. A flyout menu appears containing the names 
(Corel PHOTO-PAINT, CVPFIX, CorelKERN and Corel MOSAIC) of the additional software 
included with Corel VENTURA 5.0.

2. Choose CVPFIX from the flyout. The Re-Link Ventura File Paths dialog box opens.
3. Choose file type--publication (*.PUB) or chapter *.CHP files--from the List Files of Type 

box. 
4. Select the file(s) you want to update from the File Name box, changing drives and 

directories as required.
You can select multiple chapter or publication files by holding the Ctrl key and clicking 
individual files or holding the Shift key and selecting a the first and last file of a group.

5. Click OK. The publication or chapter files are relinked in the their new location and a 
notification box appears stating that the operation was completed successfully.



Change links to files using CVPFIX
CVPFIX, a utility provided with Corel VENTURA replacing the DOS FIXCHP command, relinks 
Ventura publication files moved using DOS or Windows copying operations. Where possible, 
use the Publication Manager to move and copy files to avoid the extra step. See also 
Copying and moving files, chapters and publications
To change links to files:

1. Click Extensions from the Tools menu. A flyout menu appears containing the names 
(Corel PHOTO-PAINT, CVPFIX, CorelKERN and Corel MOSAIC) of the additional software 
included with Corel VENTURA 5.0.

2. Choose CVPFIX from the flyout. The Re-Link Ventura File Paths dialog box opens.
3. Choose file type--publication (*.PUB) or chapter *.CHP files--from the List Files of Type 

box. 
4. Select the file(s) you want to update from the File Name box, changing drives and 

directories as required.
You can select multi-chapter or publication files by holding the Ctrl key and clicking on 
individual files or holding the Shift key and selecting a the first and last file of a group.

5. Click OK.    The publication or chapter files are relinked in the their new location and a 
notification box appears stating that the operation was completed successfully.



Install a foreign-language dictionary
If you have the CD-ROM version of Corel VENTURA, you can install dictionaries to hyphenate 
and check the spelling of words in other languages.
To install a foreign-language dictionary:
1. Copy the files from the SPELDICT directory on the CD-ROM disk #2 to the COREL50\

CUSTOM directory on your hard disk. The choices are:
Language SpellDict HyphenateDict
Danish idnf9341.dat hdndy232.dat
Dutch idnf9320.dat hduds321.dat
English ienc9231.dat hendp148.dat
Finnish ifnf9310.dat hfndy141.dat
French ifrf9221.dat hfrds221.dat
German igfr9310.dathgrds311.dat
Italian iift9260.dat hitds262.dat
Norwegian inof9320.dat hnody321.dat
Portuguese ipof9124.dat hpody141.dat
Spanish ispf9332.dathsprs311.dat
Swedish iswf931.dat hswds311.dat
Note:    If you want to have both hyphenation and spell checking occur in the chosen 
language, both files (SpellDict and HyphenateDict) must be copied to COREL50\CUSTOM.

2. Mark each paragraph to identify the language it's written in. To mark a paragraph, create
a new tag and apply the tag to all paragraphs written in the same language (e.g., 
French).

3. Modify the tag by choosing Paragraph from the Format menu, checking the Typography 
tab and choosing the appropriate language from the Dictionary list box.

4. Click OK.



Install a foreign-language thesaurus
1. Copy the files from the SPELDICT directory on the CD-ROM disk #2 to the COREL50\

CUSTOM directory on your hard disk. The choices are:
Language ThesaurusDict
Danish rdntf300.dat 
Dutch rdutf300.dat 
English renti301.dat 
Finnish rfntf211.dat 
French rfrtf222.dat
German rgrtf300.dat
Italian rittf210.dat
Norwegian rnotf313.dat 
Portuguese rpotf321.dat 
Spanish rsptf302.dat 
Swedish rswtf300.dat 

2. Using Windows Notepad or other ASCII text editor, open the CORELAPP.INI file in your 
COREL50\CONFIG directory.

3. Locate the line ThesaurusDict line and type the file name of the language you want to 
use for the thesaurus (e.g., rdnt300.dat for a Danish thesaurus).

Note:    Because Corel VENTURA uses thesauruses from the INI file, different thesaurus 
files cannot be associated with individual paragraphs.



Corel VENTURA concepts
About Publications and Chapters
About Paragraph Tags and Style Sheets
About Freeform and Tagged Text Tools
About Frames



Corel VENTURA Screen
Click a screen element below for a description of how it works.



Tools and buttons
Ribbon bars
Toolbox



Ribbon Bars
Click a button for a description of its function and characteristics.
Ribbon Bar:

Text Ribbon Bar:



Toolbox
Click a tool for a description of its purpose and characteristics.



Menus
Click a menu for the list of commands it includes. Click a command name to get information 
on what it does and how it works. 
See also How to... Use right-mouse-button menus





















Technical Support
The Technical Support Help file contains information pertaining to:

· Corel Support Services
· Common Error Messages
· Printing Information
· Import and Export File Filter information
· CorelVP.INI file
· other technical information

Click the highlighted text below to open the Technical Support Help file. 
Technical Support



Work with cross references
Inserting cross references
Marking text
Generating and updating cross references



Inserting cross references
1. Mark the location of the item you want to cross reference. See also Marking text
2. Insert a cross-reference symbol on the text exactly where you want the reference to 

appear.
3. Renumber the document to insert the cross-reference text.



Marking text
To insert markers using the Insert Special Item command:

1. Place the text insertion point at the location you want to reference.
2. From the Edit menu, choose Insert Special Item and then from the sub-menu choose 

Marker. The Insert Variable Marker dialog box appears.
3. Do one of the following:

· Type a marker name. You can use any combination of letters, numbers and spaces 
and choose any name you want. Marker names are not case-sensitive; a marker named
PICT is the same as one named Pict or pict.
· If the current document has existing markers, select a marker name from the list box.
Do this when you want to refer readers to more than one location in the document. 
When you insert the cross-reference you can specify how you want the page numbers 
separated--for example by commas (see pages 1,2,3) or by a dash to indicate a range 
of pages (see pages 1 to 4).

4. Choose OK.
To insert markers using the Cross-Ref Roll-up:

1. From the Tools menu, choose Cross-Ref Roll-Up. The Cross-Ref Roll-Up appears.
2. Place the text insertion point at the location you want to reference.
3. Choose the Insert Cross-Ref button.
4. Type or select a marker name as described in step 3 in the preceding procedure and 

then choose OK.
Refer to the Corel VENTURA User's Guide for information about marking frames.



Generating and updating cross references
Page numbers, figure numbers and other references are automatically generated or updated
in a document at cross-reference marker locations when you choose Renumber Publication 
from the Format menu or Cross-Refs Roll-up. When you edit the document, you'll need to 
update the cross-references again to ensure that they are accurate.
To generate and update cross-references:

1. From the Tools menu, choose Cross-Refs Roll-up.
2. Choose the Renumber button.
If you encounter unresolved cross-references, refer the Corel VENTURA User's Guide for 
more information.





Basics
Starting and exiting Corel VENTURA
Corel VENTURA concepts
Setting up the Corel VENTURA screen
Setting preferences
Using Corel Help
Choosing commands
Choosing tools
Working with dialog boxes
Using roll-up windows
Using accelerator keys
Using right-mouse-button menus
Cutting, copying, pasting and deleting
Undoing operations
Using measurement controls
Creating a publication
Setting page size and layout
Setting margins
Setting columns
Creating a style sheet
Saving a new publication
Opening a publication
Navigating through your publication
Opening a chapter created in Ventura 3x or 4x
Specifying footnote settings
Displaying, inserting and editing footnotes
Installing a foreign-language dictionary
Installing a foreign-language thesaurus
Using the appropriate hyphenation dictionary for previous versions of VENTURA



Setting general preferences
The General section of the Preferences dialog box lets you to set general preferences.
To set general preferences:

1. Choose Preferences from the Tools menu. The Preferences dialog box opens.
2. Choose the general preferences you want from the following:

Make Backup on Save: When checked, a backup file is created when you save. 
Backups are made of publication (PUB), chapter (CHP), style sheet (STY) and Text (TXT)
files. They have the same name as the original file, but with a dollar sign ($) 
substituted for the first letter of the extension. Refer to the Corel VENTURA User's 
Guide, General Preferences, for information on using backups.
Prompt to Save Chapter: When checked, you are prompted to save the current 
chapter before moving to another. You'll also be asked to save chapters when 
performing document-wide operations such as finding and replacing text and other 
items.
Verbose Save When saving, you are prompted to name the publication, chapter and 
style sheet as opposed to just the chapter or publication.
Auto-Convert "" &-- on Load: Word processors use inch marks instead of open and 
close quotation marks and two hyphens instead of em dashes. When checked, Corel 
VENTURA automatically converts inch marks to true typographical quotation marks and
two hyphens to an em dash. 
Disable Overrides: When checked, you cannot override tag settings.
Preview Fountain Steps: Determines the number of bands used to represent 
fountain fills on the screen. Choosing a lower value (less than 20) speeds up screen 
draws, but results in noticeable banding.
Index Sort Order: Choose the sort order for languages that have different character 
sets, such as Swedish.
Default Hyphenation: Drop-down list box allowing you to select the default language
dictionary used during the hyphenation.
Spell Check Dictionary: Drop-down list box allowing you to select the dictionary used
to spell check.



Setting text preferences
The Text section of the Preferences dialog box enables you to set defaults for the Copy 
Editor, Paragraph & Text Memory and PANOSE Font Matching.
To set text preferences:

1. Choose Preferences from the Tools menu. 
2. Click Text. The Preferences dialog box opens.
3. Choose the text preferences you want from the following:

Copy Editor: Controls the following options for the Copy Editor:
Default Tab Every: Sets the intervals for default tabs. Enter a number in the box. Set 
the units of measure in the box beside the Default Tab Every. The options are: 
centimeters, inches, millimeters, picas, points, points, didots and ciceros.
Tag Column Width: Sets the width of the column which displays all of the tag names 
for the file.
Font: Displays the current font. Click Change to open the Font dialog box. Choose a 
font and font size.
Show Codes: When checked, displays all of the codes (e.g. bold, underline).
Paragraph & Text Memory: This portion of the dialog box is to be used only if you 
have received an Out of Text Memory error message. If you have received this error 
message, increase the value in the Requested box marginally. That is, start with a 
small increase and then restart to see if the problem is solved. If not, continue with 
small increases until you no longer receive the error message.
Note: The value in the Requested box must be increased in increments of 16.
PANOSE Font Matching: Click to open the PANOSE   Font Matching Preferences   dialog 
box, where you set PANOSE Font Matching preferences. When you open Corel VENTURA 
files from other systems, PANOSE font matching matches missing fonts with similar 
fonts available on your system. PANOSE font matching also occurs when you import text
or graphic formats that support text.



Selecting text for text attribute changes
To select text for text attribute changes:

1. Choose the Tagged Text or Freeform Text tool.
2. Place the cursor anywhere in the paragraph and do one of the following:

· Click and drag the mouse to highlight the text
· Double-click the mouse to highlight a word
· Click once to determine start point, hold down the Shift key and click to determine 

end point.
· Hold down the Ctrl key and click once anywhere in the paragraph to highlight a 

paragraph.
3. Choose the Selected Text command from the Format menu. 



Selecting paragraphs (for formatting changes)
To select paragraphs:

1. Choose the Tagged Text or Freeform Text tool.
2. Do one of the following:

· Click once anywhere in the paragraph.
· Hold down the Alt key and click once anywhere in the paragraph. While the Alt key is

depressed, you can select multiple paragraphs by clicking once in each paragraph. 
The cursor will change from a text cursor to a paragraph cursor.

The Paragraph Settings dialog box will now be available in the Format menu.



Starting and exiting Corel VENTURA
Starting Corel VENTURA:

· Double click on the Corel VENTURA icon in the Windows Program Manager. The Corel 
VENTURA screen is displayed. 

Exiting Corel VENTURA:
· To exit Corel VENTURA, select Exit from the File menu. You are prompted to save the 

publication before quitting if you have not saved the current changes.



Setting up the Corel VENTURA screen
Setting display preferences
Changing views

Copy editor
Draft
Page layout



Setting display preferences
1. Choose Preferences from the Tools menu. 
2. From the Preferences dialog box, click the following checkboxes to display or hide the 

corresponding options: 
Toolbox, Floating Toolbox
Rulers
Grid
Ribbon Bars
Status Line
Tabs & Returns
Column Guides
Loose Lines
Generated Tags
Pop-up Help

You may also choose settings for Greek Text Below, which speeds up screen display by 
showing text below the specified size as bars. and Preview Colors--choose either the 256 
Color Dithering radio button or the Windows Dithering radio button. The display of color on 
your screen is determined by the dithering method chosen..



Copy Editor
The copy editor mode is used for quick editing. It displays the publication as a continuous 
stream of text in a single proportional font. The graphics, frames, structured drawings and 
font styles, color, alignment, etcetera are not displayed. You can apply paragraph tags, but 
you cannot move or edit graphics or tables.

See also:
Overview--Working with Text
To change to Copy Editor mode:

· Choose View menu, Copy Editor.



Draft
Draft mode is identical to page layout model with the exception of the graphics. The 
graphics are grayed out.
To change to Draft mode:

· Choose View menu, Draft.

See also:
Overview--Working with Text



Page Layout
Page layout displays text, graphics and tables as they would appear when printed.
To change to Page Layout mode:

· Choose View menu, Page Layout.

See also:
Overview--Working with Text



About Publications and Chapters
Most programs can work with one, or perhaps a few files, at one time. For instance, when 
you import a piece of clipart into a drawing in CorelDRAW, that piece of clipart becomes part 
of the drawing. By contrast, Corel VENTURA can combine 128 separate text and graphics 
files in a single document. Instead of integrating the files into one document, Corel VENTURA
simply remembers where the files are stored. It does this by maintaining a list of pointers in 
a chapter file. These pointers tell Corel VENTURA where to find the text and graphics files 
and how to position them in the formatted document. They also tell the program where to 
find the style sheet used to format pages and text in the document. 
Keeping the text and graphics files separate means that other documents can share the 
same text and graphics. It also means that you can edit the files in other programs at any 
time. Changes you make to the files are reflected in the Corel VENTURA document the next 
time you open it.
Documents you create in Corel VENTURA can be divided into sections, called chapters, that 
make up a publication file. Just as a chapter links the text and graphics files in a document, a
publication links the chapters so that you can manage each document as a unit. Some of the
operations you can perform on a publication file include:

· Generating a table of contents and index that covers all the chapters
· Copying individual chapters or the entire publication
· Renumbering pages, tables and figures for the entire publication
· Updating cross-references for the entire publication



About Paragraph tags and Style Sheets
A style tag is a group of text attributes such as font, line spacing and alignment which you 
can apply to text simply by selecting the tag's name from a list. The paragraph tags are 
stored in a style sheet which also contains information about the margin settings, the 
number of columns, page orientation and other document formatting.
The use of paragraph tags and style sheets simplifies the task of laying out a document. The
same style sheet can be used over and over, making it easy for you to achieve consistent 
formatting both within a document and across other similar documents. And when you 
modify a style sheet by changing attributes in a style tag, for example, the changes will be 
reflected in all other documents which use that style sheet.
Corel VENTURA remembers which style sheet a particular document uses and loads it for 
you whenever you open the document. By applying a different style sheet, you can instantly 
change the format of the entire document.
So that you can begin creating attractive documents right away, Corel VENTURA comes with 
many predefined style sheets for a wide range of document types including reports, books 
and proposals. These style sheets are described in the Templates section of the Corel 
Libraries Catalog. You can use the predefined style sheets as they are or modify them to suit 
your needs.



About Frames
Corel VENTURA uses frames to hold text and graphics. A page frame which is the size of a 
full page, is automatically created when you begin a new document. When text is placed in 
the page frame, any text that does not fit on the current page automatically flows to 
succeeding pages.
Free frames are frames you create yourself. Unlike the page frame, free frames can be 
moved anywhere on the page. They can also be anchored to text so that they move with the
surrounding text when you edit the document.
Using free frames for documents like newsletters and magazines, enables you to begin an 
article on one page and continue it on any later page. What's more, each frame can have its 
own margin and column settings.



Creating a publication--Overview
Corel VENTURA can combine any number of separate text and graphics files in a single 
document and keep them separate. Just as a chapter links the text and graphics files in a 
document, a publication links the chapters so that you can manage each document as a 
unit. 

Documents you create in Corel VENTURA can be divided into sections, called chapters 
(*.CHP), that make up a publication (*.PUB) file. They also tell the program where to find the 
style sheet (*.STY) used to format pages and text in the document, and any captions (*.CAP) 
you create. 
Instead of integrating the files into one document, Corel VENTURA simply remembers where 
the files are stored. It does this by maintaining a list of pointers in a chapter file. These 
pointers tell Corel VENTURA where to find the text and graphics files and how to position 
them in the formatted document. 
Keeping the text and graphics files separate means that other documents can share the 
same text and graphics. It also means that you can edit the files in other programs at any 
time. Changes you make to the files are reflected in the Corel VENTURA document the next 
time you open it.
Some of the operations you can perform on a publication file include:

· Generating a table of contents and index that covers all the chapters
· Copying individual chapters or the entire publication
· Renumbering pages, tables and figures for the entire publication
· Updating cross-references for the entire publication



Creating a publication from scratch
1. Choose File menu, New. The Default Style button is highlighted in the Create New 

group of the New Publication dialog box.
2. Choose a page layout from the Layout drop-down list.. The selected layout is displayed 

in the top left of the Preview box.
A default style sheet is loaded.

Note: You can load another style sheet by clicking the Load Style button. 

See also:
Loading style sheets



Creating a publication from a template
You can use the Base on Template dialog box to select a publication to use as a template. A 
template includes text files, graphic files and chapter settings of the chapters included in the
publication. You can include    the text and graphic files or you can choose just the chapter 
settings.
Note: If you select a publication that has already been used as a template in the current 
directory, you will not be able to use it again in the same directory. An icon ( ) is displayed 
beside the chapter files that have been used previously.
To create a publication from a template:

1. Choose File, New.
2. Click Base on Template on the New Publication dialog box. The File Open dialog box 

opens.
3. Choose a publication file to use as a template for the new publication and click OK.

The Base on Template dialog box opens.
4. Choose the drive and directory where the new publication is to be stored.
5. Type a name for the new publication.
6. Highlight the names of the original publication files you want to include in the new 

publication.
7. Select the file in the Files List and click Include Files to select files. Check marks appear

to the left of selected files.
If you want to omit files, click Omit Files. The Include Files button toggles between 
include and omit.
If you want to include only the style sheet, frames and columns, include the chapter 
file and omit the text and graphic files associated with the chapter.

8. Check the Copy all files option if you want to copy all selected text and graphic files in 
the drive and directory chosen for the new publication. Omit this step to keep the files 
in their original locations. The chapters included in the new publication have pointers 
that finds these files.

9. Click OK.    The new publication appears in the document area and includes the style 
sheets and selected text and graphic files from the original publication.
Note: If you have selected more than one chapter, The Go to Chapter dialog box 
opens, allowing you to move to a specified chapter.



Loading style sheets
Style sheets can be loaded using the New Publication dialog box or the Load Style Sheet 
command from the Layout menu. When you create a new publication, you have the option of
loading an existing style sheet rather than using the default style sheet.
To load a style sheet when creating a new publication:

1. Choose New from the File menu. The New Publication dialog box opens.
2. Click Default Style to load the default style sheet. 
OR
1. Choose New from the File menu. The New Publication dialog box opens.
2. Click Load Style to load a style sheet other than the default. The Open Style Sheet 

dialog box appears.
3. Choose a style sheet (.STY file).

To load a style sheet into the current publication:
1. Choose Layout, Load Style Sheet. The Open Style Sheet dialog box opens.
2. Choose a style sheet.



Loading style sheets
Style sheets can be loaded using the New Publication dialog box or the Load Style Sheet 
command from the Layout menu. When you create a new publication, you have the option of
loading an existing style sheet rather than using the default style sheet.
To load a style sheet when creating a new publication:

1. Choose New from the File menu. The New Publication dialog box opens.
2. Click Default Style to load the default style sheet. 
OR
1. Choose New from the File menu. The New Publication dialog box opens.
2. Click Load Style to load a style sheet other than the default. The Open Style Sheet 

dialog box appears.
3. Choose a style sheet (.STY file).

To load a style sheet into the current publication:
1. Choose Layout, Load Style Sheet. The Open Style Sheet dialog box opens.
2. Choose a style sheet.



Loading text
Text files are loaded into a new or existing document by using the Load File command on the
File menu.
To load text into a document:

1. Choose Load Text from the File menu. The Load Text dialog box opens.
2. Choose a text file name in the File Name box.

Note: If you want to select multiple file names, hold the CTRL key and select the file 
names with the left mouse button. A quick way to select multiple file names in a series 
is to click on the first file name, hold down the SHIFT key, then click on the last name in
the list.

3. To have the text file available in other chapters in the document, choose the Options 
button and enable the Add to File List option.

4. Click OK. The file name will be added to the Files List. If you selected a frame before 
loading, the text file will appear in the frame.



Loading graphics
Graphic files can be loaded, or imported, into a publication either by using the Load File 
command on the File menu or creating a publication from a template.
To load graphics into a document:

1. Choose Load Graphic from the File menu. The Load Graphic dialog box opens.
2. Choose a graphic file name in the File Name box.

Note: If you want to select multiple file names, hold the CTRL key and select the file 
names with the left mouse button. A quick way to select multiple file names in a series 
is to click on the first file name, hold down the SHIFT key, then click on the last name in
the list.

3. To have the graphic file available in other chapters in the document, choose the 
Options button and enable the Add to File List option.

4. Click OK. The file name will be added to the Files List. If you selected a frame before 
loading, the graphic file will appear in the frame.



Importing graphics
Graphic files can be imported into a publication by either using the Import command on the 
File menu or creating a publication from a template.
To import graphics into a new publication:

1. Choose New from the File menu. The New Publication dialog box opens.
2. Click Base on Template. The File Open dialog box opens.
3. Choose a publication file to use as a template for the new publication and click OK.

The Base on Template dialog box opens.
4. Choose a drive and directory and type a file name for the new publication.
5. Highlight the graphic files to be imported in the new publication. The chapter file 

(.CHP) under which the graphic files are listed must be selected to import the graphics.
6. Click Include Files.

To import graphics into a current publication:
1. Choose Load Graphic from the File menu. The Load Graphic dialog box opens.
2. Choose a graphic file.



Inserting and deleting pages
To insert pages:

1. Choose Insert Page... from the Layout menu. The Insert Page dialog box opens.
2. Enter the number of pages in the Insert # Pages box.
3. Click either Before or After.
4. Enter the number of the page after which or before which the pages are to be inserted.

To delete pages:
1. Choose Delete Page... from the Layout menu. The Delete Page dialog box opens.
2. Enter the number of pages in the Delete # Pages box.
3. Click either Before or After.
4. Enter the number of the page after which or before which the pages are to be deleted.



Creating headers and footers
Headers appear at the top of the page and usually occur on every page. Footers appear at 
the bottom of the page and usually occur on every page. Three entries are available for both
headers and footers: left justified, center and right justified. The left and right margins are 
the same as those specified for the page frame.
Headers and footers can contain information you want to display on each page. For example,
chapter name and topic, date, company name, etc.
To create headers and footers:

1. Choose Chapter Settings, Layout menu. The Chapter Settings dialog box opens.
2. Click the Header/Footer tab. The Headers/Footers dialog box opens.
3. Choose the header(s) and footer(s) in the Define drop-down list box. Each header and 

footer must be defined and the text must be entered separately.
4. Enter the text in the Header/Footer Text section of the dialog box. Left places the text 

at the left margin, center places the text in the center and right places the text at the 
right margin.
The name changes to reflect the selection made in the Define drop-down list box. For 
example, if you choose a header the name is Header Text.

5. Use the insert buttons below the Header/Footer text boxes to insert the following:

chapter numbers - inserts the code [C]

page numbers - inserts the code [P]

text attributes 

current time

current date

text from the first paragraph on a page formatted with first style tag 

text from the last paragraph on a page formatted with first style tag. If a page 
contains more than one paragraph with the first match tag, the text from the last paragraph 
on the page with the first match tag appears. 

6. Click Copy to Facing Page to copy the header or footer to the facing page. The position 
of the header or footer on both pages is the same. For example, if the original is on the 
right side, the one copied to the facing page is on the right side.

7. Click Mirror to Facing Page to reverse the position of the header or footer for the facing 
page. A left justified header page would appear on the right side of the facing page.

8. In the Enable section of the dialog box, click one of the following to display the footer(s)
and/or headers(s) in your document:
Left Page Header enables the left page header.
Left Page Footer enables the left page footer.



Right Page Header enables the right page footer.
Right Page Footer enables the right page footer.



Displaying, inserting and editing footnotes
Set up your footnote format in the Footnotes tab of the Chapter Settings--Footnotes dialog 
box. See also, Specifying footnote settings.
To insert a footnote:

1. Click theTaggedText or Freeform Text tool and place the cursor on the page where you 
want the footnote symbol to appear.

2. Choose Insert Special Item from the Edit menu.
3. Choose Footnote from the Insert Special Item flyout menu.

The footnote number or symbol appears at the insertion point on the page and its 
reference appears at the bottom of the page.

To turn the display and printing of footnotes on and off:
· Either Choose Enable Footnotes from the Layout menu or choose Chapter Settings from

the Layout menu and select Off on the Footnotes tab.
To edit a footnote:

1. Click the Tagged Text or Freeform Text tool.
2. Ensure that Enable Footnotes is enabled in the Layout menu.
3. Go to the end of the chapter of page and edit the footnote text.



Displaying, inserting and editing footnotes
Set up your footnote format in the Chapter Settings--Footnotes dialog box. You may edit 
footnote text in Draft and Page Layout modes. 
See also Specifying footnote settings.
To insert a footnote:

1. Click the Tagged Text tool or the Freeform Text tool and place the cursor on the page 
where you want the footnote symbol to appear.

2. Choose Insert Special Item from the Edit menu.
3. Choose Footnote from the Insert Special Item flyout menu.

The footnote number or symbol appears at the insertion point on the page and its 
reference appears at the bottom of the page.

To turn the display and printing of footnotes on and off:
· Either Choose Enable Footnotes from the Layout menu or choose Chapter Settings from

the Layout menu and select Off on the Footnotes tab.



Specifying footnote settings
Footnotes are references concerning the content of the document. For example, a quotation 
from a specific author, is referenced in a footnote.
To specify footnote settings:

1. Choose Chapter Settings from the Layout menu. The Chapter Settings dialog box 
opens.

2. Click Footnotes. The Footnotes dialog box opens.
3. Choose either Numerical or Custom. 

Numerical creates the standard numbered footnote.
Custom enables you to create footnote markers. You can use characters such letters, 
symbols, etcetera.

4. Enter the number of the first footnote to be assigned a reference in the Footnote # 
box. 

5. Enter the reference in the Reference box. 
If you have selected Numerical, the numbers are displayed sequentially corresponding 
to the numbers in the Footnote # box. If you have selected Custom, enter a number or 
character to correspond with each footnote.

6. Enter text in the Template box that you want to appear with every footnote.
7. Check the Add Separator Line checkbox to add a separator line. 
8. Enter the Space Above, Thickness and Line Width of the Separator Line.
9. Choose the Position from Superscript, Subscript or Normal.
10. Choose one of the following Options:

Start with Footnote #    Choose the starting number for the footnotes.
Restart On    Choose the location for the restart of the footnote numbers. The options 
are Each Page and Each Chapter.



Specifying footnote settings
Footnotes are references concerning the content of the document. For example, a quotation 
from a specific author, is referenced in a footnote.
To specify footnote settings:

1. Choose Chapter Settings from the Layout menu. The Chapter Settings dialog box 
opens.

2. Click Footnotes. The Footnotes dialog box opens.
3. Choose either Numerical or Custom. 

Numerical creates the standard numbered footnote.
Custom enables you to create footnote markers. You can use characters such letters, 
symbols, etcetera.

4. Enter the number of the first footnote to be assigned a reference in the Footnote # 
box. 

5. Enter the reference in the Reference box. 
If you have selected Numerical, the numbers are displayed sequentially corresponding 
to the numbers in the Footnote # box. If you have selected Custom, enter a number or 
character to correspond with each footnote.

6. Enter text in the Template box that you want to appear with every footnote.
7. Check the Add Separator Line checkbox to add a separator line. 
8. Enter the Space Above, Thickness and Line Width of the Separator Line.
9. Choose the Position from Superscript, Subscript or Normal.
10. Choose one of the following Options:

Start with Footnote #    Choose the starting number for the footnotes.
Restart On    Choose the location for the restart of the footnote numbers. The options 
are Each Page and Each Chapter.



Laying out your chapters
Chapter layout is the size of the paper, orientation, fold type, style sheet, which side the 
chapter starts on and whether it is single sided or double sided.
To set chapter layout:

1. Choose Chapter Settings from the Layout menu. The Chapter Settings, Layout dialog 
box opens.

2. Choose the orientation of the page: Portrait or Landscape.
3. Choose a page size from the drop-down list box or enter a value in the Width and 

Height boxes to create a custom paper size. The maximum size of paper is 27.3 x 27.3 
inches.
If you set the page size to the maximum, you cannot have graphics or text running 
over (bleeding) the edges of the page.

4. Choose a fold type from the Layout drop-down list box. Fold determines the way in 
which the text is printed on the page to allow for folding after the page is printed.

5. Check either Single or Double. These checkboxes determine if the pages are double 
sided (printed on both sides) or single sided (printed on one side).

6. In the Start On portion of the dialog box, check either Right Side or Left Side to 
determine which the side the chapter starts on.



Specifying footnote settings
Footnotes are references or explanations concerning the content of the document. For 
example, a quotation from a specific author, is referenced in a footnote. See also Displaying,
inserting and editing footnotes
To specify footnote settings:

1. Choose Chapter Settings from the Layout menu. The Chapter Settings dialog box 
opens.

2. Click Footnotes. The Footnotes dialog box opens.
3. Choose either Numerical or Custom. 

Numerical creates the standard numbered footnote.
Custom lets you to create footnote markers. You can use characters such as letters, 
symbols, etcetera.

4. Enter the number of the first footnote to be assigned a reference in the Footnote # 
box. 

5. Enter the reference in the Reference box. 
If you chose Numerical, the numbers are displayed sequentially, corresponding to the 
numbers in the Footnote # box. If you have selected Custom, enter a number or 
character to correspond with each footnote.

6. Enter text in the Template box that you want to appear with each footnote.
7. Check the Add Separator Line checkbox to add a separator line. 
8. Enter the Space Above, Thickness and Line Width of the Separator Line.
9. Choose the Footnote Position Superscript, Subscript or Normal.
10. Choose the Options:

Start with Footnote #    Choose the starting number for the footnotes.
Restart On    Choose the location for the restart of the footnote numbers. The options 
are Each Page and Each Chapter.



Adding numbering
The Chapter Settings, Numbering dialog sets the counters for the chapter, pages, tables and
figures and sets the automatic paragraph numbering. Note that automatic paragraph 
numbering is only available for numbering paragraphs on the base page.
The Counter portion does the following:

· Sets the chapter, page, table, and figure numbering at any point in a chapter
· Changes numbering styles (e.g., I, II, III or 1, 2, 3)
· Automatically numbers across chapters

To set the counters:
1. Choose Chapter Settings from the Layout menu. The Chapter Settings dialog box 

opens.
2. Click Numbering. The Chapter Settings, Numbering opens.
3. Click the counter (Chapter, Initial Page, Initial Figure, Initial Table) you want to set.
4. Click Continue From Previous Chapter to continue the numbering from the previous 

chapter. Starting Number and Number Style are disabled.
If you want to change the numbering, leave Continue from Previous Chapter unchecked and 
use the Starting Number and Number Style boxes.
To number paragraphs automatically:

1. Choose Chapter Settings from the Layout menu. The Chapter Settings dialog box 
opens.

2. Click Numbering. The Chapter Settings, Numbering opens.
3. Check the Auto Numbering On option.

If you want to use a built-in numbering scheme available from the Quick Format Roll-
Up, do the following, otherwise, proceed to step 4:
· Click the Quick Format button. The Auto Numbering Quick Format dialog box 

appears.
· Select the number scheme you want and click OK. A Warning Box appears 

prompting whether you want to replace current tags with the Quick Format 
defaults. Choose Yes.

· The headings will be shown in a suggested hierarchy. To change the numbering 
hierarchy, click its name in the Paragraph Type list box.

· Repeat the previous step for each addional level, making sure to increment the 
value in the Number of Levels box before selecting the paragraph tag.

4. Choose the number of levels you want from the # of Levels drop-down list box. 
5. Enter a level in the Level box. Each level is formatted individually.
6. Choose a style tag from the Paragraph Type box.
7. Choose a numbering style from the Number Style box. 
8. Enter the starting number in the Initial # box. 
9. Enter text before and/or after the number in the Additional Text box. This text appears 

with all of the numbers; for example, parentheses enclosing the number or chapter 



name.
10. Select or type additional text in the Additional Text box with the mouse and click Text 

Attributes to apply text attributes codes and click OK.
11, Repeat steps 4-10 for each additional level for which you want to define an auto-

numbering scheme.
NOTE: If auto-numbering is turned off, a previously auto-numbered paragraph may print on 
top of the paragraph preceding it. To correct the problem, select the preceding paragraph. 
Then, choose Breaks from the Format menu and set Line Break to After.



Typography
The Chapter Settings, Typography dialog box sets the following: Widows and Orphans, First 
Baseline, Column Balance, Pair Kerning and Vertical Justification.
To set chapter typography:

1. Choose Chapter Settings from the Layout menu. The Chapter Settings dialog box 
opens.

2. Click Typography. The Chapter Settings, Typography dialog box opens.
3. Enter a number in the Widows box. 
4. Enter a number in the Orphans box.
5. Choose a baseline height in the First Baseline drop-down list box. This determines 

where the first line of text begins on a page or frame
6. To balance columns, check the Column Balance checkbox.
7. To turn kerning on for the chapter, check Pair Kerning. This setting overrides the 

settings in the Paragraph Typography dialog box.
8. Set Vertical Justification with the following options:

Within Frame    Choose either feathering or carding. 
Maximum Justification    Enter a percentage. The resulting justification is the 
combination of Maximum at Top and Maximum of Bottom for paragraphs plus the 
percentage.
Around Frame    Choose either Moveable or Fixed. Fixed causes the frame to remain 
fixed. Space is added below the frame. Moveable causes the frame to move down to 
create space above.
Maximum at Top    Sets the maximum amount of space between text and frame at top.
Maximum at Bottom    Sets the maximum amount of space between text and frame at 
bottom.



Adding a new chapter
Corel VENTURA documents are divided into chapters that make up a publication file. You can 
add a new chapter at the end of a publication.    The order of chapters within a publication is 
changed using the Publication Manager command in the File menu.
To add a new chapter to a publication:
· Choose Add New Chapter from the Layout menu.

The screen is cleared and a new chapter appears.
If the chapter you were working with before adding a new chapter has been modified 
since the last save, you are prompted to save the changes.



Adding an existing chapter
Corel VENTURA documents are divided into chapters that make up a publication file. You can 
add a chapter from another publication to the current publication.    The order of chapters 
within a publication is changed using the Publication Manager command in the File menu.

1. Choose Add Existing Chapter from the Layout menu. The Open dialog box is displayed.
2. Choose a chapter. The chapter is placed after the current page.



Navigating through your publication
Going to a specific page
Going to the next or previous chapter
Using the keyboard



Going to a specific page
The Go to Page command (View menu) lets you to quickly go to a specific page in the 
current chapter. 
To go to a specific page in the current chapter:

1. Choose Go to Page from the View menu.
2. Enter a page number in the Go to Page box.

To move through the pages of the current chapter:

· Click the  buttons at the bottom right corner of the Corel VENTURA window
OR

· Choose Go To Page from the View menu and type a page number in the entry box or 
click the up or down arrow to the right of the entry box to select a number. You can also use 
the four navigation buttons at the top of the dialog box to go to the first page, previous 
page, next page and last page in the document. 
Text files are sometimes found on non-sequential pages because the text starts on one page 
of the document then continues on a much later page, like newspaper articles, or, because 
pages of illustrations are inserted between pages of text. The Go to Page command enables 
you to move through the pages that contain text from a selected text file. 
To move through pages containing text from a specific file in the chapter:

1. In the chapter, click a text file with either the Freeform or Tagged Text tool.
2. Choose Go to Page from the View menu.
3. Check the Relative to file option.
4. If you want to move through the pages of a text file other than the one selected in step

1, choose the text file in the File drop-down list box.
5. Do one of the following:

· Type a page number in the Go to Page box.    Page 1 of the text file being the first 
page of the current chapter that includes text from the selected file, it may not 
correspond to the first page of the chapter

· Use the Forward/Backward buttons to move through the pages containing text from 
the selected text file.    The buttons, from left to right, move to the First page, 
Previous page, Next page, Last page.



Going to the next or previous chapter
To display the first page in the next or previous chapter in the current publication, click the

 buttons on the Ribbon Bar.



Using the keyboard
To Press
Move to the previous page: Page Up
Move to the next page: Page Down
Move to the first page: Ctrl + Home
Move to the last page: Ctrl + End
Move to the next chapter Alt + Page Down
Move to the previous chapter Alt + Page Up



Setting page size and layout
The size of paper, orientation, fold type, style sheet, which side the chapter starts on and 
whether it is single sided or double sided can be set.
To set chapter layout:

1. Choose Chapter Settings from the Layout menu. The Chapter Settings, Layout dialog 
box opens.

2. Choose the orientation of the page: Portrait or Landscape.
3. Choose a page size from the drop-down list box or enter a value in the Width and 

Height boxes to create a custom paper size.
4. Choose a fold type from the Layout drop-down list box. Fold determines the way in 

which the text is printed on the page to allow for folding after the page is printed.
5. Check either Single or Double. These checkboxes determine if the pages are double 

sided (printed on both sides) or single sided (printed on one side).
6. In the Start On portion of the dialog box, check either Right Side or Left Side to 

determine which the side the chapter starts on.



Setting margins
You can adjust margin settings in a document using the Frame command or rulers. The 
margins on the left and right pages can be identical, symmetrical or totally different. Pages 
inserted with the Layout menu's Insert Pages command can also have unique margin 
settings. The same applies to frames added to a document using the Frame tool. 
Review your changes in the Preview window at the right side of the dialog box and adjust as 
required.
Note: Although the following procedures describe how to set margins for the base page, the
same procedures apply for inserted pages or free frames. 
To set base-page margins using the rulers:

1. Select the base page frame.
2. With the base page displayed, drag the margin boundary markers left or right along 

the horizontal ruler.
Note: The margin boundary markers snap to the tick marks on the ruler. To override 
snapping, hold down the Ctrl key as you drag. Also, the left-margin boundary marker is 
divided has two halves--top and bottom. The top half of the marker moves 
independently, while dragging the bottom half moves both at once.

To set base-page margins with the Frame command:
1. Select the base page frame.
2. From the Format menu, choose Frame and then click the Margins tab.
3. Adjust the settings as required. Note: You can choose your preferred unit of measure 

from the list box at the bottom center of the dialog box.
· To change the current Top, Bottom, Left or Right inside margins, type or select the 

settings you require. Click the All radio button before choosing your settings to 
apply your new settings to all pages equally, or choose Left or Right before you 
make your changes to apply different settings for the left and right pages.

· To place vertical lines, or "rules," down the length of the page (you can have one or 
two) choose the ruling line you want (1 or 2), set its Position from the left edge of 
the page (not the margin) and choose a line thickness.

· To mirror the left and right settings to the opposite pages of a double-sided 
document, choose the Mirror to Facing Pages button. Corel VENTURA reflects the 
settings so that the right margin and rule settings for the right page become the left
margin and rule settings for the left page and vice versa.

4. Click OK to apply your changes.



Setting columns
You can adjust column settings in a document using the Frame command or rulers. The 
columns on the left and right pages can be identical, symmetrical or totally different. Pages 
inserted with the Layout menu's Insert Pages command can also have unique column 
settings. The same applies to frames added to a document using the Frame tool. 
Review your changes in the Preview window at the right side of the dialog box and adjust as 
required.
Note: Although the following procedures describe how to set columns for the base page, the
same procedures apply for inserted pages or free frames, with the exception that Columns 
set for the base page repeat on regular following pages. 
To set base-page columns using the rulers:

1. Select the base page frame.
2. With the base page displayed, drag the column boundary markers left or right along 

the horizontal ruler.
Note: The column boundary markers snap to the tick marks on the ruler. To override 
snapping, hold down the Ctrl key as you drag. 

To set base-page columns with the Frame command:
1. Select the base page frame.
2. From the Format menu, choose Frame and click the Columns tab.
3. Adjust the settings as required. Note: You can choose your preferred unit of measure 

from the list box at the bottom center of the dialog box.
· Choose All, Left, or Right to determine how the columns repeat on following pages. 

Click the All radio button before choosing your settings to apply your new settings to
all pages equally, or choose Left or Right before you make your changes to apply 
different settings for the left and right pages.

· To place vertical lines, or "rules," between the columns, (you can have up to eight--
with 7 inter-column lines) choose Inter-Column Rules, choose line- and gutter-widths.

· To mirror the left and right settings to the opposite pages of a double-sided 
document, choose the Copy to Facing Pages button. Corel VENTURA reflects the 
settings so that the right column and rule settings for the right page become the left
column and rule settings for the left page and vice versa.

· Click Equal Width to automatically make all columns of equal widths.
· Turn column balance on or off as required.

4. Click OK to apply your changes.



Cutting, copying, pasting and deleting

Cutting
Cutting text
Cutting frames
Cutting graphic objects

Copying
Copying text
Copying frames
Copying graphic objects
Copying between publications

Pasting and deleting
Pasting text
Pasting frames
Pasting graphic objects
Pasting ASCII text from other applications
Pasting bitmaps and metafiles
Pasting linked objects
Pasting objects
Deleting text, frames and graphics



Overview
The Cut, Copy, Paste and Delete functions allow you to delete, move and copy text, frames 
and graphics. Cut, Copy and Paste use the Windows clipboard to store the information. Only 
one item can be cut or copied to the clipboard at a time. If you cut or copy an object to the 
clipboard, any    previous information is cleared from the clipboard.
Cut Removes the selected object and places it on the clipboard.
Copy Places an identical copy of the selected object on the clipboard without removing the 

original.
Paste If the clipboard contains text, places the last item cut or copied at the current 

position of the text cursor. If the clipboard contains a frame or a graphic, places the 
item at the identical location on a new page or current one if a frame or a graphic. If 
the clipboard contains paragraph tags, places them into the current style sheet.

Delete Removes the selected object. It is not placed on the clipboard and cannot be 
pasted into the chapter. The only way to restore the cut object is to use the Undo 
command on the Edit menu.

Using Cut, Copy and Paste, you can:
· Move text, frames and graphics from one part of a chapter to another and between 

chapters.
· Move text between different documents.
· Place identical copies of the same picture on more than one page.
· Make duplicate blank frames. (If you want to have the same frame on every page, use 

the Repeating frame section of the Frame settings dialog box.)
· Copy or move selected graphics.
· Move tags between style sheets.
· Move text between Windows applications.



Cutting text
You can cut text and special items such as frame anchors, markers or index entries that 
have been inserted into it . When you cut text, it is placed on the clipboard until either it is 
pasted back into the document or it is replaced by text or a graphic from another cut or copy
operation. If you include the paragraph symbol with the selected text, the text will retain its 
original formatting when it is pasted back into the document. Otherwise, it will adopt the 
formatting of the paragraph it's being inserted into.
To cut text:

1. Click either the Freeform or Tagged Text tool.
2. Select the text.
3. Choose Cut from the Edit menu. 

If you make a mistake while cutting the text, choose Undo from the Edit menu.
To cut special items:

1. Choose Copy Editor from the View menu.
2. Make sure that Tabs and Returns are enabled from the Preferences dialog box (Tools 

menu) which will allow you to see the codes. 
3. Click either the Freeform or Tagged Text tool.
4. Highlight the code for the special item by swiping.
5. Choose Cut from the Edit menu.

Note: The special item is removed from the text, but is not placed on the clipboard. If 
you want to reinsert the special item, use the Undo command on the Edit menu.



Cutting frames
When you cut a frame, its contents and all graphics attached to the frame are placed on the 
clipboard. To paste the frame back into the document, use the Paste command from the Edit 
menu. The table and figure counters are automatically updated for frames that contain 
captions.
To cut frames:

1. Click the Pick tool.
2. Do one of the following:

· To select a single frame, click inside it with the mouse pointer. 
· To select multiple frames, hold down the Shift key and click inside the individual 

frames with the mouse pointer.
3. Choose Cut from the Edit menu.    The frame is placed on the clipboard. You can paste it

back into your document using the Paste command.



Cutting graphic objects
When you cut a graphic object, it is placed on the clipboard until either you paste it back 
into your document or it is replaced by text or a graphic from another cut or copy operation.
To cut graphic objects:

1. Click the Pick tool.
2. Do one of the following:

· To select a single graphic object, click on it with the mouse pointer. 
· To select multiple graphic objects, press and hold down the Shift key and click on 

the individual frames with the mouse pointer. Only graphics in the same frame can 
be selected simultaneously.

3. Choose Cut from the Edit menu. The graphic object is placed on the clipboard. You can 
paste it back into your document using the Paste command.



Copying text
You can copy text and special items such as frame anchors, markers or index entries that 
are inserted into it. Copied text is placed on the clipboard until either it is pasted into your 
document or replaced by text or a graphic from another cut or copy operation.    If you 
include the paragraph symbol with the selected text, the text will retain its original 
formatting when it is pasted into the document. Otherwise, it will adopt the formatting of the
paragraph it's being inserted into. 
To copy text:

1. Click either the Freeform or Tagged Text tool.
2. Select the text.
3. Choose Copy from the Edit menu. Any special items in the selected text are copied too.

To copy special items:
1. Click either the Freeform or Tagged Text tool.
2. Make sure Tabs and Returns (under the Tools menu, choose Preferences, View tab) are 

turned on so that you can see the degree symbol that marks the location of the special
item.

3. Highlight the special item by swiping.
4. Choose Copy from the Edit menu. 

See also:
Copying between publications



Copying frames
When you copy a frame, its controls and all graphic objects attached to the frame are copied
to the clipboard until the frame is either pasted into a document or replaced by text or a 
graphic from another cut or copy operation. The table and figure counters are automatically 
updated for frames that contain captions.
To copy frames:

1. Click the Pick tool.
2. Do one of the following:

· To select a single frame, click inside it with the mouse pointer.
· To select multiple frames, press and hold down the Shift key and click on the 

individual frames with the mouse pointer. 
3. Choose Copy from the Edit menu.

See also:
Copying between publications



Copying graphic objects
When you copy a graphic object, a replica of the original is placed on the clipboard until 
either it is pasted into a document or replaced by text or a graphic from another cut or copy 
operation.
To copy graphic objects:

1. Click the Pick tool.
2. Do one of the following:

· To select a single graphic object, click on the object with the mouse pointer.
· To select multiple graphic objects, press and hold down the Shift key and click on 

the objects with the mouse pointer.
3. Choose Copy from the Edit menu. The copy of the graphic object is placed on the 

clipboard. You can paste it into your document using the Paste command.

See also:
Copying between publications



Copying between publications
Text, frames and graphic objects can be copied from one document to another using the 
clipboard. The copied text, frame or graphic remains on the clipboard when you open a new 
publication. How copied text affects the formatting of the paragraph it is pasted into 
depends on whether your text includes the paragraph symbol or just part of a paragraph. 
Text copied without the paragraph symbol does not affect tagging. If you do include the 
paragraph symbol when copying the text, the tag and its attributes will be carried with the 
copied text when pasted to any document with the same style sheet. Local formatting 
changes in the new paragraph will not be affected in either case. However, when you copy 
and paste text to another publication, the tag attributes are not copied; the tag assumes the
attributes of the paragraph it is pasted into and the tag name is added to the tag list. 
To copy or replace tags from the current style sheet with those in another, choose Manage 
Tag List from the Format menu (Shortcut: Shift+F9) and choose Merge Tags. Corel VENTURA
will replace the tags of the same name in the current style sheet with those in the selected 
one. See also Copying text
To copy text and frames between publications:

1. Cut or copy text, frames or graphics.
2. Choose Save from the File menu to save the current publication.
3. Choose Open from the File menu. The Open dialog box opens.
4. Choose the publication into which you want the selected item pasted.
5. Go to the page on which the item is to be pasted.
6. Choose Paste from the Edit menu.



Pasting text
When you paste text into a document from a cut or copy operation, a copy of the text 
remains on the clipboard. Therefore, you can paste additional copies without cutting or 
copying the text again.
To paste text:

1. Click either the Freeform or Tagged Text tool.
2. Place the text cursor at the location where you want the text to appear.
3. Choose Paste from the Edit menu. The text will be inserted into the document at the 

insertion point. If the paragraph symbol was cut or copied with the text, it will retain its
original formatting. Otherwise, the text will take on the formatting attributes of the 
paragraph it was inserted into.



Pasting frames    
When you paste a frame, it appears in the same location as on the page from which it was 
cut or copied. The clipboard retains a copy of the original, allowing you to paste additonal 
copies without performing another cut or copy operation. 
To paste frames:

1. Click the Pick tool.
2. If you want to paste the frame on another page or in a different chapter, use the Go to 

Page or Go to Chapter command from the View menu.
3. Choose Paste from the Edit menu. The frame, the file it contains, and any graphic 

objects attached to the frame are all placed on the page. 
Note: Pasting a frame or graphic on the same page from which it was copied places it 
directly on top of the original. You can move the new copy to another location.



Pasting graphic objects
When you paste a graphic object, it appears in the same location as on the page from which 
it was cut or copied. The clipboard retains a copy of the original, allowing you to paste 
additonal copies without performing another cut or copy operation. 
To paste graphics:

1. Click the Pick tool.
2. Select the frame or the page on which you want to paste the graphic.
3. Choose Paste from the Edit menu.

Note: Pasting a frame or graphic on the same page from which it was copied places it 
directly on top of the original. You can move the new copy to another location.



Pasting ASCII text from other applications
If you want to encorporate text created in other applications into your Corel VENTURA 
document, select the text, choose the Cut command and then paste it into your document.
To paste ASCII text:

1. In the other application, cut or copy the text.
2. Switch to Corel VENTURA using the Switch To command from the Control menu. 

Shortcut: hold down the Alt key and press the Tab key until Corel VENTURA is visible.
3. Select either of the Text tools and place the cursor where you want the text to appear.
4. Choose Paste from the Edit menu.

Note: The other application must have saved onto the clipboard in ASCII format.



Pasting bitmaps and metafiles
You can paste metafiles (line art) and bitmapped images from other applications. Corel 
VENTURA automatically detects the format of the data on the clipboard. When you paste a 
metafile or a bitmapped image from the clipboard into Corel VENTURA, a file is created and 
automatically loaded as if you had used the Load Graphic command from the File menu.
To paste bitmaps and metafiles:

1. Cut or copy the image in the other application.
2. Switch to Corel VENTURA using the Switch To command from the Control menu. 

Shortcut: Hold down the Alt key and press the Tab key until Corel VENTURA is visible.
3. Click the Pick tool and select a frame where you want the graphic to appear. Corel 

VENTURA creates a frame in the top, left corner of the current page if you don't select 
or create one first.

4. Choose Paste from the Edit menu. 



Pasting an object
Corel VENTURA can paste OLE objects copied to the clipboard into the publication as 
embedded objects.
To paste an embedded object:

1. Cut or copy the object in the other application.
2. Save the file. 

The original file must be saved in the originating application before the object can be 
linked to VENTURA.

3. Switch to Corel VENTURA using the Switch To command from the Control menu. 
Shortcut: Hold down the Alt key and press the Tab key until Corel VENTURA is visible.

4. Click the Pick tool and select a frame.
5. Choose Paste from the Edit menu. 

See also:
Working with other applications



Pasting linked objects
Corel VENTURA can paste objects copied to the clipboard from any OLE server application 
into the publication as a linked object.
To paste a linked object:

1. Cut or copy the object in the other application.
2. Save the file. 

The original file must be saved in originating application before the object can be 
linked to VENTURA.

3. Switch to Corel VENTURA using the Switch To command from the Control menu. 
Shortcut: hold down the Alt key and press the Tab key until Corel VENTURA is visible.

4. Click the Pick tool and select a frame.
5. Choose Paste Special from the Edit menu. The Paste Special dialog box opens.
6. Click Paste Link. 
7. Choose the format in the As list box. 

See also:
Working with other applications



Deleting text, frames and graphics
The Delete command on the Edit menu removes the text, frame or graphic from the 
publication. Unlike the Cut command, the object is not copied to the clipboard and the only 
way to retrieve it is to use Undo .
To delete text:

1. Click either the Freeform or Tagged Text tool.
2. Select the text.
3. Choose Delete from the Edit menu.

To delete a frame(s):
1. Click the Pick tool.
2. Select the frame.

To select multiple frames, hold the Shift key down and select the frames.
3. Choose Delete from the Edit menu.

To delete a graphic(s):
1. Click the Pick tool.
2. Select the graphic.

To select multiple graphics, hold the Shift key down and select the graphics. The 
graphics must be within the same frame.

3. Choose Delete from the Edit menu.
To delete linked or embedded objects:

1. Click the Pick tool.
2. Select the object.

To select multiple objects, hold the Shift key down and select the objects. The objects 
must be within the same frame.

3. Choose Delete from the Edit menu.



Opening a publication
You can open an existing publication by choosing Open from the File menu or by clicking the 
Open button on the Ribbon bar.
To open a publication:

1. Choose Open from the File menu. The File Open dialog box opens.
2. Choose a publication. 

If you want to load the publication without the graphics, enable the Suppress Graphics 
checkbox. When the document displays, the frames for the graphics will be visible in 
the publication, the graphic files will be listed in the Files list and the connections 
between frames and graphics files will remain intact. The graphics will not print if you 
print the publication.This option speeds up printing and editing when you are working 
with a publication containing numerous graphics. Note: Enabling the checkbox will 
change the setting for Suppress Graphics in the General section of the Preferences, 
General dialog box.

3. Double-click on the publication to load it or choose OK.
Note: Unlike earlier versions of VENTURA where custom page sizes were set manually in the
Sizing and Scaling dialog box, Corel VENTURA 5.0 supports custom page sizes and can 
automatically create custom page sizes for chapters saved in earlier versions.
When you open a chapter from an earlier version of VENTURA with a custom frame setting 
for the base page, a dialog box will appear prompting you either to create a custom page 
size based on the base frame or retain your original settings.
· click "Yes" and Corel VENTURA automatically creates a custom page size based on the 

base frame size, or 
· click "No" to retain the original settings. 

See also:
Opening a chapter created in Ventura 3x or 4x
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Opening a chapter created in Ventura 3x or 4x
Because chapter files created in earlier versions of Ventura don't belong to publication files, 
you have to select the Chapter option in the List Files of Type box (File Open dialog box) 
before you can open them. If after you've opened a chapter you want to add it to an existing
publication, choose Publication Manager from the File menu or Add Existing Chapter from the
Layout menu.
To open a chapter:

1. Choose Open from the File menu. The File Open dialog box opens.
2. From the List Files of Type list box, choose 3x, 4x Chapters (*.chp).
3. Select the chapter.
4. Choose OK to open the chapter.

Note: Unlike earlier versions of VENTURA where custom page sizes were set manually in the
Sizing and Scaling dialog box, Corel VENTURA 5.0 supports custom page sizes and can 
automatically create custom pages sizes for chapters saved in earlier versions.
When you open a chapter from an earlier version of VENTURA with a custom frame setting 
for the base page, a dialog box will appear prompting you either to create a custom page 
size based on the base frame or retain your original settings.
· click "Yes" and Corel VENTURA automatically creates a custom page size based on the 

base frame size, or 
· click "No" to retain the original settings. 



Saving a publication
You can save a current publication under the same name or give it a new name. The Save 
command on the File menu saves the changes you have made to the publication under the 
same name without opening a dialog box. If the publication is new and has not been saved 
previously, the Save As dialog box opens. The Save As command opens the Save As dialog 
box allowing you to give a new publication a name or change the name of the current 
publication.
To save the current publication:
· Choose Save from the File menu.

To save a publication with a new name:
1. Choose Save As from the File menu. The Save As dialog box opens.
2. Enter a name in the File Name box.



Choosing commands
The menu bar contains the names of the eight drop-down menus. Click on a menu name 
with the mouse. A list of commands is displayed.
To choose a menu command with the mouse:

1. Click with the menu name with the left mouse button.
2. Click the command with the left mouse button.

To choose a menu command by pressing keys:
1. Press the ALT key.
2. Press the underlined letter in the name of the menu. Release the Alt key.
3. Press the underlined letter in the name of the command.

To close a menu without choosing a command:
· Move the mouse pointer away from the menu and click with the left mouse button or 

press Esc.



Choosing tools
The toolbox gives you quick access to the most common operations in Corel VENTURA. Some
of the tools feature flyouts.
To choose a tool with the mouse:

· Click the tool with the left mouse button Hold the mouse button down over a tool to 
see the available flyout tools.



Working with dialog boxes
When Corel VENTURA requires information to carry out a command, it displays a dialog box. 
Some dialog boxes, such as the Chapter Settings dialog, feature multiple Tabs--buttons 
across the top which, when clicked, display controls for related commands and features.
To set options in a dialog box:

· Click on the option with the left mouse button.
To select an item in a list box:

· Click the scroll arrows to display the option you want, then click on it with the left 
mouse button.

To select an item in a drop-down list box:
· Click the down arrow, then click on the option with the left mouse button.

To type in a text box:
· Click on the text box and begin typing.

If the box contains text do one of the following:
· Hold down the left mouse button, move the mouse pointer over the text you want to 

replace, then start typing.
To edit text in a text box:
To Do this
Move insertion point Click on the new location, or press the ®, ¬, HOME or END key.
Select text Drag with the mouse, or hold down the SHIFT key and press the ®, ¬, 

HOME or END key.
Delete text Press the BACKSPACE or DEL key to delete one character at a time or 

select the characters and press the DEL key. 
Replace text Select text and begin typing.
To carry out the options you set:

· Choose OK or press the ENTER key.
To close a dialog box without carrying out the options you set:

· Choose Cancel or press the Esc key.
To open an Online Help topic about an open dialog box:

· Press F1. A topic about the open dialog box appears. For a list of related procedures, 
click the "How to..." button (available in most dialog box Help) in the upper-right-hand 
corner.



Using Roll-Up windows
Roll-Up windows contain many of the controls found in dialog boxes: command buttons, text 
boxes, drop-down list boxes and so on. But unlike most dialog boxes, the roll-up stays open 
after you apply the selected options. This lets you make adjustments and experiment with 
different options without having to continually re-open a dialog box. When you are not using 
a roll-up, you can hide the controls leaving just the Title bar visible.
To carry out your selections:

· Click Apply.
To roll a window up and down:

· Click the arrow in the top right corner.
To close a Roll-Up window:

· Click  and choose Close or Close All to close all roll-ups.
To move a Roll-Up window:

· Click on the Title bar, hold the left mouse button down, and move to the new location.
To arrange open Roll-Up windows:

1. Click .
2. Do one of the following:

· Choose Arrange All to roll-up the active window and move it to the top left corner of 
the document window.

· Choose Arrange All to roll-up all open windows and move some to the top right 
corner and others to the top left corner of the document window.

To get Help on Roll-Up windows:
Do one of the following:

· Press SHIFT+F1 and click the Roll-Up.

· Click  and choose Help.



Undoing operations
Choose Undo from the Edit menu to undo the previous text, tag, graphic, or frame editing 
action. When an editing action is undone, the Redo action is available. Choose Redo to redo 
the initial editing action. 
Note: The Undo option is only available if the changed item is still selected. If the changed 
item is deselected or if another tool is selected, you cannot use Undo.
Actions you cannot undo:

· any change of view (zooming, scrolling, etc.)
· any file operation (open, saving, importing, etc.)
· any object selection operations.

To undo the last action you performed:
· Choose Undo from the Edit menu.

Shortcut: Ctrl + Z
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Using measurement controls--Overview
Numerical settings in each dialog box may be set in inches, centimeters, picas & points, 
ciceros-didots, ciceros or fractional points. To change a unit of measure, simply point to the 
unit of measurement and press the mouse button until the desired measurement appears.
To change the ruler dimensions, select the Ruler Set-Up command from the Tools menu. You 
can select different units for the horizontal and vertical ruler. (Choose Options from the View 
Menu to display the ruler.)



Using measurement controls
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Snap to Grid
Snap to Inter-Line
Snap to columns



Using the rulers
You can set the type of measurement displayed on the rulers and where the zero points on 
the rulers and the rulers themselves are positioned.
To set the rulers:

1. Choose Ruler Set-up from the Tools menu. The Set Ruler dialog box opens.
2. Choose the type of measurement from the Horizontal Units and Vertical Units drop-

down list boxes.
To set the location of the zero points:

1. Enter a Horizontal and a Vertical position in the corresponding boxes under ruler origin.
2. Choose a measurement type.

To move the rulers onto the screen:
1. Point to the large button where the rulers meet.
2. Hold down the Shift key and press the mouse button.
3. Drag the mouse until the intersection is at the location you want.
4. Release the mouse button.
5. When you want to reanchor the rulers, double click the intersection button. 



Snap to Grid
The Grid Set-up command enables you to create an invisible grid to align frames.
To set a grid:

1. Choose Grid Set-up from the Tools menu. The Grid Setup dialog box opens.
2. Enter a Horizontal and a Vertical frequency in the corresponding boxes. The amount 

entered in the Horizontal and    Vertical frequency boxes determines the number of grid 
lines per selected measurement.

3. Choose a unit of measurement for both Vertical and Horizontal frequencies. 
4. Enter a value in the Horizontal and Vertical grid origin boxes. These values determine 

the origin of the grid lines, that is, where the zero points on the rulers are located.
5. Check the Snap to Grid box if you want frames to snap to the grid.



Snap to Inter-Line
The Line snap command forces frames to line up exactly with Body Text. Turning line snap on
does not move frames already in the chapter until those frames are moved or resized.

· Choose Snap to Interline from the Layout menu. 
Note: Keep Inter-Line Snap turned on to avoid line-spacing problems with rotated frames. 

See also:
Snap to Columns 



Snap to Inter-Line
The Snap to Inter-Line command forces frames to line up exactly with body text. Turning 
Snap to Inter-Line on does not move frames already in the chapter until those frames are 
moved or resized.

· Choose Snap to Inter-Line from the Layout menu. 
Note: Keep Snap to Inter-Line turned on to avoid line-spacing problems with rotated frames.

See also:
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Snap to Columns
The Snap to Columns command forces all frames to align with the sides of the page's 
column guides. Turning Snap to Columns on does not move frames already in the chapter 
until those frames are moved or resized. Frames do not snap to the top or bottom of the 
column guides.

· Choose Snap to Columns from the Layout menu. 
Note: Keep Inter-Line Snap turned on to avoid line-spacing problems with rotated frames. 

See also:
 Snap to Inter-Line



Snap to Columns
The Snap to Columns command forces all frames to align with the sides of the page's 
column guides. Turning Snap to Columns on does not move frames already in the chapter 
until those frames are moved or resized. Frames do not snap to the top or bottom of the 
column guides.

· Choose Snap to Columns from the Layout menu. 
Note: Keep Inter-Line Snap turned on to avoid line-spacing problems with rotated frames. 

See also:
Snap to Inter-Line



Installing a foreign-language dictionary
If you have the CD-ROM version of Corel VENTURA, you can install dictionaries to hyphenate 
and check the spelling of words in other languages.
To install a foreign-language dictionary:
1. Copy the files from the SPELDICT directory on the CD-ROM disk #2 to the COREL50\

CUSTOM directory on your hard disk. The choices are:
Language SpellDict HyphenateDict
Danish idnf9341.dat hdndy232.dat
Dutch idnf9320.dat hduds321.dat
English ienc9231.dat hendp148.dat
Finnish ifnf9310.dat hfndy141.dat
French ifrf9221.dat hfrds221.dat
German igfr9310.dathgrds311.dat
Italian iift9260.dat hitds262.dat
Norwegian inof9320.dat hnody321.dat
Portuguese ipof9124.dat hpody141.dat
Spanish ispf9332.dathsprs311.dat
Swedish iswf931.dat hswds311.dat
Note: If you want to have both hyphenation and spell checking occur in the chosen 
language, both files (SpellDict and HyphenateDict) must be copied to COREL50\CUSTOM.

2. Mark each paragraph to identify the language it's written in. To mark a paragraph, create
a new tag and apply the tag to all paragraphs written in the same language (e.g., 
French).

3. Modify the tag by choosing Paragraph from the Format menu, checking the Typography 
tab and choosing the appropriate language from the Dictionary list box.

4. Click OK.



Installing a foreign-language thesaurus
1. Copy the files from the SPELDICT directory on the CD-ROM disk #2 to the COREL50\

CUSTOM directory on your hard disk. The choices are:
Language ThesaurusDict
Danish rdntf300.dat 
Dutch rdutf300.dat 
English renti301.dat 
Finnish rfntf211.dat 
French rfrtf222.dat
German rgrtf300.dat
Italian rittf210.dat
Norwegian rnotf313.dat 
Portuguese rpotf321.dat 
Spanish rsptf302.dat 
Swedish rswtf300.dat 

2. Using Windows Notepad or other ASCII text editor, open the CORELAPP.INI file in your 
COREL50\CONFIG directory.

3. Locate the line ThesaurusDict line and type the file name of the language you want to 
use for the thesaurus (e.g., rdnt300.dat for a Danish thesaurus).

Note: Because Corel VENTURA uses thesauruses from the INI file, different thesaurus files 
cannot be associated with individual paragraphs.



Using the appropriate hyphenation dictionary for previous versions 
of VENTURA
Previous versions of VENTURA (3.x - 4.x) did not store the hyphenation dictionary with the 
file. Therefore, chapters created using a previous version must choose the default 
hyphenation in the Preferences dialog box that corresponds to the language of the chapter.
To use the default hyphenation:

1. Choose Preferences from the Tools menu. The Preferences, General dialog box appears.
2. Choose a default hyphenation from the Default Hyphenation drop-down list box. 



Saving a chapter
You can save a chapter under a separate name using the Save Chapter As command on the 
Layout menu.
To save a chapter:

1. Choose Layout, Save Chapter As. The Save Chapter As dialog box opens.
2. Type in the name of the new chapter in the File Name box.
3. If you want to save the chapter in a different location, select the drive and directory.



Using accelerator keys
Accelerator keys, also known as speed keys, execute menu commands when pressed in 
combination. Some people prefer to use accelerator keys rather than reach away from the 
keyboard for the mouse and click two or more menu items or a tool button. 
To open the Files Roll-Up using accelerator keys:

1. Press and hold down the Alt key.
2. Press and release the F2 key.
3. Release the Alt key. The Files Roll-Up appears.
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Advanced Calibration features
The Color Manager is a powerful tool. Its basic features, namely the configuration of two (or 
three) devices into a System Profile, will be easily and quickly mastered by all users. The 
advanced calibration features, however, are intended to be used by informed users only. A 
solid understanding of color and calibration is essential for successful use of these features.
The System Color Profile dialog box leads to a series of further dialog boxes. 
Before using the advanced calibration features, you may want to review: Working with basic 
System Profiles



Accessing the advanced features
You access the advanced features for all devices, whether monitor, printer or scanner, in one
of two ways: by choosing "Other" from the device list, or by clicking the Edit button.

To access the advanced features:
Do one of the following:
· Other:  If your device is not listed in the System Color Profile dialog box, choose Other 

from the device list. This will give you access to the calibration dialog box for that type 
of device.

· Edit:    If your device is listed but you want to review or modify the default settings 
offered by the Color Manager, click Edit to access the calibration dialog box for that 
particular device.



Calibrating your monitor numerically
Monitor calibration can be done numerically or interactively.

To calibrate your monitor numerically:
1. In the Monitor Calibration dialog box, enter the monitor characteristics for Red, Green 

and Blue. For each of the three colors, you must specify the gamma as well as the 
chromaticity (x, y). These values can be supplied by the monitor manufacturer.

2. Enter a white point temperature in degrees Kelvin.
Click Reset to return to the default values if need be.

3. Choose OK.
Note: If you chose Other from the monitor list, a text entry field at the top of the Monitor 
Calibration dialog box allows you to enter a name for the monitor. This name is added to the 
monitor list for future recall.
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To calibrate your monitor numerically:
1. In the Monitor Calibration dialog box, enter the monitor characteristics for Red, Green 
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Calibrating your monitor interactively
Monitor calibration can be done interactively or numerically.

To calibrate your monitor interactively:
1. In the Monitor Calibration dialog box, click Interactive.

The Interactive Monitor Calibration dialog box appears.
CAUTION: The gamma and white point must definitely be adjusted, as they differ from
monitor to monitor, even within a given brand. The chromaticity values, however, 
SHOULD NOT be adjusted, for the reasons listed in step 4.

2. Do one of the following:
· Adjust the gamma for each color channel in turn (Red, Green and Blue) by scrolling 

up or down until both sides of the color box appear the same.
· Adjust the color gamma for one channel then enable Identical to set an identical 

gamma for all three channels.
Click Preview to evaluate the effect of your adjustments.

3. Use the slider bar to specify a cooler or warmer white point. The value in degrees 
Kelvin is displayed to the right of the slider bar. 
Click Preview to evaluate the effect of your adjustments.

4. It is strongly recommended that default chromaticity values be left as is, for a number 
of reasons: chromaticity values are stable and almost identical from monitor to 
monitor; the default values    are correct; visual adjustments are difficult to discern and 
evaluate.
If you must, you can adjust the chromaticity by dragging the Red, Green and Blue 
markers to achieve the desired result. The x and y values are displayed below the color
boxes. Note that the effect of your adjustments will be difficult to evaluate in the 
Preview.
Click Reset to return to the default values if need be.

5. Choose OK.
Note:    If you chose Other from the monitor list, a text entry field at the top of the Monitor 
Calibration dialog box allows you to enter a name for the monitor. This name is added to the 
monitor list for future recall.
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Calibrating your printer:    General notes
When it comes to your printer, two separate operations must be performed:
· calibration
· characterization
Calibration
The printer calibration process varies depending on whether the device employs a CMYK or 
RGB color model.
Characterization
The printer characterization process is the same for both color models. Use either a Color 
Match file or the visual method to perform the characterization.
Spectrophotometer / colorimeter settings:
When characterizing your printer, you may choose from the supplied files or generate your 
own. To generate your own IM, GRY or RNH files, you will need a spectrophotometer or a 
colorimeter. The measurement device should be set up as follows:
· Set the White Base to abs and calibrate it with the manufacturer-supplied white.
· Set the Illumination Type to D65.
· Set the Eye Angle to 2 degrees.
· Set the Filter to None (do not use D65 or Pol).



Calibrating your CMYK printer
1. In the Printer Calibration dialog box, choose CMYK as printer type.
2. Choose Printer if you are measuring from a paper print or imagesetter proof. Choose 

Film if measuring from imagesetter film.    We recommend measuring from a proof as it
is faster and produces accurate results.

3. Enter a percentage for Total Area Coverage (TAC). This refers to the maximum 
allowable quantity of ink (i.e., total combined amount of C, M, Y and K inks).

4. Adjust the K curve in the CMYK Plates box. Click Reset to return to the default values if 
need be.

5. A default dot gain is provided. It is appropriate for most jobs. Verify with your printing 
shop before changing this value.
Note:    Corel VENTURA ships with some ready-made ink models.    An .IM file to match 
or approximate your printer may be available. Check the list.    If an appropriate .IM file 
exists, you need not perform steps 6 and 7    just continue at step 8.

6. Click Print CMYK Patterns. The Print dialog box appears. Choose a printer. The CMYK320
color pattern file is printed to the chosen printer.

7. Use a spectrophotometer or colorimeter to measure the CIE XYZ values of each color 
square in numerical sequence (from 1 to 320). Enter the measurements in an ASCII file 
with three columns: X, Y and Z (with a space separating the columns).. Name the file to
reflect the printer and give it a .IM extension    for example, TEK300I.IM for data 
measured from the printout of a Tektronix 300I. Copy the file into the COREL50\COLOR 
subdirectory. Return to the Printer Calibration dialog box. 

8. Choose the appropriate .IM file .
9. Click Calculate.
10. The Color Match option becomes available. Click the button. The Printer 

Characterization dialog box appears. Establish printer characterization according to 
one of the two methods described under: 
Characterizing your printer using a Color Match file
Characterizing your printer using the visual method
When you return to the Printer Calibration dialog box after characterizing the printer, 
choose OK.

Note:    If you chose Other from the printer list, a text entry field at the top of the Printer 
Calibration dialog box allows you to enter a name for the printer. This name is added to the 
printer list for future recall.



Calibrating your RGB printer
1. In the Printer Calibration dialog box, choose RGB as printer type.
2. Click Print RGB Patterns.    The Print dialog box appears. Choose a printer. The RGB80 

color pattern file is printed to the chosen printer.
3. Use a spectrophotometer or colorimeter to measure the CIE XYZ values of the 

grayscale squares only, in numerical sequence (from 65 to 80). Enter the 
measurements in an ASCII file with three columns: X, Y and Z (with a space separating 
the columns). Name the file to reflect the printer and give it a .GRY extension    for 
example, CJ10.GRY for data measured from the printout of a Canon CJ10. Copy the file 
into the COREL50\COLOR subdirectory. Return to the Printer Calibration dialog box. 

4. Choose the .GRY file you have created.
5. Click Color Match. The Printer Characterization dialog box appears. Establish printer 

characterization according to one of the two methods described under: 
Characterizing your printer using a Color Match file
Characterizing your printer using the visual method
When you return to the Printer Calibration dialog box after characterizing the printer, 
choose OK.

Note:    If you chose Other from the printer list, a text entry field at the top of the Printer 
Calibration dialog box allows you to enter a name for the printer. This name is added to the 
printer list for future recall.



Characterizing your printer using a Color Match file
Printer characterization can be performed using a Color Match file or using the visual 
method.

To perform characterization using a Color Match file:
1. In the Printer Characterization dialog box, choose File.
2. Click Print Testing Patterns. The test pattern file is printed to the chosen printer.
3. Use a spectrophotometer or colorimeter to measure the CIE XYZ values of each color 

square in numerical sequence (from 1 to 80). Enter the measurements in an ASCII file 
with three columns: X, Y and Z (with a space separating the columns). Name the file to 
reflect the printer and give it a .RHN extension    for example, TEK300I.RHN for data 
measured from the printout of a Tektronix 300I. Copy the file into the COREL50\COLOR 
subdirectory.

4. Return to the Printer Characterization dialog box. Choose the .RHN file you have 
created.

5. Choose OK.
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Characterizing your printer using the visual method
Printer characterization can be performed visually or using a Color Match file.

To perform characterization using the visual method:
1. You must calibrate your monitor before proceeding if the visual characterization of your

printer is to be meaningful. Click Calibrate Monitor. If a Monitor calibration circuit is in 
place, it will be used. Otherwise, a dialog box will appear to allow you to calibrate your 
monitor.

2. In the Printer Characterization dialog box, choose Visual.
3. Click Print Testing Patterns. The test pattern file is printed to the chosen printer.
4. Adjust the colors interactively or by entering numeric values so that they approximate 

the test printout. Adjustments follow the norms of the HSB (Hue, Saturation, 
Brightness) model.
If you are not pleased with the changes you have made to a color, click Reset Color to 
start fresh.

5. Choose OK.
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Calibrating your scanner from a file
Scanner calibration can be done from a file or from an image.

To calibrate your scanner from a file:
1. In the Scanner Calibration dialog box, choose File.
2. Choose a file from the list of available scanner calibration files (.SCN).

If there is no file for your scanner, you can easily create one. See Calibrating your 
scanner from an image.

3. Choose OK.
Note:    If you chose Other from the scanner list, a text entry field at the top of the Scanner 
Calibration dialog box allows you to enter a name for the scanner. This name is added to the 
scanner list for future recall.
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1. In the Scanner Calibration dialog box, choose File.
2. Choose a file from the list of available scanner calibration files (.SCN).

If there is no file for your scanner, you can easily create one. See Calibrating your 
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Calibrating your scanner from an image
Scanner calibration can be done from an image or from a file.

To calibrate your scanner from an image:
1. Scan the calibration target provided by Corel, or an IT8 target if you have one. It is 

important that you scan in raw data. If you are scanning from Corel PHOTO-PAINT, 
disable the Scanner Calibration option in the Preferences dialog box. Save the scan as 
a TIFF file.

2. In the Scanner Calibration dialog box, choose Image.
3. Choose the scanned target (.TIF) file you have created. If necessary, click Browse to 

find the file.
4. Choose a reference file. If necessary, click Browse to find the file. Corel provides a 

reference file, but you may opt to use your own, such as a proprietary IT8 reference 
file. It must bear a .REF extension.

5. Click Scanned Target. The Scanned Target dialog box appears.
6. Drag each of the four corner markers such that they frame the entire color grid. Note 

that each corner of the grid is marked by a fiducial mark for your convenience.
The Color Manager will compare the values of the colors thus framed to the values in 
the reference file and perform color calibration accordingly.

7. Choose OK. The Save Scanner File dialog box appears.
8. Enter a name and choose OK. A scanner calibration file with the extension .SCN is 

created.
Note:    If you chose Other from the scanner list, a text entry field at the top of the Scanner 
Calibration dialog box allows you to enter a name for the scanner. This name is added to the 
scanner list for future recall.



Calibrating your scanner from an image
Scanner calibration can be done from an image or from a file.

To calibrate your scanner from an image:
1. Scan the calibration target provided by Corel, or an IT8 target if you have one. It is 

important that you scan in raw data. If you are scanning from Corel PHOTO-PAINT, 
disable the Scanner Calibration option in the Preferences dialog box. Save the scan as 
a TIFF file.
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3. Choose the scanned target (.TIF) file you have created. If necessary, click Browse to 
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reference file, but you may opt to use your own, such as a proprietary IT8 reference 
file. It must bear a .REF extension.

5. Click Scanned Target. The Scanned Target dialog box appears.
6. Drag each of the four corner markers such that they frame the entire color grid. Note 

that each corner of the grid is marked by a fiducial mark for your convenience.
The Color Manager will compare the values of the colors thus framed to the values in 
the reference file and perform color calibration accordingly.

7. Choose OK. The Save Scanner File dialog box appears.
8. Enter a name and choose OK. A scanner calibration file with the extension .SCN is 

created.
Note:    If you chose Other from the scanner list, a text entry field at the top of the Scanner 
Calibration dialog box allows you to enter a name for the scanner. This name is added to the 
scanner list for future recall.



Working with basic System Profiles
A color management system must take into account all factors involved for all the devices 
used for color acquisition, viewing and reproduction. This is done by building a System 
Profile. A System Profile indicates which monitor and printer are part of your publishing 
system. It may also include a scanner if you are working with Corel PHOTO-PAINT.
If any component of your system changes, you must make this change known to the Color 
Manager by updating your System Profile. Similarly, if you have access to multiple devices, 
you will need to build a System Profile for each combination of two (or three) devices that 
you use. 
Once built, simply select and enable the appropriate System Profile according to the devices 
your project currently calls for.
For step-by-step instructions, see:
Basic
Creating a basic System Profile
Selecting a System Profile

Advanced
Advanced calibration features



Creating a basic System Profile
All you need to know about your system is the brand name and model number of each 
device. The Color Manager has built-in information sheets for a large number of devices and 
chances are yours will be in the lists. You do not need to know the technical properties of 
your devices; just pick their names from the lists and save the configuration as a System 
Profile.

To create a basic System Profile:
1. Choose Color Manager from the File menu.

The System Color Profile dialog box appears.
2. Choose a monitor.
3. Choose a printer.
4. Choose a scanner (optional). This can only be done from an application that support 

scanners, such as Corel PHOTO-PAINT.
5. Enter descriptive comments in the Notes box to help you better manage your System 

Profiles (optional).
6. Click Generate. 

The Generate Profile dialog box appears.
7. Enter a name for the System Profile.
8. Click OK. System Profile generation will take a few minutes.
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Selecting a System Profile
Your work may entail working with a number of various devices of each type. You may 
therefore need to load a different System Profile depending on the task at hand. System 
Profiles can be created as explained under Creating a basic System Profile. Once created, 
selecting one is easy.

To select an existing System Profile:
1. Choose Color Manager from the File menu.

The System Color Profile dialog box appears.
2. From the Current Profile list, choose a System Profile.
3. Click Select.

Note:    By default, AutoMatch is enabled, ensuring that automatic color matching is 
performed. This is the normal way to proceed and the default should be left as is, unless you
want to force a different color matching method.
If you are working in Corel VENTURA, AutoMatching means the Color Manager will 
automatically differentiate between bitmapped and vector objects, and optimize each type 
of object accordingly. In Corel PHOTO-PAINT, AutoMatching means that the System Profile is 
optimized for bitmaps. Another application may be optimized for line art.
You can force the Color Manager to optimize the color matching for line art by enabling 
Illustration. Similarly, if you want to force the Color Manager to optimize the color matching 
for bitmaps, enable Photographic.



System Color Profile dialog box
The System Color Profile dialog box allows you to create a system color profile to help Corel 
VENTURA capture, display and print color across different devices more accurately.

Dialog Box Options

Current Profile
Displays the name of the current color profile. If you have different printers, you may wish 
to build different color profiles and then select the appropriate one before working on 
images for that output device.

Notes
Allows you to attach notes to your system profile. Useful for keeping track of different 
equipment setups.

Monitor
Displays monitor choices.

Printer
Displays printer choices.

Scanner
Displays scanner choices.

Automatch
Enables the two different color gamut mapping systems, Illustration and Photographic. 
Corel VENTURA automatically senses whether it is printing a vector or bitmapped object 
and applies the appropriate gamut map.

Photographic
Enables the Photographic color mapping only. Use to force Photographic color mapping 
regardless of object type.

Illustration
Enables Colorimetric color mapping for working with spot colors. Use to force colorimetric 
color mapping regardless of object type.
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Monitor Calibration
Allows you to calibrate your monitor to enhance color accuracy.

Dialog Box Options
Monitor Defines the monitor gamma settings. As you

Characteristics Increase the gamma level you are increasing the brightness of your 
midtone gray levels. Chromaticity defines hue and saturation or 
chroma. It's important to use the manufacturer recommended levels of 
chromaticity for your monitor. If you do not have manufacturer 
recommended levels and wish to modify gamma or chromaticity settings
use Interactive Monitor Calibration.

White Point Defines the color temperature of your monitor in creating white.

Reset Returns the gamma and chromaticity values to default.

Interactive Interactive calibration lets you adjust 

Calibration Gamma, white point and chromaticity interactively. Adjust the color fields
to enhance color accuracy. Chromaticity should be set to the 
manufacturer's specifications. Gamma or brightness is variable 
according to the level of light in the room and the brightness and 
contrast controls on your monitor. White point temperature for an 
individual monitor will have a factory default but monitors can vary from 
their default. 



Scanner Calibration
Allows you to calibrate the color accuracy of the systems scanner.

Dialog Box Options
Scanned Target 

File: Allows you to choose a pre-tested scanner setting. 

Image: Allows you to build a specific named scanner profile based on the 
characteristics of your printer.

Scanned target: Your scan of the Corel Scanned Target reference card included with Corel 
PHOTO-PAINT.

Reference file: This reference file is included with Corel PHOTO-PAINT. Color Manager 
compares this file against your scanned target to create a scanner 
profile.

Scanned target: Allows you to adjust for any skew or misalignment of your scan of the 
target. This ensures that the scanner profile compares the same areas of
both the reference file and your scanned target.

Shortcut
Pressing ALT+F,C opens the System Color Profile dialog box.



Cell Color dialog box
Use this dialog box to specify the selected cell's color using various models and custom 
palettes. As well, you can select colors from existing files in the Mixing area.
If you are using a color monitor, remember that the colors you see will not match the printed
colors exactly. To accurately specify Process colors, use the Process Color Chart included with
your Corel VENTURA User's Guide. If you are choosing colors from the TRUMATCH or 
FOCOLTONE palettes or either of the PANTONE palettes, use the corresponding Color 
Reference.

Dialog Options

Show
Selects the color model. The options are: CMYK, RGB, HSB, Grayscale, Standard Colors, 
FOCOLTONE, PANTONE Spot colors, PANTONE Process colors, TRUMATCH, Custom Palette.

Preview
The color model selected determines the display of the colors in the Preview box.
CMYK Shows CMYK model and list boxes for each of the components.
RGB Shows RGB model and list boxes for each of the components.
HSB Shows HSB model and list boxes for each of the components.
Grayscale Shows grayscale model and Gray Level list box.
Standard Colors Shows Standard Colors model.
FOCOLTONE Shows FOCOLTONE model, Show Color Names check box and a 

Search for: box.
PANTONE Spot Shows spot colors, Show Color Names check box, Tint and Search for:

boxes.
PANTONE Process Shows process colors, Show Color Names check box, Tint and Search 

for: boxes.
TRUMATCH Shows TRUMATCH colors, Show Color Names check box, Tint and 

Search for: boxes.
Current/New color Displays the current color in the top half and the new selected color 

in the bottom half. 
New

Field used for the entry of a new color name.
PostScript Options...

Opens the PostScript Options dialog box. Used to specify halftone screens for Spot colors.

Custom Palettes
Opens a menu with commands for managing the palettes.
Add Color: Adds a named color to the end of the palette. You can also add tints 

of Spot color to the end of the Spot color palette (i.e., the 
CORELDRW.CPL palette).

Delete Color: Deletes the selected color from the palette. You cannot delete colors 
from the CORELDRW.CPL Spot color palette.

New: Displays an empty palette which you can fill with colors you create or
select from the palette at the top of the dialog box.



Open: Opens the Open Palette dialog box where you can select different 
color palettes to load into Corel VENTURA.

Save: Saves a palette that you have modified by adding, deleting or 
rearranging colors.

Save As: Opens the Save Palette As dialog box where you can assign a new 
name to the current palette.

Set As Default: Loads the current palette each time you start Corel VENTURA.
Mixing Area

Used to choose colors from existing files, the Show Preview box, the Custom Palette 
Preview box or any combination of the three. Click the arrow button to display the 
following menu choices: 
· Load Paint Area File dialog box
· Save Paint Area File As     dialog box  
· Clear paint area command. 

The Paintbrush button paints the selected color in the Paint Area and can mix that color 
with colors already in the paint area. The Eyedropper button selects a color from the paint 
area which is then displayed in the Current/New preview box.



Load Paint Area File dialog box
Loads previously mixed paint colors into the Mixing Area.

Dialog Box Options
The File Name, List Files of Type, Directories and Drives lists and boxes allow you to 
choose bitmap (.BMP) files from the drives and directories on your computer system. 



Save Paint Area File As dialog box
Saves newly mixed colors in the Mixing Area as bitmaps.

Dialog Box Options
The File Name, List Files of Type, Directories and Drives lists and boxes allow you to 
choose bitmap (.BMP) files from the drives and directories on your computer system. 





Introducing Corel VENTURA
Corel VENTURA is a full-featured page layout and document composition system that lets 
you create typeset documents by combining text and graphics from many popular word 
processor and graphics programs. Whether you use it to produce simple letters and memos, 
or more complex documents such as multi-chaptered manuals and annual reports, Corel 
VENTURA has all the tools you'll need to get the job done.



About Publications and Chapters
Most programs can work with one, or perhaps a few files, at one time. For instance, when 
you import a piece of clipart into a drawing in CorelDRAW, that piece of clipart becomes part 
of the drawing. By contrast, Corel VENTURA can combine 128 separate text and graphics 
files in a single document. Instead of integrating the files into one document, Corel VENTURA
simply remembers where the files are stored. It does this by maintaining a list of pointers in 
a chapter file. These pointers tell Corel VENTURA where to find the text and graphics files 
and how to position them in the formatted document. They also tell the program where to 
find the style sheet used to format pages and text in the document. 
Keeping the text and graphics files separate means that other documents can share the 
same text and graphics. It also means that you can edit the files in other programs at any 
time. Changes you make to the files are reflected in the Corel VENTURA document the next 
time you open it.
Documents you create in Corel VENTURA can be divided into sections, called chapters, that 
make up a publication file. Just as a chapter links the text and graphics files in a document, a
publication links the chapters so that you can manage each document as a unit. Some of the
operations you can perform on a publication file include:

· Generating a table of contents and index that covers all the chapters
· Copying individual chapters or the entire publication
· Renumbering pages, tables and figures for the entire publication
· Updating cross-references for the entire publication



About Paragraph tags and Style Sheets
A paragraph tag is a group of text attributes such as font, line spacing and alignment which 
you can apply to text simply by selecting the tag's name from a list. The paragraph tags are 
stored in a style sheet which also contains information about the margin settings, the 
number of columns, page orientation and other document formatting.
The use of paragraph tags and style sheets simplifies the task of laying out a document. The
same style sheet can be used over and over, making it easy for you to achieve consistent 
formatting both within a document and across other similar documents. And when you 
modify a style sheet by changing attributes in a style tag, for example, the changes will be 
reflected in all other documents which use that style sheet.
Corel VENTURA remembers which style sheet a particular document uses and loads it for 
you whenever you open the document. By applying a different style sheet, you can instantly 
change the format of the entire document.
So that you can begin creating attractive documents right away, Corel VENTURA comes with 
many predefined style sheets for a wide range of document types including reports, books 
and proposals. These style sheets are described in the Templates section of the Corel 
Libraries Catalog. You can use the predefined style sheets as they are or modify them to suit 
your needs.



About Frames
Corel VENTURA uses frames to hold text and graphics. A page frame which is the size of a 
full page, is automatically created when you begin a new document. When text is placed in 
the page frame, any text that does not fit on the current page automatically flows to 
succeeding pages.
Free frames are frames you create yourself. Unlike the page frame, free frames can be 
moved anywhere on the page. They can also be anchored to text so that they move with the
surrounding text when you edit the document.
Using free frames for documents like newsletters and magazines, allows you to begin an 
article on one page and continue it on any later page. What's more, each frame can have its 
own margin and column settings.



About the Freeform and Tagged Text tools

Corel VENTURA has two text tools: the Freeform Text tool  and the Tagged Text tool 

. Both the Freeform Text tool and the Tagged Text tool can be used to select, enter and 
edit text as well as change text attributes (e.g., bold, italic, font size). The difference 
between the two is that if the cursor is placed into the paragraph without selecting text or 
the entire paragraph is selected using ALT + mouse click,the Tagged Text tool updates the 
current tag with any formatting changes and the Freeform Text tool applies an override to 
the current tag. For example, if the point size of a paragraph with the Body Text tag is 
modified using the Tagged Text tool, all paragraphs sharing the Body Text tag in the current 
style sheet will change to reflect this new point size. If the paragraph is modified using the 
Freeform Text tool, the point size affects only the selected paragraph and overrides the 
paragraph tag.
A good rule of thumb is to use the Copy Editor when making editorial changes to your text 
and Page Layout view when laying it out. That way, either tool can be used in the Copy 
Editor and you're sure not to inadvertently update paragraph tags.

See Also
Working with Text



Restore command (Control menu)
Returns the active window to its previous size and location.

You can also restore a window by clicking its Restore button 
· Does not affect a window moved or resized with Move or Size.



Move command (Control menu)
Moves the active window with the keyboard direction keys. 

· This command is unavailable if the window is maximized.
· You can use this command to move application icons and dialog boxes that have a 

Control menu.
For more information, see your Microsoft Windows User's Guide.



Size command (Control menu)
Resizes the active window with the keyboard direction keys.

· This command is unavailable if the window is maximized.
For more information see your Microsoft Windows User's Guide.



Minimize command (Control menu)
Shrinks the active window to an icon at the bottom of the Corel VENTURA window.

· Using the Minimize command is equivalent to clicking the Minimize button .
· You can use Restore to return the minimized window to its former size.



Maximize command (Control menu)
Enlarges the active window to fill the entire screen.

· Using the Maximize command is equivalent to clicking the Maximize icon .
· You can choose Restore or click the Restore button  to return the window to its 
former size.



Close command (Control menu)
Closes the active window. 

· Closing Corel VENTURA is the same as choosing Exit from the File menu.
· Double-clicking the Control Menu button  is 

equivalent to choosing the Close command. 



Switch To command (Control menu)
Opens the Task List, which lists all the applications currently running on your system.
Dialog Box Options
Switch To
Opens the selected application.
End Task
Closes the selected application.
Cancel
Closes the Task List.
Cascade
Overlaps all open applications so that their Title bars are visible.
Tile
Sizes all open applications to fit on the screen.
Arrange Icons
Arranges the icons of all minimized applications evenly across the bottom of the Corel 
VENTURA window. 



Control Menu
Restore command
Returns the active window to its previous size and location. You can also restore a window by
clicking on its Restore button 

· Does not affect a window moved or resized with the Move or Size commands.
Move command 
Moves the active window with the keyboard direction keys. This command is unavailable if 
the window is maximized.
Size command 
Resizes the active window with the keyboard direction keys. This command is unavailable if 
the window is maximized.
Minimize command
Shrinks the active window to an icon at the bottom of the Corel VENTURA window. You can 
use the Restore command to restore the minimized window to its former size.
Maximize command 
Enlarges the active window to fill the entire screen. You can choose the Restore command or 
click the Restore button to return the window to its former size.
Close command 

Closes the active window. Double-clicking the Control Menu button  is equivalent to 
choosing the Close command. 
Switch To command 
Opens the Task List, which lists all the applications currently running on your system.
Dialog Box Options
Switch To Opens the selected application.
End Task Closes the selected application.
Cancel Closes the Task List.
Cascade Overlaps all open applications so that their Title bars are visible.
Tile Sizes all open applications to fit on the screen.
Arrange Icons Arranges the icons of all minimized applications evenly across the bottom 

of the Corel VENTURA window. 
For more information see your Microsoft Windows User's Guide.



Creating a publication

Creating a publication from scratch
Creating a publication from a template
Loading style sheets
Loading text
Loading graphics
Inserting/deleting pages
Creating headers and footers
Specifying footnote settings
Displaying, inserting and editing footnotes
Laying out your chapters
Setting page size and layout
Setting margins
Setting columns
Setting typography
Saving a chapter
Adding a new chapter
Adding an existing chapter



Creating a publication

Creating a publication from scratch
Creating a publication from a template
Loading style sheets
Loading text
Loading graphics
Inserting/deleting pages
Creating headers and footers
Specifying footnote settings
Displaying, inserting and editing footnotes
Adding numbering
Laying out your chapters
Setting margins
Setting columns
Setting typography
Saving a chapter
Adding a new chapter
Adding an existing chapter from another publication



Setting preferences
Setting general preferences
Setting display preferences
Setting text preferences



Creating a publication from scratch
One way to begin a publication is to choose a page layout and style sheet in the New 
Publication dialog box.
To create a publication from scratch:

1. Choose File menu, New. The Default Style button is highlighted in the Create New 
section of the New Publication dialog box.

2. Click the Layout box and choose a page layout style from the list box. The selected 
layout style is displayed in the preview box.

3. Do one of the following:
· Click Default Style to load the default style sheet. The default style sheet is loaded 

and you return to your document.
· Click Load Style to load a style sheet other than the default. The Open Style Sheet 

dialog box opens. Choose the style sheet you want to use, then click OK.

See also:
Loading style sheets
Laying out your chapters



Creating a publication from a template
You can use the Base on Template dialog box to select a publication to use as a template. By
default, a template includes the chapter and style sheet files of the selected publication. You
can also select any text and graphic files in the publication to include in your template.

Note: An icon ( ) displayed beside a file name in the list box 
indicates that it is located in the same directory you've chosen for your publication and 
cannot be included in the template. If you want to include the file, choose a different 
directory for your publication in the Drives and Directories list box..
To create a publication from a template:

1. Choose File, New.
2. Click Base on Template in the New Publication dialog box. The File Open dialog box 

opens.
3. Choose a publication file to use as a template for the new publication and click OK.

The Base on Template dialog box opens.
4. Choose the drive and directory where the new publication is to be stored.
5. Type a name for the new publication.
6. Highlight the names of the original publication files you want to include in the new 

publication.
7. Select the file in the Files List and click Include Files to select files. Check marks appear

to the left of selected files.
If you want to omit files, click Omit Files. The Include Files button toggles between 
include and omit.
If you want to include only the style sheet, frames and columns, include the chapter 
file and omit the text and graphic files associated with the chapter.

8. Check the Copy all files option if you want to copy all selected text and graphic files in 
the drive and directory chosen for the new publication. Omit this step to keep the files 
in their original locations. The chapters included in the new publication have pointers 
that finds these files.

9. Click OK.    The new publication appears in the document area and includes the style 
sheets and selected text and graphic files from the original publication.
Note: If you have selected more than one chapter, The Go to Chapter dialog box 
opens, allowing you to move to a specified chapter.



Loading style sheets
You can load style sheets from the New Publication dialog box, Load Style Sheet command 
from the Layout menu or Tags Roll-Up. 
When you create a new publication, you have the option of loading an existing style sheet 
rather than using the default style sheet.
To load a style sheet when creating a new publication:

1. Choose New from the File menu. The New Publication dialog box opens.
2. Click Default Style to load the default style sheet. 
OR
1. Choose New from the File menu. The New Publication dialog box opens.
2. Click Load Style to load a style sheet other than the default. The Open Style Sheet 

dialog box appears.
3. Choose a style sheet (.STY file).

To load a style sheet into the current publication:
1. Choose Layout, Load Style Sheet. The Open Style Sheet dialog box opens.
2. Choose a style sheet.



Loading text
When you load text, you can specify whether the text is placed in the selected frame, the 
File list or after the insertion point. Placing the text after the insertion point enables you to 
merge the loaded text file with existing text. You can also load several text files in any 
supported format (for example, Word, WordPerfect) provided they are in the same directory.
To load a text file:

1. Do one of the following:
· If you want the file placed in the base page frame or in a free frame, click inside the 

frame with the Freeform Text tool or Tagged Text, or select it with the Pick tool.
· If you want the file added to the Files List, make sure no frames are selected. To 

place the file into a frame, select the frame and click the file name in the Files List 
on the ribbon bar.

· If you want the text inserted at a particular location in the document, place the 
insertion point at that spot.

2. Choose File, Load Text.
3. From the List Files of Type box, choose the format of the text file.
4. If you want to place the text after the insertion point, enable the Insert at Cursor check 

box. This option is only available if you placed the cursor before opening the dialog 
box.

5. Use the Drives and Directories list boxes to locate the desired file name. 
Note: If you want to load a range of listed files, hold down the Shift key and click the 
first and last file in the range. Use the Ctrl key instead to select non-consecutive files.

6. To have the file available in other chapters in the document, choose the Options button
and enable the Add to File List option.

7. Choose OK or double-click on the file name.

See also:
Using text from other programs



Loading graphics
When you load graphics, you can specify whether the graphic is placed in the selected frame
or in the File list. 
To load a graphic file:

1. Do one of the following:
· If you want the file placed in the base page frame or in a free frame, click inside the 

frame with the Pick tool.
· If you want the file added to the Files List, make sure no frames are selected. To 

place the file into a frame, select the frame and click the file name in the Files List 
on the ribbon bar.

2. Choose File, Load Graphic.
3. From the List Files of Type box, choose the format of the file.
4. Use the Drives and Directories list boxes to locate the desired file name. 

Note: If you want to load a range of listed files, hold down the Shift key and click the 
first and last file in the range. Use the Ctrl key instead to select non-consecutive files.

5. To have the file available in other chapters in the document, choose the Options button
and enable the Add to File List option.

6. Choose OK or double-click on the file name.



Inserting/deleting pages
To insert pages:

1. Choose Insert Page... from the Layout menu. The Insert Page dialog box opens.
2. Enter the number of pages you want to insert in the Insert # Pages box.
3. Click Before or OK to accept the default, which is After..
4. Enter the page number after or before which you want to insert pages.

To delete pages:
1. Choose Delete Page... from the Layout menu. The Delete Page dialog box opens.
2. Enter the number of pages you want to delete in the Delete # Pages box.
3. Click either Before or OK to accept the default, which is After..
4. Enter page number before or after which you want to insert pages.



Creating headers and footers
Headers appear at the top of the page and usually occur on every page. Footers appear at 
the bottom of the page and usually occur on every page. Three entries are available for both
headers and footers: left-justified, center and right-justified. The left and right margins are 
the same as those specified for the page frame.
Headers and footers contain information that you want displayed on every page, for 
example, chapter name and topic, date, company name, and so on.
To create headers and footers:

1. Choose Chapter Settings from the Layout menu. The Chapter Settings dialog box 
opens.

2. Click the Header/Footer tab. The Header and Footer dialog box is displayed.
3. Choose the header(s) and footer(s) you want to place in the your document from the 

Define list box. They are as follows:
Left Page Header enables the left page header.
Left Page Footer enables the left page footer.
Right Page Header enables the right page footer.
Right Page Footer enables the right page footer.

4. Enter the text in the Header/Footer Text section of the dialog box. Left places the text 
at the left margin, Center places the text in the center and Right places the text at the 
right margin of the page.
The name changes to reflect the selection made in the Define list box. For example, if a
header is chosen, the name is Header Text.

5. Use the insert buttons to insert the following:
chapter numbers
page numbers
text attributes
current time
current date
text from the first paragraph on a page formatted with 

specified tag. 
text from the last paragraph on a page formatted with 

specified tag.
6. Click Copy to Facing Page to copy the header or footer to the facing page. The position 

of the header or footer on both pages is the same. For example, if the original is on the 
right side, the one copied to the facing page is on the right side.

7. Click Mirror to Facing Page to mirror the header or footer on the facing page. A left-
justified header would appear on the right side of the facing page if you chose Mirror to
Facing Page.

8. In the Enable section of the dialog box, click one of the following to display the footer(s)
and/or headers(s):
Left Page Header enables the left page header.
Left Page Footer enables the left page footer.
Right Page Header enables the right page footer.
Right Page Footer enables the right page footer.





Specifying footnote settings
Footnotes are references concerning the content of the document. For example, a quotation 
from a specific author is referenced in a footnote. Note: Footnotes are not displayed unless 
Enable Footnotes is turned on in the Layout menu.
To specify footnote settings:

1. Choose Chapter Settings from the Layout menu. The Chapter Settings dialog box 
opens.

2. Click Footnotes. The Footnotes dialog box opens.
3. Choose either Numerical or Custom. 

Numerical creates the standard numbered footnote.
Custom allows you to create footnote markers. You can use characters such letters or 
symbols.

4. Enter the number of the first footnote to be assigned a reference in the Footnote #: 
box. 

5. Enter the reference in the Reference: box. 
If you have selected Numerical, the numbers are displayed sequentially corresponding 
to the numbers in the Footnote #: box. If you have selected Custom, enter a number or
character to correspond with each footnote.

6. Enter text in the Template: box that you want to appear with every footnote.
7. Check the Add Separator Line checkbox to add a separator line above the first 

footnote. 
8. Enter the Space Above, Thickness and Line Width of the Separator Line.
9. Choose the Position: Superscript, Subscript or Normal.
10. Choose the Options:

Start with Footnote #: Choose the starting number for the footnotes.
Restart On: Choose the location for the restart of the footnote numbers. The options 
are: Each Page and Each Chapter.



Displaying, inserting and editing footnotes
Set up your footnote format in the Footnotes tab of the Chapter Settings--Footnotes dialog 
box. 
See also Specifying footnote settings
To insert a footnote:

1. Click theTagged Text or Freeform Text tool and place the cursor on the page where you 
want the footnote reference to appear.

2. Choose Insert Special Item from the Edit menu.
3. Choose Footnote from the Insert Special Item flyout menu.

The footnote number or symbol appears at the insertion point on the page at the 
bottom of the page.

Choose the Enable Footnotes command to display, edit and print footnotes. 
To display footnotes:
· Choose Enable Footnotes from the Layout menu.

To edit a footnote:
1. Click the Tagged Text or Freeform Text tool.
2. Ensure that Enable Footnotes is enabled in the Layout menu.
3. Go to the page containing the footnote and edit the footnote text.



Laying out your chapters
Chapter layout includes paper size and orientation, fold type, which side of the page the 
chapter starts on, and whether it is single or double sided.
To set chapter layout:

1. Choose Chapter Settings from the Layout menu. The Chapter Settings dialog box 
opens.

2. Click the Layout tab at the top of the dialog box. Choose the orientation of the page, 
Portrait or Landscape.

3. Choose a page size from the Page Size list box or enter a value in the Width and Height
boxes to create a custom paper size. The maximum page size is 27.3 x 27.3 inches. 
Note: If you set the page size to the maximum, graphics and text cannot be set as 
bleeds.

4. Choose a fold type from the Layout list box. Fold determines the way in which the text 
is printed on the page to allow for folding after the page is printed.

5. Check either Single or Double. These checkboxes determine whether the pages are 
double-sided (printed on both sides) or single-sided (printed on one side).

6. In the Start On section of the dialog box, check either Right Side or Left Side to 
determine which side the chapter starts on (applies only to double-sided layouts).



Laying out your chapters
Chapter layout includes paper size and orientation, fold type, which side of the page the 
chapter starts on, and whether it is single or double sided.
To set chapter layout:

1. Choose Chapter Settings from the Layout menu. The Chapter Settings dialog box 
opens.

2. Click the Layout tab at the top of the dialog box. Choose the orientation of the page, 
Portrait or Landscape.

3. Choose a page size from the Page Size list box or enter a value in the Width and Height
boxes to create a custom paper size. The maximum page size is 27.3 x 27.3 inches. 
Note: If you set the page size to the maximum, graphics and text cannot be set as 
bleeds.

4. Choose a fold type from the Layout list box. Fold determines the way in which the text 
is printed on the page to allow for folding after the page is printed.

5. Check either Single or Double. These checkboxes determine whether the pages are 
double-sided (printed on both sides) or single-sided (printed on one side).

6. In the Start On section of the dialog box, check either Right Side or Left Side to 
determine which side the chapter starts on (applies only to double-sided layouts).



Specifying footnote settings
Footnotes are references or explanations concerning the content of the document. For 
example, a quotation from a specific author, is referenced in a footnote.
To specify footnote settings:

1. Choose Chapter Settings from the Layout menu. The Chapter Settings dialog box 
opens.

2. Click Footnotes. The Footnotes dialog box opens.
3. Choose either Numerical or Custom. 

Numerical creates the standard numbered footnote.
Custom allows you to create footnote markers. You can use characters such letters, 
symbols, etcetera.

4. Enter the number of the first footnote to be assigned a reference in the Footnote #: 
box. 

5. Enter the reference in the Reference: box. 
If you have selected Numerical, the numbers are displayed sequentially corresponding 
to the numbers in the Footnote #: box. If you have selected Custom, enter a number or
character to correspond with each footnote.

6. Enter text in the Template: box that you want to appear with every footnote.
7. Check the Add Separator Line checkbox to add a separator line. 
8. Enter the Space Above, Thickness and Line Width of the Separator Line.
9. Choose the Position: Superscript, Subscript or Normal.
10. Choose the Options:

Start with Footnote #: Choose the starting number for the footnotes.
Restart On: Choose the location for the restart of the footnote numbers. The options 
are: Each Page and Each Chapter.



Setting typography
The Typography section of the Chapter Settings dialog box sets the following: Widows and 
Orphans, First Baseline, Column Balance, Kerning and Vertical Justification.
To set chapter typography:

1. Choose Chapter Settings from the Layout menu. The Chapter Settings dialog box 
opens.

2. Click the Typography tab. The Chapter Settings, Typography dialog box opens.
3. Enter a number in the Widows box. 
4. Enter a number in the Orphans box.
5. Choose a baseline height in the First Baseline drop-down list box. The baseline height 

determines where the first line of text begins on a page or frame.
6. To balance columns so that they each contain the same amount of text, check the 

Column Balance checkbox.
7. To turn kerning on for the chapter, check Pair Kerning. This setting overrides the 

settings in the Paragraph Typography dialog box.
8. Set Vertical Justification with the following options:

Within Frame: Choose either feathering or carding. 
Maximum Justification: Enter a percentage. The resulting justification is the 
combination of Maximum at Top and Maximum at Bottom for paragraphs plus the 
percentage.
Around Frame: Choose either Moveable or Fixed. Fixed causes the frame to remain 
fixed. Space is added below the frame. Moveable causes the frame to move down to 
create space above.
Maximum at Top: Sets the maximum amount of space between text and at the top of
the frame.
Maximum at Bottom: Sets the maximum amount of space between text and at the 
bottom of the frame.



Adding a new chapter
Corel VENTURA documents are divided into chapters that make up a publication. You can 
add a new chapter at the end of a publication. To change the order of chapters within a 
publication use the Publication Manager command in the File menu.
To add a new chapter to a publication:
· Choose Add New Chapter from the Layout menu.

Because Corel VENTURA keeps only one chapter open at a time, the screen is cleared 
and a new chapter appears. If the chapter you were working with before adding a new 
chapter has been modified since the last save, you are prompted to save the changes.



Adding an existing chapter from another publication
Corel VENTURA documents are divided into chapters that make up a publication file. You can 
add a chapter from another publication to the current publication. The order of chapters 
within a publication is changed using the Publication Manager command in the File menu.
To add an existing chapter:

1. Choose Add Existing Chapter from the Layout menu. The Open Chapter dialog box 
opens .

2. Choose a chapter and click OK. The chapter is placed after the current page.



Saving a chapter
You can save a chapter under a new name using the Save Chapter As command on the 
Layout menu.
To save a chapter:

1. Choose Layout, Save Chapter As. The Save Chapter As dialog box opens.
2. Type in the name of the new chapter in the File Name box.
3. To save the chapter in a different location, choose a new drive and directory.



Using text from other programs
Corel VENTURA can read text directly from many popular word processors. It can also read 
text from many other programs which save text as a standard ASCII file. Text is read using 
the Load Text command. Text is saved automatically by saving a document using the Save or
Save As commands. Once saved, text can be edited using a word processor. The text can 
also be checked for spelling errors using a word processor's spelling checker, or from within 
Corel VENTURA using the Spell Check command. Finally, text originally loaded into Corel 
VENTURA in one word processor format can be converted to another word processor format 
using the Rename File command in the File menu.
This section explains how to prepare text from various word processors, spreadsheets, and 
databases for use by Corel VENTURA.
See also:
· Text translation
· ASCII text
· Spreadsheets
· Databases
· Word processors
Note: The information in this section can also be used by a programmer to convert text 
from a word processor or other program into text which can be read by Corel VENTURA as an
ASCII or word processing file.



Text translation
· Scope of text translation
· Tags
· Non-keyboard characters
· Tabs
· Text attributes codes
· Text color
· Other inserted text
· Additional inserted text
· Deleting null paragraphs



Scope of text translation
Corel VENTURA creates typeset documents. The information needed to produce these 
typeset documents is far more complex than that needed to simply print typewriterstyle text
from a word processor. Therefore, Corel VENTURA adds typesetting margins, indents, 
hyphenation, page breaks, bullets, page numbering, headers and footers, footnotes, tab 
settings, picture anchoring, font information, table of contents, index, and section 
numbering into the text which is ultimately stored back into the word processor file. In 
addition, much of the format information used by the word processor is ignored when the 
text is read into Corel VENTURA. For instance, a center command in a word processor is used
to center text across a page. However, in a typeset page, text can be centered not only 
across a page, but within a column, across two columns, or within a frame. Thus, the word 
processor's center command does not provide sufficient information to unambiguously 
define what Corel VENTURA should do.
Since the format information from the original word processor is eliminated as soon as the 
chapter is saved, you must save the text file under a different name before loading it into 
Corel VENTURA if you want to retain the original word processor formatting.
However, text attribute information used by the author to convey meaning is used. All 
attributes assigned using Corel VENTURA's Text attributes (e.g., underline, boldface, font 
settings) can be transferred to and from any word processor or ASCII file. This is described in
the sections which follow.
Note:    In order to store typesetting information into a word processor format, much of the 
word processor's format informationother than text attributes-is replaced by Corel VENTURA 
attribute codes when Corel VENTURA saves the chapter.



Tags
Corel VENTURA's paragraph format tags can be inserted from within your word processor as 
follows (the @ must be the first character in the line at the beginning of a paragraph):
@TAGNAME ^ = ^
where TAGNAME is replaced by the name of the tag assigned to the paragraph. (The ^ 
symbol indicates that you should insert a space.) Thus, whether tagged originally by the 
author, or whether entered in the word processor or in Corel VENTURA, these tags can be 
inserted into the text.



Non-keyboard characters
Additional characters not found on the keyboard can be inserted into text by enclosing the 
ASCII decimal equivalent within brackets. (Refer to the Appendix Character Sets & Codes.) 
For instance, to insert a trademark symbol ( ), type:
<191>
To use the < > characters without having them interpreted as part of a character attribute 
code, type two brackets in a row. For instance, to produce:
<text in brackets>
type:
<<text in brackets>>
If the word processor can create and edit foreign characters, Corel VENTURA will translate 
these without the need to use the < > codes.



Tabs
Any time you press the Tab key on the keyboard, you insert a tab character into the text. The
word processor then moves the cursor to the next tab stop setting for that paragraph. If the 
tab settings in the Corel VENTURA style sheet are at different locations from the tab stops in 
the word processor, this will lead to incorrectly formatted tables. To avoid this problem, use 
tab settings in the word processor that are similar to the style sheet to be used. Because 
word processor tab stops are set according to the number of characters which you want to 
skip, while Corel VENTURA's tab stops are set according to distance from the left column 
edge, this may require a little experimentation. However, you can closely approximate the 
word processor's tab settings by setting the Tab Positions the Alignment dialog box 
(Paragraph command, Format menu) to Left, and setting the distance (in inches) to a value 
given by the following formula:
(Tab Stop/Pitch) - (Left Margin/Pitch) = Distance
The tab stop and left margin options are measured in numbers of characters. Pitch is 
measured in characters per inch. Distance is measured in inches. For instance, if your word 
processor prints at 10 pitch (e.g., 10 characters per inch) and you have a tab stop set at 30 
characters from edge of the page, and a left margin of 15 characters, the Corel VENTURA tab
stop should be set for    (30/10)-(15/10) = 1.50 inches.
Tab check list:
· Set the Horizontal Text Alignment option in the Alignment dialog box (Paragraph 

command, Format menu) to a setting other than Justified for any paragraph that contains 
tabs.

· Make sure the word processor is configured to insert tabs. Certain word processors when 
configured incorrectly, add spaces rather than tabs.

· Text which includes tab characters does not automatically wrap around frames (use line 
breaks if lines extend beyond the edge of frames).



Text attributes codes
Corel VENTURA correctly translates, displays, and prints text attributes, such as boldface and
underline, from each word processor supported. Similarly, any text attributes added using 
the Freeform Text tool are stored back in the word processor's native file format.
However, because Corel VENTURA can create a much wider range of text attributes than any
word processor, and because combinations of these attributes are treated differently within 
Corel VENTURA, many attributes are stored back into the original file using the codes shown 
below.
For instance, the beginning of medium italic text is set by inserting the following directly 
before the text to be italicized: <MI>
In general, attributes native to the word processor, such as boldface, when used alone, are 
translated back to the original attribute when a chapter is saved in Corel VENTURA. When 
used in combination with other attributes, they are translated back to the original attribute 
using combinations of the following Corel VENTURA codes.

Attribute Code

Medium weight type <M>
Bold weight type <B>
Italics <I>
Underline <U>
Double underline <=>
Overscore <O>
Strike-thru <X>
Small <S>
Superscript <^>
Subscript <v>
Color index See Text Color
Typeface <F" typeface 

name">
Point Size <Pn> point size
Base Line Jump <Jn> baseline jump
Begin Kerning <Kn> kerning
Kern/Track <%n>kern track
Resume Normal <D>
Note: All attributes are terminated at the end of a paragraph, even if the Resume Normal 
character code (<D>) is not encountered. Also, all previous attributes are terminated any 
time new attributes are set.
· Examples of Text Attributes



Text Attribute Examples
Attributes can be grouped together into sequences. For example, to set Bold, Italic, Blue 
text, the code is <BIC4>. Any new text attribute sequence encountered cancels all previous 
attributes.
Attributes native to the word processor and the codes described on the previous pages can 
be intermixed.
To create the following effect using WordStar:
airplane automobile
where the first word is boldfaced and underlined, and the second word is boldface only, 
would require the following within WordStar:
^U^Bairplane^U automobile^B
This same effect can be produced using the codes described on the previous 
pages as follows:
<BU>airplane <B>automobile<D>
The author can choose either to use the attribute set shown above, or continue to place 
attributes in the text using the word processor's own commands.



Text color
When color is applied to text in Corel VENTURA, codes corresponding to the selected color 
model, palette and color are stored with the text file.    The codes can also be inserted 
manually in the text file from within a word processor.    Later, when the text file is imported 
by using the Load Text command in the File menu, the color information is correctly 
translated, displayed and printed. 
The codes for text color are as follows:

Color 
Model

Code Description

RGB <C5,P,K,r,g,b> C5=RGB identifier
P=Palette Number*
K=Knockout/Overprint (0/1)
r=Red, g=green, b=blue

PANTONE <C1,P,K,Id,Density
>

C1=PANTONE identifier
P=Palette Number*
K=Knockout/Overprint (0/1)
Id=Pantone Id
Density=Color Density

CMYK <C2,P,K,c,m,y,k> C2=CMYK identifier
P=Palette Number*
K=Knockout/Overprint (0/1)
c=Cyan, m=Magenta, 
y=Yellow,k=Black

CMY <C4,P,K,c,m,y> C4=CMY identifier
P=Palette Number*
K=Knockout/Overprint (0/1)
c=Cyan, m=Magenta, y=Yellow

CMYK255 <C3,P,K,c,m,y,k> C3=CMYK255 identifier
P=Palette Number*
K=Knockout/Overprint (0/1)
c=Cyan, m=Magenta, 
y=Yellow,k=Black

HSB <C6,P,K,h,s,b> C6=HSB identifier
P=Palette Number*
K=Knockout/Overprint (0/1)
h=Hue, s=Saturation, 
b=Brightness

HLS <C7,P,K,h,l,s> C7=HLS identifier
P=Palette Number*
K=Knockout/Overprint (0/1)
h=Hue, l=Lightness, 
b=Brightness

BW <C8,P,K,b> C8=BW identifier
P=Palette Number*
K=Knockout/Overprint (0/1)
b=1(B) or 0(W)

Grayscale <C9,P,K,Gray> C9=Grayscale identifier



P=Palette Number*
K=Knockout/Overprint (0/1)
Gray=Gray Value

YIQ255 <C11,P,K,Cy,Ci,Cq
>

C11=YIQ255 identifier
P=Palette Number
K=Knockout/Overprint (0/1)
Cy=Luminance Component
Ci=I Chroma Component
Cq=Q Chroma Component

LAB <C12,P,K,l,a,b> C12=LAB identifier
P=Palette Number*
K=Knockout/Overprint (0/1)
l=l Component
a=a Component
b=b Component

*Palette Number (P in the codes described above):
1= PAL_TRUMATCH
2= PAL_PANTONE_PROCESS
3= PAL_PANTONE_SPOT
4= PAL_IMAGE
5= PAL_USER
6= PAL_CUSTOMFIXED
7= PAL_RGBSTANDARD
8= PAL_FOCOLTONE



Other inserted text
In addition to paragraph tags and text attributes, Corel VENTURA also inserts other fields 
into the text file, including line breaks, discretionary hyphens, non-breaking spaces, frame 
anchors, index references and footnotes. These are always stored back into the word 
processor file inside of < > brackets. The codes for each attribute are as follows. Some of 
these are described more fully in the paragraphs which follow this table.

Text Attribute Text Code

Box (Hollow) <$B0>
Box (Filled) <$B1>
Chapter number <$R[C#]>
Discretionary Hyphen  <>
Em space <_>
En space <~>
Figure Space <+>
Footnote <$Ftext>
Fraction <$Enumerator/denominator>
Fraction <$Enumerator over 

denominator >
Hidden text <$!text>
Index <$IPrimary[Primary 

sort];Secondary[Secondary 
sort]>

Line Break <>
Non-Breaking Space  <N>
Page number <$R[P#]>
Picture anchor (below) <$&anchor name[v]>
Picture anchor (same 
page)

 <$&anchor name>

Picture anchor (above) <$&anchor name[^]>
Picture anchor (automatic) <$&anchor name[-]>
Thin Space <|>
See:
· TrueType weights
· Line Break <R>
· Discretionary Hyphen
· Non-Breaking Space
· Footnotes <$F>
· Frame anchors
· Hidden text
· Index
· Box characters



TrueType weights
The follow table lists the TrueType text attribute weight codes. These codes are entered into 
text in exactly the same manner as other text attribute bracket codes.

TrueType Weight Attribute Code
Thin <W1>
Extra Light or Ultra Light <W2>
Light <W3>
Normal or Regular <W4>
Medium <W5>
Semi Bold or Demi Bold <W6>
Bold <W7>
Extra Bold or Ultra Bold <W8>
Black or Heavy <W9>

Line Break <R>
A line break begins a new line without creating a new paragraph. Use line breaks when 
printing large database files to separate individual lines within a record. The fewer 
paragraphs in a database printout, the larger the database file can be. Make sure, however, 
that you do not create a paragraph longer then 4-6K bytes.



Discretionary Hyphen <->
A discretionary hyphen <-> presents an additional hyphenation opportunity to Corel 
VENTURA's hyphenation algorithm. If the word which contains a discretionary hyphen is not 
placed at the end of a line, no hyphen is shown on the screen and no hyphen is printed.
Placing a discretionary hyphen at the beginning of the word disables hyphenation for the 
one occurrence of that word.



Non-Breaking Space <N>
The non-breaking space <N> inserts a space, but unlike a normal space, no break (line 
break, page break, etc.) may occur at this point. The non-breaking space is used to keep 
words together on the same line.
The non-breaking space is expanded and compressed during justification, unlike the thin, 
figure, em, and en spaces which are always fixed width, regardless of justification.



Footnotes <$F>
Footnotes can be inserted at any point in a text file by specifying <$Ftext> where text is the
footnote text which will appear at the bottom of the page. Within Corel VENTURA, the 
appropriate footnote number is generated at the location in the text where the <$Ftext> 
appears.



Frame anchors
Frames can be anchored in one of four ways:
· Fixed, on the same page
· Relative, above the anchor location
· Relative, below the anchor location
· Relative, automatically at anchor
The anchor reference is placed in the text as indicated in the earlier table. For instance, 
<$&SCREEN23[v]> will anchor the frame named SCREEN23 to the spot immediately below 
the line which contains the anchor.



Hidden text
The hidden text allows you to place comments and other text in your files which Corel 
VENTURA will not display or print. Thus, if you place the following in a text file:
<$!Note: this section revised on June 26, 1989>
This text will not appear in your document, but will still be available to edit within your word 
processor.



Index
Index entries are placed within a text file as follows:
<$IMain Entry[Main Entry sort];Sub Entry[Sub Entry sort]>
Where Main Entry is replaced by the Main index entry; Sub Entry is replaced by the Sub 
index entry; and Main Entry sort and Sub Entry sort are replaced with the two sort keys. For 
See references, $S is used in place of $I. For See Also references, $A is used in place of $I.

If no sort keys are specified, the correct code is:
<$IMain Entry;Sub Entry>
If only a Main Entry reference is used, the code is:
<$IMain Entry>
Index references can easily be entered directly into your favorite word processor. Simply 
locate the point you wish to index and type the index references.
For instance, this paragraph was indexed within WordPerfect by typing:
<$IWord processor;Developing index in>
(At the beginning of the paragraph.)



Box characters
To place box characters in your document, enter:
<$B0> or <$B1>



Additional inserted text
The following shows additional codes which can be entered from within a word processor or 
from any other program to create the effects used by Corel VENTURA.
· Cross references
· Reference Error Messages
· Equations
· Tables



Cross references
Marker
<$M> - Text marker used to provide a reference point in a text stream which may be 
referenced (forward or backward) by a <$R> code. Syntax:
<$M[label]>
label is the identifying label (name) of the marker. (Note: case will be ignored.)
String variable
<$V> - String variable used to define a string variable which may later be backward 
referenced by a <$R> code. The most recent declaration of a string variable is the one used 
when referenced. Syntax:
<$V[label]string>
Where label is the identifying label (name) of the string variable (note: case will be ignored).
string is the string which is to be substituted when the variable is referenced. The string is 
not limited in length and may be an empty string.
Reference
<$R> - Reference used to cause a reference substitution into the text stream. Syntax:
<$R[type,label,format]string>
type may be one of the following:
· C# to designate the chapter number of the referenced frame or marker.
· P# to designate the page number of the referenced frame or marker.
· F# to designate the figure number of the referenced frame.
· T# to designate the table number of the referenced frame.
· S* to designate the section number string of the referenced marker (e.g., the text is 

derived from the section number paragraph immediately preceding the paragraph in 
which the marker appears).

· C* to designate the caption label text of the referenced frame.
· V* to designate a string variable substitution.
label is the name of the desired string variable or marker, or the anchor name of the desired 
frame. This parameter is optional. Refer to restrictions below (note: case will be ignored).
format is a format identifier, using the same syntax as is used for the format identifier for 
chapter, page, figure, and table counters. This parameter is optional; refer to restrictions 
below.
string is the text which is last determined to be the appropriate substitution during 
publication reference generation. Initially, it may be an empty string or any default string. A 
specified default string will be overwritten when publication cross-referencing is performed. 
Optional parameters in the <$R> code may be used only when appropriate. Specifically, the
following formats are the only valid ones.
· [C#] or [P#]: substitute the current chapter or page number in the format specified for 

the current chapter or page.
· [C#,label], [P#,label], [F#,label], or [T#,label]: substitute the chapter, page, figure, or 

table number of the object or position referenced by label, using the format currently 



defined for the object/location's chapter or page. The label must reference a frame for 
figure and table numbers. It may reference either a frame or a text marker for chapter 
and page numbers.

· [C#,label,format], [P#,label,format], [F#,label,format], or [T#,label,format]: as described 
for the optional syntax immediately above, except that the specified format is to be used.

· [S*]: substitute the section number string of the current paragraph.
· [S*,label]: substitute the section number string of the paragraph which holds the marker 

referenced by label. The label must reference a text marker.
· [C*,label]: substitute the caption label string of the frame referenced by label.
· [V*,label]: substitute the variable string referenced (and already defined) by label.



Reference Error Messages
Two types of error messages may be generated during cross referencing and written to an 
error file with the same file name as the publication with the last three letters change to ERR
and an extension of GEN. The entries in this file have the following format:
· XXX.CHP, page 51: No section number defined.
This type of error indicates that a [S*] or [S*,label] reference was made to a paragraph which
has no active section number.
· XXX.CHP, page 52: Unresolved reference label (LABEL 1).
This type of error indicates that reference was made to a label which does not exist.
An alert directing the user to examine the error file will appear on the screen if an error is 
encountered. 



Equations
Equations are entered in a word processor exactly as you type them from within the Corel 
VENTURA equation editor. Precede the equation with <$E and end it with >. For example:
<$E2~sqrt { -^{ a over 3 } cos theta sub 1 }>
Any > character should be entered as >>.
No attributes (e.g., <B>) should be included within the equation. Use font and size instead.



Tables
Tables begin with a @Z_TBL_BEG = statement and end with a @Z_TBL_END = statement. 
The information directly after the @Z_TBL_BEG = statement defines the structure of the 
table as described below. Each row in the table is entered in a separate paragraph. Each 
column in each row is separated by a comma followed by a space (type two commas 
followed by a space to make a comma followed by a space appear within a column). If no 
space follows the comma, (e.g., within a number) only one comma is needed. What follows 
is the definition of each element within a table. These elements should appear in the order 
shown. The example following the definitions shows the actual structure for this table as it 
appears within a word processor.

Command Use Example

@Z_TBL_BEG = Place at the beginning 
of a table.

 @Z_TBL_BEG = 

COLUMNS( ) Defines the number of 
columns in the table.

COLUMNS(4)

DIMENSION( )  Defines the 
dimensions used for 
the parameters which 
follow. IN specifies 
inches; PT specifies 
points; CM specifies 
centimeters; PI 
specifies picas. You 
can locally override 
the global setting by 
placing these 
parameters directly 
after the parameter.

DIMENSION(IN)

COLWIDTHS(W1, 
W2, ... WN)

Defines the width of 
each cell within the 
table. E specifies 
variable width.

COLWIDTHS(.67,2.
97,E1),

WIDTH( ) Optional parameter. 
Width of table if 
Custom is specified.

WIDTH(5.00)

INDENT( ) Optional parameter. 
Indent from left 
column if custom 
width is less than 
current column width.

INDENT(1.00)

ABOVE( ) Optional parameter. 
Space above the table.

ABOVE(.049)

BELOW( ) Optional parameter. 
Space below the table.

BELOW(.017)

VJTOP( ) Optional parameter. 
Vertical justification 
above the table.

VJTOP(.015)

VJBOT( ) Optional parameter. 
Vertical justification 
below the table.

VJBOT(.031)

HGUTTER( ) Optional parameter. 
Space between 
columns.

HGUTTER(.032)

VGUTTER( ) Optional parameter. 
Space between rows.

VGUTTER(.059)

BOX( ) Optional parameter. 
Tag to be used for 
ruling lines around.

BOX( Z_DOUBLE)

HGRID( ) Optional parameter. 
Tag to be used for 
ruling lines between 
rows.

HGRID(Z_SINGLE)

VGRID( ) Optional parameter. VGRID(Z_SINGLE)



Tag to be used for 
ruling lines between 
columns.

KEEP( ) Breaks are allowed 
(OFF) or not allowed 
(ON).

KEEP(OFF)

RULE(Tag Name, 
Cell Range)

Optional parameter(s).
Defines ruling line 
override for any range 
in the cell. List all 
ruling line overrides at 
the beginning of table 
in one paragraph 
separated by commas.

RULE(Z_HIDDEN,R9C
2..R9C3)

L0(Cell Range), 
L1(Cell Range), 
L2(Cell Range), 
L3(Cell Range)

Defines the line type 
override for a line or 
cell. If the specified 
range is a number of 
cells, attributes will 
apply only to the lines 
bordering the specified
range.

L0(R3C1..R5C5)

L0 = Hidden line
L1 = Single line
L2 = Double line
L3 = Thick line

@@Z_TBL_HEAD 
= tag1, tag2,    ...,  
tagn

Defines the tags for 
each column in the 
header row.

@Z_TBL_HEAD = 
TABLE TEXT, TABLE 
2, TABLE 3, TABLE 4

@@Z_TBL_BODY 
= tag1,    tag2,  
  ...,    tagn

Defines the tags for 
each column in a row. 
Use before first non-
header row and before
any row whose tags 
are different from 
preceding row. A tag 
for each column must 
be specified.

@Z_TBL_BODY = 
TABLE TEXT, TABLE 
TEXT, TABLE TEXT, 
TABLE TEXT

C1, C2, C3, C4 Data for each column 
in a row. Use a ^ 
character before the 
comma to indicate this
cell is joined with the 
one above; + to 
indicate this cell is 
joined with cell to the 
right.

 1, 2, 3, 4
5, 6, ^,    8
9, 10, 11, +, +

<$!Bnm> Set tint for cell. Tint 
appears at end of cell 
entry. n is color, m is 
pattern.

1b, 2b, 3b, 4b<$!
B26>

@Z_TBL_END = Indicates the end of 
the table.

 @Z_TBL_END = 

Deleting null paragraphs
Each time you press the Enter key when using the word processor, you create a new 
paragraph. If you press Enter twice in a row in order to place a blank line between 
paragraphs, Corel VENTURA creates a null paragraph, complete with all the space normally 
placed between paragraphs. If this is not desirable, you can delete all extra carriage returns 
by using your word processor to place the following tag at the beginning of the text file:
@PARAFILTR    ON    =          
Be sure to enter a space after the equal sign.
This must be added from within your word processor, not from within Corel VENTURA. The 
extra paragraphs will be eliminated the next time you load this text file or open a chapter 
containing the text file. When you save the chapter, the extra paragraphs are permanently 
eliminated.



If you want to retain two carriage returns at a few places in a document, but still use the 
@PARAFILTR ON = feature, place a space in front of the second carriage return. Corel 
VENTURA will see carriage return-space-carriage return rather than two carriage returns in a 
row and will not eliminate the second carriage return.



ASCII text
· Overview
· Characters not used in ASCII text
· Text from mainframe computers



Overview of ASCII text
Most word processors, spreadsheets, and database programs save information in their own 
file format, usually identified by a unique file extension. For instance, Lotus 1-2-3 saves 
worksheets in WKS or WK1 files, and dBase III saves databases in DBF files. Text can be 
moved to and from many of these popular programs as standard ASCII text files. You can 
load ASCII files using either the ASCII option or 8 Bit ASCII option. Loading as an ASCII or 8 
Bit ASCII file requires two carriage return-line feed combinations to create a new paragraph. 
See:
· Characters not used in ASCII text
· Text from mainframe computers



Characters not used in ASCII text
The American Code for Information Interchange (ASCII) uses seven bits for data and one bit 
for parity. This allows 128 characters. However, to allow for non-English and typographic 
characters, Corel VENTURA provides an 8 Bit ASCII converter which uses the parity bit as 
data. This allows the entire Corel VENTURA character set to be represented in a pseudo-
ASCII format. Please note that ASCII characters below decimal 32 (except tab-decimal 9-) are
not translated to or from Corel VENTURA.



Text from mainframe computers
Some ASCII files, especially those transferred via a communication program to your PC from 
mainframe computers, do not have two pairs of carriage return (decimal 13) and line feed 
(decimal 10) characters at the end of each paragraph ([CR][LF][CR][LF].) Additional carriage 
returns without a matching line feed (or vice versa) will cause unpredictable results.



Spreadsheets
· Overview
· Windows spreadsheet applications
· DOS spreadsheet applications



Overview of Spreadsheets
Data from both DOS-based and Windows-based spreadsheet applications can be imported 
into Corel VENTURA. The procedures used for importing the spreadsheet data into Corel 
VENTURA is dependent on whether the spreadsheet application is DOS-based or Windows-
based, and how the data is exported from the spreadsheet application. The two methods for 
importing spreadsheet data are:
· Exporting the data from the spreadsheet application as an ACSII file, or via the Windows 

clipboard (for Windows-based spreadsheet applications). The data is then imported into 
Corel VENTURA as tabbed text.

· Exporting the data as a space or comma delimited ASCII file and importing it into Corel 
VENTURA as a table using the PRN file type.

See:
· Windows spreadsheet applications
· DOS spreadsheet applications



Windows spreadsheet applications
Data from Windows-based spreadsheet application can be imported into Corel VENTURA in 
two ways. The first method is to print the data to a file and then load the file into Corel 
VENTURA as a table. The second imports the data as tabbed text via the Windows clipboard.
Print data to a file
Most Windows-based spreadsheet applications have the ability to print the spreadsheet data
to a file that can be loaded into Corel VENTURA as a table using the PRN file type in the Load
Text dialog box. Refer to the documentation accompanying the spreadsheet application for 
the procedures required for printing the spreadsheet data to a file.
For those Windows-based spreadsheet applications that do not have the capability to print to
a file as a function of the application, the data can be printed to a file using the Generic/Text 
Only Windows printer driver. This driver is installed in Windows using the Printer option in 
the Windows control panel. Refer to the Windows documentation for information on installing
this driver and configuring it to output to a file.
By installing this driver and setting it to output to a file, the spreadsheet can be output 
through this driver to a file that can then be loaded into Corel VENTURA as a table. However,
the spreadsheet must output this data to the printer driver with either two spaces (space 
delimited), or a comma and two spaces (comma delimited) between each cell. This can 
generally be done by adding two spaces after the data in each cell. or by adjusting the 
column width so that two spaces will follow the data in each cell when the spreadsheet is 
printed to a file.
Import via Windows clipboard
The Windows clipboard can be used to import data from Windows-based spreadsheet 
applications into Corel VENTURA as tabbed text. To import the data:

1. Open the spreadsheet application and load the desired spreadsheet.
2. Highlight the cells containing the data you want to import into Corel VENTURA.
3. Select the Copy option from the spreadsheet application's menu.
4. If not already running, start Corel VENTURA.
5. Load the chapter in which you want the data imported.
6. Click the Freeform Text tool and place the text cursor in text at the location you want 

the spreadsheet data to be imported.
7. Select Paste from the Edit menu.

The spreadsheet data is pasted into the chapter as tabbed text. The spacing of the data is 
dependent on the tab settings set for the tag associated with the spreadsheet data (typically
Body Text). Assign another tag to the data, adjust the tab settings, and format the data as 
desired.



DOS spreadsheet applications
Data from DOS-based spreadsheets can be saved as ASCII files using the spreadsheet's 
print-to-file option (/PF in Lotus 1-2-3.) In 1-2-3, the file name chosen automatically has the 
extension PRN added. Most spreadsheets, including Lotus 1-2-3, place spaces, not tabs, 
between each column and cannot be configured to automatically insert tab characters 
between columns. Therefore, when using proportionally spaced fonts on Corel VENTURA, the 
columns will not align, unless you manually place tabs between each column, as described 
in the Tabs section.
When loading a text file generated by a spreadsheet application, first set the tab stops for 
Body Text to the desired positions. Then, use the Load Text command in the File menu to 
load the spreadsheet print file as a WordStar file. (Because each row is separated by a single
carriage return, and because Corel VENTURA ignores single carriage returns in ASCII text, 
loading as an ASCII file would cause each line to run directly into the next line. In WordStar 
files, Corel VENTURA treats single carriage returns as paragraph breaks.) Finally, use the 
Freeform Text tool to delete all spaces and then insert tabs between each column in each 
row.
A simpler solution which doesn't require inserting tabs is to simply change the imported 
spreadsheet text to Courier or some other font which is not proportionally spaced. This can 
be done by creating a new tag, changing its font to Courier, and then tagging the 
spreadsheet paragraph(s) with this new tag. Make sure to set the Normal Word Spacing 
option in the Typography dialog box (Paragraph command, Format menu) to 1.0 in order to 
get the columns to align perfectly.



Databases
· Overview



Databases
Most database applications allow you to export selected database information to an ASCII 
file using commands such as REPORT and LABEL. To import database information into Corel 
VENTURA, the files generated by the database application must be either comma delimited 
(a comma and two spaces are placed after the information from each field) or double space 
delimited (two spaces are entered after the information from each field) files. Refer to the 
documentation for your specific database application for information on generating a 
delimited ACSII file from the database application.
ASCII files generated by database application can be imported into Corel VENTURA using the
PRN to Table import option.



Word processors
· Ami Pro
· Microsoft Word
· Microsoft Word for Windows
· Multimate
· Windows Write
· WordPerfect
· Wordstar
· Xywrite



Ami Pro
Corel VENTURA can read and write standard Ami Pro 2.0 and 3.0 text files. Corel VENTURA 
automatically converts standard Ami Pro text attributes into Corel VENTURA text attributes, 
(e.g. bold, italic, superscript, subscript).
Note: Corel VENTURA cannot import Ami Pro protected text files. Save the file as an 
unprotected file before importing it into Corel VENTURA.

Attribute Keyboard keys

Begin/End Bold Ctrl B
Begin/End Superscript (Special Effects)
Begin/End Subscript (Special Effects)
Begin/End Strike-thru (Special Effects)
Underline Ctrl U
Discretionary Hyphen Ctrl -
Non Break Space Ctrl Space
All other attributes, attribute combinations, footnotes, index references, and text characters 
must be entered into Ami Pro using the < > commands outlined in Text attributes.
In Corel VENTURA 5, the following error message appears when you open a VENTURA 4.2 
chapter which includes Ami Professional files: "The file is invalid or has an unsupported 
format...".
Opening the text files in Ami Professional and saving them again allows the files to load as 
part of the chapter in Corel VENTURA 5.



Microsoft Word
Corel VENTURA can read and write standard Microsoft Word files. Microsoft Word style sheets
are not usable by Corel VENTURA.
Corel VENTURA automatically converts standard Word text attributes to Corel VENTURA text 
attributes.

Attribute Keyboard keys
Begin/End Bold Alt B
Begin/End Superscript Alt +
Begin/End Subscript Alt -
Begin/End Strike-thru Alt S
Underline Alt U
Discretionary Hyphen Ctrl -
Non Break Space Ctrl Spacebar
All other attributes, attribute combinations, footnotes, index references, and text characters 
must be entered into Microsoft Word using the < > commands outlined in Text attributes.



Microsoft Word for Windows/Windows Write
Corel VENTURA can read and write standard Microsoft Word for Windows and Windows Write 
files. Microsoft Word for Windows style sheets are not usable by Corel VENTURA.
Note: In order to load text files created in Windows Write, the file must be saved using the 
Microsoft Word format option.
Corel VENTURA automatically converts standard Word text attributes to Corel VENTURA text 
attributes.

Attribute Keyboard keys
Begin/End Bold Alt B
Begin/End Superscript Alt +
Begin/End Subscript Alt -
Begin/End Strike-thru Alt S
Underline Alt U
Discretionary Hyphen Ctrl -
Non Break Space Ctrl Spacebar
All other attributes, attribute combinations, footnotes, index references, and text characters 
must be entered into Microsoft Word using the < > commands outlined in Text attributes.
Corel VENTURA imports Word for Windows text files containing graphics. However, the 
graphics will not be imported into Corel VENTURA, and all graphics codes will be stripped 
from the text file when the file is saved by Corel VENTURA.
Note:    Pending the release of the appropriate export filter by Microsoft, Corel VENTURA 
saves Microsoft Word for Windows 6.0 files in Word for Windows 2.0 format. When you return
to Word for Windows 6.0 to and resave files saved earlier in Corel VENTURA, a prompt will 
appear stating that the file was last saved in Word 2.0. You may then save the file in either 
Word format.



Multimate
Corel VENTURA 5.0 does not support conversion of Multimate files.



WordPerfect
Corel VENTURA reads and writes standard WordPerfect 5.x and 6.x files.
General Notes and Limitations
· Text in WordPerfect's Table of Contents and Index functions are not supported by Corel 

VENTURA.
· WordPerfect Style Sheets and v. 4.x files are not supported.
· Equations and formulas created in WordPerfect's equation language are converted to 

regular text by Corel VENTURA.
· Graphic features like HLine and VLine are not converted to Corel VENTURA.
Page Size

When importing text the page size in the original document is ignored. The text is fit to the
current Corel VENTURA page size. This may affect the placement of text.

Note: Password protected WordPerfect files cannot be imported into Corel VENTURA. In 
order to import a WordPerfect file that is password protected, you must first open the text 
file in WordPerfect, save the text file under a different name as a non-password protected 
file, and then import the new file.
Corel VENTURA automatically converts standard WordPerfect text attributes to Corel 
VENTURA text attributes.

Attribute Keyboard keys

Begin/End Bold F6
Begin/End Superscript Shift F1
Begin/End Subscript Shift F1
Begin/End Strike-thru Alt F5
Underline F8
Discretionary Hyphen Ctrl
Non Break Space Home
All other attributes, attribute combinations, footnotes, index references, and text characters 
must be entered into WordPerfect using the < > commands outlined in Text attributes.



File Open dialog box
Loads and displays an existing document. If there is more than one chapter in a publication, 
an additional dialog box opens where you can select which chapter you would like displayed 
when the document opens.

Dialog Box Options
File Name

To open a file, double-click the name from the list or type the name in the File Name box. If
you're unsure of the name of the file you want to open, you can use wild cards (* and ?).

Drives
Choose the drive where the file is stored.

Directories
Choose the directory where the file is stored.

List Files of Type
Choose the type of file to open. You can open publication and chapter files.

Network
Opens the Connect Network Drive dialog box where you can connect to a shared directory. 
This option appears in dialog boxes only when you have Windows for Workgroups installed 
on your computer.

Suppress Graphics
When checked, the graphics are not loaded when a publication is opened, speeding up the 
loading process. However, the frames are visible in the publication, the graphic files are 
listed in the Files List and the connections between frames and graphics files remain. If you
print the publication, the graphics are not printed. The frames are blank. 
This checkbox will change the setting for Suppress Graphics in the Preferences, General 
dialog box.

Shortcut:
Pressing CTRL + O or clicking the open icon on the Ribbon Bar opens the File Open dialog 
box. 

See also:
Opening VENTURA 4.2 chapters that include Ami Professional files



File Save As dialog box
Saves a publication and its component chapters, style sheets, text files and graphics files to 
a specified drive and directory location. File Save As does not save text and graphics files 
under another name or in another directory. Use Rename File to rename text files and the 
Publication Manager to move or copy them to a different directory.

Dialog Box Options
File Name

Type a file name. To overwrite an existing file, choose its name from the list. The filename 
precedes the three character extension and can contain up to eight characters.

Drives
Choose the drive where you want the file stored.

Directories
Choose the directory where you want the files stored.

List Files of Type
Choose the type of file to be saved.

Network
Opens the Connect Network Drive dialog box where you can connect to a shared directory. 
This option appears in dialog boxes only when you have Windows for Workgroups installed 
on your computer.

Note: To back up your work, use Make Backup on Save from the Preferences, General dialog
box. When checked, a backup file is created when you save. Backups are made of 
publication (PUB), chapter (CHP), style sheet (STY) and Text (TXT) files. They have the same 
name as the original file, but with a dollar sign ($) substituted for the first letter of the 
extension. Refer to Chapter 21 of Corel VENTURA's User Manual, General Preferences, for 
information on using backups.



How to...
· Save a new publication
· Export selected text files
· Work with dialog boxes



File Save As dialog box
Saves a publication and its component chapters, style sheet(s), text files and graphics files 
to a specified drive and directory location. File Save As does not save text and graphics files 
under another name or in another directory. Use Rename File to rename text files and the 
Publication Manager to move or copy them to a different directory.

Dialog Box Options
File Name

Type a file name. To overwrite an existing file, choose its name from the list. The filename 
precedes the three character extension and can contain up to eight characters.

Drives
Choose the drive where you want the file stored.

Directories
Choose the directory where you want the files stored.

List Files of Type
Choose the type of file to be saved.

Network
Opens the Connect Network Drive dialog box where you can connect to a shared directory. 
This option appears in dialog boxes only when you have Windows for Workgroups installed 
on your computer.

Note: To back up your work, use Make Backup on Save from the Preferences, General dialog
box. When checked, a backup file is created when you save. Backups are made of 
publication (PUB), chapter (CHP), style sheet (STY) and Text (TXT) files. They have the same 
name as the original file, but with a dollar sign ($) substituted for the first letter of the 
extension. Refer to Chapter 21 of Corel VENTURA's User Manual, General Preferences, for 
information on using backups.



Open dialog box
Opens a publication, specific chapter in a multi-chapter publication or chapter created in 
earlier versions of Corel VENTURA that don't belong to a publication. The same dialog box 
appears but with a different title (Select Source Publication) when you create a document 
from a template by choosing New from the File menu and clicking Base on Template.

Dialog Box Options
File Name

Type a file name or select its name from the list.
Drives

Choose the drive where the publication or chapter you want is stored.
Directories

Choose the directory where the publication or chapter you want is stored.
List Files of Type

Choose the file type (publication, or Ventura version 4.x or 3.x chapter) from the List Files 
of Type box.



How to...
· Open a publication
· Load style sheets
· Create a publication
· Work with dialog boxes



Opening version 4.2 chapters that include Ami Professional files
In Corel VENTURA 5, the following error message appears when you open a VENTURA 4.2 
chapter which includes Ami Professional files: "The file is invalid or has an unsupported 
format..." 
Opening the text files in Ami Professional and saving them again enables the files to load as 
part of the chapter in Corel VENTURA 5.



Go to Chapter dialog box
The Go To Chapter dialog box is used to select a chapter from a publication which will be 
displayed when the publication is opened. This dialog box opens only when a multi-chapter 
publication has been selected in the File Open dialog box. Corel VENTURA enables you to 
choose which chapter to display when the publication is loaded. 

Dialog Box Options
Chapter list

Displays the chapters from a publication that was selected in the File Open dialog box. 
Clicking on a chapter selects it. Double-clicking opens the publication and displays the 
chapter.

Chapter File Information
Displays information about the selected chapter such as the number of pages and style 
sheet(s) used.

Go To Chapter
Opens the publication and displays the selected chapter.



Load Text dialog box
The Load Text dialog box is used to select and load supported text files into a document. 
Corel VENTURA supports a variety of file types including Microsoft Word, WordPerfect as well 
as files saved in ASCII and Rich Text Formats.

Dialog Box Options
File Name

Double-click the file's name in the list or type the name in the File Name box and choose 
OK. 

Directories
Displays a list of directories from a selected drive. Double-click on a directory to display 
the related sub directories and to list all file names of a given format in the File Name box. 

List Files of Type
Displays the supported file formats available for selection. When opening a directory, 
choose a specific file type to have only files of that type display in the display screen. 

Drives
Lists the drives available for selection.

Preview
Is not available for text files.

Insert at Cursor
Only available if you have placed the text cursor in a free frame or the base page frame. 
When enabled, loads the selected text file into the document at the current cursor 
location.

Filter Information
When chosen, displays the information about the import filter that will be used to open the
selected file.

Options >>
Expands the dialog box to show additional options including a Sort list box where you can 
sort the files from a selected directory by name or date. Information about the selected file
such as file size and file format are also displayed. 
The Add to File List checkbox enables you to add the file to the list of available files for the 
current chapter without automatically replacing text in a selected frame. Choose the file 
from the File List to load it into a frame.



Load dialog box
The Load dialog box is used to select and load supported graphics and text files into a 
document. 

Dialog Box Options
File Name

Double-click the file's name in the list or type the name in the File Name box and choose 
OK. To load several files of the same type at once, hold down the Shift key and click each 
file name successively.

Directories
Displays a list of directories from a selected drive. Double-click on a directory to display 
the related sub directories and to list all file names of a given format in the File Name box. 

List Files of Type
Displays the supported file formats available for selection. When opening a directory, 
choose a specific file type to have only files of that type display in the display screen. 

Drives
Lists the drives available for selection.

Preview
When enabled, shows a thumbnail image of the graphic highlighted in the File Name box. 
Preview is not available for text files.

Filter Information
When chosen, displays the information about the import filter that will be used to open the
selected file.

Options >>
Expands the dialog box to show additional options including a Sort list box where you can 
sort the files from a selected directory by name or date. Information about the selected file
such as file size and file format are also displayed. 
The Add to File List checkbox enables you to add the file to the list of available files for the 
current chapter without automatically replacing the contents of a selected frame. Choose 
the file from the File List to load it into a frame.



How to...
· Load text
· Use text from other programs
· Load graphics
· Work with dialog boxes



Load Graphic dialog box
The Load Graphic dialog box is used to select and load supported graphics files into a 
document. 
Note: By default, graphics are set to fit in the selected frame and maintain their original 
"aspect ratio," or proportions relative to the original, even when resized. If you do not create 
a frame, Corel VENTURA creates one automatically and loads the graphic into it. See also 
Frame Settings, Graphic dialog box

Dialog Box Options
File Name

Double-click the graphic file's name in the list or type the name in the File Name box and 
choose OK. To load several files of the same type at once, e.g., PCX files, hold down the 
Shift key and click each file name successively.

Directories
Displays a list of directories from a selected drive. Double-click on a directory to display 
the related sub directories and to list all file names of a given format in the File Name box. 

List Files of Type
Displays the supported file formats available for selection. When opening a directory, 
choose a specific file type to have only files of that type display in the display screen. 

Drives
Lists the drives available for selection.

Preview
When enabled, shows a thumbnail image of the graphic highlighted in the File Name box.
Note: The Load Graphic dialog box previews only bitmap images (with the exception of 
IMG files) and those vector files that contain bitmap image headers (e.g. CDR, CCH, CMX, 
EPS).

Filter Information
When chosen, displays information about the import filter that will be used to open the 
selected file.

Options >>
Expands the dialog box to show additional options including a Sort list box where you can 
sort the files from a selected directory by name or date. Information about the selected file
such as file size and file format are also displayed. 
The Add to File List checkbox enables you to add the file to the list of available files for the 
current chapter without automatically replacing the contents of a selected frame. Choose 
the file from the File List to load it into a frame.



Remove File dialog box
Eliminates a text or graphics file from a frame or chapter.

Dialog Box 
Options
File Name

Lists the names of files in the current chapter. Click inside the list box to display the other 
file names and select the one you want to remove.

Remove from Frame
When enabled, eliminates a text or graphic file from a selected frame. The file remains 
part of the chapter.

Remove from Chapter
When enabled, eliminates a file from a chapter. The file can be retrieved by importing it 
using the Load Graphic or Text dialog boxes.



File Type/Rename dialog box
The File Type/Rename dialog box enables you to rename or change the format of text files. 
Select the frame that has the text file you want to rename and choose File, Rename File. See
also Exporting to different word processor formats

Dialog Box 
Options
File Name

The name of the selected file is displayed. Enter a new name or use the existing name.
Drives

Choose the drive where the file is to be stored.
Directories

Choose the directory where the file is to be stored.
List Files of Type

Choose the type of file. You can export your file in any of the formats displayed in the drop-
down list box.

Filter Information
Click the Filter Information button to display information about the export filter.

Network
Opens the Connect Network Drive dialog box where you can connect to a shared directory. 
This option appears in dialog boxes only when you have Windows for Workgroups installed 
on your computer.

Note: Word for Windows 6.0 documents should be saved in Word for Windows 2.0 format.



How to...
· Export selected text files
· Work with dialog boxes



Mosaic Roll-Up
Opens Corel Mosaic, a file management application. The Mosaic Roll-Up is used to display a 
collection of thumbnails, each representing a file. You can use drag and drop to open or 
import files displayed in the roll-up, in the application you are working with.
Two Mosaic Roll-Ups can be opened at the same time in an application, enabling you to 
move or copy files between collections using drag and drop. 

Dialog Box 
Options
Control menu box    

Use to roll up, roll down, close the Mosaic Roll-Up, arrange all open roll-ups or close them 
all.

Directory drop-down list
Located immediately below the Control menu box, the directory drop-down list enables you
to select or change the directory, library or catalog displayed in the Mosaic Roll-Up. A file 
folder icon precedes each directory name in the list, a book icon precedes catalog names 
and a book collection icon precedes library names. An open collection, of any type, has an 
open file folder preceding its name.

Open collection button
Enables you to select or change the, library or catalog displayed in the Mosaic Roll-Up. It 
opens the Open Collection dialog box, where you choose the type of collection you wish to 
open: directory, library (.CLB) or catalog (.CLC). To open a directory, select the file type 
you want to see, All Image Files to see thumbnails of all graphic files or All Files to see 
thumbnails of all files in the directory.
The Options button displays additional options to sort files, see notes associated and 
keywords associated with them and a Find button to find files that have specific keywords. 
The keyword options are not available in every Corel application.

Thumbnail size and orientation
The thumbnail size, orientation and other settings used in the collection are the ones 
saved when the standalone mode of Corel MOSAIC was last used.

Drag and Drop to the application
You can import a file into the application by clicking its thumbnail    and dragging it to the 
current document in the application. Files of any files formats supported by the Corel 
application can be imported.

Moving and copying files between collections
You can copy a file to a different collection by clicking its thumbnail and dragging it to the 
collection of your choice. Holding down the Shift key while dragging the file moves it 
instead of copying it.

Shortcut:
Clicking  on the Ribbon Bar opens the Mosaic Roll-Up.



Character Set Roll-Up
Enables you to insert special characters without changing the current font. The roll-up 
previews all fonts currently installed on your computer. To place the character on the page, 
click inside a paragraph and double-click any character in the roll-up.

Roll-Up Options
Font name

Contains all of the fonts or typefaces available on the system.
Font style

Contains all typefaces available for the selected font.
Character icons

Display of individual characters in a character set. The actual characters displayed will 
depend on the selected font.

Status line
The area at the bottom of the roll-up which displays the keyboard code for the selected 
character. You can use the keyboard method to insert special characters without opening 
the roll-up.



How to...
· Insert cross references
· Mark text
· Generate and update cross references
· Work with dialog boxes



Insert Cross Reference dialog box
The Insert Cross Reference dialog box enables you to insert a new cross-reference marker or 
create an association with an existing cross reference. Note: Place the text cursor in a 
paragraph before you insert a cross reference.

Dialog Box 
Options
Reference type

Selects the type of reference to be inserted. The options are: Page Number, Chapter 
Number, Figure Number, Table Number, Section Number, Chapter and Page Number, 
Chapter and Section Number, Section and Page number, Caption Text.

Marker
Refer to Marker: Displays existing markers in the publication. New marker names can 

be added, thereby creating a new association. By selecting the "No 
Marker" option, no association is created.

Reference All References all instances
Occurrences: of the selected marker.
Delimiter: Defines how multiple instances of the selected marker will be 

rendered. The options are:
,,,, ("See pages 1, 2, 3, 4")
,,,and ("See pages 1, 2, 3, and 4")
,,, or ("See pages 1, 2, 3, or 4")
x to y ("See pages 1 to 4")
x - y ("See pages 1 - 4")

Format
This section is not available when the Reference Type is Caption Text.
List box: Specifies the printed format of the cross reference. The options are: 

Default, Arabic Numerals, Roman Numerals, Text.
Upper Case: Specifies that the cross reference and any associated prefix will be 

rendered using capital letters.
Capitalize First 
Letter: Specifies that the cross reference and any associated prefix will be 

rendered with the first letter of each word capitalized.
Insert "Chapter": Inserts the words "Chapter," when the Reference Type is Chapter.
Insert "Page": Inserts the words "Page," when the Reference Type is Page Number.



Cross-Refs Roll-up
Use the Cross-Refs Roll-up to manage cross references and markers in your publication. 
Note: The text cursor must be placed in a paragraph when you insert cross references.

Roll-Up Options
Flyout Menu commands

Unresolved Lists unresolved cross
References references and existing markers throughout the publication.
All References Lists all cross references (resolved and unresolved) and existing 

markers throughout the publication.
Unresolved Lists unresolved markers
Markers and existing cross reference links throughout the publication.
All Markers Lists all markers and existing cross reference links throughout the 

publication.
Renumber

Renumbers chapters, pages, table, and figure numbers across the entire publication, and 
then updates all cross references.

Insert Cross Ref
Opens the Insert Cross Reference dialog box. The button will be unavailable unless the text
cursor has been positioned in the text where the cross reference is to appear.

Insert Marker
Opens the Marker Name dialog box. The button will be unavailable unless the text cursor 
has been positioned in the text where the cross reference is to appear.



Add Link dialog box
Selecting a cross reference from the list creates a link between it and the currently selected 
marker in the Cross Reference Roll-Up.

Dialog Box 
Options
Cross Reference

Lists currently defined cross references in the publication.



Marker Name dialog box
The Marker Name dialog box enables you to define cross-reference markers for insertion in 
text.

Dialog Box 
Options
Name

A list where the marker name can be inserted or selected from the list. The same name 
can be used for several markers. If "Reference All Occurrences" in the Insert Cross 
Reference dialog box was checked, all markers of the same name will be cross referenced. 
Otherwise, only the first marker of the same name will be referenced.



Preferences, General dialog box
The Preferences, General dialog box controls the general operations of Corel VENTURA. Click 
the View tab to control display of screen items, dithering of colors and greeking. Click the 
Text tab to set default tab spacing, font type and paragraph and text memory in Copy Editor 
view.

Dialog Box Options
Make Backup on Save

When checked, a backup file is created when you save.
Prompt to Save Chapter

When checked, you are prompted to save the chapter (if it has not been saved) before you
close the file or exit Corel VENTURA.

Verbose Save
When saving, you are prompted to name the publication, chapter and style sheet as 
opposed to just the chapter or publication.

Auto-Convert "" & --    on Load
Word processors use inch marks instead of open and close quotation marks and double 
hyphens instead of em dashes. When checked, Corel VENTURA automatically converts inch
marks to true typographical quotation marks and double hyphens to an em dash. 

Disable Overrides
When checked, you cannot override tag settings.

Print to Separate File
Enabling this option when printing a multi-chapter document to a disk file creates a 
separate print file for each chapter. This enables printing of individual files and makes 
copying to diskettes more manageable.

Preview Fountain Steps
Determines the number of bands used to represent fountain fills on the screen. Choosing a
lower value (less than 20) speeds up screen draws, but results in noticeable banding.

Index Sort Order
Choose the sort order for languages that have different character sets, such as Sweden.

Default Hyphenation
Enables you to select the default hyphenation.

Spell Check Dictionary
Enables you to select the dictionary used to check spelling.



Find and Replace dialog box
The Find and Replace dialog box enables you to set search and replacement parameters for 
text, paragraph tags, and special items.

Dialog Box 
Options
Text/Paragraph tag/Special Item

Click to choose text, a paragraph tag or a special item as the search criterion.
Find What

Text window used to enter search string when Text is selected as the search criterion. 
When Paragraph tag or Special Item is selected, this field changes to a drop list where 
paragraph tags or special text items can be selected.

Replace With
Text window used to enter replacement string when Text is selected as the search criterion.
When Paragraph tag or Special Item is selected, this field changes to a drop list where 
paragraph tags or special text items can be selected.

Match Whole Word
Select to find only entire words matching the search string specified in the Find What 
window. This option is disabled when Paragraph tag or Special Item is the search criterion.

Match Case
Select to find only the strings matching the case used in the search string specified in the 
Find What window. This option is disabled when Paragraph tag or Special Item is the search
criterion.

Search Chapter
Enables search on entire chapter, and not just from the text cursor location.

Find Next
Initiates or continues the search operation.

Replace
Initiates or continues the search operation.

Replace All
Initiates the automatic replacement of all instances of the search field with the 
replacement field.

Search Attributes
This section of the dialog box is available only when Text is the search criterion. The 
options are bold, italic, superscript, subscript, underline, double underline, strikethru, 
overscore and small text.
Font drop Lists all fonts currently 
down list available on the system. Selecting the Ignore option disables the font attribute

as a search option.
Replace Attributes

This section of the dialog box is available only when Text is the search criterion. The 
options are bold, italic, superscript, subscript, underline, double underline, strikethru, 



overscore and small text.
Font drop Lists all fonts currently
down list available on the system. Selecting the Ignore option disables the font attribute

as a replacement option.



Insert Frame Anchor dialog box
The Insert Frame Anchor dialog box is used to insert frame anchors within the text of a 
document. Frames corresponding to existing frame anchors will be linked and will move with 
the anchor as the text flows. After making changes to the document, choose Re-Anchor 
Frames from the Format menu to move frames back to pages on which their anchors appear.

Dialog Box 
Options
Name

Lists existing frame anchors and enables you to select an existing anchor name or enter a 
new anchor name.

Frame Position:
Choose where you want the frame positioned relative to the anchor in the text.
Fixed on Page Positions affected frame(s) at the same physical page coordinates on 

each page.
Above Anchor Line Positions the bottom edge of affected frame(s) immediately above 

the line in which the anchor is located. If the anchor moves to a new 
line, the frame shifts accordingly.

Below Anchor Line Positions the top edge of affected frame(s) immediately above the 
line in which the anchor is located. If the anchor moves to a new line,
the frame shifts accordingly.

At Anchor Positions the center of affected frame(s) right at the frame anchor 
location. If the anchor moves to a new line, the frame shifts 
accordingly.



How to
· Anchor frames
· Work with dialog boxes



Grid Setup dialog box
Controls the spacing of the grid lines and whether or not graphic objects snap to the grid. 
Every frame in VENTURA has its own grid which is useful as a reference point when sizing 
and placing graphic objects.

· When you save your document, the Grid settings are saved with it.
· If you change the grid spacing, frames and graphics in your publication retain their 

position even if they do not line up with the new grid line positions.
· When you change Grid Frequency units, the values in the dialog box are not converted.

Each time you change units, you must specify the frequency you want to use with that 
unit.

Dialog Box Options
GRID FREQUENCY:
Horizontal: Determines the number of horizontal grid lines per unit of measurement.
Vertical: Determines the number of vertical grid lines per unit of measurement.

Note: To space the grid lines more than one whole unit of measurement 
apart, enter fractional values from the keyboard. For example, to space the
grid lines two inches apart, enter 0.5.
The maximum number of grid lines is 72 per inch, 12 per pica, 1 per point 
and 2.82 per millimeter.
When you change Grid Frequency units, the ruler units and those 
displayed on the Status Line are not changed to match. To change the 
ruler's units of measure, use the Set Ruler command.

Snap To Grid: Forces objects close to a grid line into alignment with the grid. Note: Snap
to Grid must also be turned on for the selected frame on the Layout menu 
(Shortcut: Ctrl+Y).



Set Hotkeys dialog box
The Set Hotkeys dialog box controls the assignment of keys to paragraph tags. Assigning 
hotkeys to frequently-used paragraph tags makes them easier to apply. Hotkeys can be 
assigned manually or automatically.

Dialog Box 
Options
Paragraph tags

Lists the paragraph tags. Also shows the previously assigned key combinations and the 
point size of each text paragraph tag. Choose the paragraph tag you want to assign a key 
combination to or whose key combination you wish to change.

Sort By
Lists styles alphabetically from largest to smallest. The options are tag name, point size 
and hotkey.

Hotkey
Choose how you want the hotkeys assigned.
Unassigned, 0-9: Lists the keys available as hotkeys. You cannot assign the same 

hotkey to two paragraph tags. None can be used to remove a hotkey 
assignment.

Auto Assign: Assigns Ctrl+1 to the first style, Ctrl+2 to the second and so on.



How to...
· Set hotkeys
· Work with dialog boxes



Index Entries Roll-Up
The Index Entries Roll-Up is used to specify main and secondary (sub) index entries for 
documents. All selected entries are displayed in alphabetical order in the Index list. Index 
markers are placed in the text at or close to the targeted words or phrases. When the index 
is generated, VENTURA will search the document for the markers, place the text associated 
with the markers in a text file and sort the entries alphabetically. 
Note: Remember to place the insertion point in a paragraph before you start coding your 
insert index markers.

Roll-Up Options
Index List

Provides an alphabetic and indented listing of all defined index markers in the publication, 
along with page numbers and references, if any.

Type of Entry
Enables the inclusion of an index reference with specific entries. Options are index entry, 
see and see also.

Main Entry
Use to enter the wording to be used for the main index entry. After the text has been 
entered, or swiped in the publication, click Add to Index List to add the new entry to the 
index list.

Sort Key
Overrides the default alphabetic sorting sequence.

Sub-Entry
Use to enter the wording to be used for the optional secondary index entry.

Main Entry Button
Use to inset swiped text into the Main Entry text box. This button does not actually add the
item to the index list. After the format has been set correctly, press Add to Index List to 
finalize the procedure.

Sub-Entry Button
Use to insert swiped text into the Sub-Entry text box. This button does not actually add the
item to the index list. After the format has been set correctly, press Add to Index List to 
finalize the procedure.

Add to Index List Button
Finalizes the index entry creation procedure by adding the current entry to the list box, and
inserting an index marker into the text of the document.

Generate Index Button
Opens the Table of Contents & Index dialog box so that you can format and generate the 
index.



Insert Pages dialog box
Use this dialog box to insert pages into the current chapter.

Dialog Box 
Options
Insert # Pages

Defines number of pages to be inserted.
Before

When enabled, the new pages are inserted before the page number specified in the Page 
box.

After
When enabled, the new pages are inserted after the page number specified in the Page 
box.

Page
Defines the page number where the new pages will be inserted.



Delete Pages dialog box
Use this dialog box to delete pages into the current chapter.

Dialog Box 
Options
Delete Page

Defines the page number to be deleted.
Thru Page

Enables range box which defines the end of the range of pages to be deleted.



Go to Page dialog box
The Go to Page dialog box enables you to move to specific pages in the document. It is a 
different type of dialog box than most of those found in Corel VENTURA. It will remain on 
screen while you work on the document. In this way, it resembles to a roll-up. You can close 
the dialog box using the Control menu .
You can use it as many times as you require during the time you are working with the 
document and leave it on screen until you close it. 

Dialog Box 
Options
Forward/Backward buttons

Four buttons used respectively to go to the First page, Previous page, Next page and Last 
page. These buttons can be used to move through the pages of the document or through 
the pages that contain text from the selected text file when Relative to file, described 
below, is selected.

Go to Page
Defines the page to be accessed in the publication.

Relative to file
Constrains access to within the range of the currently selected text file. The first page in 
this case is not necessarily the first page of the chapter but rather the first page of the 
chapter that contains text from the selected file.

Files List
List of text files in the current chapter. Used to choose the file to use in conjunction with 
the Relative to File option described above.



How to...
· Go to a specific page
· Work with dialog boxes



Selected Text Attributes dialog box
The Selected Text Attributes dialog box is used to set style, alignment and other attributes to
text that has been selected in the document. See also Selecting text

 Dialog Box 
Options
Font

Displays all fonts available on the system.
Style

Displays the styles available for the selected font. Styles are bold, italic, normal or bold 
Italic. Some fonts do not have bold and italic; therefore, the only style displayed is normal.

Size
Defines font size of selected text.

Kerning
Defines manual kerning for the selected range of characters. Kerning value is specified in 
ems.

Shift Up
Defines vertical shift from the baseline. A positive value denotes an upward shift, while a 
negative value denotes a downward shift.

Color
Defines the font color for the selected text string. See also Selected Text Color dialog box

Bold
Renders selected text in bold characters.

Italic
Italicizes selected text.

Underline
Applies underline to selected text.

Double Underline
Applies double underline to selected text.

Overscore
Applies overscore to selected text.

Strike-thru
Applies strike-thru to selected text.

Sample
Select to enter sample text to view the effect of the current settings.

See also:

Open Palette dialog box



Save Palette As dialog box



New Publication dialog box
The New Publication dialog box provides a quick method of setting up a document or 
"publication." Page settings can be built from the default settings, an existing template or 
document.

Dialog Box 
Options
Create New

Used to select style sheet for the first chapter of the new publication. To use a style sheet 
other than Default Style, click Load Style to open the Open Style Sheet dialog box.

Base on Template
Opens the File Open dialog box where an existing publication can be selected, and its 
chapter settings and component files used to create a new publication.

Open Publication
Opens the File Open dialog where an existing publication can be selected.

Layout
Lists page folds available when starting a publication from scratch. The selected layout is 
displayed in the preview window.



How to...
· Create a publication from scratch
· Create a publication from a template
· Work with dialog boxes



Base on Template dialog box
The Base on Template dialog box opens when you choose Base on Template in the New 
Publication dialog box. You may then adopt styles, layout or text from another publication by
taking files, such as chapters, a style sheet or text, from that document and applying them 
to your new publication. This saves time and helps in maintaining a consistent look for 
similar types of documents. The Base on Template feature could be useful for creating a 
newsletter in which only the text is modified from one issue to the next, while the style sheet
and some graphic elements such as the masthead remain the same.

Dialog Box 
Options
File Name

Used to type the name of the new publication file.
Drives

Choose the drive where the new publication is to be stored.
Directories

Choose the directory where the new publication is to be stored.
List Files of Type

When creating a new publication based on a template, the file type must be .PUB file . If 
you select a different file type, the OK button in the dialog box is grayed out indicating that
a template cannot be created using that file type.

Copy all files
Creates a copy of all selected files (chapter, graphic and text) to the drive and directory of 
the new publication. The chapter pointers that identify the location of the graphic and text 
files are updated to the new location of the files. The files are selected from the File list 
described below. 
When this option is not checked, only the chapter files that were selected using the Include
Files button are copied in the destination. The original chapter pointers remain as they 
were pointing to the original location of the text and graphic files.

File list
Displays all chapter, text and graphic files included in the original publication which is used
as a template for the new publication. The first file listed is the first chapter file. 
Immediately below it are the component files (text and graphics) included in that chapter. 
The second chapter follows and so on.
The drive and directory where each file is stored appears to the right of the file name.
A check mark appears on the left of selected files. A chapter file must be selected in order 
to select any of its component files. 

An icon ( ) displayed beside a file name in the list box 
indicates that it is located in the same directory you've chosen for your publication and 
cannot be included in the template. If you want to include the file, choose a different 
directory for your publication in the Drives and Directories list box..

Include Files/Omit Files
Used to select and deselect files from the list. Files can be selected one at a time by 



clicking the file name and the Include Files button. When a selected file is highlighted in 
the list, the button name changes to Omit Files. To select several files at once, hold the 
mouse button and drag over contiguous file names, then click Include Files. To select 
several non-contiguous files, press the CTRL key and click the file names.

Include All
Selects all files in the original publication. If you select a chapter using the Include Files 
button, clicking Include All selects only that chapter's files.

Omit All
Deselects all files in the original publication. 



How to
· Create a publication from a template
· Work with dialog boxes



Publication Manager dialog box
The Publication Manager dialog box performs file operations, such as copying and moving 
publications, and scans directories.
Note: The Publication Manager temporarily closes your current document to perform its 
work. 

Dialog Box 
Options
File Operations

The File Operations dialog box is used to manage publications by providing a list of 
available publications and file operations that can be performed on the selected 
publication(s).

Scan Directories
The Scan Directories dialog box customizes the scanning structure of the system by 
enabling you to add or remove drives that should be scanned when the Publication 
Manager is opened.



Publication Manager, File Operations dialog box
The Publication Manager's, File Operations tab is used to manage publications by providing a
list of available publications and file operations that can be performed on the selected 
publication(s).
Note: The Publication Manager temporarily closes your current document to perform its 
work. 

Dialog Box 
Options
File List

Provides a list of all publications or chapters found in scanned directories, and adds them 
to the list box. Double-clicking a publication will expand the list to show all chapters 
referenced in the selected publication. Double-clicking a chapter will expand the list to 
show all files referenced in the selected chapter.

File Information
Shows information about the document or chapter selected in the File List. 

List Files of Type
Used to filter display in the Publications list box. The options are: Publications, Chapters, 
Component Files if you have used the Find File command and the last selected chapter or 
publication.

Operations: File
Displays buttons for copying, moving and deleting chapters and whole documents and for 
finding files.
Smart Copy Opens Smart Copy Destination dialog box. Selected publication and all 

its associated graphics, text files and chapters will be copied to the new 
destination.

Smart Move Opens Smart Move Destination dialog box. Selected publication and all 
its associated graphics, text files and chapters will be moved to the new 
destination.

Smart Delete Deletes chapters and publications. Corel VENTURA prompts for delete 
confirmation for each file associated with the selected chapter or 
publication. Text and graphics files are never deleted.

Find Files Opens the Find Files dialog box; enter a specific file name (e.g., 
abook.txt) or file type (e.g., *.txt) with wildcard characters to display 
specific file types.

Operations: Publication
Displays buttons for adding and removing chapters, renumbering documents and saving 
document information to a text file. 
Add Chapter Opens the Open File dialog box. Once a chapter has been selected, it will

be added at the end of the selected publication.
Remove Chapter Disassociates the selected chapter from the current publication.
Renumber Renumbers all numbered items, such as pages, captions, cross 

references, in the selected publication or chapter.
Save Info Saves contents of File Information to an ASCII text file. Opens the Save 

As dialog box, enabling you to name the file.



Re-Scan
Re-scans directories specified in the Scan Directories dialog box.



Smart Copy and Smart Move dialog boxes
Smart Copy

Opens the Smart Copy Destination dialog box. The selected publication and all its 
associated graphics, text files and chapters will be copied to the new destination.

Smart Move
Opens the Smart Move Destination dialog box. The selected publication and all its 
associated graphics, text files and chapters will be moved to the new destination.



How to
· List files in the Publication Manager dialog box
· View and save file information
· Add existing chapters to a publication
· Remove chapters from a publication
· Change the order of chapters in a publication
· Renumber a publication
· Copy and move files, chapters and publications
· Delete files, chapters and publications
· Find files
· Work with dialog boxes



Publication Manager, Scan Directories dialog box
The Publication Manager's Scan Directories feature enables you to change the path and 
drives Corel VENTURA scans when you open the Publication Manager. Change the settings 
and choose rescan to load information about new drives or directories. 
Be sure the path you scan includes all directories or drives containing the Ventura document
files you want to manage. With the exception of the current publication, Corel VENTURA 
scans only for publication files in the specified path.
Note: The Publication Manager temporarily closes your current document to perform its 
work. 

Dialog Box 
Options
Available Drives

Displays all drives available on the system. Double-clicking a drive entry displays a 
cascading list of sub-directories on that drive.

Scan Directories
Displays the current structure of directories which will be scanned when the Publication 
Manager is opened, or when Find Files is used.

Add Selected
Adds a selected directory from the Available Drives list to the Scan Directories list. Note 
that any sub-directories displayed will also be scanned for publications.

Remove Selected
Removes selected directory from the Scan Directories list.

Re-Scan
Begins scanning the specified directory structure.

Close
Closes the Publication Manager.



How to...
· Scan your system for publications and chapters
· Work with dialog boxes



Smart Copy Destination dialog box
The Smart Copy Destination dialog box controls where the publication or chapter will be 
copied during a Smart Copy operation.

Dialog Box 
Options
Source

Displays the publication or chapter file to be copied.
Destination Directories

Specifiy where you want files in the selected publication or chapter copied.
PUB (CHP's) Shows the destination for the publication or chapter file. Clicking the 

checkbox at the end of the text box enables the copy process for the 
publication or chapter. If desired, you can enter a different 
destination for each file type or leave a specific type of file in its 
current location by clearing its checkbox.

Style Sheets Shows the destination for the style sheet(s). Clicking the checkbox at
the end of the text box enables the copy process for the style 
sheet(s). If desired, you can enter a different destination for each file 
type or leave a specific type of file in its current location by clearing 
its checkbox.

Text Files Shows the destination for the text file(s). Clicking the checkbox at the
end of the text box enables the copy process for the text file(s). If 
desired, you can enter a different destination for each file type or 
leave a specific type of file in its current location by clearing its 
checkbox.

Graphic Files Shows the destination for the graphic file(s). Clicking the checkbox at
the end of the text box enables the copy process for the graphic 
file(s). If desired, you can enter a different destination for each file 
type or leave a specific type of file in its current location by clearing 
its checkbox.

Make all directories Takes the selected
the same destination and establishes the same destination for all other files to 

be copied.
Browse Opens the Select Destination Directory dialog box, where you can 

choose an existing drive or directory.



How to...
· Copy and move files, chapters and publications
· Work with dialog boxes



Smart Move Destination dialog box
The Select Copy Destination dialog box controls where the publication or chapter will be 
copied during a Smart Move operation.

Dialog Box 
Options
Source

Displays publication or chapter file to be copied.
Destination Directories:

PUB (CHP's): Shows the destination for the publication of chapter file. Clicking the 
checkbox at the end of the text box enables the copy process for the 
publication or chapter. If desired, you can enter a different 
destination for each file type or leave a specific type of file in its 
current location by clearing its checkbox.

Style Sheets: Shows the destination for the style sheet(s). Clicking the checkbox at
the end of the text box enables the copy process for the style 
sheet(s). If desired, you can enter a different destination for each file 
type or leave a specific type of file in its current location by clearing 
its checkbox.

Text Files: Shows the destination for the text file(s). Clicking the checkbox at the
end of the text box enables the copy process for the text file(s). If 
desired, you can enter a different destination for each file type or 
leave a specific type of file in its current location by clearing its 
checkbox.

Graphic Files: Shows the destination for the graphic file(s). Clicking the checkbox at
the end of the text box enables the copy process for the graphic 
file(s). If desired, you can enter a different destination for each file 
type or leave a specific type of file in its current location by clearing 
its checkbox.

Make all directories Takes the selected
the same: destination and establishes the same destination for all other files to 

be copied.
Browse: Opens the Select Destination Directory dialog box so that you can 

choose an empty drive or directory.
Copy if Shared Creates a copy of the file If the file is currently in use.
Reference if Creates a references
Read Only to the file if it is read only.



Select Destination Directory
This dialog box appears when you click the Browse button in the Smart Move Destination or 
Smart Copy Destination dialog boxes.
It is used to choose a drive and directory where the selected files are to be moved or copied.

Dialog Box 
Options
Directories: Choose the directory where the file is stored.
Drives: Choose the drive where the file is stored.



Ruling Lines dialog box
The Ruling Lines dialog box controls the number of rules, rule thicknesses and colors, rule 
spacing for the current frame or tagged paragraph. It is also used to define the rule above, 
below or around the current frame or tagged paragraph.
The ruling lines attributes are set in the tabs labeled ABOVE, BELOW and AROUND. Each tab 
enables you to set attributes for three different ruling lines (see below). Only one tab 
corresponding to the Rule Style you select in the drop-down list, becomes available. The 
ABOVE & BELOW rule style is the exception. You can toggle between the ABOVE tab and the 
BELOW tab to set attributes for both ruling lines.
The Rule Style drop-down list box is used to select the location of ruling lines and apply them
to the selected frame or paragraph. 

Dialog Box 
Options
Frame/Tag

List labeled TAG when a paragraph is selected, FRAME when a frame is selected. In 
paragraph mode, it determines which paragraph tag is currently being modified. Paragraph
tags cannot be added or deleted from this dialog box. Selecting a different paragraph tag 
from this list will load that paragraph tag's ruling line settings where they can be modified. 
When a frame is selected, this list box is inoperative

Rule Style
Defines the location of the ruling lines. The options are None, Above, Below, Around and 
Above & Below. If None is selected, ruling line attributes can not be set in the tabs; all 
options for controlling thickness, color and spacing are dimmed. If Above, Below or Around 
is selected, only the corresponding tab in the dialog box is available. If Above & Below is 
selected, both the above and below tab can be used to set ruling line attributes.
Note: When adding a new ruling line to a paragraph or frame that has an existing ruling 
line in either the above or below position, choose Above & Below option from the Rule 
Style list. If you do not use this option and choose either Above or Below, the existing 
ruling line is removed. For example, if you have a ruling line above and you want to apply 
a ruling line below, choose Above & Below and add the ruling line below. 

Above, Below, Around Tabs
Note: When a ruling line is applied to a frame, rule 1 appears on the frame's border. Rules 
2 and 3 appear inside the frame. When a ruling line is applied to a paragraph, rule 1 
appears closest to the paragraph and rules 2 and 3 appear outside rule 1.
Rule 1: Enables and defines the thickness and spacing of ruling line 1 for the 

selected frame or paragraph tag. The Spacing text box offset to the top of the
Thickness text box controls the space above rule 1. The Spacing text box 
offset to the bottom of the Thickness text box controls the spacing below rule
1.

Rule 2: Enables and defines the thickness and spacing of ruling line 2 for the 
selected frame or paragraph tag. The Spacing text box offset to the top of the
Thickness text box controls the space above rule 2. The Spacing text box 
offset to the bottom of the Thickness text box controls the spacing below rule
2.

Rule 3: Enables and defines the thickness and spacing of ruling line 3 for the 
selected frame or paragraph tag. The Spacing text box offset to the top of the



Thickness text box controls the space above rule 3. The Spacing text box 
offset to the bottom of the Thickness text box controls the spacing below rule
3.

Nib Icon: Opens the Outline Pen dialog box. The nib icon controls the color of each 
ruling line defined.

Units: Determines the unit of measure used for the ruling line(s) thickness and 
spacing.

Total Rule Displays the current
Thickness:  thickness and spacing of the ruling line(s) associated with the current frame 

or paragraph tag.
Border width

Defines the width of the ruling line(s). For frames the ruling lines are always the width of 
the frame. For paragraphs, the ruling lines can be the width of the frame, margin, column 
or a custom width you enter in the Custom Width box.

Custom Indent
Defines a custom indent from left for the current rule. This option is available only when 
Custom is selected under Border width.

Custom Width
Defines the custom width for the current rule. This option is available only when Custom is 
selected under Border width.

Units
Determines the unit of measure used for the custom indent and custom width of the ruling
line(s).

Preview
Displays a visual representation of the attributes set in the selected tab.



Spell Check dialog box
The Spell Check dialog box controls the search for misspelled words by enabling you to 
select a dictionary, specifying a range and interactively replacing misspelled words with the 
correct version. 

Dialog Box 
Options
Current Range

Displays the range of text currently being spell checked.
Unknown Word

Displays a word that Corel VENTURA has identified as a potential spelling mistake.
Change to

Displays a potential replacement for the spelling mistake. Replacement words can be 
typed directly in this field, or can be selected from the list of suggested words just below it.

Suggested Words
Provides a list of alternative replacement words generated by Corel VENTURA for the 
current unknown word.

Dictionary
Use to specify the personal dictionary to be used for spell-checking.

Add Word
Adds the Unknown Word to the currently selected personal dictionary.

Context
Displays the sentence which has the unknown word.

Range
Expands or collapses the Spell Check dialog box. When it is expanded, the Spell Check 
Range can be defined.

Options
Opens the Spell Check Options dialog box.

Begin Check
Starts spell checking.

Change
Replaces the current instance of the unknown word with the word currently specified in the
Change To text box.

Change All
Replaces all instances of the unknown word with the word currently specified in the 
Change To text box.

Skip
Ignores the current instance of the unknown word, and continue spell checking.

Skip All



Ignores all instances of the unknown word, and continue spell checking.
Spell Check Range

Specify whether you want to check the entire chapter or certain parts only.
Entire Chapter: Select to spell check all text elements in the entire chapter.
Captions: Select to spell check only caption files in the current chapter.
Untitled Elements: Select to spell check only those text elements keyed into Corel 

VENTURA frames or box text.
Selected Text: Select to spell check only the text that was highlighted before the Spell 

Check dialog box was opened.
Modified Files: Select to spell check only those text files in the chapter which were 

modified since the last session.
Selected Files: Select to spell check text files selected from the neighboring Files list.



Rename Paragraph Tag dialog box
The Rename Paragraph Tag dialog box is used to rename selected paragraph tags.

Dialog Box 
Options
From

List used to select existing tag to rename.
To

Text box where the new tag name is entered.



Add New Frame Tag dialog box
The Add New Frame Tag dialog box controls frame tag creation and settings.

Dialog Box 
Options
Tag Name

Text box where the new frame tag name is entered.
Copy Attributes From

List used to select an existing frame tag whose attributes can be used as a starting point 
for the new tag.



Rename Frame Tag dialog box
The Rename Frame Tag dialog box is used to rename selected frame tags.

Dialog Box 
Options
From

List used to select existing frame tag to rename.
To

Text box where the new frame tag name is entered.



Delete Frame Tag dialog box
The Delete Frame Tag dialog box is used to delete selected frame tags.

Dialog Box 
Options
Delete

List used to select existing frame tag to delete.
Reformat Frame as

List used to select existing frame tag to which tagged paragraphs can be transferred.



Table Settings, General dialog box
The General dialog box controls the number of rows and columns, column widths and default
border for the selected table.

Dialog Box 
Options
Row & Columns

Specify the number of rows and columns in the table and whether breaks are permitted 
within the table.
Rows Type or select the number of rows you want in the table.
Columns Type or select the number of columns you want in the table.
Auto-Flow Table When enabled and the number of header rows is defined, the header 

rows will be repeated across pages when a natural or forced page 
break occurs.

Header Rows Text box where the number of header rows can be entered or 
selected by scrolling with the arrows.

Table Border
Select the style of ruling lines (if any) to apply to the table.
Around Border Defines the default border around the entire table.
Horizontal Rules Defines the default border for all horizontal rules.
Vertical Rules Defines the default border for all vertical rules.

Column Widths
Specify the width of columns in the table.
Column Number Type or select the number of the column you want to adjust.
Fixed Select to define a fixed column width for the selected column. When 

this option is selected a fixed column width is entered in the Column 
Width box just below.

Proportional Select to define a proportional column width for the selected column.
When this option is selected, the Column Width box is no longer 
available.

Column Width Text box used to define a fixed column width for the selected column.
Units Determines the unit of measure used for the fixed column width.



Table Settings, Positioning dialog box
The Positioning dialog box controls spacing, alignment and justification settings for the 
selected table.

Dialog Box 
Options
Table Spacing

Above Defines the space above the selected table.
Below Defines the space below the selected table.
Units Determines the unit of measure used for the space above and below 

the selected table.
Cell Spacing

Inter-Row Defines the space between rows in the selected table.
Inter-Column Defines the space between columns in the selected table.

Vertical Justification
At Top Defines the maximum amount of space to be used at the top of the 

table when vertical justification is incurred.
At Bottom Defines the maximum amount of space to be used at the bottom of 

the table when vertical justification is incurred.
Alignment & Indent

Left Select to align the left edge of the selected table to the left of the 
column frame.

Center Select to center the selected table in the column frame.
Right Select to align the right edge of the selected table to the right of the 

column frame.
Indent Defines the table indent from the left edge of the frame. This option 

is available only when the left alignment option is enabled.
Units Determines the unit of measure used for the table indent.
Custom Width Select to define a custom table width.
Custom Width Box Select to define the overall width of the selected table. This option is 

available only when Custom Width is enabled.



How to...
· Set the width and position of a table
· Work with dialog boxes



Table Settings, Cell Borders dialog box
The Cell Borders dialog box is used to define the borders that can be applied to tables.

Dialog Box 
Options
Rule Settings

Specify the number of rules in the border and the attributes (thickness, spacing    color etc)
of the rules. When a ruling line is applied to a cell, rule 1 appears on the cell's edge. Rules 
2 and 3 appear inside the cell.
Rule 1: Enables and defines the thickness and spacing of ruling line 1 for the 

selected cell(s). The Spacing text box offset to the top of the 
Thickness text box controls the space above rule 1. The Spacing text 
box offset to the bottom of the Thickness text box controls the 
spacing below rule 1.

Rule 2: Enables and defines the thickness and spacing of ruling line 2 for the 
selected cell(s).The Spacing text box offset to the top of the 
Thickness text box controls the space above rule 2. The Spacing text 
box offset to the bottom of the Thickness text box controls the 
spacing below rule 2.

Rule 3: Enables and defines the thickness and spacing of ruling line 3 for the 
selected cell(s). The Spacing text box offset to the top of the 
Thickness text box controls the space above rule 3. The Spacing text 
box offset to the bottom of the Thickness text box controls the 
spacing below rule 3.

Opens the Outline Pen dialog box. The nib icon controls the color of each ruling line 
defined.
Units: Determines the unit of measure used for the ruling line(s) thickness and spacing.

Total Rule 
Thickness: Displays the current thickness and spacing of the ruling line(s) 

associated with the current cell(s).
Border Tag

Lists all of the ruling styles which can be applied to border cells. Additional tags can be 
added to the list by + button. Border tags are removed by selecting the border tag from 
the list and clicking the - button.



How to...
· Apply color to cells
· Work with dialog boxes



Variable Definitions dialog box
The Variable Definition dialog box provides a list of all existing variable markers. Variable 
markers can be renamed or deleted globally, as well as added, from this dialog box. This 
dialog box is also used to substitute the variable's current definition throughout the entire 
publication.

Dialog Box 
Options
Variable Marker

Displays the currently selected variable marker from the list. New marker names can also 
be entered in this field.

Variable Marker List
Provides a list of all variable marker names currently defined in the publication.

Substitution Text
Defines the substitution text associated with the selected marker.

Add
Adds a new variable marker definition to the publication when a new name is entered in 
the Variable Marker field.

Rename
Renames the selected variable marker throughout the publication.

Renumber
Updates all variable definitions throughout the publication, replacing all existing 
substitution text with the most current definitions.



Insert Variable Marker dialog box
The Insert Variable Marker dialog is used to insert variable markers in the text. It is also used
to rename existing variable markers.

Dialog Box 
Options
Name

Text box used to select an existing marker name or enter a new name to create a new 
variable marker.



System Color Profile dialog box
Color Manager creates a System Color Profile by learning about your monitor, scanner and 
printers. The profiles help to accurately capture, display and print color across different 
devices.
This System Color Profile helps ensure:

· colors that you view on your monitor closely resemble the colors that your printer can 
print

· the images and colors that you include in your documents will be accurately described 
to your printer

· colors from your scanner are adjusted to accurately reflect the colors of the image 
being scanned

Note: The defaults built into the Color Manager are pre-tested settings; use them whenever 
possible.

Dialog Box Options
Current Profile

Displays the name of the current color profile. If you have different printers, you may wish 
to build different color profiles and then select the appropriate one before working on 
documents for that output device.

Notes
Enables you to attach notes to your system profile. Useful for keeping track of different 
equipment setups.

Monitor
Displays monitor choices. See Monitor Calibration

Printer
Displays printer choices. See Printer Calibration.

Scanner
Displays scanner choices. See Scanner Calibration.

Automatch
Enables the two different color gamut mapping systems, Illustration and Photographic. 
Corel VENTURA automatically senses whether it is printing a vector or bitmapped object 
and applies the appropriate gamut map.

Photographic
Enables the Photographic color mapping only. Use to force Photographic color mapping 
regardless of object type.

Illustration
Enables Colorimetric color mapping for working with spot colors. Use to force colorimetric 
color mapping regardless of object type.

See also:
More about Color Manager





Monitor Calibration dialog box
Enables you to calibrate your monitor to enhance color accuracy.
Monitor Characteristics

Defines the monitor gamma settings. As you increase the gamma level you are increasing 
the brightness of your midtone gray levels. Chromaticity defines hue and saturation or 
chroma. It's important to use the manufacturer recommended levels of chromaticity for 
your monitor. If you do not have manufacturer recommended levels and wish to modify 
gamma or chromaticity settings use Interactive Monitor Calibration.

White Point Reset
Defines the color temperature of your monitor in creating white. Returns the gamma and 
chromaticity values to default.

Interactive Calibration
Interactive calibration lets you adjust gamma, white point and chromaticity interactively. 
Adjust the color fields to enhance color accuracy. Chromaticity should be set to the 
manufacturer's specifications. Gamma or brightness is variable according to the level of 
light in the room and the brightness and contrast controls on your monitor. White point 
temperature for an individual monitor will have a factory default but monitors can vary 
from their default. 



How to...
· Calibrate your monitor numerically
· Calibrate your monitor interactively



Printer Calibration dialog box
This dialog box enables you to calibrate your printer to enhance color accuracy.

Dialog Box Options
Printer Type

Defines whether the printer prints using four colors (CMYK) or three (RGB).
UCR

Choose Film or Printer, depending on the output device you are configuring. TAC (Total Ink 
Coverage) adjusts the level of UCR. See your printer for the appropriate level of UCR. (It 
depends on paper stock and the printer used.)

Dot Gain
Enter a Dot Gain value in this box. See also Setting Dot Gain

Ink model
Defines the ink model for the selected printer.

Color Match
Displays the Printer Characterization dialog box enabling you to match your printer and 
monitor color accuracy. Matching establishes a normalized color relationship between your 
device and the CIE-based reference Color System. This characterization may be based on 
spectro-photometric measurements (File) or visual methods (Visual).
Color Matching: Calibrate Monitor--If you
Visual haven't already done so, click calibrate your monitor before 

continuing with your Color Match. 
Reset Color--returns Hue, Saturation and Brightness to the default 
values.
Print Testing Patterns--print these patterns to match the View field in 
the Printer Characterization dialog box.

Color Matching: Print Testing Patterns--Print
File: these patterns and measure the CIE X Y Z values in order to create a 

new RHN file. In the dialog box that appears, choose an RHN that 
matches your output device or choose a new RHN that you have 
built. 
For GCR, UCR, Black Point, Dot Gain and other prepress definitions, 
see Prepress Definitions.

Print CMYK Pattern
Displays another dialog box so that lyou can generate a test file to be measured to create 
a new Ink Model.

Calculate
Updates the calibration changes you have made before you go to Color Match.

Reset
Returns your values to the defaults.



How to
· Calibrate your printer: General notes
· Calibrate your CMYK printer
· Calibrate your RGB printer
· Characterize your printer using a Color Match file
· Characterize your printer using the visual method



Scanner Calibration dialog box
Enables you to calibrate the color accuracy of the systems scanner.
Scanned Target

File
Enables you to choose a pre-tested scanner setting. 

Image
Enables you to build a specific named scanner profile based on the characteristics of your 
printer.

Scanned target
Your scan of the Corel Scanned Target reference card included with Corel VENTURA. 

Reference file
This reference file is included with Corel VENTURA. Color Manager compares this file 
against your scanned target to create a scanner profile.

Scanned target
Enables you to adjust for any skew or misalignment of your scan of the target. This 
ensures that the scanner profile compares the same areas of the reference file and your 
scanned target.

Shortcut:
Pressing ALT+F, C opens the System Color Profile dialog box.



How to...
· Calibrate your scanner from a file
· Calibrate your scanner from an image



More about Color Manager
Color Manager is a sophisticated color management system that provides three levels of 
color _support.
Calibration

Color Manager creates a linearized standard against which it can calibrate image 
acquisition, viewing and reproduction devices. These devices include scanners, monitors, 
hard copy printers, film recorders and image setters.

Characterization
Characterization establishes a normalized color relationship between your device and the 
CIE based reference Color System. This characterization may be based on spectro-
photometric measurements or visual methods.

Gamut Mapping
Gamut Mapping provides a method of mapping colors to and from different devices. 
Gamut mapping enhances the accuracy of colors displayed on your monitor and the color 
and tonal ranges printed by your output device. Corel VENTURA uses two types of color 
mapping: Colorimetric for illustrations and Photographic for photographs. 
In Corel VENTURA, gamut mapping is applied automatically according to the image. If 
Corel VENTURA is printing a vector-based image, it applies colorimetric gamut mapping. If 
Corel VENTURA is printing a photograph it will automatically use Photographic gamut 
mapping. Even if both types of images are on the same page, Corel VENTURA will use the 
gamut mapping appropriate for that image.



Print Setup dialog box
Chooses the printer and printer options for printing your publication.

Dialog Box Options
Printer

Selects the default printer or a printer listed in the box under Specific Printer. Only 
installed printers appear in the list. You install printers through the Windows Control Panel.

Orientation
Selects orientation of the printer page. Choose an orientation that matches the orientation 
specified for your publication with the Page Setup command.

Paper
Selects paper size and source. Click on the arrows on the right of the Size and Source 
boxes to see a list of options you can choose.

Options
Displays a dialog box where you can choose default options for the printer you select. For 
more information, choose the Help button after you choose the Options button.
Note: Before you print a final print file, or send a print file to an output bureau for film or 
direct imaging, make sure that you choose the correct System Color Profile with Color 
Manager for the output device chosen.



Print dialog box
The Print dialog box prints the current publication according to the options you specify. See 
also Print Publication command
Note: Before you make a final print file or send a print file to an output bureau for film or 
direct imaging, make sure that you chose the appropriate System Color Profile in the Color 
Manager for the output device chosen.

Dialog Box Options

Print Range
Check Publication to print all pages in a multi-page document. Choose Current Chapter to 
print the chapter currently displayed.
Choose Current Page to print the currently displayed page.
Specify the range of Pages in the current chapter to be printed, for example, 1-3, 5,7, 9-12 
would print pages 1, 2, 3, 5, 7, 9, 10,11 and 12. Inserting a tilde (~) between two numbers 
means that every other page prints as well as the two selected pages. 1~6 would print 
pages 1, 3, 5 and 6.
To print odd pages, enter 1~. To print even pages, enter 2~.

Printer
Shows the active printer. If other printers are installed, choose the one you want to use 
from the list.
You can also choose installed printers with the Print Setup command in the File menu.

Printer Quality
Choose a resolution depending on the printer chosen. Resolution is measured in dots per 
inch (dpi). 

Printer Color Profile
Displays the current Color Profile. 

Print to File
Creates a file that can be printed from DOS. Commonly used to print files from systems 
which do not have Corel VENTURA installed or when sending files to a service bureau for 
high-resolution printing. When you click OK, a dialog box opens, prompting you to type a 
filename. See Print to File dialog box.
For Mac: When printing to file, select this option if you are printing on a device controlled 
by a Macintosh computer. Available only with Print to File checked (PostScript printers 
only).

Setup
Enables you to select specific printer options such as paper size, orientation, paper source,
that are unique to the printer selected. See also, Windows Control Panel Help, Printers. See
also Print Setup command.

Options
Opens the Print Options dialog box for more advanced options for controlling the way a 
publication prints. See Print Options--Layout dialog box, Print Options--Separations dialog 
box, and Print Options--Options dialog box.



Copies
Prints multiple copies of the current publication. You can print as many as 999 copies.

Shortcut:
Pressing CTRL+P opens the Print dialog box
Click  on the Ribbon Bar to open the Print dialog box.



Print Options dialog box 
The Print Options dialog box contains advanced options for controlling the way a publication 
prints.

Dialog Box Options

Page Window
Shows how a publication will look when printed. The bounding box surrounding the preview
image shows the area within which the selected printer is capable of printing. Resize the 
image or change its position on the page by specifying values in the Position and Size 
boxes.
Rulers enable to you judge the relative size and placement of the image. Change the 
rulers' units by clicking on the Units box and selecting a new unit from the list.
Note: Changing the publication's size and position does not affect the publication file, only
how it is printed.

See also:
Print Options--Layout dialog box
Print Options--Separations dialog box
Print Options--Options dialog box



How to...
· Position the document before printing
· Size the document before printing
· Print documents larger than the printer's paper size
· Print color separations
· Print Spot colors as separations
· Work with dialog boxes



Print Options--Layout dialog box 
Enables you to set the size at which the publication prints and its position on the printed 
page.

Dialog Box Options

Position and Size
Changing the publication's size and position does not affect the publication file, only how it
is printed.
Top, Left: Adjusts the position of publication on page. The value in the Left box 

represents the location of the top left corner of the publication. The 
Top value represents the location of the top of the publication.

Width, Height: Adjusts the size of the image. When the value in one box is changed, 
the value in the other changes proportionately to maintain the 
publication's aspect ratio.

Center: Centers publication on the page.
Fit to Page: Reduces or enlarges the publication to fit on the size of paper in the 

printer. Use this option to proof large publications that exceed the 
printer's maximum paper size.

Maintain Aspect: Resizes the publication when it is printed. Values below 100 shrink 
the publication; values above 100 enlarge it. Useful for proofing very 
small or very large publications. Use this option with the Tile option 
to print a single page publication as a large poster.

Print Tile Pages: Prints parts of publication outside the Printable Page on additional 
pages. Use this option if you are also using the Maintain Aspect 
option to print your publication at a size larger than the printer's 
paper size.

Layout Style
Lets you adjust the size and position of a publication to reflect different printing needs. For 
example, if you are printing a chart that you want to fit to a three-column format to which 
you will later add text, you would adjust the columns and rows here to resize the chart to 
print on one column.

Rows
Sets the number of vertical rows on the printable page.

Columns
Specifies the number of horizontal columns on the printable page.

Gutter Width
Sets the size of the gutter between Columns and Rows.

Clone Frame
Clones the frame. If you are printing a business card, for example, and set up multiple 
rows and columns, clicking Clone Frame will place a clone of the frame into each of the 
other frames defined by your Columns and Rows setting. Be careful not to scale your 
image with a frame setting that is too small.

Preview Image
Displays the current publication in the "page" window.



Printers' References
Located under the Preview Image area, the Printers' references are represented by a row 
of buttons. Use these references to add standard printers' marks and file information to 
your publication.

Note: For references to appear, the size of the Page (as set in the Chapter Settings, Layout 
dialog box) must be smaller than the size of the page you are printing on. Many 
imagesetters have an "extra" page setting ("letter extra" is 9.5x12, for example) which 
allows for crop marks and file information.

See also:
Print Options dialog box
Print Options--Separations dialog box
Print Options--Options dialog box



How to...
· Position the document before printing
· Size the document before printing
· Print documents larger than the printer's paper size
· Work with dialog boxes



Print Options--Separations dialog box
Use to prepare a publication for color separation. 

Dialog Box Options
Print Separations

When checked, prints the color information of your publication in grayscale separations. 
Usually, these are the four process colors (cyan, magenta, yellow and black) and any spot 
colors used in the publication. Click the colors you want to separate.

In Color
When checked, prints the separations in color rather than grayscale. This option is 
available if you are printing to a color printer or to file. Printing on transparencies with this 
option enabled allows you to check any trap you've applied to objects in your publication.

Convert Spot to CMYK
Converts spot colors in the publication to their process color equivalents.
Note: Converted color appears the same on screen but may not match Spot color exactly 
when printed.

Use Custom Halftone
Choose this option to specify halftone screen angles and line frequencies for each of the 
CMYK colors. If unchecked, your publication prints using Corel's default angle and 
frequency.

Edit
Clicking the Edit button opens the Advanced Screening dialog box. Control screening 
technology, output resolution, line screen, screen angles and frequencies for the four 
Process colors. Set halftone screen type. The look-up table in the CORELPRN.INI file defines 
the default screen frequency and angle for different resolution devices.
Unless you specify a different screen angle in the PostScript Options dialog box, objects 
with Spot colors print using the screen angle specified for Black.

Colors
Lists four process colors (cyan, magenta, yellow and black) and any spot colors used in the
publication. Click to choose the colors to separate.

Auto Trapping
Adds trap to certain objects in your publication. 
Note: Autotrapping creates spreads, not chokes. If you are experienced with trapping, use 
Corel VENTURA's overprinting feature to create a trap with more accurate results. 
Always Overprint Adds trap to any
Black  object that contains 95 percent black if necessary. Change this value

by editing the PSOverprintBlackLimit in the CORELPRN.INI file.
Auto-Spreading Adds trap to all objects which meet three conditions: they have no 

outline, they are filled with a uniform color and they have not already
been designated to overprint with the Overprint Fill command in the 
Object menu.
In the Maximum box, specify the maximum amount of trap you want 
to add. Actual amount added depends on the object's color: the 



lighter the color, the greater the percentage of the maximum value 
Corel VENTURA adds.
If Always Overprint Black is also checked, black overprinting will 
occur even if the object does not meet the three conditions for auto-
trapping.

Preview Image
Displays the current publication in the "page" window.

Printers' References
Located under the Preview Image area, the printers' references are represented by a row 
of buttons. Use these references to add standard printers' marks and file information to 
your publication.

Note: For references to appear, the size of the Page (as set in the Chapter Settings, Layout 
dialog box) must be smaller than the size of the page you are printing on. Many 
imagesetters have an "extra" page setting ("letter extra" is 9.5x12, for example) which 
allows for crop marks and file information.

See also:
Print Options dialog box
Print Options--Layout dialog box
Print Options--Options dialog box



How to...
· Print color separations
· Print Spot colors as separations
· Work with dialog boxes



Print Options--Options dialog box
Use to specify additional settings for printed files.

Dialog Box Options

Screen Frequency
Determines the halftone screen frequency used to print your publication. Unless you 
specified a new halftone screen in the    PostScript Options dialog box, objects will print 
using the screen frequency selected here.
If you are printing color separations, adjust the screen frequency of each CMYK color in the
Separations dialog box in the Use Custom Halftone option.

Fountain Steps
Determines the number of stripes or bands printers use to render a fountain fill. Values 
higher than 40 produce a smooth fountain, but take longer to print. Even higher values 
may be necessary to create large fountain fills.
When printing to a high-resolution output device, you may need to use fountain fill values 
over two hundred steps to avoid banding when creating larger fountain fills. These types of
fills may be too complex for some older high-resolution output devices. Check with your 
service bureau to be sure they can handle more complex fountain fills.
Note: The Steps setting in the Fountain Fill dialog box overrides the settings in this dialog 
box and in the Preferences dialog box.

Acrobat  and Acrobat Notes

Creates a PostScript file for conversion into an Adobe Acrobat PDF file. If your VENTURA 
document contains hidden text which you want to appear in the PDF file, select Acrobat 
Notes. See also Corel VENTURA User's Guide, Appendix B

Preview Image
Displays the current publication in the "page" window.

Printers' references
Located under the Preview Image area, the printers' references are represented by a row 
of buttons. Use these references to add standard printers' marks and file information to 
your publication.

Note: For references to appear, the size of the Page (as set in the Chapter Settings, Layout 
dialog box) must be smaller than the size of the page you are printing on. Many 
imagesetters have an "extra" page setting ("letter extra" is 9.5x12, for example) which 
allows for crop marks and file information.

See also:
Print Options dialog box
Print Options--Separations dialog box
Print Options--Layout dialog box



How to...
· Specify the number of stripes used to print fountain fills
· Work with dialog boxes



Paste Special dialog box
Inserts information from the Clipboard into your document. You can specify the format the 
information will be in and, optionally,    create a link to the source file.

Dialog Box Options
Source

Displays the name and location of the source file providing the information on the 
clipboard.

Paste
Inserts the contents of the CIipboard into the document without creating a link to the 
source file.

Paste Link
Inserts the contents of the Clipboard and creates a link to the source file. The Paste Link 
option is only available if the Clipboard contents came from an application which can link 
information to Corel VENTURA.

As
Lists formats in which the information can be pasted.



Insert Object dialog box
Inserts a linked or embedded object such as a chart, graphic or spreadsheet data created in 
another application. Also lets you insert the contents of another file as an embedded or 
linked object.

Dialog Box Options
Create New

Select to embed a new object from another application. Choose the application you want 
to use to create the object from the Object Type List. Click OK to open the selected 
application.

Create from File
Select this option to embed or link the contents of an existing file.
File Type the name, including the path and extension, of the file you want to embed or 

link. If you don't know the name of the file or its location, click the Browse button to
display the Browse dialog box.

Link Select this option to link the file.

See also:
Exchanging information with other applications--Overview



Convert dialog box
This dialog box enables you to convert or emulate OLE objects that appear in Corel VENTURA
documents as other types of objects. This is particularly useful when you want to edit an OLE
object that was created, perhaps by someone else, in an application which is not installed on
your system. 
This dialog box appears when you select an embedded object or linked object and choose 
the Object command from the Edit menu and then the Convert command from the flyout . 

Dialog Box Options
Current Type

Shows the format in which the selected OLE object is currently saved.
Object Type

Lists the formats available for conversion or emulation.
Convert to

Choose to select the conversion operation. When chosen, the OLE object is converted to 
the selected format. It is therefore registered as if it was created in the application 
corresponding to the format you select. The original OLE server application in which the 
object was created will probably not recognize this object anymore. If you need to edit an 
OLE object that was created in an OLE application you do not have installed on your 
system, and you know that eventually it will also be edited in its original OLE server 
application (by a colleague for example, the Activate as option described below is 
preferable to a conversion.

Activate as
Click to create emulation of an OLE object in a different file format than the one created by
the original server application in which it was created. When this option is selected, you 
may edit the object in another application but the object will not be converted. The OLE 
server in which it was created will still recognize the object.

Display As Icon
Used to show the OLE object by the server application icon in the Corel VENTURA 
document. Icons may be less complex than the actual OLE object and this can speed up 
the redraw of the page while you are editing the document. When you check this box, the 
Change Icon button appears. Clicking it opens the Change Icon dialog box.



Change Icon dialog box
Enables you to select an icon to be used to display the selected OLE object in the current 
Corel VENTURA document. 

Dialog Box Options
Icon

Current Displays the currently used icon.
Default Displays the icon used by default to represent the OLE object file type. Check 

the radio button to enable the default icon.
From File Displays other icons available in the current directory listed above the preview

window. Use the horizontal scroll bar to see all icons available. Click the icon 
of your choice to select it and click the From File radio button to use that icon 
instead of the OLE object. 
To change the directory, click Browse and choose the appropriate drive and 
directory from the Browse dialog box.

Label
Text box for typing a label which will appear below the selected icon. 



Links dialog box
Lists all the links in the current file. This list includes internal links to other Corel VENTURA 
files and external links to other Windows applications, such as CorelCHART.

Dialog Box Options
Link

Lists the links in your file along with the type of object and the update method (manual or 
automatic).

Source
Shows the file name and directory of the selected linked information.

Type
Shows the file type of the select linked information and the server application, if available.

Update
Specifies the type of link you want for the links selected in the Links box.
Automatic: Revises your file whenever a change is made to the linked object.
Manual: Revises your file when you choose the Update Now button.

Update Now
Updates the selected links and closes the dialog box.

Open Source
Opens the application in which the linked object originated. For example, if your file 
contained a CorelCHART graph, CorelCHART would open with the graph displayed, enabling
you to edit the information. See also Editing CorelDRAW 3 and 4 OLE objects in Corel 
VENTURA 5 documents

Change Source
Displays the Change Source dialog box, which lets you change the selected link to receive 
an object from another application and/or file, or a different object altogether.
Note: If the new linked file is significantly different from the original file, you may 
drastically alter the appearance of your document.

Break Link
Breaks the selected links so that there is no longer a connection between the Corel 
VENTURA file and the source file. The object is then an embedded object.



Chapter Settings, Layout dialog box
The    Layout dialog box changes the size of the paper, orientation, fold type, style sheet(s), 
which side the chapter starts on and whether it is single sided or double sided.

Dialog Box Options
Page Size

This section of the dialog box determines the page size, orientation and layout. The 
maximum page size is 27.3 x 27.3 inches. If you set the page size to the maximum, you 
cannot have graphics or text running over (bleeding) the edges of the page.
Portrait Click the Portrait radio button to orient the paper vertically.
Landscape Click the Landscape radio button to orient the paper horizontally.
Size drop-down Choose a paper
list box  size from the drop-down list box.
Width/Height Enter a value in the Width and Height boxes to create a custom paper 

size.
Choose the units of measurement from the drop-down list box.

Layout Choose a fold type from the drop-down list box. Fold determines the 
way in which the text is printed on the page to allow for folding after 
the page is printed.

Sides
Check either Single or Double to specify whether the pages in the chapter are double sided
or single sided. The format you've chosen will determine whether you will have to define a 
page layout (headers/footers, margins, etc.) for both the left and right sides of the page or 
just for a single side. Once you've determined the format, select which side the chapter 
will start on, left or right.

Start On
Check either Right Side or Left Side to determine which side the chapter starts on. 



Chapter Settings, Footnotes dialog box
The Footnotes dialog box enables you to define the format of footnotes in the current 
chapter. Choose Enable Footnotes from the Layout menu to display footnotes.

Dialog Box 
Options
Numerical

Defines numerical footnotes. 
Custom

Defines custom footnotes.
Off

Enables and disables the footnotes feature.
Footnote

Footnote #: Determines which footnote is assigned the reference displayed in the 
Reference box. 

Reference: Defines the footnote symbol that appears in the text of the document. If 
Numerical is selected, sequential numbers are displayed in the 
Reference box. If Custom is selected, each footnote must be defined. For 
example, for the first footnote, enter a "*", for the second, enter "%", and
so on.

Template: Defines text that always appears before and/or after every footnote 
number. Enter the text in box. The footnote number must be entered as 
well. It is represented by "#". For example, entering (#) puts 
parentheses around each footnote number.

Position: Positions the footnote references in the text. The options are: 
superscript, subscript and normal.

Separator
Add 
Separator Line Adds a line that separates the footnote text from the main body.
Space Above Determines the amount of space between the separator line and the text

of the first footnote.
Thickness: Determines the thickness of the separator line.
Line Width: Determines the width of the separator line. The box below determines 

the units of measurement, e.g., points, inches.
Options
Start with 
Footnote #: Determines the first footnote reference to be used. Only whole positive 

numbers can be entered.
Restart On: Resets the footnote numbering. The options are: Each Page, Each 

Chapter.



How to...
· Specify footnote settings
· Display, insert and edit footnotes
· Work with dialog boxes



Chapter Settings, Numbering dialog box
The Numbering dialog box sets the counters for the chapter, pages, figures and tables and 
sets automatic paragraph numbering.

Dialog Box 
Options
Counters

Preview: Displays the current settings.
Chapter Counter: Select to set initial chapter counters using Continue From 

Previous Chapter, Starting Number and Number Style. 
Initial Page Counter: Select to set initial page counters using Continue From Previous 

Chapter, Starting Number and Number Style. 
Initial Figure Counter:Select to set initial figure counters using Continue From Previous 

Chapter, Starting Number and Number Style. 
Initial Table Counter: Select to set initial table counters using Continue From Previous 

Chapter, Starting Number and Number Style. 
Continue from Continues the counting from
previous chapter:  the previous chapter if selected. The initial counter is set to the 

last counter in the previous chapter + 1 with the same format. 
Starting Number and Number Style can be modified for each 
chapter.

Starting Number Enter the start number for the chapter.
Number Style Choose a number style from the Number Style drop-down list box.

Automatic Paragraph Numbering
Preview Displays the current settings for automatic numbering.
Automatic Paragraph Enables and disables the
Numbering On: paragraph numbering feature.

Note: Only paragraphs on the base page can be auto-numbered. 
If auto-numbering is turned off, a previously auto-numbered 
paragraph may print on top of the paragraph preceding it. To 
correct the problem, select the preceding paragraph. Then, 
choose Breaks from the Format menu and set Line Break to After.

# of Levels: Enter a number or use the scroll arrows to choose the number of 
levels.

Level: Enter a number or use the scroll arrows to choose a level for 
editing.

Paragraph Type: Choose a paragraph tag from the drop-down list box. The level 
selected in the Level box applies to the paragraph tag selected in 
Paragraph Type.

Number Style: Choose a number style from the drop-down list box. The options 
are: 
1, 2, 3
A, B, C
a, b, c 
I, II, III, IV
i, ii, iii iv



Initial #: Choose a starting number if you want a number other than one.
Additional Text: Enter any text you want to appear before and/or after the 

automatic number (e.g., the word "Step" before numbered 
instructions). The automatic number is represented by a pound 
sign (#). Attributes of the text can be edited. Highlight the text 
using the mouse and click the Text Attributes button. The Text 
Attributes dialog box opens. Change font, size, color and 
character style.

Suppress Preceding Suppresses the 
Level Numbers: preceding levels. Check to enable.
Text Attributes: Opens the Text Attributes dialog box. This button works in 

conjunction with Additional Text. Highlighted text in the Additional
Text field can be edited with the Text Attributes dialog box.

Paragraph Settings: Opens the Paragraph Settings dialog box. You can define the 
format of the current section style.

NOTE: Because 



How to...
· Add numbering
· Work with dialog boxes



Chapter Settings, Typography dialog box
The Typography section of the Chapter Settings dialog box sets the following: Widows and 
Orphans, First Baseline, Column Balance, Pair Kerning and Vertical Justification.

Dialog Box 
Options
Widows

Enter the number of lines for widow lines.
Orphans

Enter the number of lines for orphan lines.
First Baseline

Determines the location of the first line of text on a frame or page. The options are: cap 
height and inter-line.

Only use Discretionary Hyphens
Select this option to have Corel VENTURA use only discretionary hyphens in your document
when automatic hyphenation is turned on (Paragraph Settings, Typography dialog box). 
Note: Corel VENTURA 5.0 saves your discretionary-hyphen settings in each style sheet. 
The default style sheet has hyphenation turned on.

Column Balance
Determines text distribution from column to column. Options are: On, Off and Default. 
Turning Column Balance On will distribute text evenly across every column.

Pair Kerning
When checked, space between all letters in a paragraph is automatically adjusted.

Within Frame
Adjusts vertical justification in the frame. The options are: feathering and carding.

Maximum Justification
Enter a percentage. Uses the Maximum at Top and Maximum at Bottom for the paragraphs
plus the percentage to determine the maximum justification.

Around Frame
Determines the vertical justification around the frame. There are two options: Moveable 
and Fixed. Moveable moves the frame down to create space above. Fixed cause the frame 
to remain in position and adds space below.

Maximum at Top
Sets the maximum amount of space between text and frame at the top.

Maximum at Bottom
Sets the maximum amount of space between text and frame at the bottom.



How to...
· Set typography
· Work with dialog boxes



Paragraph Settings, Character dialog box
Enables you to set typeface, or font, specifications for the selected paragraph.

Dialog Box 
Options
Paragraph Text

Click to modify settings for the selected paragraph.
Drop Cap

Click to modify font settings for the drop cap character only for the selected paragraph.
Bullet Character

Click to choose from a list of bullet characters for the selected paragraph.
Font

Used to select typeface for the selected paragraph.
Style

Used to select special effects, such as bolding and italics for the font.
Size

Used to define the type size for the selected paragraph.
Units

Defines the units of measure used for the font.
Color

Determines the color of the font for the selected paragraph.
Overprint

If enabled, the text, drop cap or bullet character is printed over the background. If 
disabled, they are printed as knockout.

Ruling Lines
Invokes the Ruling Lines dialog box. Ruling lines can be applied above, below or around the
selected paragraph.

Apply Effect
Used to define the selected paragraph as a drop cap or bulleted paragraph.

Attributes
Underline: Used to underline the text in the selected paragraph.
Double Underline: Used to double underline the text in the selected paragraph.
Overscore: Used to overscore the text in the selected paragraph.
Strike-thru: Used to strike through the text in the selected paragraph.

Sample
Shows text you type in the text box in the select font and style. Displays only when the 
settings for paragraph text are being modified.

Drop Cap



Displays only when the settings for the drop cap are being modified.
Custom 
Spacing: Used to define custom spacing for the drop cap character.
Lines: Determines the number of lines of spacing the custom drop cap should use.
Shift Up: Determines the vertical shift the drop cap character will take within the 

allocated space.
Units: Defines the units of measure used for the drop cap settings.
Bullet
Displays only when the settings for the bullet character are being modified.
Bullet 
Character: Defines the ANSI bullet character for the selected paragraph. Either select 

the character from the list box or type its ANSI code by holding down the Alt 
key and typing the code using the numeric keypad. (The codes are listed in 
Appendix A in the Corel VENTURA User's Guide.)

Indent: Defines the indent between the bullet character and the paragraph text.
Shift Up: Determines the vertical shift of the bullet character.
Units: Defines the units of measure used for the bullet settings.

Tag Name
Shows the name of the paragraph tag being modified.



How to...
· Add paragraph tags
· Apply formatting changes to paragraph tags
· Apply overrides
· Work with dialog boxes



Paragraph Settings, Alignment dialog box
This dialog box enables you to set the alignment and tab parameters for the selected 
paragraph tag.

Dialog Box 
Options
Text Alignment

Vertical: Determines the vertical alignment of the tagged paragraph within a 
frame. The options are: Top, Middle and Bottom.

Horizontal 
Alignment: Determines the horizontal alignment of the tagged paragraph within 

a frame, column or page. The options are: Left, Center, Right, 
Justified, Forced and Decimal.
Note: If you choose Justified text, you cannot use tabs.

Frame Wide Text: Select have the paragraph extend the width of the frame as opposed 
to its column.

In From Right: Determines the right indentation of decimal alignment on 
paragraphs.

Units: Determines the units of measure used for the Decimal option.
Breaks: Displays the Breaks dialog box. The Breaks dialog box is used to 

define breaks settings for the paragraph tag.
Alignment 
Character: Defines the ANSI character where decimal tabs and decimal 

alignment will occur.
Default Tab Every

Defines equally spaced tab settings.
Units

Defines the units of measured used for tab settings.
Leader Character

Defines the ANSI character used to fill leader spaces between tabs.
Leader Spacing

Defines character spaces between leader characters.
Auto-Leader

Enable to add leader characters between the end of the last line of the tagged paragraph 
and the right margin.

Tab Positions
List box: Defines the tab stops currently set in the selected style.
Alignment Buttons: Define the alignment for the currently selected tab stop. The 

options are Left, Center, Right and Decimal.
Leadered: Enable to add leader characters to the selected tab stop.
Add: Click to add a new tab stop.

Note: If you choose Justified text, you cannot add tabs.
Delete: Click this button to remove the selected tab stop.



Tag Name
Shows the name of the paragraph tag being modified.



How to...
· Align paragraphs
· Work with dialog boxes



Paragraph Settings, Spacing dialog box
This dialog box enables you to adjust spacing along with text rotation for the selected 
paragraph.

Dialog Box 
Options

Paragraph Indent:
Determines the position of text in relation to the left and right margins.
Pages: Sets paragraph indents as follows for all pages, or left pages or right 

pages only.
Left: Enter a value for the left paragraph indent.
Right: Enter a value for the right paragraph indent.

Line Indents
Sets the number of lines to indent and the amount of the indent as follows:
Lines to Indent: Defines the number of lines in the paragraph to be indented.
Indent Amount: Defines the space between the left margin and the indented lines.
Add Width of Select to add the
Preceding Lines: width of the last line of the preceding paragraph to the current 

paragraph's indent amount.
Spacing: Sets the spacing between lines and paragraphs as follows: 
Above: Defines the space above the paragraph.
% of font size: Calculates spacing above based on a percentage of the current font 

size.
Below: Defines the space below the paragraph.
% of font size: Calculates spacing below based on a percentage of the current font 

size.
Inter-Line: Defines the space from baseline to baseline within the paragraph.
% of font size: Calculates inter-line spacing based on a percentage of the current 

font size.
Inter-Paragraph: Inter-paragraph spacing only adds space between paragraphs that 

have identical settings for Inter-Paragraph space.
Inter Paragraph space is occasionally useful when you want the 
space between similar paragraphs to be greater than the space 
between these paragraphs and the headings or other paragraphs 
which precede them. The _PRPT-P1.STY in the VENTURA\typeset 
directory provides a good example of how to use the Inter paragraph 
spacing option. In this style sheet(s), the space between Body Text 
paragraphs is set with Inter-Paragraph space. The Inter-Paragraph 
settings for Head Level 1 and Head level 2, on the other hand, are 
different and, therefore, do not apply when the two types of 
paragraphs are placed adjacent to one another.

Grow Inter-Line Select to increase inter-line
to Fit: spacing to accommodate characters that may be larger than the 

normal paragraph font. 
Note: This option should be disabled to properly flow text around 
frames anchored in a line of text.



Auto-Adjust: Select to automatically update spacing options if the paragraph font 
is changed. If you use By Addition, only the Inter-Line box in the 
Spacing section of the dialog box is available. 
Note: Auto-Convert, used to convert hyphens and quotation marks, 
is controlled in the Preferences, General dialog box.

Add Above Space Select to apply
at Column Top: Space Above at the top of a column at all times.
Grow Inter-Line 
to Fit: Select to increase inter-line spacing to accommodate characters that 

may be larger than the normal paragraph font.
Text Rotation:

Determines the angle and maximum height of rotation
Angle: Defines text rotation within a frame. The options are: 0 degrees, 90 

degrees, 180 degrees and 270 degrees. The selected text is rotated 
while the frame remains fixed.

Maximum Height: Defines the maximum vertical area in which the text will be rotated.
Units: Determines the units of measure used for all options in the Spacing 

dialog box.
Tag Name: Displays the currently selected tag.



How to...
· Set spacing
· Work with dialog boxes



Paragraph Settings, Defaults dialog box
This dialog box enables you to define the default line and font settings for the selected 
paragraph tag.

Dialog Box 
Options

Line Settings
Overscore 
Thickness: Defines the default line thickness used to overscore paragraph text.
Overscore 
Baseline Shift: Defines the shift 

of the overscore from the paragraph's baseline. A negative value 
moves the overscore closer to the baseline. A positive value moves it
away.

Strike-thru: Defines the default line thickness of the paragraph text strike-thru.
Baseline Shift: Defines the shift of the strike-thru from the paragraph's baseline. A 

negative value moves the strike-thru closer to the baseline. A 
positive value moves it away.

Underline 1: Defines the default line thickness of the first underline of the 
paragraph tag.

Baseline Shift: Defines the shift of the underline from the paragraph's baseline. A 
positive value moves the strike-thru closer to the baseline. A 
negative value moves it away.

Underline 2: Defines the default line thickness of the second underline of the 
paragraph tag.

Baseline Shift: Defines the shift of the underline from the paragraph's baseline. A 
positive value moves the strike-thru closer to the baseline. A 
negative value moves it away.

Font Settings
Superscript Defines the size
Font Size:  of the superscript characters in the paragraph tag.
Superscript Determines the distance
Baseline shift:  from the paragraph's baseline for the superscript characters.
Subscript Defines the size 
Font Size: of the subscript characters in the paragraph tag.
Subscript Determines the distance
Baseline shift:  from the paragraph's baseline for the subscript characters.
Alternate: Defines the alternate size of characters in the paragraph tag.
Units: Defines the units of measure used for all options in the Defaults 

dialog box.
Auto Adjust Settings to Font Size

Select to automatically update all settings in the Default dialog box when the paragraph 
font size is changed. Changes will be proportionate to paragraph font size.

Next Tag
Determines which tag is automatically assigned to the next paragraph when you press 



Enter.
Tag Name

Displays the currently selected tag.



How to...
· Select text
· Apply formatting changes to paragraph tags
· Apply overrides
· Work with dialog boxes



Paragraph Settings, Typography dialog box
This dialog box enables you to define kerning, tracking, word spacing, vertical justification 
and hyphenation for the selected paragraph tag.

Dialog Box 
Options
Justified Text

Word Spacing Defines the minimum 
Proportion: amount of proportional space allowed between words on justified 

paragraphs.
Word Spacing Defines the minimum
Em Space:  amount of em space allowed between words on justified paragraphs.
Word Spacing Defines the maximum
Proportion:  amount of proportional space allowed between words on justified 

paragraphs.
Word Spacing Defines the maximum
Em Space:  amount of em space allowed between words on justified paragraphs.
Automatic Letter Applies letter
Spacing: spacing on justified text.
Maximum Limit: Defines the maximum amount of letter spacing, in ems, allowed on 

justified text.
Vertical Justification

Maximum Above: Defines the maximum amount of space allowed above the paragraph
during vertical justification.

Maximum Below: Defines the maximum amount of space allowed below the paragraph 
during vertical justification.

Maximum Inter-Line: Defines the maximum amount of space allowed between lines 
in the paragraph during vertical justification.

Units: Determines the units of measure used for the vertical justification 
options.

Automatic Kerning
Select to apply pair kerning to the paragraph tag.

Character Tracking
Defines the inter-character spacing in ems for the selected paragraph.

Normal Word Spacing
Defines the inter-word spacing in ems for the selected paragraph.

Automatic Hyphenation
Select to have Corel VENTURA automatically hyphenate your text using the dictionary 
selected in the Dictionary list box. You can also use discretionary hyphens and override 
automatic hyphens in the Chapter Settings, Typography dialog box.

Dictionary
Use to select the dictionary governing hyphenation. See also How to... Use the 
appropriate hyphenation dictionary for previous versions of VENTURA and Install a foreign-
language dictionary



Successive Hyphens
Defines the maximum number of consecutive lines that can be hyphenated. The default 
number is 2. See also Discretionary hyphens

Tag Name
Displays the currently selected tag.



How to...
· Set tracking and kerning
· Hyphenate text automatically
· Work with dialog boxes



Breaks dialog box
This dialog enables you to set page, column and line breaks for the selected paragraph tag.

Dialog Box 
Options
Style tag

Determines the paragraph tag where the breaks will apply.
Page Breaks

Defines where the page break will occur in relationship to the paragraph. The options are: 
None, Before, After, Before & After, Before/Until Left and Before/Until Right. The latter two 
options force a page break before the paragraph and redirect the same paragraph to the 
next left or right page.

Column Break
Defines where the column break will occur in relationship to the paragraph. The options 
are: None, Before, After and Before & After.

Line Break
Defines where the line break will occur in relationship to the paragraph. The options are: 
None, Before, After and Before & After.

In Line with Previous Paragraphs
Select to determine the start point of the selected paragraph to be located on the same 
line and next to the last line of the previous paragraph.

Allow Breaks Within Paragraph
Determines when page breaks are allowed within the paragraph.

Keep With Next Paragraph
Select to keep the selected paragraph with the following paragraph, thereby not allowing 
page or column breaks between them.



How to...
· Set breaks
· Work with dialog boxes



Frame Settings dialog box
The Frame Settings dialog box has five sections: General, Margins, Columns, Typography.

Dialog Box Options
General

Click the General tab to display the General dialog box.
Margins

Click the Margins tab to display the Margins dialog box.
Columns

Click the Columns tab to display the Columns dialog box.
Graphic

The Graphic tab is displayed in the Frame Settings dialog box only when a frame 
containing a graphic is selected. Click it to see the Graphic dialog box.

Typography
Click the Typography tab to display the Typography dialog box.

Note: The Graphics tab is only displayed if the selected frame contains a graphic file. 



How to...
· Work with frames
· Work with dialog boxes



Frame Settings, General dialog box
The Frame Settings, General dialog box enables you to modify general information related to
the selected frame.

Dialog Box 
Options
Flow Text Around Frame

Determines whether the text will flow around, or through the selected frame.
Note: Corel VENTURA automatically disables this option for frames anchored using the At 
Anchor position option in the Insert Frame Anchor dialog box. But even with the option 
disabled, it may be necessary to disable Grow Inter-Line Space to Fit for the paragraph 
containing the frame anchor in order to get the text to flow properly around the frame. 
You'll find the aforementioned option on the Spacing tab in the Paragraph Settings dialog 
box.

Frame Anchor
Determines the anchor name for the selected frame. The text anchor name must match 
that of the frame anchor. The list box contains names of existing frame anchors in the 
publication. A new frame anchor name can be entered to add to this list.

Lock Frame
Locks the frame so that it can't be resized or moved.

Dimensions
Width: Determines the width of the selected frame.
Height: Determines the height of the selected frame.
Units: Determines the unit of measure used for frame width and height.

Frame Origin
Horizontal: Determines the left-to-right position of the upper left corner of the selected 

frame on the page.
Vertical: Determines the top-to-bottom position of the upper left corner of the 

selected frame on the page.
Units: Determines the unit of measure used for the horizontal and vertical frame 

positioning.
Caption Format

Caption: Determines the position of the caption on the frame: above, below, left , 
right or none.

Reference: Determines the caption text and numbering format for the frame caption. 
The options in the list box can be edited. The options are: Figure [#], Figure 
[C#] - [F#], Table [T#], Table [C#] - [F#] and None.

Repeating Frame:
Repeat on: Defines where the selected frame will be repeated. The options are: All 

Pages, Left Pages, Right Pages and No Other Pages.
Hide on Select to hide the
Current Page:  repeating frame from the current page.
Frame Tag: Associates the selected frame to a frame tag.
Rotation: Determines the angle the frame and its contents will be rotated.





How to
· Move and resize frames
· Rotate frames
· Repeat frames
· Anchor frames
· Attach a caption to the selected frame
· Work with dialog boxes



Frame Settings, Margins dialog box
The Frame Settings, Margins dialog box enables you to modify margin settings for the 
selected frame.

Dialog Box 
Options
Pages

Defines the location of the selected frame where the margin settings will take effect. The 
options are: Left, Right and All.

Inside Margins
Top: Defines the white space inside the margin at the top of the selected frame.
Bottom: Defines the white space inside the margin at the bottom of the selected 

frame.
Left: Defines the white space inside the margin at the left of the selected frame.
Right: Defines the white space inside the margin at the right of the selected frame.

Outside Margins
Horizontal: Defines the white space outside the horizontal margins.
Vertical: Defines the white space outside the vertical margins.

Vertical Rules
Rule #: Defines the rule to be edited. Options are: 1 or 2.
Position: Defines the left-to-right position of the vertical rules to be edited.
Thickness: Defines the line thickness of the vertical rule to be edited.
Units: Determines the units of measure used in this dialog box.

Frame Tag
Displays the tag assigned to the selected frame.



How to...
· Set margins
· Work with dialog boxes



Frame Settings, Columns dialog box
The Frame Settings, Columns dialog box enables you to create multi-column frames.

Dialog Box 
Options
Settings For

Defines the location of the selected frame where the column settings will take effect. The 
options are: Left Pages, Right Pages and All Pages.

Number of Columns
Defines the number of columns for the selected frame.

Equal Width Columns
Select to distribute space equally over the number of columns selected.

Column
Determines which column is being edited.

Width
Defines the width of the selected column.

Gutter
Defines the inter-column space. When Equal Width Columns is used, the gutter space is 
divided equally between columns.

Units
Determines the units of measure used in defining column widths and gutters.

Overall Width
Displays the total column width.

Over Size
Displays how much columns exceed the current frame width.

Column Balance
Determines text distribution from column to column. Options are: On, Off and Default. 
Turning Column Balance On will distribute text evenly across every column.

Inter-Column Rules
Select to determine whether rules will be inserted between columns.

Thickness
Defines line thickness of inter-column rules.

Units
Determines the units of measure used to define line thickness of inter-column rules.

Copy to Facing Page
Clicking this button will reflect the column settings on the left and right pages.

Frame Tag
Shows the name of a tag assigned to the selected frame.





How to...
· Set columns
· Work with dialog boxes



Frame Settings, Graphic dialog box
Th Frame Settings, Graphic dialog box, available when a graphic object is selected, enables 
you set parameters to scale and crop graphic objects within a selected frame.

Dialog Box 
Options
Dimensions

Width: Defines the width of the graphic within the selected frame.
Height: Defines the height of the graphic within the selected frame.
Units: Determines the units of measure used for width and height.
Fit in Frame: Turned on by default, Fit in Frame resizes a graphic to the same width or 

height as the frame it's placed in. Enlarging is limited to the size of the 
original. Turn off Fit in Frame to shift a graphic within its frame (see below) 
and crop a graphic. When Fit in Frame is turned off, the graphic will revert 
to its original size; its will appear in the Dimensions section of the dialog 
box.

Maintain Turned on by default,
Aspect Ratio:Maintain Aspect Ratio preserves the original proportions of a graphic when 

you resize it. 
Note: Corel VENTURA automatically resizes graphics to fit in free frames; 
you may also resize a graphic and its frame with the mouse or by turning 
off Fit in Frame and Maintain Aspect Ratio.

Shift Within Frame (Panning):
Horizontal: Determines the distance the graphic will be shifted from the frame's center 

point. A positive value will move it to the left. A negative value will move it 
to the right.

Vertical: Determines the distance the graphic will be shifted from the frame's center 
point. A positive value will move it up. A negative value will move it down.

Halftone Screening
Halftone Type Lists the types of screens by the shape of the halftone dots. Dot, Line, 

Diamond1, Diamond2, Dot2, Elliptical, Euclidean, Grid, Lines, MicroWaves, 
OutCircleBlk, OutCircle Whi, Rhomboid, and Star are all screen types you 
can apply.
The Default type uses the printer's default screen parameters unless 
overridden in the Print dialog box. A dot screen with 60 lines per inch at 45 
degrees has typical screen parameters for a 300 dpi laser printer.

Screen Angle: Controls the resolution of the screen. The lower the frequency, the 
more apparent the screen will appear when printed. A 60-line screen (LPI) 
will appear quite coarse. 80 to 100 is suitable for imaging art to be printed 
on newsprint. Magazines use a 133- or 150-line screen. High-quality 
photography books use up to a 300-line screen.
Choosing an appropriate frequency depends on the resolution of your 
printer and the results you want to achieve. For example, setting a 133-line 
screen for printing to film is appropriate when printing on a high-resolution 
image setter. When printing on a 300 dpi laser printer, use a value from 60 
to 80. Values below 40 are useful for creating special effects.
Remember frequency affects the number of gray levels in the printed 
output: the higher the screen frequency, the higher the level of output 



resolution necessary to create an adequate number of gray levels. This is 
important to remember when creating smooth fountain fills. If you're 
printing fountain fills at high resolution, you'll need over two hundred steps 
or gray levels to keep large fountain fills from banding. 
If you're printing to a laser printer with 600 dpi. resolution you'll find that 
photos and fountain fills look better with a 80-line screen because they 
have more gray levels; thus photos have more tonal values and fountain 
fills can print with more steps.
To calculate grayscales when creating screens: Divide your output 
resolution squared by line screen squared to arrive at the number of 
grayscales. 

E.g.,  levels of gray.
Frequency: Controls the angle of the screen.

Screen angle does not change when you rotate or skew an object.
Hide Graphic

Click Hide Graphic to hide the graphic in the selected frame.



Frame Settings, Typography dialog box
The Typography section of the Frame Settings dialog box sets the following: Widows and 
Orphans, First Baseline, Column Balance, Pair Kerning, Vertical Justification and Frame 
Rotation.

Dialog Box 
Options
Widows & Orphans

Widows: Enter the number of lines for widow lines.
Orphans: Enter the number of lines for orphan lines.

Text Positioning
First Baseline: Determines the location of the first line of text on a frame or page. 

The options are: cap height and inter-line.
Pair Kerning: When checked, space between pairs of letters in a paragraph is 

automatically adjusted.
Vertical Justification

Within Frame: Adjusts vertical justification in the frame. The options are: feathering,
carding and off.

Maximum Enter a percentage. 
Justification: Uses the Maximum at Top and Maximum at Bottom for the 

paragraphs plus the percentage to determine the maximum 
justification.

Around Frame: Determines the vertical justification around the frame. There are two 
options: Moveable and Fixed. Moveable moves the frame down to 
create space above. Fixed causes the frame to remain in position and
adds space below.

Maximum at Top: Sets the maximum amount of space between text and frame at the 
top.

Maximum at Bottom: Sets the maximum amount of space between text and frame at 
the bottom.

Units: Determines the units of measure used in this dialog box.
Frame Tag

Shows the tag name assigned to the selected frame.



How to...
· Work with dialog boxes



Pen Roll-up
The Pen Roll-up gives you quick access to a variety of attributes for outlining graphic objects.

Roll-Up Controls

Roll window icon :
Hides the controls leaving just the title bar visible.

Thickness Selector 
Selects a line thickness from .001 to 0.5 inches. Each click on the scroll arrows changes 
the thickness by .01 inches. Scroll down repeatedly for the Hairline or No Outline options.

Arrowhead Selectors 
Displays a box with a selection of arrowheads you can apply to the ends of open paths. 
The left and right selectors let you choose different arrowheads for both ends of the path.
Use the scroll bars to see other arrowheads in the list. Click the one you want. To close the 

box without making a selection, press the ESC key.
Line Style Selector 

Displays a selection of dashed and dotted line styles.
Use the scroll bars to see other styles in the list. Click the one you want. To close the box 
without making a selection, press the ESC key.

Color Selector 
Displays a palette of outline colors. Use the scroll bars to see other colors in the list. Click 
the one you want. To close the box without making a selection, press the ESC key.

Update From...
Loads the selected object's outline into the roll-up so that you can make changes to it. 
After making changes choose the Apply button.
You can also use Update From to copy another object's outline to the selected object. Click 
on the object with the outline you want to copy, click on the Update From... button, then 
on the Apply button.

Edi
Opens the Outline Pen dialog box where you can access all of the available Outline Pen 
controls.

Apply
Applies your choices to the selected object.



How to...
· Apply outlines and fills
· Set default outline and fill attributes
· Use roll-ups



Outline Pen dialog box
Controls the color, width, and shape of the pen used to draw the object's outline. You can 
also apply arrowheads to lines and choose dashed and dotted outlines from this dialog box.

Dialog Box Options
Color

Displays the object's current outline color and the color's name. Clicking on the color 
button displays a box with other colors you can choose.
Use the scroll bars to see other colors in the list. Click the one you want. To close the box 
without making a selection, press the ESC key.
Clicking More opens the Outline Color dialog box for creating custom colors and selecting 
them by name.

Arrows
Displays a selection of arrowheads and symbols you can apply to the ends of lines. The left
button selects an arrowhead for the beginning of the line, the right button for the end of 
the line. 

Options
Opens a menu with the following commands.
None Removes the displayed arrowhead.
Swap Puts the arrowhead at the other end of the line.
Edit Displays the Arrowhead Editor which let you change the size and placement of

the arrowhead.
Delete Deletes the displayed
From List arrowhead from the list.

Width
Varies the thickness of the outline.
A value of 0.00 prints a line one pixel wide at the printer's current resolution. If you change
to a higher resolution printer, be aware that the line will print much thinner.
If you want to use a different unit of measurement, select it from the units box. Corel 
VENTURA will automatically convert the displayed value to its equivalent in the unit you 
select.

Style
Displays a box with a selection of dashed and dotted line styles. Use the scroll bars to see 
other colors in the list. Click the one you want. To close the box without making a selection,
press the ESC key.
Dotted lines are created by applying round Line Caps to a line style with short, widely 
spaced segments.
You can create your own line styles and have them added to the list in the dialog box. You 
do this by editing the CORELDRW.DOT file. 

Corners
Controls how outlines are drawn on objects with sharp corners. Also selects a square or 
round Pen Shape.



Draws mitered corners. Selecting Mitered also selects a square Pen Shape.
Draws rounded corners. Also selects a round Pen Shape.
Draws blunted corners. Also selects a square Pen Shape.

Line Caps
Controls how the ends of lines are drawn. The same selection is applied to both ends of the
line and the ends of all dashed and dotted line segments.

Squares the line off at each end.
Draws round caps extending beyond the ends of the line.

 Draws square caps extending beyond the ends of the line.
Calligraphy

The effect of calligraphy controls is only evident when applying outlines to objects created 
with the Ellipse tool. 

Behind Fill
Specifies whether the outline is placed behind, or in front of the object's fill. 
When placed behind, only half the outline's thickness will be visible.

Shortcut
Pressing Shift+F12 with an object selected opens the Outline Color dialog box.



How to...
· Apply outlines and fills
· Set default outline and fill attributes
· Work with dialog boxes



Outline Color, Uniform Fill, Select Color dialog boxes
Use these dialog boxes to specify the selected object's outline, fill color or choose a color for 
a texture fill.
· If you are using a color monitor, remember that the colors you see will not match the 

printed colors exactly. To accurately specify Process colors, use the Process Color Chart 
provided with your Corel VENTURA User's Guide. If you are choosing colors from the 
TRUMATCH, FOCOLTONE or either of the PANTONE palettes, then use the corresponding 
Color Reference.

· Colors previewed on monochrome monitors and printed on black and white printers will
appear as appropriate shades of gray.

Dialog Box Options
Show

Selects a color specification method.
CMYK, RGB, HSB
Displays controls for creating custom process colors using one of three Process color 
models.
You can create colors by specifying percentages in the text boxes or by dragging color-
adjustment markers in the visual selector.
If you print color separations, colors specified with the HSB and RGB models will be 
converted to their CMYK equivalents.
After you create a color, Corel VENTURA applies it to the selected object but does not add 
it to the Custom Palette unless you type a name in the New box and choose Add Color 
from the Custom Palette menu displayed by clicking the right arrow button.

Grayscale
Displays controls for creating custom grayscales.
You can set grayscales by specifying a Gray Level between 0 for white and 255 for black, 
or by dragging the grayscale marker in the visual selector.

Uniform Colors
Displays a color palette built from RGB percentages.
Process Colors Lets you choose predefined process colors from the FOCOLTONE, 

TRUMATCH or PANTONE Process color palettes. Use this method if your 
document contains several different colors which you plan to 
reproduce on a four-color offset printing press. Process color can also 
be used when printing directly to a color printer.

Spot Color Displays spot colors defined with the PANTONE Matching System (PMS).
Spot color is appropriate for creating documents that contain only a 
few colors that you intend to separate on paper or film. You can also 
use it when printing directly to a color printer.

Note: If your document contains only shades of gray, and you want to apply different 
PostScript halftone screens to them, use the Spot method.

Current Color
Displays the selected object's current outline/fill color at the top and the new color you 



select or create at the bottom.
New

Displays the color selected from the palette and its name. When you create a color, type a 
name for it in this box. When you click OK, the named color will be added to the end of the 
custom palette.

Tint
Adjusts the density of the selected Spot color.

Show Color Name
Enables you to choose colors by name.
Note: Only available when FOCOLTONE, TRUMATCH, PANTONE or Uniform color palette is 
selected.

Search for
Lets you find a particular color by typing some part of its name. As you type, the list box 
scrolls automatically to the color that most closely matches what you type. For example, if 
you type "or" the color "Pantone Orange 021 CV" will be highlighted. (You do not need to 
type the word "Pantone".)

PostScript Options...
Opens the PostScript Options dialog box. Used to specify halftone screens for Spot colors.

Custom Palettes
Opens a menu with commands for managing the palettes.
Add Color: Adds a named color to the end of the palette. You can also add tints of 

Spot color to the end of the Spot color palette (i.e., the CORELDRW.CPL 
palette).

Delete Color: Deletes the selected color from the palette. You cannot delete colors from 
the CORELDRW.CPL Spot color palette.

New: Displays an empty palette which you can fill with colors you create or 
select from the palette at the top of the dialog box.

Open: Opens the Open Palette dialog box where you can select different color 
palettes to load into Corel VENTURA.

Save: Saves a palette that you have modified by adding, deleting or rearranging 
colors.

Save As: Opens the Save Palette As dialog box where you can assign a new name to
the current palette.

Set As Default: Loads the current palette each time you start Corel VENTURA.
Mixing Area

Used to choose colors from existing files, the Show Preview box, the Custom Palette 
Preview box or any combination of the three. Click the arrow button to display the 
following choices: 
· Load Paint Area File dialog box
· Save Paint Area File As     dialog box  
· Clear paint area command. 
The Paintbrush button paints the selected color in the Paint Area and can mix that color 
with colors already in the paint area. The Eyedropper button selects a color from the paint 
area which is then displayed in the Current/New preview box.



Shortcut
· Pressing SHIFT+F12 with an object selected opens the Outline Color dialog box. Choose 

an outline color for the object.
· Pressing Shift+F11 with an object selected opens the Uniform Fill dialog box. Choose a 

fill color for the object.
· Pressing F11 with an object selected opens the Fountain Fill dialog box. Choose a 

fountain fill.



Paragraph Text Color dialog box
Use this dialog box to specify the color of Paragraph text.
· If you are using a color monitor, remember that the colors you see will not match the 

printed colors exactly. To accurately specify Process colors, use the Process Color Chart 
provided with your Corel VENTURA User's Guide. If you are choosing colors from the 
TRUMATCH, FOCOLTONE or either of the PANTONE palettes, then use the corresponding 
Color Reference.

· Colors previewed on monochrome monitors and printed on black and white printers will
appear as appropriate shades of gray.

Dialog Box Options
Show

Selects a color specification method.
CMYKcd, RGB, HSB
Displays controls for creating custom process colors using one of three Process color 
models.
You can create colors by specifying percentages in the text boxes or by dragging color-
adjustment markers in the visual selector.
If you print color separations, colors specified with the HSB and RGB models will be 
converted to their CMYK equivalents.
After you create a color, Corel VENTURA applies it to the selected object but does not add 
it to the Custom Palette unless you type a name in the Color Name box and choose Add 
Color from the Custom Palette menu.

Grayscale
Displays controls for creating custom grayscales.
You can set grayscales by specifying a Gray Level between 0 for white and 255 for black, 
or by dragging the grayscale marker in the visual selector.

Uniform Colors
Displays a color palette built from RGB percentages.
Process Colors Lets you choose predefined process colors from the FOCOLTONE, 

TRUMATCH or PANTONE Process color palettes. Use this method if your 
graphic contains several different colors which you plan to reproduce 
on a four-color offset printing press. Process color can also be used 
when printing directly to a color printer or film recorder.

Spot Color Displays spot colors defined with the PANTONE Matching System (PMS). 
Spot color is appropriate for creating graphics that contain only a few 
colors that you intend to separate on paper or film. You can also use it 
when printing directly to a color printer or film recorder.

Note: If your drawing contains only shades of gray, and you want to apply different 
PostScript halftone screens to them, use the Spot method.

Current Color
Displays the selected object's current outline/fill color at the top and the new color you 
select or create at the bottom.



New
Displays the selected color and its name. When you create a color, type a name for it in 
this box. When you click OK, the named color will be added to the end of the custom 
palette.

Tint
Adjusts the density of the selected Spot color.

Show Color Name
Enables you to choose colors by name.

Search for
Lets you find a particular color by typing some part of its name. As you type, the list box 
scrolls automatically to the color that most closely matches what you type. For example, if 
you type "or" the color "Pantone Orange 021 CV" will be highlighted. (You do not need to 
type the word "Pantone".)

PostScript Options...
Opens the PostScript Options dialog box. Used to specify halftone screens for Spot colors.

Custom Palettes
Opens a menu with commands for managing the palettes.
Add Color: Adds a named color to the end of the palette. You can also add tints of 

Spot color to the end of the Spot color palette (i.e., the CORELDRW.CPL 
palette).

Delete Color: Deletes the selected color from the palette. You cannot delete colors from 
the CORELDRW.CPL Spot color palette.

New: Displays an empty palette which you can fill with colors you create or 
select from the palette at the top of the dialog box.

Open: Opens the Open Palette dialog box where you can select different color 
palettes to load into Corel VENTURA.

Save: Saves a palette that you have modified by adding, deleting or rearranging 
colors.

Save As: Opens the Save Palette As dialog box where you can assign a new name to
the current palette.

Set As Default: Loads the current palette each time you start Corel VENTURA.
Mixing Area

Used to choose colors from existing files, the Show Preview box, the Custom Palette 
Preview box or any combination of the three. Click the arrow button to display the 
following choices: 
· Load Paint Area File dialog box
· Save Paint Area File As     dialog box  
· Clear paint area command. 
The Paintbrush button paints the selected color in the Paint Area and can mix that color 
with colors already in the paint area. The Eyedropper button selects a color from the paint 
area which is then displayed in the Current/New preview box.



Selected Text Color dialog box
Use this dialog box to specify the color of selected text.
· If you are using a color monitor, remember that the colors you see will not match the 

printed colors exactly. To accurately specify Process colors, use the Process Color Chart 
provided with your Corel VENTURA User's Guide. If you are choosing colors from the 
TRUMATCH, FOCOLTONE or either of the PANTONE palettes, then use the corresponding 
Color Reference.

· Colors previewed on monochrome monitors and printed on black and white printers will
appear as appropriate shades of gray.

Dialog Box Options
Show

Selects a color specification method.
CMYK, RGB, HSB
Displays controls for creating custom process colors using one of three Process color 
models.
You can create colors by specifying percentages in the text boxes or by dragging color-
adjustment markers in the visual selector.
If you print color separations, colors specified with the HSB and RGB models will be 
converted to their CMYK equivalents.
After you create a color, Corel VENTURA applies it to the selected object but does not add 
it to the Custom Palette unless you type a name in the Color Name box and choose Add 
Color from the Custom Palette menu.

Grayscale
Displays controls for creating custom grayscales.
You can set grayscales by specifying a Gray Level between 0 for white and 255 for black, 
or by dragging the grayscale marker in the visual selector.

Uniform Colors
Displays a color palette built from RGB percentages.
Process Colors Lets you choose predefined process colors from the FOCOLTONE, 

TRUMATCH or PANTONE Process color palettes. Use this method if your 
graphic contains several different colors which you plan to reproduce 
on a four-color offset printing press. Process color can also be used 
when printing directly to a color printer.

Spot Color Displays spot colors defined with the PANTONE Matching System (PMS). 
Spot color is appropriate for creating documents that contain only a 
few colors that you intend to separate on paper or film. You can also 
use it when printing directly to a color printer or film recorder.

Note: If your document contains only shades of gray, and you want to apply different 
PostScript halftone screens to them, use the Spot method.

Current Color
Displays the selected object's current outline/fill color at the top and the new color you 
select or create at the bottom.



New
Displays the selected color and its name. When you create a color, type a name for it in 
this box. When you click OK, the named color will be added to the end of the custom 
palette.

Tint
Adjusts the density of the selected Spot color.

Show Color Name
Enables you to choose colors by name.

Search for
Lets you find a particular color by typing some part of its name. As you type, the list box 
scrolls automatically to the color that most closely matches what you type. For example, if 
you type "or" the color "Pantone Orange 021 CV" will be highlighted. (You do not need to 
type the word "Pantone".)

PostScript Options...
Opens the PostScript Options dialog box. Used to specify halftone screens for Spot colors.

Custom Palettes
Opens a menu with commands for managing the palettes.
Add Color: Adds a named color to the end of the palette. You can also add tints of 

Spot color to the end of the Spot color palette (i.e., the CORELDRW.CPL 
palette).

Delete Color: Deletes the selected color from the palette. You cannot delete colors from 
the CORELDRW.CPL Spot color palette.

New: Displays an empty palette which you can fill with colors you create or 
select from the palette at the top of the dialog box.

Open: Opens the Open Palette dialog box where you can select different color 
palettes to load into Corel VENTURA.

Save: Saves a palette that you have modified by adding, deleting or rearranging 
colors.

Save As: Opens the Save Palette As dialog box where you can assign a new name to
the current palette.

Set As Default: Loads the current palette each time you start Corel VENTURA.
Mixing Area

Used to choose colors from existing files, the Show Preview box, the Custom Palette 
Preview box or any combination of the three. Click the arrow button to display the 
following choices: 
· Load Paint Area File dialog box
· Save Paint Area File As     dialog box  
· Clear paint area command. 
The Paintbrush button paints the selected color in the Paint Area and can mix that color 
with colors already in the paint area. The Eyedropper button selects a color from the paint 
area which is then displayed in the Current/New preview box.

Shortcut
· Pressing SHIFT+F12 with an object selected opens the Outline Color dialog box. Choose 

an outline color for the object.



· Pressing Shift+F11 with an object selected opens the Uniform Fill dialog box. Choose a 
fill color for the object.

· Pressing F11 with an object selected opens the Fountain Fill dialog box. Choose a 
fountain fill.



Open Palette dialog box
Use this dialog box to load different palettes supplied with Corel VENTURA and those you 
have modified and saved with the Save Palette As command. 
There are two custom palettes available when you first open Corel VENTURA:
· The default color palette loaded when you first installed Corel VENTURA, the 

CORELDRW.CPL palette. It is built with the CMYK color model.
· The RGB color palette, CORELPNT.CPL, built with the RGB color model. 

You can open .pal files from CorelDRAW versions 2, 3 or 4 to use in Corel VENTURA 5.0. If you
modify them, a message box will appear when you close asking you whether you want to 
save the changes. If you choose Yes, the changes are saved, and the palette is saved in the 
new CorelDRAW 5.0 format (.cpl). (You cannot save changes to a .pal file in Corel VENTURA 
5.0 using the .pal format.)
Note: If you are creating documents that will eventually be color separated and printed on a
four-color device (CMYK), use the CORELDRW.CPL palette. The RGB color model has a larger 
gamut than the CMYK model, which may cause you to choose colors that do not fit inside the 
CMYK gamut. 

Other color models available:
· The TRUMATCH palette lets you specify Process colors using the TRUMATCH Swatching 

System. By using this palette along with a TRUMATCH color reference book, you can be 
reasonably certain how the colors will look when printed.

· The FOCOLTONE palette provides pre-mixed CMYK process colors using the FOCOLTONE 
Swatching System. By using this palette along with a FOCOLTONE color reference book, 
you can be reasonably certain how the colors will look when printed on a CMYK printer. 
The FOCOLTONE colors are organized so that you can easily select colors with at least 
10% of one process color in common with another, which minimizes the need for trap.

· The PANTONE Process Colors palette is a process version of the PANTONE Spot color 
palette. Due to the different color gamut between spot and process colors note that 
color variation may occur. A swatch book for the PANTONE Process palette is included 
with Corel VENTURA.

Dialog Box Options
File Name

Choose the palette you want to open. Either type the name of the file or select it from the 
list.

Directories
Choose the directory in which the palette you want to open is stored.

Drives
Choose the drive in which the file you want to open is stored.

List Files of Type
Choose the type of palette--Process or Custom--you want to open. The .CPL (CorelDRAW 
5.0) or .PAL (CorelDRAW 4.0) color palettes are available from the List Files of Type box.



Fill Roll-Up
The Fill Roll-Up gives you quick access to Corel VENTURA's fills.

Roll-Up Controls

Roll window icon 
Hides the controls, leaving just the title bar visible.

Uniform Fill 
Displays the color last applied to an object. Clicking the color displays a palette with other 
colors you can use to fill the selected object. To apply the selected color, click Apply. 
Clicking More opens the Uniform Fill dialog box, where you choose or create a uniform fill 
color. 

Fountain Fill 
Displays controls for creating fountain fills. 
Type Above the Update From button, there are four fountain fill options to 

choose from: the left-center button, a radial fountain; the right-center 
button, a conical fountain; and the right button, a square fountain.
You can change the angle of linear and square fountains and the center of 
a radial, conical, and square fountains by dragging the control in the 
preview box.
Hold down the Ctrl key while you click and drag in the preview box to 
constrain the angle of a linear fountain to multiples of 15 degrees, and to 
constrain the amount of offset for a radial or conical fountain to 10-percent
increments.
Click and hold down the right mouse button to constrain the angle of 
conical and square fountain fills.
Click and hold down the left mouse button while dragging in the preview 
box to offset radial, conical, and square fountain fills.
Hold down the Shift key while you click and drag in the preview box to 
constrain the angle of conical and square fountain fills to multiples of 15 
degrees.
Clicking on the fountain fill button with no object selected opens a dialog 
box for assigning the currently displayed fountain fill as the default fill for a
particular type of new object.

Two-Color pattern Fills 
Displays controls for selecting and editing two-color pattern fills.

 Pattern List Clicking the preview box displays a list of patterns. Click on a pattern 
and choose OK. Choosing Cancel ignores your selection and closes the list.

Delete Item: Deletes the selected pattern from the list.
Import Pattern: Opens another dialog box that lets you create a pattern from an 

imported graphic. 
Note: For best results, use graphics with no more than two colors.

 Colors Displays a palette for choosing the foreground and background colors. Click on
the left button to specify the foreground color, the right button to specify the background 



color.
Update From: The arrow enables you to copy a pattern from another object.
Edit: Opens the Two-Color Pattern dialog box
Apply: Applies the pattern to the selected object or to the new objects default.

Full-Color pattern Fills 
Displays controls for selecting and editing full-color pattern fills.
Pattern List: Clicking the preview box displays a list of patterns. Click on a pattern 

and choose OK. Choosing Cancel ignores your selection and closes the 
list.
Choosing File displays a menu for deleting and importing patterns.
Delete Item: Deletes the selected pattern from the list.
Import Pattern: Opens the Import dialog box that lets you create a 
pattern from an imported    graphic. See Import dialog box.

Update From: The arrow enables you to copy a pattern from another object.
Edit: Opens the Full-Color Pattern dialog box.
Apply: Applies the pattern to the selected object.

Texture Fills 
Displays controls for selecting and editing Texture fills.
Texture List Clicking the preview box displays a list of textures. Click on a texture and 

choose OK. Choosing Cancel ignores your selection and closes the list.
Choosing File displays a menu for choosing Texture Libraries and deleting 
textures.
Load Texture Library: Opens a dialog box where you can choose the library 
containing the texture you want. You can also select libraries from the list 
below the preview box.
Delete Texture: Deletes the selected texture from the list.

Library field Choose a new Texture Library from this field.
Texture List field Choose a texture by clicking the name of the texture in this field.

Update From...
Loads the selected object's fill into the roll-up so that you can make changes to it or apply 
the same fill to another object.

Edit
Opens the Texture dialog box. See the Texture Fill dialog box.

Apply
Applies your choices to the selected object.



Arrowhead Editor
Use this dialog box to size the selected arrowhead or line ending shape and position it with 
respect to the start and end points of the line.

Dialog Box Options
Reference Line

Solid black line representing the line in your drawing to which the arrowhead is applied. 
Used to gauge the arrowhead's size and position.

Moving Handles
Hollow markers along the outline of the arrowhead and at the tip of the Reference line. 
Drag these to move the arrowhead or reference line.

Stretching/Scaling Handles
Solid markers around the arrowhead. Drag the corner handles to scale and the middle 
handles to stretch the arrowhead.

Guidelines
Three dotted lines used to align the arrowhead. As you drag a moving handle close to a 
guideline, the handle snaps to it ensuring precise alignment.

Reflect in X
Flips the arrowhead horizontally.

Reflect in Y
Flips the arrowhead vertically.

Center in X
Centers the arrowhead horizontally with respect to the X marker.

Center in Y
Centers the arrowhead vertically with respect to the X marker.

4x Zoom
Magnifies the arrowhead by a factor of four. Helpful when positioning the arrowhead.



Texture Fill dialog box
Use this dialog box to select one of the 100 plus bitmap texture fills included in Corel 
VENTURA. Each texture has a set of parameters that you can change to create millions of 
variations.
· Texture fills add significantly to the size of your file and the time it takes to print. As 

such, you should avoid filling numerous and/or large objects with them.
· The textures look best on color monitors. If you are using a monochrome monitor, you 

may not get a very good representation of the texture's appearance.
· When you rotate an object with a texture fill, the fill does not rotate.
· Resizing an object with a texture fill can distort the texture. To restore its appearance, 

open the Texture Fill dialog box and choose OK. Or, click the Update From button in the 
Fill Roll-Up, click on the object and then on the Apply button.

Dialog Box Options
Texture Library

Choose the library that contains the texture you want. The Samples library contains 
textures which you can modify and save for later use. Textures in the Styles Library can 
also be modified and saved. However, you must store them in another library when you 
save them. You cannot save modified textures to the Styles Library.

Texture List
Displays textures in the selected library. Click the one you want.

Preview
Varies the appearance of the selected texture by randomly changing all unlocked 
parameters. You lock and unlock parameters by clicking the Lock icon next to it.
You also use the Preview button to update a texture after changing the parameters 
yourself.

Save
After changing the parameters of a texture in a library (or a new library you created) 
choose save to overwrite the original. Textures from the Styles library cannot be 
overwritten but can be saved to another library.

Save As
Opens a dialog box for naming (or renaming) a texture you've created. See also Save 
Texture Fill As dialog box

Delete
Deletes the selected texture. You can delete textures from any Library but the Styles 
library.

Style Name <name>
Lists parameters for the selected texture. Changing one or more of these parameters 
alters the appearance of the texture.
The left side of the Style Name field lists up to six numeric parameters. All textures have a 
Texture Number parameter which ranges from 0 to 32,768. The names of the other 
parameters vary with the texture and have a range from 0 to 100 or -100 to 100. Some 



textures will have ranges past 100.
To change a numeric parameter, enter a value in the text box and click the Preview button.
The right side of the field lists up to six color parameters. To change a color, click on the 
color button and select a new one from the pop-up palette. Click the More button to create 
a color or choose it by name. To see the effect the new color has on the texture, click the 
Preview button. Other color parameters may be available depending on the texture. 
Experiment to see the effect the parameter will have.
Note: You can use colors from any color model or palette for texture fills. However, if you 
apply a Spot color to a texture fill, it will automatically be converted to a Process color 
(CMYK) when you create color separations. Since the conversion may not reproduce 
exactly the same color, and since you would necessarily have four color plates in a CMYK 
separation, it's best to apply Process colors to texture fills. 
 Locks and unlocks the texture parameters. Locked parameters are not changed when you

click the Preview. Unlocked parameters change when you click the Preview button.

See also:
Open Palette dialog box
Save Palette As dialog box



How to...
· Apply outlines and fills
· Set default outline and fill attributes
· Work with dialog boxes



Save Texture As dialog box
Use this dialog box to save a modified texture under its own name. Saving a texture makes it
easier to apply to other objects later on. You can also create and rename libraries in this 
dialog box.

Dialog Box Options
Texture Name

Type a name up to 32 characters (including spaces).
Library Name

Type a name in this box to create a new library in which to store the textures you create. 
You can type up to 32 characters (including spaces).

Library List
Choose the library to store the modified texture in.

Note: You must save modified Style textures in the Samples Library or in a library you 
create.



How to...
· Apply outlines and fills
· Set default outline and fill attributes
· Work with dialog boxes



Full-Color Pattern dialog box
Lets you specify the size of the tiles that make up the pattern. Also lets you shift the entire 
pattern inside the object you are filling and stagger the individual pattern tiles.

Dialog Box Options
Preview Box

Displays a tile of the selected pattern.
Click the preview box to display a list of patterns. Click on a pattern and choose OK. 
Choosing Cancel ignores your selection and closes the list.
Choosing File displays a menu for deleting, and importing patterns.
Save Current Saves the pattern fill
Fill: that's currently displayed in the preview box. Use this command to add a 

pattern created from an imported graphic to the list of patterns.
Delete Item: Deletes the selected pattern from the list.
Import Pattern: Opens another dialog box that lets you create a pattern from an 

imported graphic. See also Import command
Import

Opens another dialog box that lets you create a pattern from an imported graphic. See 
also Import command

Small, Medium, Large
Selects a pattern tile size of 0.25x0.25, 0.50x0.50, or 1.00x1.00 inches. You can set a 
custom size in the number fields below.
Width/Height:Specifies a custom pattern tile size from .10 of an inch to 15 inches.

To use a different unit of measurement, choose one from the units list.
First Tile Offset

Specifies the placement of the first tile relative to the upper left corner of the object's 
highlighting box.

Row/Column Offset
Shifts alternating rows or columns by the amount specified.

Seamless Tiling
If you have created a custom tile that does not appear to line up properly, try applying the 
Seamless tiling option. It will turn your tile into a standard size which should create a 
seamless fit between tiles.



Align dialog box
Aligns the selected objects.
· Free frames and graphics are aligned with respect to the handles on their highlighting 

box.
· The last free frame or graphic you select maintains its position; all others move to align

with this object.
· To align to the grid or the center of the page, choose the corresponding option first, 

followed by the Horizontal and Vertical options.

Dialog Box Options
Horizontal

Aligns horizontally with respect to the left, center or right handle.
Vertical

Aligns vertically with respect to the top, center or bottom handle.
Align to Grid

Considers the Horizontal and Vertical options, and then aligns the selected objects to the 
nearest grid point. 
Note: You must choose at least one of the Horizontal or Vertical alignment options.

Align to Center of Page
Selecting this option without selecting any Horizontal or Vertical alignment options centers
the objects on the page. If you choose this option followed by a Horizontal and/or Vertical 
option, then the objects will be aligned accordingly with respect to the center of the page.

Shortcut
Pressing CTRL+A with an object(s) selected displays the Align dialog box.



Chapter Settings, Header/Footer dialog box
The Header/Footer dialog box enables you to create headers and footers for each chapter.

Dialog Box Options
Define

Choose the header(s) and footer(s) in the drop-down list box. Each header and footer has 
to be defined and the text entered separately.

Header-Footer Text
Enter the text in the Header-Footer Text portion of the dialog box. Left places the text at 
the left margin, center places the text in the center and right places the text at the right 
margin.

Inserts chapter numbers
Inserts page numbers
Inserts text attributes
Inserts current time
Inserts current date
Inserts text from the first paragraph on a page formatted

with a particular paragraph tag. Select the tag from the Tags Roll-Up, which appears when 
you click the button.

Inserts text from the last paragraph on a page formatted
with a particular paragraph tag. If a page contains more than one paragraph with the first 
match tag, the text from the last paragraph on the page with the first match tag appears. 
Select the tag from the Tags Roll-Up, which appears when you click the button.
Copy to Facing Pages

Copies the header or footer to the facing page. The position of the header or footer on 
both pages is the same. For example, if the original is on the right side, the one copied to 
the facing page is on the right side.

Mirror to Facing Pages
Mirrors the header or footer on the facing page. A left justified header would appear on the
right side of the facing page.

Enable
Select which header or footer you want to appear in the document.



How to...
· Work with headers and footers
· Work with dialog boxes



Node Edit Roll-Up
The Node Edit Roll-Up is used to edit text wrap paths.

Roll-Up Options
Add (+)

Adds a node at the spot along the segment that you double-clicked on. Add nodes if you 
cannot shape a curve the way you want by moving the existing nodes and control points.

Delete
Deletes the selected node or segment. Use to remove surplus nodes from an excessively 
complex drawing and to smooth unwanted bumps along a curve.

Reduce
Deletes any nodes which can be deleted without significantly changing the shape of the 
curve. You can adjust the sensitivity of the Reduce feature through the Preferences 
command in the Special menu.

to Line
Changes the selected curve segment to a line segment.

to Curve
Changes the selected line segment to a curve segment.

Cusp
Changes the selected node to a cusped node. Use when you want to add a sharp bend to a
curve.

Smooth
Changes the selected node to a smooth node. Use when you want a different curvature on 
each side of the node.

Symmet
Changes the selected node to a symmetrical node. Use when you want the same curvature
on both sides of the node.

Elastic mode
Changes the way multiple-selected nodes move when dragged with the mouse. If 
unchecked, all nodes move by the same amount. When checked, nodes move in proportion
to their distance from the base node (i.e., the node you are dragging). The end result is 
that the curve appears to behave like an elastic expanding and contracting in response to 
the movement of the mouse.



Thesaurus dialog box
Suggests synonyms for words in your document. Use the Text tool to highlight the word you 
want a synonym for, and then choose the Thesaurus command.
Since the Thesaurus command is always available; you can use it to look up any word, not 
just those in the current document.

Dialog Box Options
Looked Up

Displays the word you selected before choosing the Thesaurus command. If you chose the 
command without selecting a word, you can look up synonyms for any word you type in 
the box. After typing the word, click the Look Up button.

Definitions
Displays definitions for the selected word. Choose the definition that fits the context of the 
selected word in your document. 

Replace With
Displays synonyms for the word in the Looked Up box. The list changes according to the 
definition selected.

Lookup
Displays a list of synonyms for the word in the Looked Up box.

Replace
Replaces the word in the Looked Up box with the word selected in the Replace With box.

Previous
Replaces the word in the Looked Up box with the word you looked up most recently.



Type Assist dialog box 
Controls the capitalization of some text. It also enables you to build quick shortcut words 
when entering repetitive information. All correction takes place after the word is complete as
indicated by either a punctuation mark or a space. Type Assist is also used to correct 
habitual spelling errors automatically. For example, if you often type "teh" for "the," you can 
have Type Assist correct your mistake by entering "teh" in the Replace box and typing and 
"the" in the With box.

Dialog Box Options
Capitalize first letter of sentences

Capitalizes the first letter following a sentence end. A sentence end is defined by a period 
(.), an exclamation mark (!), or a question mark (?). In Spanish, the marks ¿ and ¡ are also 
supported.

Change Straight Quotes to Typographic Quotes
Changes straight quotes to typographic quotes.

Correct two initial, consecutive capitals
Changes to lowercase the second capital if you start a word with two capitals without a 
space or period.

Capitalize names of days
Automatically capitalizes the names of days.

Replace text while typing
Enables the Replacement Text option.

Replacement text 
Enables you to define shortcuts, where you type a short version of the text and Corel 
VENTURA automatically inserts the full word or text string.
Replace:The shortcut word, such as "H!".
With: The complete version, such as "Heroes".
Add Enables you to add Replacement text to the list.
Delete Enables you to delete replacement options, such as the defaults provided in 

Corel VENTURA.



Manage Tag List, Paragraph Tags dialog box
The Paragraph Tags section of the Manage Tag List dialog box enables you to add, delete, 
edit, rename and merge paragraph tags, set hotkeys, save and print style sheet(s).

Dialog Box Options
Tag List

Displays all of the existing paragraph tags for the publication. Clicking the tag name 
selects the tag.

Add Tag
Displays the Add Paragraph Tag dialog box. Create a new tag using this dialog box.

Delete Tag
Displays the Delete Paragraph Tag dialog box. Delete an existing tag using this dialog box.

Rename Tag
Displays the Rename Paragraph Tag dialog box.

Edit Tags
Displays the Paragraph Settings dialog box. 

Edit Ruling Lines
Displays the Ruling Lines dialog box

Merge Tag
Displays the Merge Tag dialog box. Select a style sheet to merge with the current style 
sheet, or, in the case of frame tags, select the chapter containing the tags to merge with 
the current chapter.

Print Style Sheet
Displays the File Save As dialog box. Enter a name for the style sheet with the Generated 
(*.gen) extension in the File Name box.

Save Style Sheet
Displays the Save Style Sheet As dialog box. Enter a name for the new style sheet in the 
File Name box and select Style Sheet (.sty) as the file type.

Set Hotkeys
Displays the Set Hotkeys dialog box. Choose a hot key for the selected tag.



Merge Tags dialog box
The Merge Tags dialog box enables you to combine the tags from other style sheet(s) with 
the document's current style sheet. Frame tags are merged from other chapters.

Dialog Box Options
Tag List
Lists the tags that are in the selected chapter. Click one or more tags; you will be prompted 

whether you want to overwrite tags with the same names. If you 
choose No, the duplicate tag will be added, with its name displayed in 
capital letters. Body text tags cannot be merged.

Select All
Selects all of the tags in the Tag List.
Merge
Merges the tags with the current chapter.



How to...
· Copy paragraph tags
· Work with dialog boxes



Save Style Sheet As dialog box
The Save Style Sheet As dialog box saves the current style sheets with a new or existing 
name. The style sheet is also saved along with the rest of the publication when you choose 
Save or Save As from the File menu.

Dialog Box Options
File Name:

Type a file name. To overwrite an existing file, choose its name from the list. The filename 
precedes the three character extension and can contain up to eight characters.

Drives:
Choose the drive where you want the file stored.

Directories:
Choose the directory where you want the files stored.

List Files of Type:
Choose Style Sheet (*.sty) from the list of file types.



Save Chapter As dialog box
The Save Chapter As dialog box enables you to save the current chapter with a different 
name or in a different location while keeping the original chapter intact. Corel VENTURA 
automatically updates the publication to refer to the new chapter file and not the old one.

Dialog Box Options
File Name:

Type a file name for the chapter.
Drives:

Choose the drive where the chapter is to be stored.
Directories:

Choose the directory where the chapter is to be stored.
List Files of Type:

Choose .CHP from the list of file types.      



Open Style Sheet dialog box
This dialog box is used to select one or more style sheet(s) to merge with the current one.

Dialog Box Options
File Name:

Type a file name. To overwrite an existing file, choose its name from the list. The filename 
precedes the three character extension and can contain up to eight characters.

Drives:
Choose the drive where you want the file stored.

Directories:
Choose the directory where you want the files stored.

List Files of Type:
Choose Style Sheet (*.sty) from the list of file types.



Paragraph Settings dialog box
The Paragraph Settings dialog box has five sections: Character, Alignment, Spacing, Defaults
and Typography.

Dialog Box Options
Character

Click the Character tab to display the Character dialog box.
Alignment

Click the Alignment tab to display the Alignment dialog box.
Spacing

Click the Spacing tab to display the Spacing dialog box.
Defaults

Click the Defaults tab to display the Defaults dialog box.
Typography

Click the Typography tab to display the Typography dialog box.

See also:

Paragraph Text Color dialog box



Add Paragraph Tag dialog box
The Add Paragraph Tag dialog box controls new paragraph tag creation and settings.

Dialog Box Options
Tag Name

Enter the name of the new tag in the Tag Name box.
Copy Attributes From

Choose a tag from the drop-down list box. The new tag uses the attributes of the tag 
selected in this box.

Tag Type
Choose a tag type from the drop-down list box. The tag type classifies the new tag as 
belonging to a specific type of tag. Each tag type has a set of built-in defaults. These 
defaults can be found in the CORELVP.INI. The tag type options are: Undefined, Body Text, 
Heading, List Item (Bullet), Tabbed Text and Table Text. 

Next Tag
Choose a tag from the drop-down list box. The tag selected in this box automatically 
follows the new tag. When you press enter, the next paragraph uses the tag selected in 
this box.



Delete Paragraph Tag dialog box
The Delete Paragraph dialog box is used to delete a selected paragraph tag.

Dialog Box Options
Delete

Choose a tag to delete from the drop-down list box.
Reformat Text As

Applies the selected tag to the text which used the deleted tag. Choose a tag from the 
drop-down list box.



How to...
· Delete paragraph tags
· Work with dialog boxes



Manage Tag List, Frame Tags dialog box
The Frame Tags section of the Manage Tag List dialog box enables you to add, delete, edit, 
rename and merge frame tags.

Dialog Box Options
Tag List

Displays all of the existing paragraph tags for the publication. Clicking the tag name 
selects the tag.

Add Tag
Displays the Add Frame Tag dialog box. Create a new tag using this dialog box.

Delete Tag
Displays the Delete Frame Tag dialog box. Delete an existing tag using this dialog box.

Rename Tag
Displays the Rename Frame Tag dialog box.

Edit Tags
Displays the Frame Settings dialog box. 

Merge Tag
Displays the Open Style Sheet dialog box, used for merging tags. When you choose a style 
sheet to merge with the current style sheet, the Merge Tags dialog box appears. Click one 
or more tags; you will be prompted whether you want to overwrite tags with the same 
names. If you choose No, the duplicate tag will be added, with its name displayed in 
capital letters. Body text tags cannot be merged.



Manage Tag List, Border Tags dialog box
The Border Tags section of the Manage Tag List dialog box enables you to add, delete, edit 
and rename border tags.

Dialog Box Options
Tag List

Displays all of the existing border tags for the current style sheet. Clicking the tag name 
selects the tag.

Add Tag
Displays the Add Border Tag dialog box. Create a new tag using this dialog box.

Delete Tag
Displays the Delete Border Tag dialog box. Delete an existing tag using this dialog box.

Rename Tag
Displays the Rename Border Tag dialog box.

Edit Tags
Displays the Table Settings dialog box. 



Add Border Tag dialog box
The Add Border Tag dialog box creates a new border tag.

Dialog Box Options
Tag Name

Enter the name of the new tag in the Tag Name box.



Delete Border Tag dialog box
The Delete Border dialog box is used to delete a selected border tag.

Dialog Box Options
Delete

Choose a tag to delete from the drop-down list box.
Reformat Text As

Applies the selected tag to the text which used the deleted tag. Choose a tag from the 
drop-down list box.



Rename Border Tag dialog box
The Rename Frame Tag dialog box is used to rename selected frame tags.

Dialog Box 
Options
From

Select the existing frame tag you want to rename.
To

Enter your new frame tag name.



Table Settings dialog box
The Table Settings dialog box has three sections: General, Positioning and Cell Borders.

Dialog Box Options
General

Click the General tab to display the General dialog box.
Positioning

Click the Positioning tab to display the Positioning dialog box.
Cell Borders

Click the Cell Borders tab to display the Cell Borders dialog box.



Manage Overrides dialog box
The Manage Overrides dialog box controls overrides applied to paragraph tags. Overrides 
are settings such as alignment that are not part of the tag. The overrides can be applied 
(saved) to the tag or removed from the paragraph.

Dialog Box Options
Remove Overrides from

Removes attributes overriding the tag for the selected paragraph.
Transfer Overrides to

Applies the overrides to the paragraph tag listed in the drop-down list box.    They are no 
longer considered overrides because they are part of the tag.    All paragraphs using that 
tag will show the attributes selected and transferred using this dialog box.

Paragraph Tag
Used to select a tag to transfer overrides to.    When removing overrides, this box displays 
the tag assigned to the selected paragraph.

Select Attributes
Selects attributes to be applied or removed: All, Alignment, Spacing, Indents, Font, Size, 
Style and Color, Tabs, Drop Cap or Bullet, Breaks and Typography.



How to...
· Apply overrides
· Work with dialog boxes



Override Counter dialog box
The Override Counter dialog box enables you to restart numbering of counters 
independently of the Chapter Settings, Numbering dialog box.

Dialog Box Options
Increment From Last Counter

Starts the numbering beginning with the next number after the last counter ends. If this 
checkbox is enabled, the Starting Number box is not accessible.

Starting Number
Enter the starting number.

Number Style
Choose a numbering style from the drop-down list box.



Files Roll-Up
The Files Roll-Up lists the text and graphics files included in the current chapter.

Roll-Up Options
Files list box
Lists the files that have been loaded into the chapter.

Opens a menu displaying the following commands:
Place in Frame Places the selected file in the current frame.
Load Text File... Opens the Load Text dialog box. Choose a text file to load into the 

current chapter.
Load Graphic File... Opens the Load Graphic dialog box. Choose a graphic file to 

load into the selected frame.
Remove File... Opens the Remove File dialog box. Select a file to remove from the 

chapter or frame.
Rename File... Opens the Rename File dialog box. Choose a file to rename.
Sort Files by The files in the Files list box are sorted according to the options 

selected from the Sort Files by flyout menu. Choose either Name or 
Extension.



Tags Roll-Up
The Tags Roll-Up displays paragraph tags and border tags contained in the style sheet that is
currently loaded and the frame tags in the current chapter. The list also displays each 
paragraph tag's point size and associated hotkey. The roll-up's flyout is accessed by clicking 
the left arrow at the top of the roll-up. This flyout contains tag management functions 
described below.

Roll-Up Options
Tag list box

Displays the tag name, point size and hotkey of existing tags. 

Opens a menu displaying the following commands:
Add Tag... Opens the Add Paragraph Tag dialog box. Create a new paragraph tag 

using this dialog box.
Delete Tag... Opens the Delete Paragraph Tag dialog box. Delete the selected tag in 

the Tag list box.
Rename Tag... Opens the Rename Paragraph Tag dialog box. Rename the selected tag 

in the Tag list box.
Edit Tag... Opens the Paragraph Settings dialog box. Edit the tag selected in the 

Tag list box.
Set Hotkeys... Opens the Set Hotkeys dialog box. Assign or change a hotkey for the 

selected tag in the Tag list box.
Show GeneratedDisplays generated 
Tags tags when enabled.
Sort Tags by Opens the Sort Tags by flyout menu. Choose the sort method from the 

following: Name, Point Size, Hotkey and Tag Type.



Placement Roll-Up
The Placement Roll-Up enables you to place free frames and graphic objects using X and Y 
co-ordinates, change the size of a frame or graphic object using horizontal and vertical 
measurements, rotate and align frames or graphic objects.
Note: The flyout menu commands can be used on either single or multiple frames or 

graphic objects. The options on the roll-up can only be used for a single frame or 
graphic object.

Roll-Up Options

Displays a flyout menu which aligns and sizes single or multiple frames and graphic 
objects. Select one or more frame(s) or graphic object(s) and choose one of the following 
options:
Align... Opens the Align dialog box. 
Same Size All of the objects or frames selected are made the same size as the last 

selected object.
Same Horizontal All of the objects
Size  or frames selected are made the same size horizontally.
Same Vertical All of the objects
Size  or frames selected are made the same size vertically.

Position
Enter a number in the X (horizontal) and the Y (vertical) boxes. The X and Y coordinates 
determine the exact location of the frame on the page. The unit of measurement is chosen
in the Units box.
Note: The Position option only affects a single frame or graphic object.

Size
Enter a number in the H (horizontal) and the V (vertical) boxes. These numbers determine 
the width and length of the frame. Units of measurement is determined in the Units box.
Note: The Size option only affects a single frame or graphic object.

Units
Choose a unit of measurement from the drop-down list box. The options are: inches, 
millimeters, picas, points, points, ciceros, didots, centimeters and pixels.

Rotation
Enter a degree in the box to rotate the frame.
Note: The Rotation option only affects a single frame or graphic object.

Apply
Click Apply to use the entered options.



Quick Format Roll-Up
The Quick Format Roll-Up provides preset formats for formatting tables, paragraphs, ruling 
lines, columns, page layouts, and headers and footers. 

Roll-Up Options
Select Format

Preview window displaying the available presets for the selected type of formatting. Use 
the scroll bars to see all of the presets.

Type list box
Choose a style of formatting from the drop-down list box. The options are: Table, 
Paragraph, Ruling Lines, Columns, Page Layout, Headers and Footers.
Note: For the Page Layout presets that have only frames and those presets that have 
frames included, the frames will only be applied to the selected page and not to all pages 
of your document. 

Apply
Click Apply to apply the selected preset. Shortcut: Double-click the preset shown on the 
roll-up to apply it.
Note: For Table, Rules and Columns, you must have an existing table, rule or column 
before applying the presets. Otherwise, the Apply button is inaccessible.
If you select a Header or Footer preset that contains text, the Header/Footer dialog box 
appears.



Zoom dialog box
The Zoom dialog box enables you to specify a magnification factor for your document.

Dialog Box Options
Zoom Factor

Enter a zoom factor or click the arrow to select one of the preset zoom factors from the 
drop-down list box.

 Zoom In
Magnifies an area of the screen. After clicking the icon, hold down the mouse button and 
drag a box around the area you want to magnify.

 Zoom Out
Zooms out by a factor of two each time you click or returns to the view you were at before 
the last zoom-in.

 Actual Size
Displays the page at the size at which it will print.

 Fit In Window
Adjusts the magnification to display the full page

 Full Width
Adjusts the magnification factor so that the full width of the page is displayed.

 Full Height
Adjusts the magnification factor so that the full height of the page is displayed.



Date and Time dialog box
The Date and Time dialog box provides date and time formats you can insert into your 
document. As well, you can create custom date and time formats.

Dialog Box Options
Available Formats

List of date and time formats. Click on the format to select it.
Language

Choose the language for the date and time from the drop-down list box.
Update Every Time

If enabled, the date and time is updated each time you open your document.
Custom

When clicked, this button opens the Custom Format section of the dialog box.
Custom Format

Enables you to enter and save a custom date and time. 



Insert Special Item command
Choose this command to insert one of the following:
Character Opens the Character Set Roll-Up
Footnote Inserts a footnote when the Enable Footnotes command is turned on 

in the Layout menu. 
See also Working with footnotes and Displaying, inserting and editing
footnotes

Equation... Opens the Equation Editor. Press F1 for Online Help with the Equation
Editor open.

Frame Anchor... Opens the Insert Frame Anchor dialog box
Cross Reference... Opens the Insert Cross Reference dialog box
Marker... Opens the Marker Name dialog box
Variable Marker... Opens the Insert Variable Marker dialog box
Date and Time... Opens the Date and Time dialog box
The Insert Special Item command inserts special items, whose codes are visible in Copy 
Editor view, at the cursor point. 
Note: Equations, cross references, markers and variable markers must be edited using the 
Edit Special Item command.



Cell Color dialog box topic can be found in COLORDBS.RTF. 



How to...
· Apply color to cells
· Work with dialog boxes



Preferences, View dialog box
The View dialog box controls how the Corel VENTURA screen looks. 

Dialog Box Options
Toolbox

Displays the Toolbox. When checked, the Toolbox is visible. You can check Float Toolbox 
checkbox only if you have checked Toolbox. The toolbox will then be freely moveable.

Ribbon Bar
Enables/Disables the Ribbon Bar. When checked, the Ribbon Bar is visible.

Rulers
Enables/Disables the rulers. When checked, the rulers are visible.

Grid
Enables/Disables the grid. When checked, the grid is visible.

Status Line
Enables/Disables the status line. When checked, the status line is visible.

Tabs and Returns
Enables/Disables tab and returns symbols. When checked, tabs and returns are visible.

Column Guides
Enables/Disables column guides. When checked, the column guides are visible.

Loose Lines
Enables/Disables loose lines. When checked, the loose lines are visible.

Generated Tags
Enables/Disables generated tags. When checked, generated tags are visible.

Pop-Up Help
Displays Pop-Up Help when the pointer rests over the Toolbox or Ribbon Bars. 

Enable Tagged Cursor
Displays the insertion point with a tag symbol.

Greek Text Below
Enter a pixel size to determine the size at which greeked text is displayed. Greeked text is 
displayed as horizontal lines rather than the individual characters. This speeds up the time
required to redraw the screen. All text with a lower pixel size than the one entered in this 
box will appear as greeked text.

Preview Colors
Choose either the 256 Color Dithering radio button or the Windows Dithering radio 
button. The display of color on your screen is determined by the dithering method chosen.



Preferences, Text dialog box
This dialog box controls the Copy Editor and Paragraph & Text memory.

Dialog Box Options
Copy Editor

Controls the following options for the Copy Editor:
Default Tab Every: Sets the intervals for default tabs. Enter a number in the box. Set the 

units of measure in the box beside the Default Tab Every. The options 
are: centimeters, inches, millimeters, picas, points, points, didots and
ciceros.

Tag Column Width:Sets the width of the column which displays all of the tag names for 
the file.

Font: Displays the current font. Click Change to open the Font dialog box. 
Choose a font and font size.

Show Codes: When checked, displays all of the codes (e.g., bold, underline).
Paragraph & Text Memory

This portion of the dialog box is to be used only if you have received an Out of Text 
Memory error message. If you have received this error message, increase the value in the 
Requested box marginally. That is, start with a small increase and then restart to see if the 
problem is solved. If not, continue with small increases until you no longer receive the 
error message.
Note: The value in the Requested box must be increased in increments of 16.

PANOSE Font Matching
Click to open the PANOSE   Font Matching Preferences   dialog box, where you set PANOSE Font
Matching preferences. When you open Corel VENTURA files from other systems, PANOSE 
font matching matches missing fonts with similar fonts available on your system. PANOSE 
font matching also occurs when you import text or graphic formats that support text.



Font dialog box
The Font dialog box enables you to choose the default font for the Copy Editor. 

Dialog Box Options
Font

Enter the name of the font or choose a font from the drop-down list box. The fonts 
displayed in the list box are the ones that have been loaded on your system.

Size
Enter a font size or choose a font size from the drop-down list box.

Sample
Preview window displays a sample of the selected font.



PANOSE Font Matching Preferences
PANOSE font matching matches missing fonts with similar fonts available on your system. 
PANOSE font matching also occurs when you import text or graphic formats that support text.

Dialog Box Options
Allow font matching

Enables font matching. Font matching occurs when you open a Corel VENTURA file from 
another user and when you import text or a graphics file that supports text.

Show mapping results
When you open a Corel VENTURA file from another user and you do not have the required 
font, the PANOSE Font Matching dialog box will open. The missing fonts will be listed along 
with a Substituted font suggestion. You can add or edit the suggested Substituted font list 
using the Add and Edit buttons. 
Mapping results are not shown when you import text or a graphic format that supports 
text.
Note: If you do change font mapping to something other than what the program offers as 
an alternative, save the override as an exception by choosing Yes in the resulting Save 
Changes dialog box. If you do not save your changes, whenever you perform any operation
affecting the entire publication, such as renumbering, going to another chapter, 
generating a Table of Contents or printing, the exception will be lost.

Substitution tolerance
Move the slider to the left to make the font substitution tolerance more exact. Moving the 
slider to the right makes font substitution easier for your system but less exact.

Default font
This is a user-definable default font. If PANOSE font matching cannot find a reasonable 
facsimile of the missing font, it substitutes the default font that you specify here.

Spellings
Click to open the Alternate Spellings dialog box, which enables you to match fonts that 
may be the same but are spelled differently. (This is quite common when opening 
Macintosh files in Windows.) Add, Remove or Edit the list from this dialog box.

Exceptions
Click this button to open the Font Matching Exceptions dialog box, where you can specify a
font substitution by editing the file list in this dialog box. This is handy when you have to 
do global font replacements. Add, Remove or Edit the list from this dialog box.



Alternate Spellings dialog box
This dialog box enables you to match fonts that may be the same but whose names are 
spelled differently.

Dialog Box Options
Windows name

Displays the Windows name for the font.
Macintosh name

Displays the Macintosh name for the font.
Add

Enables you to add a font name to the alternate spellings list. Click Add. The Add Alternate
Spelling dialog box opens.

Edit
Enables you to edit a font name in the alternate spellings list. Select the font name and 
click Edit. The Edit Alternate Spelling dialog box opens.

Remove
Removes the selected font from the font list.



Add Alternate Spelling dialog box
Adds an alternate font name to the Alternate Spellings dialog box.

Dialog Box Options
Windows name

Enter the name of the Windows name for the font.
Macintosh name

Enter the name of the Macintosh name for the font.



Edit Alternate Spelling dialog box
Edits an alternate font name in the Alternate Spellings dialog box.

Dialog Box Options
Windows name

Enter the name of the Windows name for the font.
Macintosh name

Enter the name of the Macintosh name for the font.



PANOSE Font Matching Exceptions dialog box
This dialog box enables you to specify a font substitution by editing the file list. This is handy
when you have to do global font replacements. This dialog box enables you to match fonts 
that may be the same but are spelled differently.

Dialog Box Options
Missing font

Displays the fonts missed by the Panose Font Matching process.
Substituted font

Displays a list of the fonts replaced by the Panose Font Matching process.
Add

Enables you to add a font name to the exceptions list. Click Add. The Add Matching 
exception dialog box opens.

Edit
Enables you to edit a font name in the exceptions list. Select the font name and click Edit. 
The Edit Matching Exception dialog box opens.

Remove
Removes the selected font from the exceptions list.



Add Matching Exception dialog box
This dialog box adds to the exception list.

Dialog Box Options
Missing font

Enter the name of the missing font.
Substituted font

Enter the name of the substituted font.



Edit Matching Exceptions dialog box
This dialog box enables you to edit fonts in the PANOSE Font Matching Exceptions dialog 
box.

Dialog Box Options
Missing font

Enter the name of the missing font.
Substituted font

Enter the name of the substituted font.



Set Ruler dialog box
The Set Ruler dialog box controls the origin (location of zero points) and the horizontal and 
vertical units displayed on the ruler.

Dialog Box Options
Horizontal Units

Choose the horizontal units from the drop-down list box. The options are: centimeters, 
inches, millimeters, picas, points, points, didots and ciceros.
Changes made to this field will not display unless Ruler is checked in the Preferences, 
General dialog box, 

Vertical Units
Choose the vertical units from the drop-down list box. The options are: centimeters, 
inches, millimeters, picas, points, points, didots and ciceros.
Changes made to this field will not display unless Ruler is checked in the Preferences, 
General dialog box, 

Ruler Origin
Determines the position of 0 on the vertical and horizontal axis. Enter a number in the 
Horizontal and Vertical boxes. Choose a unit of measure from the drop-down list box. The 
options are: centimeters, inches, millimeters, picas, points, points, ciceros, didots and 
ciceros. 
Note: The Ruler Origin can interactively be set by pressing and dragging the intersecting 
corner of the both rulers onto the page. Double-clicking the intersection resets the zero 
point on both ruler to the top left corner of the page.



Table of Contents & Index
This dialog box enables you to create and generate indexes and table of contents.

Dialog Box Options
Table of Contents

Click on the Table of Contents tab to open the Table of Contents dialog box.
Index

Click on the Index tab to open the Index dialog box.



How to...
· Insert a new table
· Add rows or columns
· Merge and split cells
· Apply color to cells
· Set the width and position of a table
· Create custom cell borders
· Change cell borders
· Resize columns
· Work with dialog boxes



Table of Contents & Index dialog box, Table of Contents tab
This dialog box creates and generates tables of contents.

Dialog Box Options
# of Levels

Enter the number of levels for the table of contents. 
Title

Enter the title of the table of contents.
Level

Choose each of the levels you have specified in the # of Levels box and specify a 
reference tag and a number format.

Reference Tag
Choose a paragraph tag from the drop-down list box for each level in the table of contents.

Preset Formats
Choose a numbering format for each of the levels in the table of contents.

Table of Contents Text
Edit the formatting designated in the Reference Tag and Numbers boxes. You can directly 
type in the text box or you can use the following icons:

Inserts a chapter number code (C#).

Inserts a page number code (P#).

Opens the Selected Text Attributes dialog box. Select attributes for the text.

Inserts a tab code.
Generate

Generates the table of contents. Opens the File Save As dialog box. The default extension 
of the file is *.gen. Give the file a name and click OK. The table of contents is generated.



Table of Contents & Index dialog box, Index tab
The Index dialog box formats and generates indexes.

Dialog Box Options
Title

Enter the title of the index in the text box.
Delimiter

Delimiters are used to separate index entries. For example, in the index entry "[C#],[P#]" 
a comma delimiter would separate Chapter and Page number codes. Choose one of the 
following options from the drop-down list box: comma (,), hyphen (-), forward slash (/), 
Space and Tab.

Preset Formats
Choose a numbering format from the drop-down list box. The options are: [P#], [C#] [P#], 
Chp [C#],Pg [P#], Pg [C#] [P#] and Pg [P#].
You can also choose a numbering format using the following icons:

Inserts a chapter number code [C#].
Inserts a page number code [P#].
Opens the Selected Text Attributes dialog box. Select 

attributes for the text.

Inserts a tab code (Note: Tabs do not work with full-justification turned on).
Index Text

Enter any additional text after the number. For example, you can add a period after the 
page number. 
You can use the Tab icon and the Text icon in the Additional Text box:

Cross-Reference Prefix
Works in conjunction with the Index Entries Roll-Up. You can change the text for the See 
and See Also options in the Type of Entry drop-down list box of the Index Entries Roll-Up 
using the See and See Also boxes in the Index dialog box. For example, you can change 
See to Look under. 
You can use the Tab and Text icons in the Cross-Reference boxes.

Letter Headings
When checked, each letter of the alphabet becomes a heading for the corresponding part 
of the index.

Generate
Generates the index. Opens the File Save As dialog box. The default extension of the file is 
*.gen. Give the file a name and click OK. The index is generated.



How to
· Create an index
· Delete an index entry
· Change the order of entries in an index
· Generate an index
· Add an index file to your document
· Edit index entries
· Update an index
· Create a table of contents
· Add a table of contents file to your document
· Update a table of contents



Manage Tag List dialog box
The Manage Tag List dialog box controls paragraph tags, frame tags and border tags. The 
dialog box is divided into three separate sections called Paragraph Tags, Frame Tags and 
Border Tags which you access by clicking on the appropriate tab.

Dialog Box Options
Paragraph Tags

Opens the Paragraph Tags dialog box. This dialog box enables you to add, delete, rename, 
edit and merge paragraph tags and print and save style sheet(s).

Frame Tags
Opens the Frame Tags dialog box. This dialog box enables you to add, delete, rename, edit 
and merge frame tags.

Border Tags
Opens the Border Tags dialog box. This dialog box enables you to add, delete, rename and 
edit border tags.



Chapter Settings dialog box
The Chapter Settings dialog box controls chapter settings for layout, headers and footers, 
footnotes, numbering and typography. Click the appropriate tab to see the dialog box.

Dialog Box Options
Layout

Opens the Layout dialog box. This dialog box controls the layout of the chapter: page size, 
single or double-sided and which side the chapter starts on.

Header/Footer
Opens the Header/Footer dialog box. This dialog box enables you to create and format 
headers and footers.

Footnotes
Opens the Footnotes dialog box. This dialog box enables you to create and format 
footnotes.

Numbering
Opens the Numbering dialog box. This dialog box is used to set and apply numbering for 
chapters, pages, figures and tables.

Typography
Opens the Typography dialog box. This dialog box controls widows, orphans, column 
balance, pair kerning, first baseline and vertical justification.



Change Link dialog box
Use this dialog box to change the source of existing linked objects.

Dialog Box Options
File Name

Type the name of the new file with the object you want to link.
The file name precedes the extension and can contain up to eight characters.

List Files of Type
Use to select the application with the changed link if different from the original.

Directories
Use to select the directory in which you want the files stored.

Drives
Use to select the drive in which you want the file stored.



How to...
· Change a link
· Work with dialog boxes



Publication Manager, Find Files dialog box
The Find Files dialog box enables you to locate specific files or files of the same type, e.g., 
chapter files.

Dialog Box Options
Find

Enter the file name or click the arrow to display file extensions. If you select an extension, 
all of the files with that extension in the directories chosen in the Scan Directories dialog 
box are displayed in the Component Files list of the File Operations dialog box.



Header/Footer Text
This dialog box appears when you select a header or footer preset that includes text in the 
Quick Format Roll-Up.    It is used to change the text that appears in headers / footers and 
the default header / footer text.

Dialog Box Options
First Line

Used to type the text which is to appear on the first line of the header or footer.
Second Line

Used to type the text which is to appear on the second line of the header or footer.
Use As Defaults

Check box for setting the text that is to appear as header / footer by default.    If the option
is checked, the text displayed in the First    and Second Line boxes will appear in this box 
the next time you choose a header or footer that includes text in the Quick Format Roll-Up. 
You may then type over that text if you do not wish to use the default header / footer.



Import dialog box
Enables the import of graphic files as fill patterns in Corel VENTURA.

Dialog Box Options
File Name

Type the name of the file you want to import, or select it from the list. To list a different 
type of file, choose the type from the List Files of Type box.

Directories
Select the directory in which the file you want to import is stored.

Drives
Select the drive in which the file you want to open is stored.

List Files of Type
Use to select the type of file you want to import. 

Filter Information...
Displays the developer and version number of the filter used to import the selected file 
type.

Preview
Check box used to display the selected file in the preview window.

Image size list
Lists options for modifying the size and resolution of an image file when loading it as a fill 
pattern. You can open the image at its Full Size, Crop it or even Resample it. 



Crop Image dialog box
The Crop Image dialog box enables you to crop an image before loading it as a fill pattern. 
The cropping is permanent and reduces the size of the image.

Dialog Box Options:
Preview Window

Displays the entire image with a bounding box. Move the nodes on the bounding box to 
crop the image. Use the Hand cursor to move the bounding box to a specific area of the 
image.

Units
Choose the units of measurement.

Max
Click to select entire image or to resize the bounding box to cover the entire area and 
reselect the cropped area.

Top
Enter a number or use the scroll arrows to position the top of the cropped area.

Left
Enter a number or use the scroll arrows to position the left side of the cropped area.

Width
Enter a number or use the scroll arrows to select the width of the cropped area.

Height
Enter a number or use the scroll arrows to select the height of the cropped area.

New Image Size
Displays the size of the cropped image.



Resample dialog box
The Resample dialog box resizes an image and creates a new file. The Resample option on 
the Import dialog box only resamples to a smaller size.

Dialog Box Options
Units

Choose a unit of measurement from the drop-down list box.
Width

Enter a number or use the scroll arrows to choose a number or enter a percentage in the 
% box. If a number is entered in the first box, the % box reflects the change and vice 
versa. You can enter either a number or percentage but not both.

Height
Enter a number or use the scroll arrows to choose a number or enter a percentage in the 
% box. If a number is entered in the first box, the % box reflects the change and vice 
versa. You can enter either a number or percentage but not both.

Horizontal
Enter a resolution. The maximum is 300 dots per inch.

Vertical
Enter a resolution. The maximum is 300 dots per inch.

Identical Values
When checked, the Horizontal and Vertical resolutions are always equal.

Original Image Size
Displays the size of the original image.

New Image Size
Displays the size of the resampled version.



Delete Table dialog box
This dialog box enables you to delete selected row(s), column(s) or table using the delete 
key. 

Dialog Box Options:
Row(s)

Deletes the selected row(s).
Column(s)

Deletes the selected column(s).
Table

Deletes the selected table.



Insert Column dialog box
The Insert Column dialog box inserts column(s) into the current table.

Dialog Box Options:
Number

Enter the number of the columns to insert. The maximum number is 32.
Before

Inserts the column(s) before the selected cell.
After

Inserts the column(s) after the selected cell.



Insert Row dialog box
The Insert Row dialog box inserts row(s) into the current table.

Dialog Box Options:
Number

Enter the number of the rows to insert. The maximum number is 32,000+.
Before

Inserts the row(s) before the selected cell.
After

Inserts the row(s) after the selected cell.



Insert Row/Column dialog box
The Insert Row/Column dialog box inserts row(s) or column(s) into the current table. If you 
choose the Insert Row command from the Table menu, the Insert Row dialog box opens. If 
you choose Insert Column from the Table menu, the Insert Column dialog box opens.

Dialog Box Options:
Number

Enter the number of the rows or columns to insert. The maximum number of rows is 
32,000+ and the maximum number of columns is 32.

Before
Inserts the row(s) or column(s) before the cell in which the cursor is located.

After
Inserts the row(s) or column(s) after the cell in which the cursor is located.



System Info dialog box
Use System Info to display information about your system, display, network, printing, Corel 
EXEs & dlls and system DLLs.

Dialog Box Options
Choose a category

Choose a category from the drop-down list box. The categories are: System, Display, 
network, printing, Corel EXEs and DLLs and system DLLs.

List box
Displays the system information for the chosen category.
System: information about your computer. For example, Windows version, DOS version, 
processor, and so on.
Display: information about your monitor. For example, driver, driver version, and so forth.
Network: information about the network. For example, drivers, whether a network is 
installed, and so forth.
Printing: information about installed printers.
Corel EXEs and DLLs: lists all of the Corel EXEs and DLLs.
System DLLs: lists all of the system DLLs.

Save
Saves all of the selected category's details to a predefined file.



Re-Link Ventura File Paths dialog box
The Re-Link Ventura File Paths dialog box appears when you choose CVPFIX from the Tool 
menu's Extensions flyout. CVPFIX enables you to remap Corel VENTURA's links for chapter 
and publication files when the files have been moved to a new location using Windows or 
DOS copy commands. See also Copying and moving files, chapters and publications

Dialog Box Options:
File Name

Double-click the name from the list or type the name in the File Name box. You can select 
multiple chapter or publication files by holding the Ctrl key and clicking individual files or 
holding the Shift key and selecting the first and last files in a group.

Drives
Choose the drive where the file is stored.

Directories
Choose the directory where the file is stored.

List Files of Type
Choose the type of file to remap. Only publication and chapter files require remapping.

Network
Opens the Connect Network Drive dialog box where you can connect to a shared directory. 
This option appears in dialog boxes only when you have Windows for Workgroups installed 
on your computer.

Note: CVPFIX is a small application and behaves the same way as other Windows 
applications. You may leave CVPFIX open and work in other dialog boxes, leave it open when
you close VENTURA, create a program icon for it, or launch it from the File Manager (when 
Corel VENTURA is running).



About Corel VENTURA 5.0 dialog box
The About Corel VENTURA 5.0 dialog box displays information on which version of Corel 
VENTURA is running, registration and the amount of space available on the drive last used to
save or open a file.
Clicking the System Info button opens the System Info dialog box.



Undo command (Edit menu)
The Undo command reverses the last operation you performed.



How to...
· Undo operations



Redo command (Edit menu)
The Redo command reverses the Undo command and reapplies the last operation.



Cut command (Edit menu)
The Cut command removes the selected text, frame or graphic object and places it on the 
Clipboard.



How to...
· Cut and copy objects using the Clipboard
· Cut, copy, paste and delete objects
· Cut text
· Cut frames
· Cut graphics objects



Copy command (Edit menu)
The Copy command copies the selected text, frame or graphic object to the Clipboard.



How to...
· Cut and copy objects using the Clipboard
· Cut, copy, paste and delete objects
· Copy text
· Copy frames
· Copy graphics
· Copy between publications



Paste command (Edit menu)
The Paste command pastes a copied or cut graphic or text item onto the current page.



How to...
· Paste text
· Paste frames
· Paste graphics
· Paste ASCII text
· Paste bitmap and metafile
· Paste objects



Paste Special command (Edit menu)
Opens the Paste Special dialog box.
The Paste Special command pastes a linked or embedded object onto the current page. If 
the object is embedded, it is pasted into the chapter, but retains its application identity. If 
the object is linked, it retains its identity and can be updated in the originating application 
with the results reflected in the linked object.



How to...
· Paste an embedded object from the source application
· Link an object from the source application
· OLE Objects - Limitations on transformations and effects



Delete command (Edit menu)
The Delete command removes the selected text, frame or graphic object. The Paste 
command cannot be used to paste the deleted object.



How to...
· Delete text, frames and graphics



Find & Replace command (Edit menu)
Opens the Find and Replace dialog box.
This command searches for specified text, paragraph tags or special items (e.g., index 
entries, cross references, markers, variable definitions). It also allows you to replace the 
found text or tag with different ones.



How to...
· Find and replace text and text attributes
· Find and replace paragraph tags
· Find and replace special items
· Work with dialog boxes



Insert Special Item command (Edit menu)
Opens the dialog box or inserts the item corresponding to your selection:
Character Opens the Character Roll-Up
Footnote Inserts a footnote. Note: To display footnotes, choose Enable 

Footnotes command in the Layout menu.
See also Specifying footnote settings and Displaying, inserting and 
editing footnotes

Equation... Opens the Corel Equation Editor. Press F1 with the Equation Editor 
open for Online Help.

Frame Anchor... Opens the Insert Frame Anchor dialog box
Cross Reference... Opens the Insert Cross Reference dialog box
Index Entry... Opens the Index Entries Roll-Up
Marker... Opens the Marker Name dialog box
Variable Marker... Opens the Insert Variable Marker dialog box
Date and Time... Opens the Date and Time dialog box
The Insert Special Item command inserts special items, whose codes are visible in Copy 
Editor view, at the insertion point. 
Note: Equations, cross references, markers and variable markers are edited using the Edit 
Special Item command.



How to...
· Insert Special Items
· Edit Special Items



Edit Special Item command (Edit menu)
The Edit Special Item command edits the following special items that cannot be edited in 
text mode:    Equations, cross references, markers and variable markers. VENTURA's other 
Special Items--special characters, footnotes, frame anchors and date and time codes--are 
edited in text mode. Note that when you place the cursor to the left of a Special Item, its 
name appears on the right side of the Status Line.



Define Variables command (Edit menu)
Opens the Variable Definitions dialog box.
This command is used to specify the text which is to be inserted at all locations of a variable 
marker and update the entire document accordingly.



Insert Object command (Edit menu)
Opens the Insert Object dialog box.
This command inserts an OLE object created in another application into the current chapter. 
The object can be linked or embedded.
See also Editing CorelDRAW 3 and 4 OLE objects in Corel VENTURA 5 documents.



How to...
· Work with other applications:    Overview
· Embed new objects from within Corel VENTURA
· Create a link from Corel VENTURA
· OLE Objects--Limitations on transformations and effects



Editing CorelDRAW 3 and 4 OLE objects in Corel VENTURA 5 
documents
Editing CorelDRAW objects brought in a Corel VENTURA 5 document through OLE is done 
automatically in CorelDRAW 5 regardless of the CorelDRAW version used to create the 
object. CorelDRAW 5 appends the Corel Presentation Exchange data (CMX) to the OLE 
object's file.
CorelDRAW 5 must therefore be installed on your system in order to edit a CorelDRAW 3 or 4 
object embedded or linked in a document loaded in Corel VENTURA 5. If you have an earlier 
version of CorelDRAW installed, the object cannot be edited from within Corel VENTURA 5. It 
will however display and print properly from Corel VENTURA 5. 



Object command (Edit menu)
The Object command is available only when an OLE object is selected. The name of the 
command changes to show the name of the OLE server application used to create the 
object. When the selected OLE object is linked, the word "Link" precedes the application 
name.
Choosing the command displays a flyout menu which lists commands provided by the OLE 
server. For example, if you have a Paintbrush object, the commands on the flyout are Edit 
and Convert or if you have a Microsoft Excel 5.0 object, the command are Add, Edit and 
Convert.
Edit opens the application in which the selected embedded object or linked object was 
created allowing you to make changes to it. Convert opens the Convert dialog box.

See also:
Editing CorelDRAW 3 and 4 OLE objects in Corel VENTURA 5 documents.



How to...
· Work with Other Applications:    Overview
· Edit a linked object from Corel VENTURA
· OLE Objects--Limitations on transformations and effects



Links command (Edit menu)
Opens the Links dialog box.
This command lists linked objects in the current chapter and allows you to change, update 
and break them.



How to...
· Work with other applications:    Overview
· Update Links automatically
· Update links manually
· Jump from a destination file to its source file
· Change a link
· Break a link



Exporting to different word processor formats
Using the Rename File command in the File menu, you can save text in a format used by 
various word processors and spreadsheets. When you select a frame containing text and 
choose Rename File from the File menu, the File Type/Rename dialog box opens. Use this 
dialog box to specify one of the following types of formats to save the text file to:
· Ami Professional 2.0, 3.0, (*.sam)
· ANSI Text (*.*)
· ASCII Text (*.txt)
· ASCII Text, 8-bit, (*.txt)
· Corel VENTURA Generated File (*.gen)
· MS Excel for Windows 3.0, 4.0 (*.xls)
· Lotus 123 1A, 2.0 (*.wk?)
· Lotus 123 3.0 (*.wk?)
· Lotus/Excel Print Table (*.prn)
· Microsoft Rich Text Format (*.rtf)
· MS Word for Windows 2.x (*.doc, *.*)
· MS Word for Windows 1.x (*.*)
· MS Word 5.0, 5.5 (*.*)
· MS Word for Macintosh 5.0 (*.*)
· MS Word for Macintosh 4.0 (*.*)
· WordPerfect 5.1 (*.wp, *.*)
· WordPerfect 5.0 (*.*)
· WordStar 3.31, 3.3, 3.45, 4.0, 5.0, 5.5, 6.0, 7.0
· Xywrite III, III Plus, IV, Windows 1.0
For more information on exporting text to different word processor formats, see Using text 
from other programs.



New command (File menu)
Opens the New Publication dialog box.
The New command creates a new publication.



How to...
· Create a publication
· Work with dialog boxes



Open command (File menu)
Opens the File Open dialog box.
The Open command opens an existing publication or chapter.

See also:
Opening VENTURA 4.2 chapters that include Ami Professional files.



Save command (File menu)
Saves the current publication using its name and current location. 
When used for saving a new publication for the first time, this command opens the Save As 
dialog box to assign a name and choose a location for the file. If you have enabled Verbose 
Save in the Preferences, General dialog box, you are prompted for a name for the 
publication, chapter and style sheet. 
To back up your work, use Make Backup on Save from the Preferences, General dialog box. 
When checked, a backup file is created when you save. Backups are made of publication 
(PUB), chapter (CHP), style sheet (STY) and Text (TXT) files. They have the same name as 
the original file, but with a dollar sign ($) substituted for the first letter of the extension. 
Refer to Chapter 21 of Corel VENTURA's User Manual, General Preferences, for information 
on using backups.
Note: The Revert to Saved command has been dropped from Corel VENTURA 5.0. You can 
return to a previously saved version of your file by closing the current chapter without 
saving and then reopening the chapter. To avoid data loss, try to save your work frequently 
and especially before trying advanced functions you are unfamiliar with. 

See also:
Setting General Preferences



Save As command (File menu)
Opens the File Save As dialog box.
The Save As command saves the current Publication under a new name or in a different 
location. If you have enabled Verbose Save in the Preferences, General dialog box, you are 
prompted for a name for the publication, chapter and style sheet.
To back up your work, use Make Backup on Save from the Preferences, General dialog box. 
When checked, a backup file is created when you save. Backups are made of publication 
(PUB), chapter (CHP), style sheet (STY) and Text (TXT) files. They have the same name as 
the original file, but with a dollar sign ($) substituted for the first letter of the extension. 
Refer to Chapter 21 of Corel VENTURA's User Manual, General Preferences, for information 
on using backups.
Note:    You must use the Rename File command if you want to rename only the current text 
file.

See also:
Setting general preferences



Load Text command (File menu)
Opens the Load Text dialog box which lists supported text file formats.
This command is used for importing text files from work processors such as Microsoft Word 
and WordPerfect as well as ASCII, RTF (rich text format) and other text file formats listed in 
the Load Text dialog box.



How to...
· Load text
· Use text from other programs
· Work with dialog boxes



Load Graphic command (File menu)
Opens the Load Graphic dialog box which lists all supported graphic file formats.
This command is used for importing graphic files of various formats into the current chapter.



How to...
· Load graphics
· Work with dialog boxes



Remove File command (File menu)
Opens the Remove File dialog box.
Enables you to remove imported graphics and text files from either their frames or from the 
current chapter.



How to...
· Remove text files
· Work with dialog boxes



Rename File command (File menu)
Opens the Rename File dialog box.
Saves any text within a chapter with a new file name or exports to a new file format if 
needed. 
See also Exporting to different word processor formats
Note: Pending the release of the appropriate export filter, Corel VENTURA saves Microsoft 
Word for Windows 6.0 files in Word for Windows 2.0 format. When you return to Word for 
Windows 6.0 to resave files saved earlier in Corel VENTURA, a prompt will appear stating 
that the file was last saved in Word 2.0. You may then save the file in either Word format.



Mosaic Roll-Up command (File menu)
Displays the Corel MOSAIC Roll-Up for importing files using drag and drop and visually 
managing graphic files.



How to...
· Open collections
· Resize the Mosaic roll-up window
· Open files using drag and drop
· Move/copy files between collections
· Use roll-up windows



Publication Manager command
(File menu)
Opens the Publication Manager dialog box and displays the Files Operations tab. 
This dialog box enables you to list publications found in scanned directories, determine 
which directories are to be scanned, sort chapters within publications, show files grouped by 
type, display file information, add chapters to a publication, remove chapters from a 
publication, renumber a publication, copy publications, move publications, delete 
publications and save file information as a text file.
Note:    The Publication Manager temporarily closes your current document to perform its 
work. 



How to...
· Scan your system for publications and chapters
· List files in the Publication Manager dialog box
· View and save file information
· Add existing chapters to a publication
· Remove chapters from a publication
· Change the order of chapters in a publication
· Renumber a publication
· Copy and move files, chapters and publications
· Delete files, chapters and publications
· Find files
· Work with dialog boxes



Print command (File Menu)
Opens the Print dialog box. Prints the publications, current chapter, page or range of pages, 
according to the options you specify. 



How to...
·    Print a document
·    Choose a default printer
·    Set up the active printer
·    Print a document to disk
·    Position the document before printing
·    Size the document before printing
·    Print documents larger than the printer's paper size
·    Download fonts before printing
·    Specify the number of stripes used to print fountain fills
·    Print color separations
·    Print Spot colors as separations
·    Work with dialog boxes



Print Setup command (File menu)
Opens the Print Setup dialog box. Use this command to select the printer and printer 
options.



How to...
· Choose a default printer
· Set up the active printer
· Work with dialog boxes



Print Publication command (File menu)
Use Print Publication to print your entire document. Choosing Print Publication displays the 
Print dialog box with the Chapter, Current Page and Pages options disabled. 
Print Publication--which replaces the print function of VENTURA 4.2's Manage Publication 
command--is disabled until you save a new publication. If you choose Print Publication 
before saving, VENTURA prompts you to save before continuing with the print job.



How to...
·    Print a document
·    Work with dialog boxes



Color Manager command (File menu)
Opens the System Color Profile dialog box.
The Color Manager command enables you to calibrate your system (monitor, printer and 
scanner). 



How to...
·    Work with basic System Profiles
·    Use advanced calibration features
·    Work with dialog boxes



Exit command (File menu)
Closes Corel VENTURA



How to...
·    Start and exit Corel VENTURA
·    Work with dialog boxes



1, 2, 3, 4 command (File menu)
Displays the file names of the last four publications opened. To open the file, type the 
number that corresponds with the file that you want to open or close the file's name from 
the File menu.





Outline tool flyout 
The following describes the Outline tool flyout menu options.

Menu Icons

Outline Pen 
Opens the Outline Pen dialog box where you can enter a custom value for the outline 
thickness, choose an outline color, a dashed or dotted line style, arrowheads and other 
special effects.

Pen Roll-up 
Opens the Pen Roll-up, for quick access to various outline attributes. See Outline Pen Roll-
Up

None    
Removes outlines from the selected graphic object(s). 

Line Widths 
Selects line thicknesses ranging from 1/4 (hairline), 3, 5, 7, and 9 points.

Outline Color Dialog Box    
Opens the Outline Color dialog box to choose or create colors to be applied to the outline.

White, Black, Gray    
Offers white, black and successive shades of gray for the outline color.



How to...
· Apply outlines and fills
· Set default outline and fill attributes
· Work with dialog boxes



Color Models
Corel VENTURA provides three different color models for creating process colors: CMYK (cyan,
magenta, yellow, black), RGB (red, green, blue) or HSB (hue, saturation, brightness).
You can create colors using the model you are most comfortable with. If you are going to 
produce color separations, Corel VENTURA will convert any RGB and HSB colors into their 
CMYK equivalents. The conversion will not be exact, however, since the RGB and HSB models 
create color in a fundamentally different way than the CMYK model.
CMYK Model
The CMYK model, as its name suggests, is based on the colors of the inks used in four-color 
printing. By combining percentages of cyan, magenta, yellow and black, you can reproduce 
virtually any color you want.
The advantage of the CMYK model is that you can specify your colors using CMYK color 
reference charts and be reasonably certain of what the colors will look like when printed. No 
such charts exist for specifying colors with the RGB and HSB models.
When you use the Visual Selector to specify colors, Corel VENTURA automatically adjusts the
amount of black through a process called Gray Component Replacement (GCR). If you are 
specifying colors numerically, you must do the gray replacement yourself by entering 
appropriate percentages of black. 
If your document contains large areas of black, you will want to override the GCR process 
and increase the percentages of cyan, magenta and yellow. Doing this makes the blacks look
much darker. Ask your printer or service bureau for advice on the exact percentages you 
should use.
RGB Model
The RGB color model uses percentages of red, green and blue to create colors. Each 
component has 100 levels of intensity, ranging from black to the component's full intensity. 
Thus, to produce pure red for example, set Red to 100 and Green and Blue to 0. Similarly, 
set Green to 100 and the others to 0 to produce pure green. To produce a dark but pure 
shade of one of the three, lower its setting while leaving the others at 0.
White is produced by setting all three components to 100. Setting them all to 0 produces 
black. Equal amounts of each produces varying shades of gray.
HSB Model
The HSB model, creates color by varying three parameters: hue, saturation and brightness. 
Hue refers to the quality which makes a particular color different from another. Blue, red, 
and green, for example, are all hues. Saturation refers to the purity or intensity of a color. By
varying the intensity, you can make the color lighter or darker. Brightness refers to the 
percentage of black in a color, where 0 percent is black and 100 percent is white.



Open Palette dialog box
Use this dialog box to load different Process color palettes supplied with Corel VENTURA as 
well as ones you have modified and saved with the Save Palette As command.

· The default process color palette, loaded when you first installed Corel VENTURA, is 
the CORELDRW.PAL palette. Another palette with the same colors, PURE99.PAL, is 
provided as a backup to the default one.

· The TRUMATCH palette is used to specify Process colors using the TRUMATCH Swatching
System. By using this palette along with a TRUMATCH color reference book, you can be
reasonably certain how the colors will look when printed. A similar book is available 
for use with the PANTONE Process palette included with Corel VENTURA.

· The other Process color palettes differ in the number and range of colors they 
contain. They also differ in the way in which their colors are displayed on the screen: 
one uses dithered color while the others use pure color.

· There is only one Spot color palette, CORELDRW.IPL.

Dialog Box Options

File Name
Select the palette you want to open. Either type the name of the file or select it from the 
list.

Directories
Select the directory in which the palette you want to open is stored.

Drives
Selects the drive in which the file you want to open is stored.

List Files of Type
Select the type of palette--Process or Spot--you want to open.



Save Palette As dialog box
Enables you to save a palette that you have modified by adding, deleting or rearranging 
colors. Creating custom palettes makes it easier to apply colors to documents that use many
colors. They also save time when working on different documents that use the same colors.
You can create as many custom palettes as you want and load them when required with the 
Load New Palette command.

Dialog Box Options

File Name
Type a name for the new palette. If you want or overwrite an existing palette, select its 
name from the list.

Directories
Select the directory in which you want the palette file stored.

Drives
Select the drive in which you want the palette file stored.

List Files of Type
Shows the type of palette--Process or Spot--being saved.



Fill tool 
The following describes the Fill tool flyout menu options which are used to define the color(s)
or patterns that will fill selected object(s). 

Menu Icons

Uniform Fill Color 
Displays the Uniform Fill dialog box for selecting or create a uniform color fill.

Fill Roll-up Window 
Displays the Fill Roll-up window for quick access to various fills.

Fountain Fill 
Displays the Fountain Fill dialog box for specifying fountain fills.

Two-Color Pattern 
Displays the Two-Color Pattern dialog box from which you can choose a two-color pattern 
fill.

Full-Color pattern 
Displays the Full-Color pattern dialog box from which you can choose a full-color pattern 
fill.

Bitmap Textures 
Displays the Texture Fill dialog box from which you can choose a Bitmap texture fill.

None 
Makes the object transparent allowing objects behind it to show through.

Patterns and Solid 
Selects white or black solid fills and various patterns.



Fountain Fill dialog box
Displays controls for creating fountain fills.

Dialog Box Options

Preview Box
Shows you how the fountain fill will look with the colors you have chosen.

Type
Select the type of fountain you want to create.
Linear Selects a fountain fill that changes color in one direction.
Radial Selects a fountain fill that changes color in concentric circles from the center 

of the object outwards.
Conical Selects a fountain fill that radiates from the center of the object like rays of 

light.
Square Selects a fountain fill that changes color in concentric squares from the center 

of the object outwards.
Palette

Contains colors you can select to create a custom fountain.
Center Offset

Repositions the center of a radial, conical, or square fountain fill so that it no longer 
coincides with the center of the object. Negative values shift the center down and to the 
left; positive values shift the center up and to the right.
You can also move the center by dragging the crosshairs that appear when you click in the 
Preview box. For Conical fountains, you must hold down the SHIFT key will dragging.
Holding down the CTRL key while dragging, constrains the amount of offset to 10 percent 
increments.

Options
Adjust any of these settings to customize the appearance of the fountain.
Angle Determines the angle of gradation in a linear, conical, or square fountain fill. 

The Preview box shows the effect of changing the angle.
If you rotate the object, the fountain angle adjusts automatically.
You can also change the angle by dragging the line that appears when you 
click in the Preview box. Use the right mouse button (or the left mouse button 
and SHIFT) to change the angle for conical and square fountains.
Holding down the CTRL key while dragging, constrains the angle to multiples of
15 degrees.

Steps Displays the number of bands used to display and print the fountain. You can 
change these settings for the selected object by clicking the Lock button and 
entering a value in the text box.

Edge Pad Increases the amount of start and end color in the fountain fill. Used primarily 
with circles and irregularly shaped objects in which the first and/or last few 
bands of color lie between the object and its highlighting box. This option is 
not available for conical fountain fills, and therefore, is grayed out.



Color Blend
Indicate the colors you want to use.
Direct Takes the intermediate colors along a straight line beginning at the From color 

and continuing across the color wheel to the To color.
Rainbow Takes the intermediate colors from a path around the color wheel. You can 

specify the direction the path takes by clicking the rotation buttons. The From 
and To colors coincide with endpoints of the path.

Custom You can select up to 99 intermediate colors from the palette at the right of the
dialog box. Specify where you want the color to appear by adding markers 
above the preview box. There are two ways to do that:
· double-clicking just above the preview box.
· select the "to" or "from" color squares at either end of the preview ribbon 

and specify a new value in the Position box.
After adding a marker choose a color from the palette.
To reposition a color, select its marker and drag it to the desired spot or edit 
the value in the Position box.
To delete a color, double-click the marker.
Note: More than one color marker can be selected at a time be holding down 
the SHIFT key when selecting or deselecting.

Presets
You can save the fountain settings you specified so that you can apply them to other 
objects. Type a name in the Presets box then click the plus sign. Clicking the minus sign 
removes the selected settings from the Preset list.

PostScript Options
Opens the PostScript Options dialog box. Used to specify halftone screens for Spot colors.



Two-Color Pattern dialog box
Use this dialog box to select, edit, create and import Two-Color patterns.

Dialog Box Options

Preview Box
Displays the pattern, if any, in the selected object. The display changes as you choose 
patterns from the Selection Box and adjust the Tile Size and Tile Offset settings.

Pattern List    
Clicking on the arrow in the top right corner of the preview box displays a list of patterns. 
Click the pattern you want and choose OK. Choosing Cancel ignores your selection and 
closes the list.
Choosing File displays a menu for deleting, and importing patterns.
Delete Item Deletes the selected pattern from the list.
Import Pattern Displays another dialog box used to create a pattern from an imported 

graphic.
Note: Graphics you import should use no more than two colors for best 
results.

Create
Displays the Two-Color pattern Editor which you can use to create your own patterns and 
edit certain existing ones.

Import
Displays another dialog box used to create patterns from imported images in any of the 
formats Corel VENTURA supports.

Back/Front Color
Clicking on the color boxes displays a list of colors you can apply to the background and 
foreground of the pattern.
Use the scroll bars to see other colors in the list. When you find the one you want, click on 
it. To close the box without making a selection, press the ESC key.
Clicking the More button displays the Uniform Fill dialog box which you can use to create 
custom colors and select colors by name.

Small, Medium, Large
Selects a pattern tile size of 0.25x0.2, 50.50x0.50, or 1.00x1.00 inches.

PostScript Options
Displays the PostScript Options dialog box. If you are producing spot color separations, you
can use this dialog box to specify halftone screens.

Tiling
Displays additional controls for sizing and offsetting the tiles that make up the pattern.
Width/Height Specifies a custom pattern tile size up to 3x3 inches.



If you want to use a different unit of measurement, open the units 
list then choose the unit you want.

First Tile Offset Specifies the placement of the first tile relative to the upper left 
corner of the object's highlighting box.

Row/Column Offset Shifts alternating rows or columns by the amount specified.
Scale Pattern If checked, the pattern will be scaled as you scale the object.
with Object Otherwise, the pattern keeps its size when you scale the object; it is

repeated more times if the object is enlarged, fewer if it is reduced.



Two-Color Pattern Editor
Used to create your own Two-Color patterns. You can also edit existing patterns provided 
their resolution is no more than 64x64 pixels. If the selected pattern's resolution is too high, 
it does not appear in the editor's drawing area when you choose the Create button in the 
previous dialog box.

Dialog Box Options

Drawing Area
You create patterns by clicking with the left mouse button to fill a square with black, or the 
right mouse button to fill it with white. Holding down the mouse button as you draw 
enables you to fill a wide area of pixels.
Each square represents a pixel. The Bitmap Size options specify the number of pixels which
in turn determines the resolution of the pattern.

Bitmap Size
Determines the resolution of the pattern. Choose the smallest size (16x16) to create 
simple patterns consisting of rectangular shapes and horizontal or vertical lines. For more 
intricate patterns with curves and diagonal lines, use one of the other two sizes.
Note: If you choose a Bitmap Size option, whatever you have drawn up to that point will 
be erased. Also, if you Click OK without drawing anything, an empty pattern is created. 

Pen Size
Determines how many pixels are filled when you click in the drawing area. For example, 
2x2 fills four pixels at a time.



Full-Color Pattern dialog box
Used to choose a full color fill pattern and specify the size of the tiles that make up the 
pattern. Also used to shift the entire pattern inside the object you are filling and stagger the 
individual pattern tiles.

Dialog Box Options

Preview Box
Displays a tile of the selected pattern.

Pattern List     
Clicking on the arrow in the top right corner of the preview box displays a list of patterns. 
Click the pattern you want and choose OK. Choosing Cancel ignores your selection and 
closes the list.
Choosing File displays a menu for deleting, and importing patterns.

Delete Item Deletes the selected pattern from the list.
Import Pattern Displays another dialog box used to create a pattern from an 

imported graphic.
Load

Displays a dialog box for you to load full-color patterns saved in other directories.
Import

Displays another dialog box used to create a pattern from an imported graphic.
Tiling

Displays additional controls for sizing and offsetting the tiles that make up the pattern.
Small, Medium... Selects a pattern tile size of 0.25x0.2, 50.50x0.50 or 1.00x1.00 

inches.
Width/Height Specifies a custom pattern tile size up to 3x3 inches. 

If you want to use a different unit of measurement, open the units list
then choose the unit you want.

First Tile Offset Specifies the placement of the first tile relative to the upper left 
corner of the object's highlighting box.

Row/Column OffsetShifts alternating rows or columns by the amount specified.
Scale Pattern with Object

If checked, the pattern will be scaled as you scale the object. Otherwise, the pattern keeps 
its size when you scale the object; it is repeated more times if the object is enlarged, fewer
if it is reduced..



Texture Fill dialog box
Use this dialog box to select one of the 100-plus bitmap texture fills included in Corel 
VENTURA. Each texture has a set of parameters that you can change to create millions of 
variations.

· Bitmap textures add significantly to the size of your file and the time it takes to print. 
As such, you should avoid filling numerous and/or large objects with them.

· The textures look best on color monitors. If you are using a monochrome monitor, 
you may not get a very good representation of the texture's appearance.

· When you rotate an object with a texture fill, the fill does not rotate.
· Resizing an object with a texture fill can distort the texture. To restore its appearance,

open the Bitmap Texture dialog box and choose OK.

Dialog Box Options

Texture Library
Select the library that contains the texture you want. The Samples and Textures libraries 
contain textures which you can alter and save for later use. When you save them, 
however, you must store them in another library. You cannot save modified textures to the 
Styles Library.

Texture List
Displays textures in the selected library. Click the one you want.

Preview
Varies the appearance of the selected texture by randomly changing all unlocked 
parameters. Lock and unlock parameters by clicking the Lock icon next to it.
You must use the Preview button to update a texture after changing the parameters 
manually.

Save
After changing the parameters of a texture in a library choose save to overwrite the 
original. Textures from the styles library cannot be overwritten but can be saved to another
library.

Save As
Opens the Save Texture As dialog box for naming (or renaming) a texture you've created.

Delete
Deletes the selected texture. You can only delete textures from any library but the Styles 
Library. When you click the Delete texture button, a dialog box appears asking for 
confirmation before the style is deleted.

Style Name <texture name>
Lists parameters for the selected texture. Changing one or more of these parameters 
alters the appearance of the texture. 
Note:    Available parameters change depending on the type of texture selected.
The left side of the Style Name field lists up to six numeric parameters. All textures have a 



Texture Number parameter which ranges from 0 to 32,768. The names of the other 
parameters vary with the texture and have a range from 0 to 100 or -100 to 100.
To change a numeric parameter, enter a value in the text box and click the Preview button.
The right side of the field lists up to six color parameters. To change a color, click the color 
button (e.g., Shade, Mid-Shade, Light) and choose a new color from the pop-up palette. 
Click the More button if you want to create a color or choose one by name from the More 
Color dialog box. To see the effect a new color has on the texture, click the Preview button.



Save Texture As dialog box
Use this dialog box to save a modified texture under its own name. Saving a texture makes it
easier to apply to other objects later on. You can also create and rename libraries in this 
dialog box.

Dialog Box Options

Texture Name
Type a name up to 32 characters (including spaces).

Library Name
Type a name in this box if you want to create a new library in which to store the textures 
you create. You can type up to 32 characters (including spaces).

Library List
Select the library you want to store the modified texture in.

Note: You must save modified Style textures in the samples Library or in a library you 
create.



PostScript Options dialog box
Controls halftone screens used to print the selected object's fill or outline. 

· Useful for special effects and when overprinting spot colors.
· Screens are available only when printing Spot colors to a PostScript printer.
· The effect of varying the halftone screen parameters will not appear on screen, but 

they will show up when printed.
· All other objects except those whose screen settings you specify in this dialog box 

print using the screen settings specified in the Print Options dialog box.

Dialog Box Options
PostScript Halftone Screen

Type Lists the types of screens by the shape of the halftone dots. Dot, Line, 
Diamond1, Diamond2, Dot2, Elliptical, Euclidean, Grid, Lines, MicroWaves, 
OutCircleBlk, OutCircle Whi, Rhomboid, and Star are all screen types you can 
apply from Corel VENTURA.
The Default type uses the printer's default screen parameters unless 
overridden in the Print dialog box. A dot screen with 60 lines per inch at 45 
degrees has typical screen parameters for a 300 dpi laser printer.

Frequency Controls the resolution of the screen. The lower the frequency, the more 
apparent the screen will appear when printed. A 60-line screen (LPI) will 
appear quite coarse. 80 to 100 is suitable for imaging art to be printed on 
newsprint. Magazines use a 133- or 150-line screen. High quality 
photography books use up to a 300-line screen.
Choosing an appropriate frequency depends on the resolution of your printer 
and the results you want to achieve. For example, setting a 133-line screen 
for printing to film is appropriate when printing on a high-resolution image 
setter. When printing on a 300 dpi laser printer, use a value from 60 to 80. 
Values below 40 are useful for creating special effects.
Remember frequency affects the number of gray levels in the printed output: 
the higher the screen frequency, the higher the level of output resolution 
necessary to create an adequate number of gray levels. This is important to 
remember when creating smooth fountain fills. If you're printing fountain fills 
at high resolution you'll need over two hundred steps or gray levels to keep 
large fountain fills from banding. 
If you're printing to a laser printer with 600 dpi. resolution you'll find that 
photos and fountain fills look better with a 80-line screen because they have 
more gray levels; thus photos have more tonal values and fountain fills can 
print with more steps.
To calculate grayscales when creating screens: Divide your output resolution 
squared by line screen squared to arrive at the number of grayscales. 

E.g.,  levels of gray
Angle Controls the angle of the screen.

Screen angle does not change when you rotate or skew an object.



Paragraph command (Format menu)
The Paragraph command displays the Paragraph Settings dialog box. It is only available if 
you have selected text using the Freeform Text or Tagged Text tool. This dialog box allows 
you to format character, alignment, spacing, defaults and typography of the current 
paragraph. 
If the Tagged Text tool is used, the formatting affects all paragraphs tagged with the same 
paragraph tag. If you have used the Freeform Text tool to select the paragraph, the 
formatting changes are applied to the current paragraph only and are called overrides.



How to...
· Select paragraphs for formatting changes
· Work with styles
· Work with dialog boxes



Selected Text command (Format menu)
The Selected Text command displays the Selected Text Attributes dialog box. It is only 
available when text or portions of text are selected. 

See also:
Selecting text



How to...
· Select text for text attribute changes
· Change text attributes
· Remove applied text attributes
· Work with dialog boxes



Frame command (Format menu)
Opens the Frame Settings dialog box which provides the following options:
Frame Dimensions, caption format, frame anchor, frame origin, repeating frame, 

tag, text flow, locking, rotation, grid setup and ruling lines.
Margins Inside, outside and rules.
Columns Size, number of columns and page location.
Graphics Placement and dimensions.
Typography Widows and orphans, text positioning, frame rotation, vertical justification 

and ruling lines.
This command enables you to modify the attributes of selected frame.



How to...
· Move and resize framesmove_resize_frames_proc>howto
·   Rotate frames  
· Set margins
· Set columns
· Repeat frames
· Wrap text around graphics
· Use ruling lines
· Use frame tags
· Use anchors and captions
· Work with dialog boxes



Graphic command (Format menu)
Opens the Frame Settings dialog box open to the Graphic tab.
The Graphic command appears on the Format menu and the Graphics tab in the Frame 
Settings dialog box only when the selected frame contains an imported graphic. It provides 
controls to size and place graphics as well as to set halftone screens.



How to...
· Size graphics
· Crop a graphic
· Recommended settings for halftone screening
· Use halftoning process
· Use halftoning guidelines
· Specify halftone screen settings for grayscale images
· Show and hide graphics
· Work with dialog boxes



Table command (Format menu)
Opens the Table Settings dialog box which provides the following options:
General Rows and columns, column widths and default border.
Positioning Table spacing, cell spacing, vertical justification and alignment and 

indent.
Cell Borders Rule settings, border tag, line style and color.
This command allows you to modify the attributes of the current table. It is only available 
when a table is selected.



Quick Format Roll-Up command (Format menu)
Opens the Quick Format Roll-Up. This roll-up enables you to quickly format tables, rules, 
columns and page layout based on the styles displayed in the preview window.



How to...
· Format tables
· Format paragraphs
· Format ruling lines
· Format columns
· Layout pages
· Format headers
· Format footers



Manage Tag List command (Format menu)
Opens the Manage Tag List dialog box.
Allows you to modify the current style sheet by adding, editing, removing or renaming tags. 
Also saves, loads and prints style sheets.



Manage Overrides command (Format menu)
The Manage Overrides command displays the Manage Overrides dialog box. In this dialog 
box, you can remove or update the overrides for the following properties:    All, Font, Size, 
Style and Color, Alignment, Spacing, Indents, Tabs, Drop Cap or Bullet, Breaks and 
Typograghy.



Override Counter command
Opens the Override Counter dialog box.
Overrides Corel VENTURA's default numbering scheme for the selected frame, table, figure 
or chapter.



Re-Anchor Frames command (Format menu)
Re-anchors frames in the current chapter.    Particularly useful after manipulations of text and
pages in the chapter.



How to...
· Re-anchor frames
· Anchor frames



Renumber Publication command (Format menu)
Renumbers paragraphs, cross-references, pages, figures and tables for all chapters in the 
current publication.



How to...
· Add numbering



Update Auto Numbering command (Format menu)
Located in Format menu, Update Autonumbering updates numbering of auto-numbered 
paragraphs in the current chapter. Use after adding or deleting auto-numbered paragraphs.



How to...
· Add numbering



How to...
· Add paragraph tags
· Work with dialog boxes



How to...
· Add paragraph tags
· Delete paragraph tags
· Rename paragraph tags
· Print a style sheet
· Set hotkeys
· Copy paragraph tags
· Modify paragraph tags
· Use frame tags
· Work with dialog boxes



Ruling Lines command (Format menu)
Opens the Ruling Lines dialog box with the Ruling Lines Above tab displayed. 
The Ruling Lines dialog provides options to create and control the appearance of ruling lines 
for selected frames or paragraphs. The other tabs apply formatting changes to lines below 
and around selected frames or paragraphs.



How to...
· Use ruling lines
· Work with dialog boxes



Breaks command (Format menu)
Opens the Breaks dialog box.
Sets page, column and line breaks for the selected style tag.



TOC & Index command (Format menu)
Opens the Table of Contents & Index dialog box.
Creates a Table of Contents or an Index for the current publication.



How to...
· Create an index
· Change the order of entries in an index
· Generate an index
· Add an index file to your document
· Edit index entries
· Update an index
· Create a table of contents
· Add a table of contents file to your document
· Update a table of contents





Using Corel Help
Help shortcuts
Using secondary windows
How to use Context-sensitive Help
Opening other programs' Help files
Keeping Help on top
Using Help's Search feature
Using the History button



How to use Context-sensitive Help
Corel VENTURA offers the range of Context-sensitive Help features--specific Help topics 
about the task at hand--described below:
· Context-sensitive Help pointer : Choose the Help pointer from the right side of 

the Ribbon Bar and click the menu item, tool, button, or interface item you want 
information about. Keyboard: Shift+F1

· F1: Press F1 while you have any dialog box open--a Help topic specific to the dialog 
box will appear. Click the "How to..." button available in the upper-right-hand corner of most 
dialog box Help topics for relevant procedures.
· Right mouse button Help: Click the right mouse button on the Toolbox, Ribbon Bar 
or Text Ribbon Bar. 
· Pop-Up Help: Rest the mouse pointer over any button on the Toolbox, Ribbon Bar or 
Text Ribbon Bar. The item's name will appear in a small yellow callout or "bubble." Pop-Up 
Help is turned on by default; you can turn it off from the Preferences dialog box, found in the
Tools menu.
· Status line Help: Read the message in the Status line when you choose a menu 

command or tool, click a button on the Ribbon Bar or Text Ribbon or open a dialog box.



Using the History button
The History button, which lists the last 50 Help topics viewed, provides a useful alternative 
to the Contents buttons.
To use the History button:

1. Press "t" on the keyboard, or click the History button and scroll through the topics until 
you find the one you are interested in.

2. Click the topic you want to review and close the History window.
3. When you close the History window, the list of most recently viewed topics remains in 

memory.



Using the History button
The History button, which lists the last 50 Help topics viewed, provides a useful alternative 
to the Contents buttons.
To use the History button:

1. Press "t" on the keyboard, or click the History button and scroll through the topics until 
you find the one you are interested in.

2. Click the topic you want to review and close the History window.
3. When you close the History window, the list of last topics viewed remains in memory.



Opening other programs' Help files
You can open any of the Online Help files for Corel VENTURA from the Programs subdirectory 
by double-clicking their file names in the main directory where you installed Corel VENTURA, 
usually \COREL50\PROGRAMS. 

1. Choose Open from the Corel VENTURA Help Menu bar. 
2. Double click [filename.hlp] from the File Name box.



Opening other programs' Help files
You can open Online Help files for other Microsoft Windows programs using the Help File 
menu. The example below explains how to open Online Help for CorelDRAW.
To open CorelDRAW's Online Help:

1. Choose Open from the Corel VENTURA Help Menu bar. 
2. Double click CORELDRW.HLP from the File Name box.

Note: You can also use the File Manager to open any Online Help file. To open another 
Corel application's Help file, go to the Corel Programs subdirectory, usually \COREL50\
PROGRAMS, and open the file you want to use by double-clicking the file, e.g., 
CORELDRW.HLP. 



Using Help's Search feature
The Windows Online Help Search feature is designed to help you find and display information
quickly. Help Search keywords are usually limited to specific topic names or subjects. When 
Searching, start with the subject area, as described below.
To search for information about tags:

1. With a Help window active, press "s" or click the Search Help button.
2. Type "import" in the Search box and press Enter. A list of topics on importing appears in 

the Show Topics area of the Search dialog box.
3. Scroll through the listing in the Go To list box.
4. Press Enter with the topic you want highlighted to open a topic.



Using Help's Search feature
Help Search keywords are usually limited to specific topic names or subjects. If the topic is 
procedural, the keyword describing it will take you to a Contents section. From there choose 
the topic you are looking for.
In general, try to use the terms used by Corel VENTURA, beginning with subject area in 
searching for help about dialog boxes, menu items or subject areas. In the example below, 
using the key words "Setting up spreadsheets" would not bring up the desired topics. 
To search for information about formatting spreadsheets:

1. With a Help window active, press "s" or click the Search Help button.
2. Type "import" in the Search box and press Enter. A list of topics on importing appears in 

the Show Topics area of the Search dialog box.
3. Scroll through the listing in the Go To list box.
4. Press Enter with the topic you want highlighted to open a topic.



Keeping Help on top
By default, Online Help windows remain open but drop out of sight when you activate 
another window. Sometimes, however, you may find it useful to keep Help windows visible 
while you work---the smaller secondary windows containing procedures are particularly 
useful this way. (Application menus will still appear on top of your Help window when called 
using speed keys.)
To keep a Help window on top:

1. Click the Help from Help Menu Bar in any main Help window.
2. Choose Always on Top.

This causes both main and secondary windows to remain on top. Resize as required.
Notes:    You may toggle the On Top command on and off, and minimize on-top Help 
windows to icons. 



Keeping Help on top
By default, Online Help windows remain open but drop out of sight when you activate 
another window. Sometimes, however, you may find it useful to keep Help windows visible 
while you work---the smaller secondary windows containing procedures are particularly 
useful this way. (Application menus will still appear on top of your Help window when called 
using speed keys.)
To keep a Help window on top:

1. Click the Help from Help Menu bar in any main Help window.
2. Choose Always on Top.

This causes both main and secondary windows to remain on top. Resize as required.
Notes:    You may toggle the On Top command on and off, and minimize on-top Help 
windows to icons. 



Using secondary windows
Secondary Online Help windows, the smaller windows that appear when you click a 
procedural topic title in a Help contents listing, display concise step-by-step Help 
information. Secondary windows are useful because they cover a smaller portion of the 
active application window than main Help windows. And because they stay on top, 
secondary windows make it easier to carry out a procedure and view its Help topic at the 
same time without switching back and forth between windows.
Always on top: Corel's secondary Help windows differ from main Help windows in that they
are programmed to remain on top of your current application window until you need to close
or minimize them. 
The following limitations apply to secondary windows:
Search: Help topics shown in secondary windows cannot be coded for search keywords. If 
you use Help's Search function for a topic in a secondary window, Help takes you to a main 
menu which will include the topics you are looking for.
Sizing: Unlike other window types in the Windows Operating System, secondary windows do
not "remember" when you change their default size and position. 
To resize a secondary window and retain that size for subsequent topics viewed during the 
current Corel VENTURA session, minimize the window rather than closing it when finished. 
The next time you open a topic in a secondary window it will appear in the size and location 
you set for the minimized window.
The Buttons: Secondary window buttons cannot at this time be programmed for underlined
characters which "press the button" when you press the underlined letter on the keyboard; 
they must be clicked with the mouse pointer. Secondary windows also cannot include 
browse buttons. 
Note:    Basics and How to... procedures which appear in secondary Help windows contain 
a special button which reopens their contents screens in the main Help window. Click the 
Basics button in Basics secondary windows to reopen the Basics contents screen in the main
Help window, and click the How to... button in How to... secondary windows to reopen the 
How to... contents in the main Help window.



Help shortcuts
Press the key or keys on the left to produce the action described at right.

 Key(s) Result
F1 Displays the main Corel VENTURA Help Contents screen
F1-F1 Pressing F1 from within any Help window displays the Microsoft 

Windows Using Windows Help topics
F1 (in a given context) With a menu item selected or a dialog box or system message on 

screen, displays context sensitive Help (where available). Also, dialog
box Help topics usually include a "How to..." button in the upper-
right-hand corner containing lists of related procedures.

SHIFT+F1 Changes the pointer to  so that you 
can get Help on a specific command, screen region, or key. You can 
then choose a command, click the screen region, or press a key or 
key combination you want to know more about.

CTRL+F1 Opens Help's Search dialog box
CTRL+HOME Moves to top of the Help topic
CTRL+END Moves to the bottom of the Help topic
> Moves to the next topic 
< Moves to the previous topic
Note: As an alternative to clicking with the mouse, you may also use the keyboard to 

"press" Help buttons. Simply type a Help button's underlined letter to execute its 
function. E.g., to press the    Back button, press b on the keyboard; to press the Close 
button, press c, and so on.



Help menu
Contents
Screen/Menu Help
Search for Help On
Tutorial
QuickTour
About Corel VENTURA



Contents command (Help menu)
Displays the opening Help screen. From this screen, you can choose the type of Help you 
want. When you are in Help, clicking on the Contents button takes you back to the opening 
screen.

Shortcut:
Pressing F1 displays the Help Contents, or a Help topic on the selected command or open 
dialog box.



Screen/Menu Help command (Help menu)

Changes the mouse pointer to an arrow with a question mark . You can then click on an 
available menu command or a part of the screen (for example, a tool in the Toolbox) to get 
Help about that item. You can also press a function key or key combination such as Ctrl+N to
get Help about the command or tool associated with it.
Note:  To get Help on unavailable (gray) commands, select the command and press F1.

Shortcut:

Pressing SHIFT+F1 displays the Help pointer.



How to...
· Use Context-sensitive Help



Search for Help On command (Help menu)
Displays the Help Search dialog box where you enter keywords to search for a specific Help 
topic. The Search dialog box can also be opened by choosing the Search button from the 
Help window.

Shortcut:
Pressing Ctrl+F1 displays the Search dialog box.



How to...
· Use Help's Search feature



Tutorial command (Help menu)
Launches the Corel VENTURA Online tutorial.



QuickTour command (Help menu)
Available when you have installed the QuickTour, a CD-ROM introduction to Corel VENTURA.



About Corel VENTURA command (Help menu)
Displays a dialog box with information about which version of Corel VENTURA you are 
running. 





Import file filters--Technical notes
Click the plus button  for technical information about Corel VENTURA's import filters.
Text

 All Files (*.*)
 Ventura Generated (*.GEN)
 Ami Professional 2.0, 3.0 (*.SAM)
 ANSI text (*.*)
 ASCII text (*.TXT)
 ASCII text (8-bit) (*.TXT) 
 Excel for Windows 3.0, 4.0 (*.XLS)
 Lotus 123 1A, 2.0 (*.WK?)
 Lotus 123 for Windows 3.0 (*.WK?)
 Lotus/Excel Print Table (*.PRN)
 Microsoft Word for Windows 1.x (*.*)
 Microsoft Word for Windows 2.x & 6.x (*.DOC)
 Microsoft Word 5.0, 5.5 (*.*)
 Microsoft Word for Macintosh 4.0 (*.*)
 Microsoft Word for Macintosh 5.0 (*.*)
 Microsoft Rich Text Format (*.RTF)
 TagWrite--Style Match RTF (*.RTF), SGML/Custom Template (*.*), Style Match WP 5.x (*.*)
 Xywrite (*.*), III, III Plus, IV, 1.0 for Windows
 WordPerfect 5.0 (*.*)
 WordPerfect 5.1 for Windows (*.*)
 WordPerfect 6.0 for Windows, (*.*)
 WordStar 3.3, 3.31, 3.45, 4.0, 5.0, 5.5, 6.0, 7.0 1.x, 2.0 for Windows (*.*)

Graphics
 CorelDRAW graphic, (*.CDR, *.PAT)
 CorelCHART, (*.CCH)
 Corel Presentation Exchange, (*.CMX)
 CorelTRACE (*.EPS)
 Windows 3.0 Bitmaps (*.BMP, *.DIB, *.RLE)
 Compuserve Bitmaps (*.GIF)
 Computer Graphics Metafile (*.CGM)
 JPEG Bitmap (*.JPG, *.JFF, *.JTF, *.CMP)
 Paintbrush (3.0 and above) (*.PCX)
 SCITEX (*.CT)
 Targa Bitmaps (*.TGA, *.VDA, *.ICB, *.VST)
 TIFF 5.0 Bitmaps (*.TIF, *.SEP, *.CPT)
 Windows Metafile (*.WMF)
 WordPerfect Graphic (*.WPG)
 Adobe Illustrator 1.1, 88, 3.0 (*.AI, *.EPS)
 AutoCAD (*.DXF, *.DXF)
 GEM files (*.GEM)
 GEM Paint / HALO files (*.IMG)
 IBM PIF (GDF) (*.PIF)
 Lotus PIC (*.PIC)
 Macintosh PICT (*.PCT)
 Micrographx 2.x, 3.x (*.DRW)
 EPS (Placeable) (*.EPS); (Interpreted) (*.EPS, *.PS)



General notes on importing 
· All grahpics import as non-editable images. 
· When text in certain formats is imported into Corel VENTURA, it's assigned Corel 

VENTURA's default font. If you want to preserve the font the original document used, you
must convert the text to curves in the application which created the file. If this isn't 
possible, convert it to a bitmap format such as PCX or TIFF before importing it.

· If you choose the Graphics Resolution, High option from the View menu, Corel 5 vector 
formats such as DCR and CCH will display using the actual vector image. However, if you
choose the Graphics Resolution, Low option, the image header is displayed instead.



Import--All Files (*.*)
This auto-sense option automatically senses which file format you are importing and uses 
the appropriate filter to bring the object into Corel VENTURA. If the auto-sense option is 
unable to determine the format, import the file using the appropriate filter format. 



Import--CorelDRAW (CDR)
Imports graphics from CorelDRAW.



Import--Windows Metafile (WMF)
Technical Notes
Imports graphics in a format used by many Windows programs, including Harvard Draw, 
Lotus Freelance Graphics and Aldus Persuasion.
Corel VENTURA substitutes fonts missing from a WMF file to similar fonts available on your 
system.



Import--BMP, CPT, GIF, TGA,TIF, JPG, JFF, JFT, DIB, RLE, CMP, VDA, ICB, VST, SEP, 
PCX, JPEG, JFF, .JTF, .JPG, .CMP
Technical Notes
Imports bitmap graphics created in paint programs such as Windows Paintbrush (BMP). 
Compuserve (GIF) and Targa (TGA) are color bitmap formats commonly used to store 
digitized photographs. OS/2 BMP's can also be imported into Corel VENTURA.
SCITEX (CT), a high-quality four-color (CMYK) bitmap format, can be imported by Corel 
VENTURA.TIFF is a bitmap file format used by many digital scanners.
JPEG Bitmap 

JPEG is a standard format developed by the Joint Photographers Experts Group, allowing 
transfer of files between a wide variety of platforms, using superior compression 
techniques. This import filter also supports Lead bitmaps with a CMP extension.

Windows Bitmaps
Corel VENTURA imports BMP files conforming to the Windows BMP specification. They may
be either color, gray-scale or black & white and will print accordingly, depending on your 
printer. Corel VENTURA also imports RLE's (compressed bitmaps).

CPT Bitmaps
Corel VENTURA imports Corel PHOTO-PAINT CPT files. CPT files are an RGB TIFF 6.0 format. 
Import support for "objects" placed into a CPT file is not supported except by Corel PHOTO-
PAINT.

GIF Bitmaps
Corel VENTURA imports GIF files conforming to the 87A and 89A specifications. Preview of 
interlaced GIF images is not supported.
PCX Bitmaps

Corel VENTURA imports PCX files conforming to the following specifications: 2.5, 2.8, and 
3.0. These files can contain 1, 2 or 4 color planes. Files containing 3 color planes cannot 
be imported.

TGA Bitmaps
Corel VENTURA imports 16- and 24-bit Targa files.    It also imports the following 
variations:
· uncompressed color-mapped images
· uncompressed RGB images
· RLE-compressed color-mapped images
· RLE-compressed RGB images (types 1, 2, 9 and 10 as defined by AT&T Electronic 

Photography and Imaging Center)
· some 32-bit TGA's are imported, ignoring the last 8 bits

TIFF Bitmaps
Corel VENTURA imports black & white, color and gray-scale TIFF files up to and including 
the 5.0 specification. TIFF files compressed using the CCITT, Packbits 32773 or LZW 
compression algorithms can also be imported. However, you may notice additional 
loading time with these, as Corel VENTURA decodes the file compression.
TIFF 6.0 support includes:



· TIFF 6.0 using JPEG compression
· TIFF 6.0 files with CMYK data
Corel VENTURA does not support other TIFF 6.0 extensions such as YCbCr.
However, CMYK TIFFs are read by the Four Color TIFF import filter. Also, Corel VENTURA 
will read the stand-alone version of the JPEG extension.

SCITEX bitmaps
SCITEX only imports full 32-bit color images, it does not support grayscale .ct files. SCITEX 
bitmaps are a 32-bit color format created from high end scanners which can be processed or
modified for output by film recorders or to high end page layout programs. SCITEX is ideal 
for color separated images as it is a native 32-bit CMYK format.



Import--CorelTRACE
Technical Notes
Imports bitmaps converted to vector graphics created by CorelTRACE. CorelTRACE is used to 
convert bitmaps to vector graphics and text.



Import--Adobe Illustrator (.AI, .EPS)
Technical Notes
Imports vector graphics created by Adobe Illustrator for Windows or Macintosh.
Corel VENTURA provides full support for all Adobe Illustrator formats up to and including 3.0, 
Illustrator 88 and 1.1. 
The AI import filter does not support Adobe Illustrator 5.0 files, nor does it support masks in 
AI 3.0 files.
Note: Some Postscript file formats (AI, EPS) may not import properly using the All Files (*.*) 
import option. To import them, choose the AI import filter.



Import--GEM Files
Technical Notes
Imports vector graphics created by programs such as GEM Draw and GEM Artline. Also 
imports GEM files from earlier versions of Ventura.
Object Interior Fills

Objects in GEM that have a solid or percentage fill of a particular color will also have a 
corresponding fill in Corel VENTURA. However, custom fills (i.e., grids, hatches, ball 
bearings, etc.) used in the GEM programs are not supported. Objects containing such fills 
will have a tinted color fill in Corel VENTURA that corresponds to the color of the pattern 
fill of the original GEM object.

Line End Styles
The types of end styles imported by Corel VENTURA's GEM filter depend on the package 
that created the GEM file. From GEM Artline, no end caps or corners will import into Corel 
VENTURA. In a file created in GEM Draw, the following will occur in Corel VENTURA:
· Lines with arrows will come into Corel VENTURA with no end caps

Symbols
The symbols available in GEM Artline are created as text objects. They are imported as 
curves in Corel VENTURA.

Text in GEM Files
· If a typeface from the imported file is not available on your system, it will default to the

font it most closely resembles that is available on your system. 
· Text in the imported file may not align exactly as it did in the original file. This is due to

the differences in font sizes, and inter-character and inter-word spacing between the 
two programs. 

· Unsupported keyboard characters appear as question marks in Corel VENTURA. 
Underlined text from the GEM format is not supported.



Import--GEM Paint/HALO (*.IMG) Files
The .IMG format is the bitmap format of the GEM environment. This filter is useful for 
longtime users of Corel VENTURA.
In previous versions of Ventura for Windows, the import of bitmap images, stored in formats 
other than GEM, resulted in Ventura duplicating the imported file and assigning them 
the .IMG extension.    This required users to keep two versions of the same bitmap on their 
system.    
The .IMG import allows you to import the .IMG files directly and eliminates the need to keep 
two versions of bitmaps.



Import--Ventura Generated (.GEN) Files
Imports files generated by Corel VENTURA, such as tables of contents and indexes.    Corel 
VENTURA automatically assigns the .GEN file extension to all files it generates.    They are 
ASCII text files which can easily be imported in other Corel VENTURA documents by using 
this filter.



Import--Computer Graphics Metafile (*.CGM)
Technical Notes
Imports vector graphics from such programs as Harvard Graphics, Lotus Freelance and Arts 
& Letters. Also gives you access to graphics produced on mini and mainframe computers, as
well as clipart from vendors such as MGI and New Vision.
Bitmaps

Bitmaps are not supported.
Markers

Corel VENTURA's CGM import filter only accepts markers supported by the CGM standard. 
Private-use markers are ignored.

Text in CGM Files
· The typeface you see in Corel VENTURA may not correspond to the one used in the 

originating program. 



Import--Macintosh PICT (PCT)
Technical Notes
Imports graphics created in Macintosh programs such as MacDraw. Corel VENTURA can 
import vector and bitmap images contained in these files.
Colors

While not always obvious, PICT fills are often bitmap patterns. Corel VENTURA will try to 
maintain these fills as bitmap patterns.

Pattern Outlines
Pattern outlines are converted to a solid color.

Arrowheads and Dashed Lines
These are not supported from MacDraw II.

Text
· If a typeface in the imported file is not available on your system, it will default to the 

font it most closely resembles that is available on your system. 
· Unsupported Macintosh fonts come into Corel VENTURA as the default font.
· Text alignment may not quite agree with the original file. This is due to the differences 

in font size, and inter-character and inter-word spacing between the two formats.
· Unsupported characters appear as question marks in Corel VENTURA.
· The following PICT text styles are supported: Bold, Italic, Outline, Shadow, and any 

combination of these. Underlined text is not supported.



Import--AutoCAD (DXF)
Technical Notes
Imports vector graphics created by AutoCAD.
Preparing the file in AutoCAD

To create a DXF file from AutoCAD, use the DXFOUT utility while in that program. If the 
image is 3-D, save it with the view that you want to transfer to Corel VENTURA. Whenever
possible, use polylines rather than regular lines. This reduces the file's complexity when it
is imported into Corel VENTURA.
Note: DXF v11 and v12 are not fully supported.

General notes and limitations on imported DXF files
· Corel VENTURA tries to center the imported image in an 18x18 inch area. This size is 

not guaranteed though, especially with 3-D images. 
· Dashed lines in the DXF file will be given a similar dashed line pattern in Corel 

VENTURA. 
· If you have a problem with the scattering of "dimension entities" in your imported file, 

go back to your original drawing in AutoCAD and explode the dimension entity before 
creating the DXF file.

· The line width of a polyline is imported as the minimum line width which that polyline 
had in AutoCAD. The maximum line width is 4 inches. Variable line width information is 
not retained when the file is imported.

· Solid and trace entities are filled, provided the view is not    3-D (i.e., they are filled on 
x-y axis view only).

· A point is imported as an ellipse of minimum size. An extruded point is imported as a 
line segment with two nodes. PDMODE is not considered.

· Files exported as "Entities only" may come into Corel VENTURA incorrectly due to lack 
of header information.

· Arc angles are rounded to the closest tenth of a percent. Angles smaller than a tenth of
a degree are rounded up. Text objects that are smaller or larger than Corel limits are 
ignored.

AutoCAD features not supported in Corel VENTURA
The following features in AutoCAD are not supported when you import a DXF file into 
Corel VENTURA:
· Shape entities--Corel VENTURA cannot read .SHX files
· Polylines including variable-width polylines, elevation (group 38), mesh M and N vertex 

counts (groups 71 and 72), smooth surface M and N densities (groups 73 and 74) and 
smooth surface type (group 75)

· Special 3-D shapes such as cones, spheres and tori
· 3-D extrusion of circles, arcs, and text
· 3-D extrusion of polylines with width and/or dashed patterns
· Invisible lines in 3-D face entities
· Automatic wireframes
· Hidden lines removal



· Extrusion direction assumed to be parallel to the z-axis
· Binary DXF format
· Paper Space Entities within a Model Space
· AutoCAD layers cannot be mapped to Corel VENTURA layers.

Text in the DXF File
Text generated in AutoCAD and imported via DXF will show the following differences:
· Various justifications on text entries may not be preserved. Normal text placement (no 

justification) works best.
· Corel VENTURA has limits on values for text's point size and skew. If the AutoCAD text 

object exceeds these limits, the object is brought within these limits when it is 
imported.

Special characters in text strings:
· Control characters are ignored.
· Overscore and underscore indicators are ignored.
· If a character is referred to by number, the number must be three digits. i.e. character 

65 is %%065.
· %%010 is considered to be a carriage return and line feed.
· Any non-standard characters become a "?" in Corel VENTURA, including the degrees 

symbol, the +/- tolerance symbol, and the circle dimensioning symbol.



Import--IBM PIF (GDF)
Technical Notes
Imports vector graphics created on IBM mainframes.
Unsupported Functions

· No "Set Background Mix" or "Set Foreground Mix" orders are processed. Instead, Corel 
VENTURA will overlay objects in the order they are read in. Each will have its own 
defined color where there is no overlap.

· No "Call Segment" orders are processed.
· No "Set Character Set" orders are processed.
· "Set Paper Color" is not supported.
· "Set Pattern Symbol" is not supported.

PIF Line Types
· "1", "3", "4" and "6" become a "three-unit dash followed by a five-unit space" type of 

line in Corel VENTURA.
· "2" and "5" become a "one-unit dash followed by a five-unit space" type of line.
Note: The translation of line types is not dependent on the contents of CORELDRW.DOT. 
These conversions are actually a non-alterable part of the PIF import filter.

Text in PIF Files
Text in PIF files is imported and assinged Corel VENTURA's default font.



Import--Lotus PIC
Technical Notes
Imports graphs from Lotus 1-2-3.
Color

The colors contained in a PIC file are translated to a standard set of eight colors.
Text

Text is assigned Corel VENTURA's default font.



Import--Text (.TXT)
Technical Notes
In Corel VENTURA, imports text directly into a Paragraph text frame.
Allowable formats

Text imported with this filter must be in ASCII format. When preparing text for import, use 
your word processor's non-document mode or save the file as "text only" (i.e., ASCII 
format). Text attributes such as bold, italics, and underlining will be ignored, while tabs 
and indents will be converted to spaces.
Other text filters included with Corel VENTURA allow you to import text in several popular 
word processor file formats.

Corel VENTURA Character Limits
Corel VENTURA allows a character limit of 8000 characters per paragraph of Paragraph 
text. (A paragraph is defined as a block of text ending in a carriage return.)

Text import into Corel VENTURA
This file format corresponds to the 7- bit Text import filter found in previous versions of 
Ventura. Text files of that particular format come typically from applications such as 
Notepad or Write.

See also
General Notes on Importing Text files



Import--ANSI text (*.*)
Technical Notes
American National Standards Institute. At 256 characters, the ANSI character set offers 
twice as many characters as ASCII text, including the paragraph symbol. Many typefaces are
derived from the ANSI character set.



Import--ASCII 8-bit text (*.TXT)
Technical Notes
The ASCII standard uses 7 bits for data and one parity bit. This allows 128 characters. To 
allow the import of non-English characters, the 8-bit ASCII import filter was developed; it 
uses the parity bit as data thus allowing the Corel VENTURA character set to be represented 
in a pseudo-ASCII format.
ASCII characters below decimal 32 (except tab-decimal 9-) are not translated to or from 
Corel VENTURA.
Loading as an ASCII or 8 Bit ASCII file requires two carriage return-line feed combinations to 
create a new paragraph.
Text from mainframe computers
Some ASCII files, especially those transferred via a communication program to your PC from 
mainframe computers, do not have two pairs of carriage return (decimal 13) and line feed 
(decimal 10) characters at the end of each paragraph ([CR][LF][CR][LF].) Additional carriage 
returns without a matching line feed (or vice versa) will cause unpredictable results.

See also:
General Notes on Importing Text files



Import EPS (Placeable) (.EPS, .PS, .AI)
Technical Notes
Corel VENTURA imports EPS, PS, and AI files in a "Placeable" format. Corel VENTURA displays
the preview in the working file.
If the EPS file contains a placeable header (i.e., a small bitmap representation of the image), 
the placeable header is imported and displayed. The EPS information remains attached to 
the header and is used when the image is printed to a PostScript printer. This is similar to 
how EPS files are handled by many desktop publishing packages. The EPS file is not editable,
nor can text in the EPS file be edited.
EPS files placed in Corel VENTURA are parsed for DSC color comments to determine which 
Spot and Process colors are used within them. This is necessary to properly separate them to
PostScript output devices.
Some EPS files from outside sources may reference Spot, or user-defined, colors that are not 
directly supported by the Corel applications. This includes Pantone color names that have 
been abbreviated (e.g., PANTONE Wm Red). Separation of these colors is not supported. If 
the string "unknown PANTONE color" appears in the separation colors list in the Separations 
section of the Print dialog box, this situation has occurred. This color will not separate 
properly and will yield an empty separation. You should either deselect the unknown color in 
the list before outputting separations, or re-create the EPS file using only colors recognized 
by the Corel applications.
Note:    EPS file formats (AI, EPS placeable) may not import properly using the All Files the 
(*.*) import option. To import them, choose the EPS placeable import filter.



TagWrite--Style Match RTF (*.RTF), SGML Custom Template (*.*)
TagWrite provides a mechanism for transferring Corel VENTURA documents to and from 
other document processing formats (e.g., Word 6, WordPerfect 6, SGML, etc.) while retaining 
a substantial number of higher-level text formats. TagWrite addresses one of the major 
drawbacks associated with working in multiple word processing environments--the inability 
to include complex typesetting information along with the text being transferred. Most 
import filters are capable of retaining simple text formats such as bold, italics, or underline, 
but don't retain more complex information such as font, color, spacing, and justification. 
TagWrite is a file parser. It searches text files for native formatting codes and converts them 
into equivalent codes that can be interpreted by a target application. For example, TagWrite 
can convert the formatting codes in a Word document into equivalent codes that Corel 
VENTURA recognizes. 
TagWrite uses a predefined template and style sheet to convert documents from one file 
format (the source format) to a Ventura tagged format (the target format). A template is a 
table which lists formatting sequences supported by the source file format and their 
corresponding equivalents in the target file format. A TagWrite template defines a set of 
rules for finding and replacing imbedded text codes while converting text. TagWrite 
templates can be created and modified using the template editor included with Corel 
VENTURA. 
If you are using the TagWrite--Style Match RTF import filters, a dialog box containing two lists
of tags will open once you've chosen TagWrite as the import filter. The first list identifies all 
the paragraph or content tags found in the original document. The second contains all the 
paragraph tags defined in the current style sheet. By mapping the tag names from the 
original file to corresponding tag names in the current style sheet, you preserve the tag 
structure of the original document. 
If you are using the TagWrite--SGML/Custom Template filter, a list of available TagWrite 
conversion filters will appear. Use this option to choose the custom templates you've created
using the TagWrite Template Editor. When you use an SGML filter, TagWrite creates a new 
chapter in the current publication, and flows the imported document into it. Tag mapping is 
not required when you use an SGML filter.
Detailed instructions on using TagWrite and its Template Editor are provided in PDF format 
on the CD-ROM. You can view these documents online, or print a copy of them using Adobe 
Acrobat Reader (also included on the CD-ROM).



Import CorelCHART (.CCH)
Technical Notes
If you choose Save Corel Presentation Data when you save your CorelCHART file (in version 5
of CorelCHART), you'll be able to    exchange information between CorelCHART and other 
Corel applications. 

· Corel Presentation data does not maintain links between objects that make up a 
CorelCHART file. If you have data in a CorelCHART file that you've updated after 
importing the CCH file into another Corel VENTURA file, that data will not update 
automatically.

· If you have not saved the CorelCHART file with Presentation Data attached, Corel will 
open CorelCHART via OLE (provided CorelCHART is installed on your system), ask for 
the CMX data, and then import the Presentation Data. This may take a significant 
amount of time.

· Saving files with Presentation Data attached will add to the file size. 



Import Corel Presentation Exchange (.CMX)
Technical Notes
Corel Presentation format is a special file format for exchanging information between Corel 
applications. It resembles the native .cdr format, but will not maintain links to objects or 
other data. 

· Corel Presentation data does not maintain links between objects. For example, if you 
have data in a CorelCHART file that you've updated after importing the CCH file using 
the Corel Presentation format into another Corel VENTURA file, that data will not 
automatically update.

· If you have not saved the CorelCHART file with Presentation Data attached, Corel will 
open CorelCHART via OLE (provided CorelCHART is installed on your system), ask for 
the CMX data, and then import the Presentation Data. This may take a significant 
amount of time.

· Saving files with Presentation Data attached will add to the file size. 
Note: CDR files saved without Corel Presentation Exchange data (all 3.0 and 4.0 .cdr 

files, plus any 5.0 .cdr files saved without cmx) will not load into Corel VENTURA. 
To get around this, either load the .cdr file into CorelDRAW 5.0 and resave it with 
the Corel Presentation Exchange data, or open the .cdr file in CorelDRAW 4 and 
use OLE 2 to drag and drop it from CorelDRAW to Corel VENTURA. 



Micrographx 2.x, 3.x (.DRW)
Technical Notes
Imports graphic files created in Micrographx Draw 2.x or 3.x into Corel VENTURA.
Unsuppported Features

· Clip regions are not supported.
· Most raster operations are not supported.

Fountain Fills
Gradient (or fountain fills) created in Micrographx .DRW files are broken down in to 
several polygons.



Microsoft Rich Text Format (.RTF)
Technical Notes
Imports text files created and saved in Microsoft Word's Rich Text Format into Corel 
VENTURA.
Unsupported Features

· Table of Contents and Indexing Data
· Some graphics

Page Size
When importing text the page size in the original document is ignored. The text is fit to 
the current Corel VENTURA page size. This may affect the placement of text.

See also
General Notes on Importing Text files



WordPerfect Graphic (.WPG)
Technical Notes
Imports graphics created in WordPerfect applications into Corel VENTURA.
Features not supported

· WPG version 2 is not fully supported.
· Graphics Text Type 2.
· WPG version 6 is not supported.



Ami Professional 2.0, 3.0 (*.SAM)
Technical Notes
Imports text files created in Ami Professional 2.0 or 3.0 into Corel VENTURA.
Page Size

When importing text the page size in the original document is ignored. The text is fit to 
the current Corel VENTURA page size. This may affect the placement of text.

Ami Professional files in Corel VENTURA chapters
In Corel VENTURA 5, the following error message appears when you open a VENTURA 4.2 
chapter which includes Ami Professional files: "The file is invalid or has an unsupported 
format...".
Opening the text files in Ami Professional and saving them again allows the files to load 
as part of the chapter in Corel VENTURA 5.

See also
General Notes on Importing Text files



Excel for Windows 3.0, 4.0 (*.XLS)
Technical Notes
Imports spreadsheets created in Excel for Windows 3.0 or 4.0 directly into a frame in Corel 
VENTURA.
The cell widths in Excel create a ruler line in the target file with the tab stops matching the 
cell widths.



Lotus 123 1A, 2.0 (.WK?)
Technical Notes
Imports spreadsheets created in Lotus 123 1A or 2.0 directly into a frame in Corel VENTURA.
It is important to specify the currency setting with the Options / Spreadsheet Currencies 
command in Lotus 123 before converting spreadsheets containing international currency 
symbols and conventions.
The cell widths in Lotus 123 create a ruler line in the target file with the tab stops matching 
the cell widths.



Lotus 123 for Windows 3.0 (.WK?)
Technical Notes
Imports spreadsheets created in Lotus 123 3.0 for Windows directly into a frame in Corel 
VENTURA.
It is important to specify the currency setting with the Options / Spreadsheet Currencies 
command in Lotus 123 before converting spreadsheets containing international currency 
symbols and conventions.
The cell widths in Lotus 123 create a ruler line in the target file in which the tab stops match 
the cell widths.



Lotus/Excel Print Table (*.PRN)
Data from DOS- and Windows-based spreadsheet applications can be imported into Corel 
VENTURA. Most Windows-based spreadsheet applications can print spreadsheet data to a file
that can be loaded into Corel VENTURA as a table using the PRN to Table format option in 
the Load Text dialog box. Refer to the documenation accompanying the spreadsheet 
application for the procedures required for printing the spreadsheet data to a file.
For those Windows-based spreadsheet applications that can't print to a file, the data can be 
printed to a file using the Generic/Text Only Windows printer driver. This driver is installed in 
Windows using the Printer option in the Windows control panel. (Refer to the Windows 
documentation for information on installing this driver and configuring it to output to a file.)
If you install the Generic/Text Only Windows driver, the spreadsheet can be output through it
to a file which you can load into Corel VENTURA as a table. However, the spreadsheet must 
output this data to the printer driver with either two spaces (space-delimited), or a comma 
and two spaces (comma-delimited) between each cell. Generally, you can do this by adding 
two spaces after the data in each cell, or by adjusting the column width so that two spaces 
will follow the data in each cell when the spreadsheet is printed to a file. 



Microsoft Word 5.0, 5.5, 6.0 (*.*)
Technical Notes
Imports text files created in Microsoft Word into Corel VENTURA.

See also
General Notes on Importing Text files



Microsoft Word for Windows 1.x (*.*)
Technical Notes
Imports text files created in Microsoft Word 1.x for Windows into Corel VENTURA.

See also
General Notes on Importing Text files



Microsoft Word for Windows 2.x & 6.x (*.doc)
Technical Notes
Imports text files created in Microsoft Word for Windows 2.x or 6.x into Corel VENTURA.
Note:    Pending the release of the appropriate export filter by Microsoft, Corel VENTURA 
saves Microsoft Word for Windows 6.0 files in Word for Windows 2.0 format. When you return
to Word for Windows 6.0 to and resave files saved earlier in Corel VENTURA, a prompt will 
appear stating that the file was last saved in Word 2.0. You may then save the file in either 
Word format.

See also
General Notes on Importing Text files



Microsoft Word for Macintosh 4.0 (*.*)
Technical Notes
Imports text files created in Microsoft Word 4.0 for the Macintosh into Corel VENTURA.

See also
General Notes on Importing Text files



Microsoft Word for Macintosh 5.0 (*.*)
Technical Notes
Imports text files created in Microsoft Word 5.0 for the Macintosh into Corel VENTURA.
See also

General Notes on Importing Text files



WordPerfect 5.0 (*.*)
Technical Notes
Imports text files created in WordPerfect 5.0 into Corel VENTURA. 
All other attributes, attribute combinations, footnotes, index references, and text characters 
must be entered into WordPerfect using the < > commands outlined in Text attributes.
See also

General Notes on Importing Text files



WordPerfect for Windows 5.1 (*.*)
Technical Notes
Imports text files created in WordPerfect for Windows 5.1 into Corel VENTURA.
All other attributes, attribute combinations, footnotes, index references, and text characters 
must be entered into WordPerfect using the < > commands outlined in Text attributes.

See also
General Notes on Importing Text files



General notes on importing text files
Generally, the text files that you import will look the same in Corel VENTURA as they did in 
their source application. However, there will be some formatting attributes and page layout 
features which are not supported.
When a text file is imported into Corel VENTURA and saved as part of a chapter, it remains 
linked to the source document. Any editing of the text in Corel VENTURA will be saved to the 
source document. Likewise, any editing of the source document in other applications will 
appear in the Corel VENTURA chapter. This link between source documents and chapters is a
powerful feature of Corel VENTURA. But, since much of the word processor's format 
information is replaced by Corel VENTURA's attribute codes, you may wish to make backup 
copies of text files before loading them into Corel VENTURA.
Unsupported features

· Hidden text
Header, footers, footnotes and endnotes

· Justification
· Embedded graphics
· Columns
· Tables
· Macros
· Word Processor style sheets

Page size and margins
When importing text the page size in the original document is ignored. The text is fit to 
the current Corel VENTURA page size. This may affect the placement of text. 

Password-protected text files
Password-protected text files cannot be imported into Corel VENTURA. To import a text file 
that is password-protected, you must open it in the word processor in which it originated, 
save it under a different name as a non-password-protected file, and then import the new 
file.



Microsoft Word for Windows 6.0 (*.*)
Technical Notes
Imports text files created in Microsoft Word 6.0 for Windows into Corel VENTURA.

See also
General Notes on Importing Text files



WordPerfect for Windows 6.0 (*.*)
Technical Notes
Imports text files created in WordPerfect for Windows 6.0 into Corel VENTURA.
See also

General Notes on Importing Text files



PC Paintbrush (*.PCX)
Technical Notes
Many popular graphics and scanning programs save images in PCX format. Corel VENTURA 
supports PCX versions 3.0 and above, including 24-bit PCX images.
General Notes and Limitations

· A PCX format image saved once from Windows Paint does not contain a palette 
(definition of colors for the image). When this image is loaded into Corel VENTURA, 
Corel VENTURA will, to the best of its ability, generate a palette for the image. The 
colors produced in this palette may not be the same as those produced in Windows 
Paintbrush. If the image is saved a second time from Windows Paintbrush before being 
loaded into Corel VENTURA, the palette will be saved with the image and Corel 
VENTURA will not be required to generate the palette.



WordStar (*.*)
Technical Notes
Corel VENTURA can read and write standard WordStar 3.3, 3.4, 4.0, 5.X and 7.0 for DOS as 
well as versions 1.X and 2.0 for Windows. Other versions of WordStar may also work.
Corel VENTURA automatically converts standard WordStar attributes to Corel VENTURA text 
attributes. Corel VENTURA also reads all WordStar dot commands as text, so you should 
eliminate these codes from the text file before loading the file into Corel VENTURA.
All other attributes, attribute combinations, footnotes, index references, and text characters 
must be entered into WordStar using the < > commands outlined in Text attributes.
Foreign characters entered in WordStar 3.4 which are not available in both the Corel 
VENTURA and the IBM character sets do not display or print.
WordStar tabs
When you press the tab key, WordStar does not always place a tab character into the text, 
but instead inserts multiple spaces. Corel VENTURA requires the actual tab character in 
order to correctly format tabular information. If you use WordStar 3.0, turn the Vari-Tab 
feature within WordStar Off. When using WordStar 4.0 or 5.X, use the non-document mode 
and type Ctrl + PI for a tab character. The tab character will not display on the screen, but it 
will be inserted in the text and recognized by Corel VENTURA as a tab.

See also:
General Notes on Importing Text files



Xywrite (*.*)
Technical Notes
Corel VENTURA can read and write standard Xywrite 3.0,3.X, 4.0 and 1.0 (for Windows) files. 
Corel VENTURA automatically converts standard Xywrite text attributes to Corel VENTURA 
text attributes.
All other attributes, attribute combinations, footnotes, index references, and text characters 
must be entered into Xywrite using the < > commands outlined in Text attributes.

See also:
General Notes on Importing Text files



Using CorelKERN

Starting CorelKERN
Modifying the kerning value
Adding a new kern pair
Editing a kern pair
Deleting a kern pair
Changing point size
Opening pfm files
Saving a kern pair
Saving a kern pair set
Loading a kern pair set
Printing kern pairs
Changing count factors



CorelKERN Overview
CorelKERN is a professional, easy-to-use tool for adding, adjusting and modifying kern pairs.
Font information used by many applications under Microsoft Windows 3.0 and 3.1 is stored in
pfm files. CorelKERN will modify these pfm files. It's important to note that changing the 
kerning value of a font will affect all old files using that font and will also affect all new files 
created subsequent to the change.
When automatic kerning is selected within Corel VENTURA, the program will pick up the 
kerning information from these files. 
Before using CorelKERN for the first time, we strongly suggest that you make a backup copy 
of your existing pfm files which are usually located in a PSFONTS or WINDOWS directory.
Here are some of the basic steps involved in modifying kern pairs using CorelKERN:

1. Select the font/pfm you wish to modify (e.g., Times, Helvetica, Palatino, etc).
Note:    Before you start, make a backup copy of the file you'll be editing.

2. Merge, adjust, delete or add kern pairs.
3. View and/or print the pairs as they are being adjusted.
4. Save the changes to the .pfm font.

Note: If you plan on bringing a document in which the kerning pairs have been modified to a
service bureau, its advisable to send a PRN file with the downloaded fonts embedded within.
The service bureau may not have the same kerning values, causing the fonts to print 
differently. 



Starting CorelKERN
Double-click the CorelKERN icon. The application opens and the CorelKERN window is 
displayed.
Select the font/pfm you wish to work with by clicking on its name (some font vendors use 
abbreviations for their font/pfm names, refer to the user's documentation for their 
equivalent names) in the file scroll window. You can change the pathname by selecting the 
desired disk and directory in the Open File menu.
The screen displays a listing of the kern pairs for the selected font. A list of kern pairs that 
have already been established for this font will appear.



Modifying the kerning value
Using the mouse, point to the pair to be modified and double click. The Edit Kern Pair screen 
opens which displays the selected pair in 12, 18, 24 and 72 points.
Below the pair is a scroll bar and to the right is a listing of the Current Kerning values. A kern
value of 0 means that the pair is not kerned. A negative value (value preceded by a hyphen) 
indicates that the characters are closer together (kerned). A positive value (no minus sign) 
means that the characters are further apart (letterspace or positive kerning).
Note: Changing the kerning value of a font will affect all old files using that font and will also
affect all new files created subsequent to the change.
To change the kerning value:

1. Place the pointer on the left or right arrows in the scroll bar.
2. Click on the arrow. Clicking on the arrow will change the Current Kerning value by one 

unit. The display of the character reflects the changes made.
Clicking on the right arrow increases the value; clicking on the left arrow decreases the
value.



Adding a new kern pair
The Add command is used to add kern pairs that are not in the .pfm file.
To add a new kern pair:

1. Choose Update menu, Add. The Add Kern Pair box opens.
2. Enter two characters.

In the Add Kern Pair box, there are ASCII, Decimal or Hexadecimal selections. Character
pairs may be entered in ASCII (regular keyboard characters are usually typed this way).
When decimal or hexadecimal values are entered, they must be separated by a 
comma. The decimal mode is used to enter special characters normally entered by 
Alt+3 digits.



Editing a kern pair
1. Choose Update menu, Edit. The Edit Kern Pair screen opens.
2. Place the pointer on the left or right arrows in the scroll bar.
3. Click on the arrow. Clicking on the arrow will change the Current Kerning value by one 

unit. The display of the character reflects the changes made.
Clicking on the right arrow increases the value; clicking on the left arrow decreases the
value.



Deleting a kern pair
Before you delete a kern pair, make sure that you have a backup copy of the .pfm file.
To delete a kern pair:

1. Click on a pair.
2. Choose Update menu, Delete.



Changing point size
The point size chosen is the size at which the characters are displayed. The minimum size is 
12, the default 24.
To change the point size:

1. Choose Update menu, Change Size.
2. Enter a point size.



Opening pfm files
1. Choose File menu, Open.
2. Choose a pfm file from the list.

The file name and font name appear in the Title bar and a list of the kern pairs is 
displayed. If no kern pairs are displayed, there are no kern pairs set for the .pfm file.



Saving a kern pair
· Choose File menu, Save.



Saving a kern pair set
Kern pair sets can be saved as ASCII files. These files can then be brought back to merge 
with other sets or replace kern sets.
To save a kern pair set:

1. Choose File menu, Save Kern Pair Set.
2. Enter a file name. Files should end with .txt.



Loading a kern pair set
To load a kern pair set:

1. Choose File menu, Load Text.
2. Click Replace or Append.

Replace entirely removes the existing table and replaces it with the loaded file.
Append compares the two tables and adds any kern pairs from the file that do not 
appear in the existing table.

To determine the font name:
· Click the font name. CorelKERN displays the complete name of the kern set.

To adjust the overall sets:
· Use any ASCII editor and edit the first line of each set by reducing the number 

following the percent (%) sign. All kern pairs within the set become tighter. Likewise, by
increasing the value, all kern pairs within the set become looser.



Printing kerns pairs
Once you have added or modified kern pairs, it is helpful to have printed samples. A page or 
two will print with kern pairs in five different sizes. If you have chosen Include Reference 
Lines, the printed sample includes vertical lines six points apart from one another. This 
allows you to compare the effect of different kern values.
To print kern pairs:

1. Highlight the kern pair.
2. Choose File menu, Print. 



Changing the count factor
This function allows you to change the unit radix. This is used for ease of building kerning 
pairs when trying to match up with other systems. The count factor is the number of units to
the EM.
To change the count factor:

· Choose Update Menu, Change Count Factor.



Chapter Settings command (Layout menu)
Opens the Chapter Settings dialog box. 
The tabs in this dialog box allow you to set the layout, headers/footers, footnotes, 
typography and numbering for the current chapter.



How to...
· Create headers and footers
· Specify footnote settings
· Set typography
· Add numbering
· Work with dialog boxes



Insert Pages command (Layout menu)
Opens the Insert Pages dialog box.
Adds specified number of pages before or after the current page.



How to...
· Insert/delete pages
· Work with dialog boxes



Delete Pages command (Layout menu)
Opens the Delete Pages dialog box.
Removes the specified number of pages before or after the current page.



Load Style Sheet command (Layout menu)
Opens the Open Style Sheet dialog box.
Replaces the style sheet used in the current chapter by a different one. Style sheets have 
the (.STY) file extension.



How to...
· Load style sheets
· Work with dialog boxes



Save Style Sheet As command (Layout menu)
Opens the Save Style Sheet As dialog box.
Saves the style sheet used in the current chapter with a new name and in a new location if 
needed.



How to...
· Create a style sheet
· Work with dialog boxes



Save Chapter As (Layout menu)
Opens the Save Chapter As dialog box.    Allows you to save the current chapter with a 
different name or in a different location while keeping the original chapter intact.



How to...
· Save a chapter
· Work with dialog boxes



Add New Chapter command (Layout menu)
The Add New Chapter command adds a new chapter at the end of the current publication. 
The order of the chapters can be modified by using the Publication Manager command from 
the File menu.



How to...
· Add a new chapter
· Work with dialog boxes



Add Existing Chapter command (Layout menu)
Adds an existing chapter at the end of the current publication.    The added chapter can be 
associated with other publications. The order of the chapters can be modified by using the 
Publication Manager command in the File menu.



How to...
· Add an existing chapter
· Work with dialog boxes



Hide Page Header command (Layout menu)
Hides the header for the current page only.



Hide Page Footer command (Layout menu)
Hides the footer for the current page only.



Enable Footnotes command (Layout menu)
Displays and prints footnotes in the current chapter. When this command is disabled, the 
footnotes are still saved along with the chapter but they are hidden from view and do not 
print.



How to...
· Specify footnote settings
· Display, insert and edit footnotes
· Work with dialog boxes



Snap to Columns command (Layout menu)
Forces frames in a chapter to align with the column guides.



How to...
· Snap to columns
· Work with dialog boxes



Snap to Inter-Line command (Layout menu)
Forces frames to align with the inter-line spacing set for the Body Text paragraph tag.



How to...
· Snap to Inter-Line
· Work with dialog boxes



Snap to Grid (Layout menu)
Forces graphics associated with a frame to align to the frame's grid as set in the Grid Setup 
dialog box (Tools menu). 
Note:    Snap to Grid must also be turned on for the selected frame in the Grid Setup dialog 
box.



How to...
· Snap to Grid
· Work with dialog boxes





Managing publications
Scanning your system for publications and chapters
Listing files in the Publication Manager dialog box
Viewing and saving file information
Adding existing chapters to a publication
Removing chapters from a publication
Changing the order of chapters in a publication
Renumbering a publication
Copying and moving files, chapters and publications
Deleting chapters and publications
Finding files



Scanning your system for publications and chapters
Before you can manage a publication, you need to add its name to the list of publications in 
the Publication Manager dialog box. Corel VENTURA automatically sets the corel50\typeset 
directory as the directory to scan, but if you keep your publications in other directories, you 
can change the directory. You can also specifiy an entire drive for scanning; however, the 
scanning process will take more time.
To scan for publications:

1. Choose File, Publication Manager and then click the Scan Directories tab.
2. Initially, the Available Drives list shows the root directory of all drives on your system 

plus those on network servers you are currently connected to. When you double-click a
drive, a list of its subdirectories appears.

3. Do any of the following:
· To remove a drive or directory from the list of those Corel VENTURA scans, select it 

from the Scan Directories list and then choose the Remove Selected button.
· To add a drive or directory to the list of those Corel VENTURA scans, select it from 

the Available Drives list and then choose the Add Selected button.
· You can add or remove multiple drives and directories by holding down the Shift key 

while selecting them. Use the Ctrl key instead of the Shift key to select non-
consecutive items or deselect an item.

4. Choose the Re-Scan button to start scanning.
When Corel VENTURA completes the scan it adds the names of all the publications it 
finds to the list of publications.



Scanning your system for publications and chapters
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Listing files in the Publication Manager dialog box
Initially, the Publications Manager dialog box shows all publications and orphaned chapters 
found during the most recent scan. Orphaned chapters are chapters that don't belong to a 
publication because they were created in an earlier version of Corel VENTURA which didn't 
require it.
· the chapters in each publication
· the component files (text, graphics, style sheets) of each chapter 

To list files in the Publication Manager dialog box:
1. Choose File, Publication Manager and then click the File Operations tab.
2. Do any of the following:

· Double-click the name of the publication to see a list of its chapters and then the 
name of the chapter to see a list of text and graphics files it contains along with the 
style sheet it uses.

· To return to the previous level, click ..\ at the top of the Publication list.
· Display all scanned publications, selected publications only, find files results or the 

contents of all chapters by selecting the corresponding option from the list box 
below the Publications list.



Viewing and saving file information
Selecting an item in the Publication list displays information about the item. The type of 
information displayed depends on the item. Selecting a chapter, for example, shows among 
other things:
· the names of files in the chapter and where they are stored
· the style sheet used to format the chapter
· the number of pages and files in the chapter
You can also save the information in an ASCII text file and then open it in Corel VENTURA or a
text editor like Windows NotePad.
To view and save information about an item:

1. Choose File, Publication Manager.
2. From the Publications list, select the file(s) whose information you want to view and/or 

save.
Information about the file is displayed in sequential order beginning with the first item 
you selected.

3. To save the information to a file, select the Publication Operations radio button and 
then choose the Save Info button. The Save As dialog box appears.

4. In the File Name box, type a name for the file and choose a directory in which to store 
the file.    The .TXT file extension is automatically added to the file name.



Adding existing chapters to a publication
When you add an existing chapter from another publication, all its component files (text, 
graphics and style sheet) are also added to the selected publication. Each chapter you add is
placed at the end of the publication, but you can move them later so that they appear in the
correct position.
To add existing chapters to a publication:

1. Choose File, Publication Manager. Corel VENTURA scans your system's drive for 
publication files. Upon completion of the scan, the Publication Manager dialog box 
appears.

2. From the drop-down list box located below the Publications list, choose Publications.
3. In the Publications list, select the publication to which you want to add chapters.
4. Select the Publication Operations radio button and then choose the Add Chapter 

button. The Add Chapter dialog box appears.
5. In the File Name box, type the name of the chapter you want to add or select its name 

from the list.
If the chapter is not listed, select the appropriate drive and directory from the Drives 
and Directories lists.

6. Choose the Renumber button to update the publication's numbering.



Removing chapters from a publication
Removing a chapter, simply breaks the link between it and the publication it belongs to--
neither the chapter nor its contents are deleted.
To remove chapters from a publication:

1. Choose File, Publication Manager. Corel VENTURA scans your system's drive for 
publication files. Upon completion of the scan, the Publication Manager dialog box 
appears.

2. From the drop-down list box below the Publications list, choose Publications.
3. In the Publications list, double-click the publication name from which you want to 

remove chapters.
4. Select the Publication Operations radio button.
5. Select the chapters you want to remove and then choose the Remove button. A dialog 

box appears. Click Yes to confirm the operation.
6. Choose the Renumber button to update the publication's numbering.



Changing the order of chapters in a publication
You can easily change the order in which chapters appear in the Publication list. The order of
chapters determines the order in which the chapters are numbered and the order in which 
information appears in the table of contents and index.
To change the order of chapters:

1. Choose File, Publication Manager.
2. If they are not already listed, double-click the name of the publication whose chapters 

you want to re-order.
3. In the Chapters list, select a chapter and drag it up or down in the list to the 

appropriate location.
4. Repeat step 3 until all chapters are in the order you want.
5. Choose the Renumber button to update the publication's numbering.



Renumbering a publication
You need to renumber a publication after making changes affecting the numbering of pages,
chapters, tables, figures or cross-references.
To renumber a publication:

1. From the Publications list, click the publication name you want to renumber.
2. Choose the Publication Operations radio button.
3. Choose the Renumber button to update the publication's numbering.



Copying and moving files, chapters and publications
Because Corel VENTURA keeps the files that make up a publication separate, extensive 
checking is done to ensure that files aren't missed during a copy or move operation and that
publications get updated whenever a file changes location. However, it's up to you to tell 
Corel VENTURA where to look for your publications when it scans your system. (See 
Scanning your system for publications for more information).
To copy or move files, chapters or publications:

1. Choose File, Publication Manager.
2. From the Publication list, select the files, chapters, or publications you want to copy or 

move.
3. Select the File Operations radio button and then choose the Smart Copy or Smart Move

button.
4. When copying or moving component files (text, graphics or style sheets) a Browse 

dialog box appears so that you can specify a destination for the files to be copied or 
moved. 
The dialog box that appears when copying or moving entire chapters or publications 
lets you specify a different destination for each type of file.

6. In each Destination box, type the disk drive letter, followed by a colon (:), then a 
backslash (\), followed by the subdirectory (if any) where you want to copy or move 
that file type. If you specify a subdirectory that doesn't exist, Corel VENTURA 
automatically creates it. You can also specify a destination by selecting a drive and 
subdirectory in the dialog box displayed when you choose the Browse button.
If you want all files copied or moved to the same destination, make sure the check 
boxes next to each destination box are checked. Then, enter the destination in one of 
the boxes and click the Make All Directories the Same button. To copy just some of the 
file types, clear the check box next to those you don't want to copy or move.

7. Choose OK to begin moving or copying.
8. If a file by the same name already exists in the destination directory, a message 

appears with the following options for handling the conflict:
Yes:    Replaces the duplicate file in the destination directory with the one in the source
directory. The chapter file is updated to use the replacement file.
Yes to All:    Replaces all duplication files without asking for confirmation.
No:    Skips the file in the source directory. You will then be asked if you want the newly
copied/moved chapter to use the file in the destination directory. If you choose No the 
file in the source directory will be used. If you are moving, you are also asked whether 
you want to delete the file you are not using.
Cancel:    Cancel stops the move or copy operation and tries to fix the files that have 
been moved or copied to the new location. It is not recommended that Cancel be used 
because if you stop the Copy/Move operation, the files have been unlinked from the 
previous location and the new links have been cancelled. You will have to run CVPfix to 
reestablish the links.
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Deleting chapters and publications
You can delete chapters and entire publications with the assurance that if a chapter is used 
in another publication it will not be deleted. Keep in mind, however, that Corel VENTURA only
knows about publications in the directories you instructed it to scan. Unless you're certain 
chapter files belonging to all your publications are in those directories it's probably a good 
idea to scan your entire disk before deleting any files (see Scanning your system for 
publications).
To delete chapters and publications:

1. Choose File, Publication Manager.
2. Select the chapters or publications you want to delete.
3. Select the File Operations radio button and then choose the Smart Delete button.



Finding files
You can search for a specific file or a group of files by substituting an asterisk (*) as a wild 
card for any text in the filename. For example, typing rep*.txt finds all files with a .txt 
extension that begin with the letters "rep". You can also specify more than one filename if 
you separate them with a semicolon. For example, typing *.tif, *.eps finds files with either of 
those extensions.
To find a file:

1. Choose File, Publication Manager.
2. Select the File Operations radio button and choose the File Find button. The Find Files 

dialog box appears.
3. Type a filename, or use wild cards to specify a group of files you want to search for.

Unless you specify otherwise, Corel VENTURA searches only the drives and directories 
you selected on the Scan Directories tab. If you want to search all drives and 
directories, click cancel to close the Find Files dialog box and scan all drives using the 
Scanning your system for publications procedure.

4. Click OK. 
Corel VENTURA displays the list of files it finds (if any) in the Publications list.



Opening collections
The Mosaic Roll-Up command allows you to open collections of thumbnails of graphic files.    
The thumbnail representation of the files makes it easy and fast to select and manage your 
graphic files.
You can have two Mosaic roll-up windows displayed in any Corel application.    This is useful 
when you need to import files from different collections or move/copy files between 
collections.
To choose a collection:

1. Choose Mosaic Roll-Up in the File menu.    The Mosaic roll-up window appears and 
displays thumbnails of a directory's files. 

2. Click . The Open Collection dialog box appears.
3. In the Open Collection dialog box, choose a file type in the List Files of Type drop-
down list box from one of the following:
· .CLC to open a catalog file 
· .CLB to open a library file
· another file format in the list to open a directory; only the files of the chosen format 
appear.
· All Files or All Image files to display files of any format/any graphic format, included in
the selected directory.
4. The thumbnails of the graphic files included in the collection appear in the roll-up 
window. Files saved in a file format not supported by Mosaic are listed but a large "X" 
appears instead of a thumbnail.

5. Repeat steps 1-3 to open a second collection.



Resizing the Mosaic roll-up
You may want to resize the roll-up in order to see more thumbnails at one time.
To resize the Mosaic roll-up window:

1. Position the cursor over the horizontal or vertical window border of the Mosaic roll-up 
window.    The cursor changes to a double arrow indicating that you can move the 
border in both directions.

2. Click and drag the window border until the window is of the desired size.    If you drag 
the window border from a corner, the double arrow is diagonal and allows you to resize
the roll-up window horizontally and vertically at the same time.



Opening image files using drag and drop
The Mosaic roll-up makes it very easy to open graphic files in Corel applications with the use 
of drag and drop.
To import files in a Corel application using the Mosaic roll-up:

1. In a Corel application, choose Mosaic Roll-Up in the File menu.
2. If needed, change the current collection by choosing one in the directory drop-down 

list.
3. Click the thumbnail of the file you want to open. The thumbnail is highlighted.
5. Press and hold down the mouse button, drag the cursor to the application window and 

drop it by releasing the mouse button.
6. The file associated with the thumbnail appears in the image area and is ready for 

tracing. 
Note:    The Import filters for the files you want to load must be installed during Corel 
VENTURA setup or the loading operation will fail. Run Setup again to add the required 
filters. See also Technical Support 



Moving and copying files using drag and drop
You can open two Mosaic roll-up windows in a given Corel application.    Using drag and drop, 
you can copy or move files between collections displayed in the roll-up windows.
To copy or move files using drag and drop:

1. In a Corel application, choose Mosaic Roll-Up in the File menu.
2. Choose a collection.
3. Repeat steps 1 and 2 to open a second collection.
4. Click the thumbnail of the file you want to move or copy. The thumbnail is highlighted. 

Press the Ctrl key and click to select multiple thumbnails.
5. Press and hold down the mouse button, drag the cursor to the other Mosaic roll-up and 

drop it by releasing the mouse button to copy the file.    Press the Shift key before 
releasing the mouse button to move the file.

6. A dialog box appears asking you to confirm the move or copy operation.
Note:    The Import filters for the files you want to load must be installed during Corel 
VENTURA setup or the loading operation will fail. Run Setup again to add the required 
filters. See also Technical Support 



Open Collection (File menu)
Opens an existing collection (catalog, library or directory) containing graphic files for viewing
in the roll-up window.
The command displays thumbnails of the graphics files included in the collection in the file 
display screen. If a file is not a graphic file, but is a file type recognized by Corel MOSAIC, the
icon representing the program it was created in is displayed.

indicates that the file is in a format that Corel MOSAIC does not recognize. If Corel 
VENTURA supports the format, you can still import, export and print the file.
You can search for specific files by keywords and choose the order (by name or date) the 
images will be displayed in.
Several collections can be opened at the same time in Corel MOSAIC, allowing you to move 
or copy files between them using drag and drop.

Dialog Box Options

File Name
Displays the files of the selected file type contained in the current directory.    It also lists all
catalogs or libraries in the current directory. Double-click a collection name and all 
thumbnails for the files within the collection display in the display screen.

Directories
Displays a list of directories for selecting catalogs, libraries and directories. Double-click on
a directory to display the related sub directories and to list all file names of a given format 
in the File Name box. 

List Files of Type
Displays the file formats available for selection, including Catalog File(.CLC), Library File 
(.CLB), and supported file formats for all Corel applications. When opening a directory, 
choose a specific file type to have only files of that type display in the display screen. All 
Files displays all files included in a directory and All Image Files displays only files of a 
graphic nature.

Drives
Lists the drives available for selection.

Preview
When enabled, shows a thumbnail image of the graphics file highlighted in the File Name 
box.

Options >>
Displays additional options for searching and sorting files.
When viewing a collection containing many files, clicking the window as the files are being 
loaded halts the display. When ready to continue, pressing the ESC key resumes the 
display.



Open Collection Options (File menu)
The following options appear when the Options >> button is clicked in the Open Collection 
dialog box.    Their purpose is to search a collection for files that contain specific keywords 
and display their thumbnail images in the display screen. The keywords are saved with the 
original file, in the application used to create it. 

Dialog Box Options
Sort by Options for sorting files by their file name or date. Both the files listed in 

the dialog box and the thumbnails in the display screen are sorted 
according to the chosen Sort by option.

Subdirectories When selected, Corel MOSAIC searches the current directory and all 
subdirectories below it for graphics files of a specified file format. 

Keywords Displays the indexing terms associated with the selected file. 
Notes Displays the annotations associated with the selected file.
Fonts Displays the names of the fonts used in a selected file.
Find Searches a directory for Corel files that contain specific keywords and 

displays their thumbnail images in the display screen. 
Tip:    When viewing a collection containing many files, clicking the window as the files are 
being loaded halts the display. When ready to continue, pressing the ESC key resumes the 
display.





Use right-mouse-button menus
Inserted text cursor menu
Selected text menu
Frame menu
Graphic object menu
Selected table menu
Base page menu
Ruler menu



Right-mouse-button menus
Using the Inserted text cursor menu
Using the Selected text menu
Using the Frame menu
Using the Graphic menu
Using the Selected table menu
Using the base page menu
Using the Ruler menu



Using the Inserted text cursor menu

1. Click either  or 
.

2. Position the cursor on the page.
3. Click the right mouse button. The Inserted Text Cursor menu opens.
4. Choose a command.



Inserted text cursor menu
This menu appears when you click the right mouse button while one of the Text tools is 
active and the cursor is placed in a paragraph.    
Click on a command to display information about it. 



Format (Inserted Text menu)
Displays the following flyout menu.    Each command brings up a different tab of the 
Paragraph Settings dialog box.. Click a command to see its description.

Note: If the Tagged Text tool  is current when choosing a 
command from this flyout menu, the dialog box that appears is called Paragraph Settings 
and the formatting changes you set are applied to the paragraph and its associated tag.    
If the Freeform Text tool  is current, the dialog box is called 
Override Paragraph Settings and the formatting changes you set are applied to the selected 
paragraph only. The changes made override the paragraph's tag.



Tagged Text Tool option (Inserted Text menu)
A check mark to the left of this option indicates the Tagged Text tool is the current tool. If 
there is no check mark, clicking this option makes activates this tool.    



Freeform Text tool (Inserted Text menu)
A check mark to the left of this option indicates the Freeform Text tool is the current tool. If 
there is no check mark, clicking this option makes activates this tool.    



Using the selected text menu

1. Click either  or 
.

2. Click and drag to highlight the text.
3. Click the right mouse button. The Selected Text menu opens.
4. Choose a command.



Selected text menu
This menu appears when you click swiped text with the right mouse button.
Click on a command to display information about it. 



Uppercase
The selected text is converted to uppercase.



Lowercase
The selected text is converted to lowercase.



Capitalize
The first letter of every word in the selected text is capitalized.



Normal
Normal removes bold, highlight, superscript, subscript, strike-thru, overscore, alternate size 
and underline attributes from the selected text.



Bold
The selected text becomes bold.



Italic
The selected text is italicized.



Alternate Size
The selected text is converted to a point size specified in the Paragraph Settings, Default 
dialog box.



Superscript
The selected text is converted to superscript



Subscript
The selected text is converted to subscript.



Underline
The selected text is underlined with a single underline.



Double Underline
The selected text is underlined with a double underline.



Strike-thru
A line is drawn through the middle of the selected text.



Overscore
A line is drawn above the selected text.



Overprint
The selected text is printed over the background. If this command is not selected, the text is
printed as knockout.



Using the Frame menu

1. Click .
2. Select a frame.
3. Click the right mouse button. The Frame menu opens.
4. Choose a command.



Frame menu
This menu appears when you click a selected frame with the right mouse button.
Click on a command to display information about it. 



Format
Displays the following flyout menu for choosing formatting options for the selected frame.    
Click a command to see its description.



Uniform Fill
The Uniform Fill command displays the Uniform Fill dialog box. Choose a background color 
for the selected frame.



Overprint Text
The text is printed over the background. If this command is not selected, the text is printed 
as knockout.



No Fill
Removes any fill that has been applied to the background of a frame.



Overprint Outline
The outline is printed over the background. If this command is not selected, the outline is 
printed as knockout.



Overprint Background
The background is printed over the base page. If this command is not selected, the 
background is printed as knockout.



Overprint Ruling Lines
The ruling lines are printed over the background. If this command is not selected, the ruling 
lines are printed as knockout.



Add New Frame Tag command
The Add Frame Tag command displays the Add New Frame Tag dialog box. This dialog box 
allows you to add a new frame tag.



Auto Wrap
The Auto Wrap command puts a path around the perimeter of an imported graphic allowing 
text to flow around the shape of the graphic rather than its frame. You can use the Node Edit

tool  to modify the shape of the path and thus the flow of text around the graphic.



How to...
·    Wrap text around graphics



Preset Wrap Shape
A flyout menu containing a set of preset shapes. Choosing one of the shapes applies the 
shape to the graphic loaded into the selected frame. The options are: oval, diamond, heart, 
inverted rounded rectangle, octagon, rectangle, rounded rectangle, left trapezoid, right 
trapezoid, teardrop and star.
You can use the Node Edit tool  to edit the shape further.



Regenerate Wrap
Regenerate Wrap restores the previous state if you have used the Node Edit tool

 to edit the shape of the graphic, For example, if you have 
applied a preset shape such as the teardrop and edited the nodes, the Regenerate Wrap 
command restores the graphic to original teardrop shape.



Clip Graphic
Use this command to omit the text wrap path around a graphic that's too complex to print. 
Failure to print graphics with text wrap paths sometimes occurs when printing to PostScript 
Level 1 printers. Omitting the text wrap path simplifies the graphic allowing it (or the page 
it's on) to print. 
Text will still flow around the path as intended unless the path clips the graphic. If the 
graphic is clipped, the text will flow across or underneath it rather than around it. In order to 
have text flow around the graphic use CorelDRAW or CorelPHOTO-PAINT to clip the graphic 
and then reload it into Corel VENTURA. Then, use the AutoWrap command to apply a path 
around the graphic making sure that the graphic lies completely inside the path.
NOTE: Graphics print more quickly without the text wrap path. Thus, you may want to 
disable Clip Graphic if the graphic lies completely inside the path.



Size Frame to OLE Object
Use this command after resizing a frame containing a linked or embedded object if you want
to restore the object to its original size. After editing an equation inserted using the Insert 
Item command, choose Size Frame to OLE Object to resize the equation's frame so that the 
equation displays at the correct size.



Select All
The Select All commands selects all of the frames on the current page.



Using the Graphic menu

1. Click .

2. Select a graphic created using , 

, 

, 

 or 

.
3. Click the right mouse button. The Graphic menu opens.
4. Choose a command.



Graphic object menu
This menu appears when you click a selected graphic object with the right mouse button. 
Click on a command to display information about it. 



Show On All Pages
The selected graphic object is displayed on all pages of the document. If the selected 
graphic is already displayed on all pages, the option in the menu is Show On This Page. If 
this option is selected, the graphic is only displayed on the current page.



Send to Back
Moves the selected graphic object to the back of all of the graphics associated with the 
currently selected frame.



Bring to Front
Moves the selected graphic object to the front of all of the graphics associated with the 
currently selected frame.



Select All
The Select All commands selects all of the graphics on the current page.



Uniform fill
The Uniform fill command displays the Uniform Fill dialog box. Choose a fill color for the 
selected frame.



Transparent Fill
The Transparent Fill command removes any applied fill from the selected graphic object(s).
Fills are applied using the Uniform Fill command on this menu or the Fill flyout menu on the 
toolbox.



Overprint Outline
The outlines of the graphic are printed over the background. If this command is not selected,
the outlines are printed as knockout.



Overprint Fill
The fill of the selected graphic object is printed over the background. If this command is not 
selected, the fill is printed as knockout.



Outline attributes
The Outline attributes command displays the Outline Pen dialog box. Choose the color, 
width, style, corners, line caps and calligraphy for the outline of the selected graphic.



Apply Default Fill
The default fill is applied to the selected graphic object(s).
To choose a default fill:

1. Click the Pick tool or click outside the base page to deselect all frames, graphics and 
text.

2. Choose any of the following icons on the Fill flyout:
Uniform Fill Color 

Displays the Uniform Fill dialog box for selecting or create a uniform color fill.
Fountain Fill 
Displays the Fountain Fill dialog box for specifying fountain fills.
Two-Color Pattern 
Displays the Two-Color Pattern dialog box from which you can choose a two-color pattern fill.
Full-Color pattern 
Displays the Full-Color pattern dialog box from which you can choose a full-color pattern fill.
Bitmap Textures 
Displays the Texture Fill dialog box from which you can choose a Bitmap texture fill.
None 
Makes the object transparent allowing objects behind it to show through.

Patterns and Solid 
Selects white or black solid fills and various patterns.
Note:    The Fill Roll-Up cannot be used to select a default fill.

3. The Modify Default Fill Attribute message box appears. Click Yes.
4. The corresponding dialog box appears.    Select the fill color. pattern or texture.

Note: If you have selected Patterns and Solid , no 
dialog box appears.    The next graphic that you draw has the selected fill.



Using the Selected table menu

1. Click .
2. Select a cell of an existing table.

You can also select the entire table, row(s), column(s) or multiple cells.
3. Click the right mouse button. The Selected table menu opens.
4. Choose a command.



Selected table menu
This menu appears when you click selected cells in a table with the right mouse button.
Click on a command to display information about it. 



General
The General command displays the Table Settings, General dialog box. You can choose the 
number of columns and rows, column widths and table borders.



Positioning
The Positioning command displays the Table Settings, Positioning dialog box. You can choose
table spacing, cell spacing, vertical justification, alignment and indents.



Border settings
The Border Settings command displays the Table Settings, Cell Borders dialog box. You can 
choose rule settings and border tags.



Around borders
Use the Around Borders command, which appears when you choose Around Borders, the 
Table Settings, Cell Borders dialog box, to apply border settings to the outside lines of 
selected table cells.    appears. Select new settings and click OK to apply new borders around
selected cells. 



Normal Rules
The Normal Rules command applies initial rule settings for the table to the selected cell(s), 
row(s), column(s) or entire table. For example, if you have set the rules for the table as 
single and then customize selected cells, rows, columns or the entire table, using Normal 
Rules applies the original single line rules to the selected areas.



Custom Rules
Choose a custom rule from the Custom Rules flyout menu. The options are: Z-NONE, 
Z_DOUBLE, Z_SINGLE and Z_THICK.



Overprint
The selected cell, row, column or entire table is printed over the background. If this 
command is not selected, the cell, row, column or entire table is printed as knockout.



Using the base-page menu

1. Click .
2. Select the base page.
3. Click the right mouse button. The Base-page menu opens.
4. Choose a command.



Base-page menu
This menu appears when you click the base page with the right mouse button.
Click on a command to display information about it. 



Chapter command (Base Page menu)
Displays the following flyout menu for choosing formatting options for the selected frame.    
Click a command to see its description.



Frame command (Base Page menu)
Displays the following flyout menu for choosing formatting options for the selected frame.    
Click a command to see its description.



Uniform Fill command
The Uniform fill command displays the Uniform Fill dialog box. Choose a fill color for the base
page.



No Fill
Removes any fill that has been applied to the base page.



Overprint Background
The background is printed over the base page. If this command is not selected, the 
background is printed as knockout.



Overprint Ruling Lines
The ruling lines are printed over the background. If this command is not selected, the ruling 
lines are printed as knockout.



Select All
The Select All commands selects all of the frames on the current page.



Using the Ruler menu
1. Click the ruler. The Ruler menu opens.

Note:    You must have your rulers displayed. To show the rulers, choose Tools, 
Preferences and click the View tab. Choose Rulers from the View dialog box.

2. Choose a command.



Ruler menu
This menu appears when you click the ruler with the right mouse button.
Click on a command to display information about it. 



Left Align
Sets a tab that causes the text to be aligned from the left.



Center Align
Sets a tab that causes the text to be centered at the tab.



Right Align
Sets a tab that causes the text to be aligned from the right.



Decimal Align
Sets a tab that aligns text to a decimal point.





Corel VENTURA 5 New Concepts
This section is intended to familiarize users of previous versions of Ventura with some of the 
new concepts, procedures and features of Corel VENTURA 5.0.
Printing and graphics are now handled by the powerful CorelDRAW engines, and managing 
publications has been reorganized and greatly enhanced by the creation of the new 
Publication Manager. Other features have been extended, like Auto Wrap and Preset Wrap 
Shapes, while new flexibility has been added in other areas, such as text editing, which now 
includes the Freeform Text tool.
Click the subject area of your choice below for more information.

   New Features  

   Changed Features  



New Features
Align
Auto Wrap and Preset Wrap Shapes
Auto-panning and Interruptible Display
Auto-switching between tools
Node Edit tool and the Node Edit Roll-Up
Quick Format Roll-Up
Copy Editor
Overrides
Preferences
PANOSE font matching
Pasteboard
Query
Color Manager
Date & Time (Insert Special Item)
Date & Time Formatting
Border Tags
Tag Attribute Overrides
Roll-Ups
Publication Manager
Type Assist
Text Selection techniques
Place paragraphs side by side button
Next Tag
Tag Types
Create Table from Database



Changed Features
Document views
Manage Tag List
Paragraph Tags
Text Tools
Publications and chapters (PUB and CHP)
Printing
Graphics
Opening chapters created in earlier versions
Text attributes in imported text files
Reverting to previously saved chapter
Keyboard shortcuts: 4.2 vs 5.0



Roll-ups
New to version 5
Description:
A special type of window that contains many of the controls found in dialog boxes: command
buttons, text boxes, drop-down list boxes and so on. But unlike most dialog boxes, the 
window stays open after you apply the selected options. This lets you make adjustments and
experiment with different options without having to continually re-open a dialog box. When 
you are not using the roll-up, you can roll it up leaving just the Title bar visible
Corel VENTURA has the following roll-ups:
Files Roll-Up
Lets you assign text and graphic files to frames. The scrollable list of files can be arranged 
by name or type.
Tags Roll-Up
Tags are displayed in a variety of orders together with their point size and hot key 
assignments. Paragraphs can be tagged directly from the roll-up.
Character Roll-Up
Shows the selected fonts character set and lets you choose characters to insert at the 
current cursor position.
Cross-Ref Roll-Up
Shows a list of all Cross References and Markers in the document so that you can insert 
them into the document.
Index Entries Roll-Up
Lets you create and build Indexes.
Placement Roll-Up
Lets you accurately place and size frames by entering coordinates and size data directly. You
can also specify the rotation angle in this roll-up.
Node Edit Roll-Up
When you have a frame which contains an image, this roll-up allows you to draw a shape 
around that text wraps to.
Quick Format Roll-Up
Quick Formats let you quickly configure a range of things like, Page Layout, Columns, 
Headers and Footers, Paragraph Tags and Rules, Headings, and Tables. For each there are a 
list of choices and the feature is designed for novice or occasional users.
Mosaic Roll-up
This new feature shows thumb-nails of images and allows you to drag and drop objects onto 
a page.
Fill Roll-Up
The Fill Roll-Up allows you to select different types of fills for frames and graphic objects. The
fill types are: color, gradient, texture, two-color pattern and full-color pattern.
Pen Roll-Up
The Pen Roll-up gives you quick access to a variety of outline attributes such as line 



thickness, line style, color and arrowheads.

See also:
Using roll-up windows
Files Roll-Up command
Tags Roll-Up command
Character Roll-Up command
Cross Ref-Roll-Up command
Index Entries Roll-Up command
Placement Roll-Up command
Node Edit Roll-Up command
Quick Format Roll-Up command
Fill Roll-Up
Pen Roll-Up
Mosaic Roll-Up command



Tag attribute overrides
New to version 5
Description:
Tag Attribute Overrides are in-line markup that encode changes that you make using the 
Freeform Text tool. The markup is stored in the text file at the start of the paragraph in which
you are working (immediately following the Tag). Most of what you can set up in a Tag can 
be set as an override and they can be thought of as "exceptions;" for example, one instance 
of Body Text may have its Minimum Space value reduced to overcome a typographical 
anomaly.
New users of Corel VENTURA will be encouraged to use Tagging as the preferred method of 
markup, but there will be some users who will be more comfortable with the way that word 
processors work and use Overrides as their primary method of working.

See also:
Manage Overrides dialog box
Apply overrides



Type Assist
New to version 5
Description:
This feature lets you define strings or abbreviations for commonly used words or phrases. 
While Type Assist is working the abbreviations are automatically substituted as you type. 

See also:
Type Assist command
Use Type Assist
Type Assist dialog box 



Place paragraphs side-by-side button
New to version 5
Description:
This useful new feature allows you to quickly set two or more paragraphs side by side. To do 
this, create the Tags that are to be made side by side and enter some text into each 
paragraph. Then select all of the paragraphs in the set (Alt Click with the Tagged Text tool) 
and press the Place Side by Side button. VENTURA will then divide the measure equally 
amongst the paragraphs and set each tags In from Left, In from Right and Line Breaks so 
that the paragraphs are set with a 1 Pica gutter between.
This feature also sets each tags Next Tag to point to the next paragraph in the side by side 
series. The last paragraph points to the first. Try this feature as a different way of setting 
tabular material.

See also:
Place Side-by-side button



Next tag
New to version 5
Description:
You can now define a sequence of Tags for any regular structural feature of a document. For 
each tag, set its Next Tag (you will find this in Format/Paragraph/Defaults) to the next in the 
sequence. For example if Body Text always, or usually, follows the Tag Heading-2, then select
Body Text as Heading-2s Next Tag.

See also:
Paragraph Settings, Defaults dialog box
 



Tag types
New to version 5
Description:
When you Add New Tag you may supply some additional information that allows VENTURA to
apply some defaults that are appropriate for the type of Tag you are creating. There are five 
types: Heading, Body Text, List Item, Table Text, and Tabulated Line. The type is selected 
from a combo box in the Add New Tag dialog. If you use this method the defaults given to 
certain attributes will be appropriate for the type selected. 
For example, if you selected a Heading type, your tag will have hyphenation switched off, 
Alignment will be Left, there will be no tab stops set up and the Style will be Bold.

See also:
Add Paragraph Tag
Modifying paragraph tags
Adding paragraph tags



Date and Time (Insert Special Item)
Added to Special Items in version 5
Description:
Corel VENTURA 5 allows you to insert the current date and time as a special item by using 
the Insert Special Item command (Edit menu). The date and time can be formatted in a 
variety of preset and custom numeric and text formats. Text formats can be translated into 
any of the 10 languages that are supported by this feature. You can specify that the time is 
updated every time that you flow the document, or only once so that the formatted date or 
time is part of the document text.

See also:
Insert Special Item command
Date and Time dialog box
Insert Special Items
Edit Special Items



Create table from database
New to version 5
Description:
This new feature works in conjunction with Corel Query and allows you to import data from a
database and construct a table directly.

See also:
Make data query tables
Open data queries
Create from Database command



Align command
New to version 5
Description:
The Align command in the Tools menu displays the Align dialog box. This dialog box allows 
you to align graphics and frames horizontally, vertically, to the grid or to the center of the 
page.

See also:
Align command



Node Edit tool and Node Edit Roll-Up
New to version 5
Description:
The Node Edit tool can be used to edit the shape of a loaded graphic. When the tool is 
selected, nodes are displayed along the perimeters of the graphic. You can click and drag 
the nodes to define a new shape. 
The Node Edit Roll-Up is used in conjunction with the Node Edit tool. When you select one of 
the nodes of a graphic, you can use the Node Edit Roll-Up to add and subtract nodes, reduce
nodes without changing the shape of the graphic, convert curves to lines segments, convert 
line segments to curves, change nodes to cusped, smooth or symmetrical nodes and change
the manner in which the modes move. 

See also:
Node Edit tool
Node Edit command
Node Edit Roll-Up



Auto Wrap and Preset Wrap Shapes
More power and flexibility, yet easier to use
Description:
Commands listed in the right mouse button menu that is displayed when you select a frame 
and click the right mouse button. These commands allow you to wrap text around an 
irregularly shaped imported graphic, edit the shape using the Node Edit tool or use one of 
the preset wrap shapes.
The Auto Wrap command automatically wraps text around the graphic in the selected frame 
and displays nodes around the graphic. Using the Node Edit tool

, you can edit the shape around which the text is wrapped.
Preset wrap shapes are supplied.    All preset shapes can be edited further using the Node 
Edit tool.

See also:
Selected Frame menu.



Paragraph Tags
Changed in version 5
Description:
In Corel VENTURA 5, the term paragraph tag is used to define sets of formatting attributes 
applied to a particular paragraphs.    In earlier versions, they were sometimes called Style 
Tags.

See also:
Work with styles



Quick Format Roll-Up
New to version 5
Description:
The Quick Format Roll-Up (Tools menu) provides ready-made templates for formatting tables,
rules, columns, page layout, headers and footers. 

See also:



Copy Editor
New to version 5
Description:
This is an alternative view of the text in a publication and allows you to edit or add copy in a 
fixed font and size.    The Text section of the Preferences dialog box allows you to set the 
environment for the Copy Editor. Font, font size, tabs, tag column width and the visibility of 
codes can be set in this dialog box.
There is a pane to the left of the display that lets you see the tags that have been applied to 
each paragraph. You can also show or hide any in-line markup that is present in the text. 
Working in Copy Editor view is quicker.

See also:
Preferences, Text dialog box
Working with Text--Overview
Setting text preferences



Overrides
New to version 5
Description:
New to this version, overrides allow you to make adjustments to entire paragraphs without 
having to create a separate paragraph tag.    
Simply click the paragraph you want to change with the Freeform Text tool to place the 
cursor in the paragraph without swiping any text.    Apply the changes you want by choosing 
the Paragraph command in the Format menu. The entire paragraph selected is modified.    
The associated paragraph tag and other paragraphs sharing the same tag remain 
unchanged.
A diamond-shaped code is inserted in the paragraph modified with an override. To see the 
code(s), click the Show/Hide Returns button .
The Manage Overrides dialog box allows you to apply the override to the tag so that all 
paragraphs sharing that tag be modified, or remove the override entirely.    For added 
flexibility, the dialog box includes a list of attributes to choose from when performing any of 
these two operations. 

See also:
Manage Overrides command (Format menu).



Document views
New terminology, new item and changed item
Description
Corel VENTURA's View menu includes four commands for viewing your documents. 
Page Layout displays your document as it will look when printed. Text editing and scrolling 
are slower when using Page Layout because all formatting and graphics are displayed. This 
view is usually to position graphics and fine-tune the document's formatting. Version 4.2's 
Show All Pictures (View menu) corresponds to Page Layout view.
Draft View displays text formatting, but puts an X in frames containing imported graphics 
and displays objects created with the drawing tools as black outlines .    This makes for faster
editing and screen redraw. Version 4.2's Hide All Pictures    (View menu) offered a similar 
view.
Copy Editor is new to version 5 and is described in the Copy Editor section.
Facing Pages Preview lets you see facing pages in a double-sided document. Unlike 
previous versions, however, you cannot modify the document in this view.

See also:
Working with Text--Overview



Auto-switching between tools
New to version 5
Description
Corel VENTURA 5.0 provides an auto-switching feature that automatically switches from the 
Pick tool to the most recently used Text tool when you double-click inside an empty frame, a 
frame containing text, or a table cell.



Auto-panning and Interruptible display
New to version 5
Description:
With Auto-panning, Corel VENTURA automatically scrolls your view of the base page when 
you drag a free frame or graphic object beyond the edges of the document area. Auto-
panning occurs only when the window size or magnification factor is set such that less than 
the entire base page is visible.
With Interruptible Display, the screen stops refreshing when you click with the mouse or 
press the ESC key. If either of these actions occurs while a graphic is in the process of 
redrawing, refreshing stops when the graphic finishes redrawing. This lets you select a menu
command or tool without waiting for the screen to redraw completely. Redrawing resumes 
after you perform another action. Click on a scroll bar thumb or when you choose the 
Refresh Window command in the View menu.



PANOSE Font Matching
New to version 5
Description:
When you open Corel VENTURA files from other systems, PANOSE font matching matches 
missing fonts with similar fonts available on your system. PANOSE font matching also occurs 
when you import text or graphic formats that support text.

See also:
Setting text preferences
Preferences, Text dialog box
PANOSE Font Matching Preferences



Pasteboard
New to version 5
Description:
The area to the right and below the base page acts as a worktable on which you can set 
your document. You can place elements such as frames containing imported graphics on the
Pasteboard and move them onto the base page when you need them.



Publication Manager
New to version 5
Description:
New to version 5, the Publication Manager replaces version 4.2's    Multi-Chapter Operations 
dialog box. This new feature has a complete set of tools for the management of Publications.
With it you can edit the contents of a Publication by adding, re-ordering or deleting 
Chapters. You can add new chapters from other publications including those from older 
versions of Corel VENTURA. You can also scan one or several specified drives or directories to
find Corel VENTURA files.
The File List expands to show all chapters referenced in the selected publication when 
double-clicking the publication name . Double-clicking a chapter expands the list to show all 
files referenced in the selected chapter.
Indexes and Tables of Contents are now generated by choosing the TOC & Index command in
the Format menu.

See also:
Publication Manager command (File menu).



Preferences (Tools menu)
Several new items in version 5 Preferences
Overview:
The Preferences are now divided in three main categories for controlling the general settings
of Corel VENTURA, the display options for interface items and the preferences for the Copy 
Editor view. 

See also:
Preferences dialog box for details of each option available.



Color Manager (File menu)
New to version 5
Description:
Color Manager helps to accurately capture, display and print color across different devices. It
creates a System Color Profile by learning about your monitor, scanner and printers.    This 
System Color Profile helps ensure:

See also:
Work with color



Manage Tag List
Added functionality
Description:
Allows you to manage all types of tags (i.e. Paragraph, Frame and Border tags) in one 
convenient dialog box.
Added functionality includes the ability to edit tags, print and save style sheets and set 
hotkeys from within the dialog box.    

See also:
Manage Tag List command (Format menu).



Query
New to version 5
Description:
CorelQUERY, a data query facility, allows you to quickly gather information from various 
databases and bring it into a table in your Corel VENTURA chapter or publication. 
CorelQUERY is directly accessible from Corel VENTURA by choosing the Create from 
Database command in the Table menu. 

See also:
CorelQUERY Online Help



Border Tags
New to version 5
Description:
Corel VENTURA 5 allows you to save attributes given to ruling lines applied to tables as 
border tags.    The Manage Tag List command on the Format menu is used to add, delete, 
rename and edit border tags as well as other tag types.

See also:
Manage Tag List command



Text tools
New terminology
Description:
There are two text tools, roughly equivalent to the old Paragraph and Text Modes of previous
versions. If you use the Tagged Text tool you will be making changes to the Paragraph Tags 
when in the Format Paragraph Dialog, when using the Button Bar, or when moving objects 
on the ruler. 
If you use the Freeform Text tool, then any changes you make will result in attribute 
overrides to the paragraph you are working in. This means that the changes are made using 
in-line markup in the text; the changes are not stored in the paragraph tags, they are stored 
in the text file.
When either tool is being used, if you swipe some text, you will be able to apply attributes 
like Bold, or Underline, and the Ribbon Bar changes accordingly.
Although it is not recommended that a veteran VENTURA user makes frequent use of the 
Freeform Text tool, there are some occasions when it is preferable to do this to avoid 
unnecessary tag proliferation. For instance, if you create a new heading tag that just has a 
Page Break added to it and it only gets used once or twice in a document, it might as well be
done using an override. There is an added benefit if you are collecting these headings into a 
TOC - you will get them all now! If your work around was to create a Page Break Tag, 
creating the override is just as easy and simplifies the Style Sheet and the Text File.
Under Format there is an item called Manage Overrides; use this if you want to convert an 
overridden paragraph into a new tag, or to delete an overridden attribute. It is worthwhile 
considering for a few moments how you would make use of the Freeform Text tool, if at all. 
You can override nearly everything you can set up in a Tag.

See also:
Working with Text--Overview
Work with styles
Work with text
Manage Overrides command (Format menu).



Printing
Changed in version 5
Description:
Printing now uses the CorelDRAW! Print Engine and offers support for Color Management, 
Trapping, and Printer Color Profiles. 
Also, whereas previous versions had a single Print command, version 5 has two: Print and 
Print Publication. Use Print to print the current chapter or specific pages in it and Print 
Publication to print an entire multi-chapter document.

See also:
Printing



Publications and chapters (PUB and CHP)
Changed in version 5
Description:
Corel VENTURA 5.0 uses a conceptually different approach to document organization. In the 
future it will be necessary for all documents to look like the same kind of thing, from now on 
a PUB file. A single chapter publication will be no stranger to many of you who produce 
documents with a TOC or an Index, or if you routinely archive all work that is done in 
VENTURA.
Now, under the File menu, Open, Save and Save As refer to .PUB files. When you create a 
new publication that contains only one Chapter, there is no additional work: the chapter is 
saved with the same name as the PUB file automatically. 
You can then add chapters, bind them in from other publications, or add chapters that were 
created in prior versions of VENTURA. The new Publication Manager has many facilities for 
archiving, deleting and generally managing PUB files and their contents.
Now that every document is a PUB file the functions associated with the old Manage 
Publication have been relocated to a more logical place in the menu system and you will 
now find TOC and Index setup and creation in the Format menu.

See also:
Corel VENTURA concepts



Graphics
Changed in version 5
Description:
Corel VENTURA now uses Corel Draw! 5 graphics drawing tools for Rectangle, Ellipse, Line 
and Box Text.
Any graphic object can have an outline and/or a fill using the same tools [hotlink] that Corel 
Draw! uses. In addition, Fills work with any VENTURA text frame, including the Base Page 
Frame.

See also:
Drawing tools
Work with graphics



Opening chapters created in earlier versions Ventura
Changed in version 5
Description:
Whereas chapters from earlier versions of Corel VENTURA do not have to belong to a 
publication, those in version 5 do. To open a chapter that does not belong to a publication, 
use the Open command as you would when opening a version 5 document, but choose 3.x 
and 4.x Chapters (*.chp) from the List of Files of Type box.

See also:
Opening a chapter created in Corel VENTURA 3x or 4x



Text attributes in imported text files
Changed in version 5
Description:
In previous versions of Ventura all text attributes (bold, italic, underline etc.) are terminated 
at the end of a paragraph even if the Resume Normal attribute code <D> is not 
encountered. In Corel VENTURA 5, the attribute will NOT terminate at the end of a 
paragraph, but rather continue to theend of the text file or until the <D> code or another 
attribute code is encountered.



Reverting to previously saved chapter
Changed in version 5
Description
The Revert to Saved command, which in previous versions of Ventura allowed you to replace
the chapter in memory with the last saved version has been dropped in version 5.0. The 
same function can be accomplished by simply reopening the document using the Open 
command in the File menu.



Keyboard Shortcuts: 4.2 vs 5.0
File Operations
Text and Tag Formatting
Toolbox
Navigating through a document
Views
Special Characters
Miscellaneous



File Operations

Command\
Function

Version 
4.2

Version 
5.0

New Ctrl + N
Open Ctrl + O
Save Ctrl + S Ctrl + S
Print Ctrl + H Ctrl + P
Exit Alt + F4 Alt + F4

Tag and Text Formatting

Command\Function Version 4.2 Version 5.0
Paragraph Settings Dialog Ctrl+ T
Selected Text Ctrl+Shift+ 

Y
Manage Overrides Shift + F10
Manage Tag List Ctrl + K Shift + F9
Update Auto-Numbering Ctrl + B Ctrl + F2
Edit Marker Ctrl + D Ctrl + D
Refresh Window Esc Ctrl + W
Show/Hide Tabs & Returns Ctrl + T Ctrl + H
Show/Hide Column Guides Ctrl + ALT + 

G
Snap To Grid Ctrl + Y
Increase Point Size of Selected Text Arrow Up Ctrl + ALT + 

U
Decrease Point Size of Selected Text Arrow Down Ctrl + ALT + 

J
Increase Kerning Space of Selected Text Arrow Right Ctrl + ALT + 

I
Decrease Kerning Space of Selected Text Arrow Left Ctrl + ALT + 

K
Increase Interline Spacing    (1/2 pt each 
time)

Ctrl + ALT + 
0

Decrease Interline Spacing (1/2 pt each 
time)

Ctrl + ALT + 
9

Extend Selection by 1 Page/Screen Up
(Only with Text Tool)

Shift + PgUp

Extend Selection by 1 Page/Screen 
Down
(Only with Text Tool)

Shift + PgDn

Toolbox

Command\Function Version 4.2 Version 
5.0

Toggle Between Pick Tool and Text 
Tool

Ctrl + U Ctrl + 
Space



Zoom In Ctrl + E (Enlarged 
Veiw)

F2

Zoom Out Ctrl + R (Reduced 
View)

F3

Zoom To Whole Page Ctrl + N (Normal 
View)

Shift + F4

Zoom Dialog Shift + F2
Freeform Text Tool Ctrl + O F8
Tagged Text Tool Ctrl + I Shift F8
Outline Tool (Line Attributes) Ctrl + L F12
Outline Tool (Line Color) Shift + 

F12
Fill Tool ( Uniform Fill) Ctrl + F Shift + 

F11
Fill Tool (Fountain Fill) F11

Navigating though a document

Command\Function Version 4.2 Version 5.0
Move to Beginning of Text Line (Text 
tool only)

Home

Move to End of Text Line (Text tool 
only)

End

Go to First Page Home Ctrl + Home
Go to Last Page End Ctrl + End
Go to Next Page/Screen PgDn PgDn
Go to Previous Page/Screen PgUp PgUp
Go to Page Ctrl + G Ctrl + G
To Front (Only with Pick Tool) Ctrl + A Shift + PgUp
To Back (Only with Pick Tool) Ctrl + Z Shift + PgDn
Go to Next Chapter Alt + PgDn
Go to Previous Chapter Alt + PgUp

Views

Command\
Function

Version 
4.2

Version 
5.0

Copy Editor Alt + F10
Draft Alt + F11
Page Layout Alt + F12
Hide Frame 
Borders

Ctrl + K

Hide Column 
Guides

Ctrl + Alt + 
G

Special Characters

Character Version 4.2 Version 5.0
Copyright mark Ctrl + Shift + C Ctrl + Shift + C



Discretionary Hyphen Ctrl +    - Ctrl +    Shift + H
Em Dash Ctrl    + ] Ctrl    + ALT + M
Em Space Ctrl + Shift + M Ctrl + Shift + M
En Dash Ctrl + [ Ctrl + ALT + N
En Space Ctrl + Shift + N Ctrl + Shift + N
Figure Space Ctrl + Shift + F Ctrl + Shift + F
Non-breaking Space Ctrl + Spacebar Ctrl + Shift + 

Spacebar
Quote (Open) Ctrl + Shift + [ Ctrl + ALT + Q
Quote (Closed) Ctrl + Shift + ] Ctrl + ALT + C
Registered Trademark Ctrl + Shift + R Ctrl + Shift + R
Thin Space Ctrl + Shift + T Ctrl + Shift + T
Trademark Ctrl + Shift + 2 Ctrl + Shift + 2
Line Break Ctrl + Enter Shift + Enter or    

Ctrl+Enter

Miscellaneous

Function Version 4.2 Version 5.0
Constraining drawing 
tools to draw lines at 45
degree angles, squares 
and circles

Hold down Alt key while 
dragging

Hold down Ctrl while dragging

Drawing multiple 
frames and graphic 
objects

Select tool and hold 
down Shift key while 
drawing

Same as 4.2

Panning graphics inside 
frames

Press Alt key and click 
inside frame

Press Ctrl key and click inside 
frame

Selecting superimposed
frames and graphic 
objects

Hold down Alt key and 
click on top frame or 
graphic object

Hold down Alt key and click 
on top frame or graphic 
object

Select next frame or 
graphic object

Not available Press Tab key

Text Selection Techniques
New to version 5
Description:
Corel VENTURA 5.0 now adheres to the Windows conventions for text selection. For example,
you can select a word by double-clicking it or a sentence by holding down the Ctrl key and 
double-clicking anywhere in the sentence. 
Selecting non-consecutive paragraphs for the purposes of applying tags now requires 
holding down the Alt key and clicking anywhere in the paragraph. This selection technique is
available when using either of the Text tools.



Print your documents
Choosing a default printer
Setting up the active printer
Printing a document
Printing a document to disk
Positioning the document before printing
Sizing the document before printing
Printing documents larger than the printer's paper size
Downloading fonts before printing
Specifying the number of stripes used to print fountain fills
Printing color separations
Using unsupported colors in EPS files
Printing Spot colors as separations



Prepress Definitions
Prepress controls are set with the Color Manager. These definitions are provided to enhance 
your understanding of color printing. 
Gray Component Replacement (GCR)
Undercolor Removal (UCR)
Black Point
Dot Gain
Illustration 
Photographic 
Gamut
Gamut Mapping

See also:
Calibrating your system using Color Manager



Gray Component Replacement (GCR)
Technique for reducing the cyan, magenta and yellow in an image and replacing them with 
an appropriate amount of black.
When you use GCR, separations print with improved sharpness, better color fidelity, and 
increased contrast. Separations will also print with better consistency during the print run. 
You set your GCR when you build your Color System Profile using Color Manager. GCR can 
make quality separations even better, especially for darker images or those that contain 
considerable amounts of problem colors such as purples, browns, deep reds, flesh tones, and
grays.
Corel VENTURA's GCR tool in Color Manager allows you to set the GCR to different levels 
along the tonal range depending on the output device or printer. You produce skeletal blacks
by setting the GCR level to very low values near the highlights, and to higher values in the 
shadows. Because high levels of GCR reduce the total amount of ink, deep shadow and black
areas may appear to be less glossy and have less depth. You can compensate for this by 
using less GCR in the shadow areas.



Undercolor Removal (UCR)
UCR refers to the reduction of the cyan, magenta and yellow colors in the dark or neutral 
shadow areas to reduce the total amount of ink coverage. In an ideal printing environment, a
press would be able to print any combination of ink densities, up to 100% of each of the four
colors, or what is known as 400% TAC (Total Area Coverage). However, the maximum 
generally accepted TAC is 300%. TAC values higher than the maximum generally cause 
problems with black ink transfer, ink drying, and ink trapping.
Ink drying becomes particularly important when you work with the slower drying black and 
blue inks. Commonly-accepted TAC values range between 280 and 300%. 



Black Point definition
A black produced by 100% of each of the CMYK components is darker than one produced by 
full amounts of CMY. The black point indicates the blackness level relative to these two 
references in a range from 0 to 1.0. A black point of 0.0 yields a black as dark as a 3-color 
black (CMY). A black point of 1.0 yields a black as dark as a full 4-color black (i.e., darker).
Note: Black point only specifies the apparent darkness of black. The CMYK percentages 
used to produce this appearance are determined by the GCR and UCR calculations made by 
Color Manager. Black Point is not a user-definable option.



Dot Gain
Halftone dots that make up an image "gain" in size from the time you view them on film to 
the time they come off the press. This unavoidable increase in size results in colors that 
appear more intense in the printed image than intended. Fortunately, dot gain can be 
compensated for before you begin the color separation process.
Factors that contribute to dot gain are the quality of the paper, especially its absorbency; the
properties of the ink, the length of the print run, and the capabilities of the printing press.
Corel VENTURA's Dot Gain control compensates for all four colors (CMYK). The compensation
technique reduces the size of a given pixel in the image to compensate for the fact that the 
same dot will increase in size on the printing press. For example, a pixel having a density 
value of 60% when measured before printing might have a measured value of 70% after 
printing. To maintain the 60% value, the value must be reduced such that the increase 
caused by dot gain will result in the desired 60% dot. So when you calculate a dot gain and 
then apply a percentage, you enter a positive number that represents the percentage of 
decrease that you wish to apply to the pixels in that channel(s). 

See also:
Setting Dot Gainccs10_pro2_cd>howto.



 Print to File dialog box
Use to name a file to print to disk.

Dialog Box Options

File Name
Type a name for the file. To overwrite an existing file, select its name from the list.
The file name precedes the .PRN extension and can contain up to eight characters.

Drives
Choose the drive to which you want the file printed.

Directories
Choose the directory in which you want the file printed.

Save File as Type
Shows Print File as the file type being created.

Note: Before you print a final print file or send a print file to an output bureau for film or 
direct imaging, make sure that you've chosen the appropriate System Color Profile for the 
output device chosen.



Choosing a default printer
When you print from Corel VENTURA, your document is automatically sent to the default 
printer. If you have installed other printers, you can specify which one you want Corel 
VENTURA to use. The printer you specify remains active until you exit Corel VENTURA.
Note: Before you print a final print file, or send a print file to an output bureau for film or 
direct imaging, make sure that you've built your System Color Profile with Color Manager for 
the particular output device chosen.
To choose a printer:

1. Choose Print Setup from the File menu.
You can also select a printer from the Print dialog box.

2. From the box under Printer, Name, choose a printer.
Only installed printers appear. For information on installing printers, see your Microsoft 
Windows User's Guide.

3. Choose the Orientation and Paper options you want to use.
Note: When you print a document, a message will appear if the orientation of printer 
page and the Printable page (as specified in the Chapter Settings, Layout dialog box) 
do not match. The message will ask if you want Corel VENTURA to change the 
orientation of the printed page to match the Printable page. You can disable this 
message by editing your CORELPRN.INI file. See also Technical Support.

4. Click OK.



Setting up the active printer
You can specify the default settings for the active printer from Corel VENTURA.
To set up the active printer:

1. Choose Print Setup from the File menu.
You can also select a printer from the Print dialog box.

2. Choose Options.
3. Select the options you want.

Choose the Help button for information about the options.
4. Click OK.



Printing a document
You can print an entire document, the current chapter or page, or a range of pages in the 
current chapter.
To print a document:

1. Do one of the following:
· To print the current chapter or selected pages in it, choose Print from the File menu 

or click the Print button in the Ribbon Bar.
· To print all chapters in a multi-chapter document, choose Print Publication from the 

File menu. Note:    If the document is formatted as a booklet, you must use the Print 
command to print each chapter individually. 

2. If you haven't already done so, choose the Printer Setup command, select the printer 
you want to use from the Printer list box.

3. If you chose the Print command, and want to print selected pages in the current 
chapter, do either of the following:
To print a range of pages, select the Pages radio button and type the page numbers in 
the adjacent text box. You can print a series of non-consecutive pages by separating 
the page numbers with commas and consecutive pages by separating the first and last
page in the range with a dash. For example, 1-3, 5,7, 9-12 would print pages 1, 2, 3, 5, 
7, 9, 10,11 and 12.
To print only odd or even pages, type a tilde (~) after the page number.    For example, 
1~12 prints all odd pages 1, 3, 5, 7, 9, 11 plus 12.
2~ prints all even pages in the document.

4. Specify the number of copies to be printed and whether you want the copies collated 
(sorted).

5. Select a printing resolution from the Print Quality list box. (The availability of this 
option depends on the printer you selected.)
Choosing a lower resolution prints the document more quickly, but with less quality. 
You may want to use this option for printing drafts of documents containing complex 
graphics.

6. Choose OK.



Printing a document to a disk
Printing a document to a disk allows you to print it from a computer that does not have Corel
VENTURA installed. You would normally use this feature when you want to send your 
document to a service bureau for high-resolution printing.
The Windows driver for the AGFA 9000 has been found to be a good choice if you don't have 
a Postscript driver for your service bureau's film device.
When you print to file, the screen frequency used is the one specified in the Print Options, 
Options dialog box.
Note: Before you print a final print file, or send a print file to an output bureau for film or 
direct imaging, make sure that you've built your System Color Profile with Color Manager for 
the particular output device chosen. Also, check the Printer settings in the Windows Control 
Panel to ensure that the port connection is not set to "File". If it is, your file may not print. Or,
if your port setting is set to "File", do not check the Print to File checkbox in the Print dialog 
box.
To print a document to a disk:

1. Do one of the following:
· Choose Print from the File menu to print the current chapter or select pages in it.
· Choose Print Publication from the File menu to print all chapters in a multi-chapter 

publication.
Note: If your document is a large one consisting of two or more chapters, you should 
print it with the Print to Separate Files option in the Preferences dialog box (Tools 
menu) enabled. This option which is only available when printing using the Print 
Publication command, creates a separate print file for each chapter in the document.

2. Check the Print To File check box.
If you are sending the document to a service bureau that uses Macintosh computers, 
check the For Mac check box (PostScript printers only).

3. Select any other options you want. To print separations see Printing color separations 
to an output device.

4. Click OK.
Another dialog box appears, prompting you to give the file a name. Either accept the 
name shown (the same name as the file you are printing), or type your own in the File 
Name box.
Corel VENTURA will print the file to the current directory. To print it to another drive or 
directory, type the path name in the File Name box. Or, select the drive from the 
Drives box, and the directory from the Directories box.

5. Click OK.
A dialog box appears, displaying the name of the current printer, the file name and a 
bar indicating the status of the print job.



Positioning the document before printing
Before you print your document, you can use controls in the Print Options, Layout dialog box
to change its position on the page. Positioning a document in the Layout dialog box only 
affects the way it prints; the document itself remains unchanged. 
To position a document:

1. Choose Print from the File menu, then click the Options button.
The document appears in the preview box. Its size and position are proportional to its 
size and position on the printable page.

2. Enter values in the Left and/or Top boxes. 
3. Click OK.

Note: When the Center option is checked and the page size is smaller than the paper being
printed on, the document is centered on the page and you cannot change its position.



Sizing the document before printing
If you are producing an ad, for instance, which will be printed at various sizes for different 
publications, these options will allow you to scale as needed. Sizing a document in the 
Layout dialog box only affects the way it prints; the document itself remains unchanged.
To size a document:

1. Choose Print from the File menu, then click the Options button.
The document appears in the preview box. Its size is proportional to its size on the 
printable page.

2. Do one of the following:
· Click Fit to Page. The document will fill the printable page.
· Enter values in the Width or Height boxes.
· Click the Maintain Aspect box to maintain the document's aspect ratio and enter 

values in the Width box. Specify the percentage by which you want to enlarge or 
reduce the document in the Width box.

After sizing the document, you can center it on the page by clicking Center.



Printing documents larger than the printer's paper size
Corel VENTURA provides three options for printing documents that exceed the size of the 
paper in your printer. They affect the printed size of the document, not its actual size.
To print documents larger than the printer's paper size:

1. Choose Print from the File menu.
2. Choose one of the following options:

Fit To Page:    Reduces the document to fit on the size of paper the printer is using.
Tile:    Prints parts of the document outside the boundaries of the printer paper on 
additional pages.
Maintain Aspect:    Reduces the document to a percentage you choose of its original 
size. Preview to ensure that the reduced image size fits onto the page size your printer 
supports.

4. Select any other options you want.
5. Click OK.



Downloading fonts before printing
Use the Type 1 font outlines resident in your PostScript printer or download the Type 1 fonts 
to your printer to achieve the highest quality font reproduction.
Downloading fonts to your printer or to disk reduces the size of files created when a 
document is printed. You should download fonts when you send your work to a service 
bureau that has Adobe versions of the fonts you used.
Note: Corel VENTURA only downloads the font into the print file once, even if the document 
has many pages. This reduces the size of your final print file significantly. When sending a 
document to a service bureau for printing, download the fonts used in the document if 
you're not sure the service bureau has those particular fonts.
To print text in a document using downloaded fonts:

1. Choose Print from the File menu.
2. Click the Options button. The Print Options dialog box opens.
3. Click the Options button at the top of the dialog box.
4. Click the Download Type 1 fonts check box.

If you have been using TrueType fonts, click Convert TrueType to Type 1.
5. Click OK to return to the Print dialog box.

Note: Fonts that are resident in your printer will not be downloaded. (Your WIN.INI indicates 
which fonts are resident in your printer.) 



Specifying the number of stripes used to print fountain fills
When proofing documents containing frames or graphic objects filled with fountains, you 
may want to speed up printing by reducing the number of stripes used to print the fountains.
The fewer the stripes, the coarser the fountain appears, but the faster the document prints.
When you are ready to print the final version of your document, increase the number of 
stripes to the default setting (128 for PostScript printers and 64 for non-PostScript printers) 
or higher. If you are printing at a resolution over 1200 dpi or are imaging a large fountain fill 
you may want to use more than two hundred stripes to maintain an even looking fill.
Note: Unless you've specified a different number in the Fountain Fill dialog box, all fountains
will print with the number of stripes specified using the following procedure.
To specify the number of stripes used to print fountain fills:

1. Choose Print from the File menu.
2. Click the Options button and choose the Options dialog box.
3. In the Fountain Steps box, select the number of stripes you want.
4. Choose any other options you want.
5. Click OK.



Printing color separations
Separating a color image causes it to print out on several pages, depending on how you 
assigned the colors to your objects. If you used a process color model, then you'll get four 
pagesone for each of the CMYK process colors used. Spot colors are printed on a separate 
page, one page per color. Be careful, if you're printing to a four color device, but you've 
specified some colors as spot, you could end up with four plates of CMYK plus extra plates of 
spot color.
Corel VENTURA's color separator works very well when used on devices set up with the Color
Manager. Color Manager sets up prepress controls that prepare the images for different 
types of media. Some prepress tools set by Color Manager include Gray Component 
Replacement, Undercolor Removal, Dot Gain, and Black Point Generation. There are also 
color calibration controls that allow you to adjust your monitor so that the colors it displays 
match more closely with those in the printed output. See Advanced calibration features for 
details of setting up your System Color Profile.
You can print color separations on any printer, from a 300 dpi desktop laser printer for proofs
to a high-resolution PostScript imagesetter for final film. Provided you have the appropriate 
printer driver installed and selected, you don't actually need an imagesetter connected to 
your system to create the separations. You can print the separations to disk and then output 
them on another computer connected to the imagesetter. See Printing to disk.
To print color separations:

1. Choose Print from the File menu.
2. Choose the Options button.
3. Click the Separations tab.
4. Enable the Separations check box.
5. Enable the printers' references as required using the buttons below the preview box.

The printer's references will print only when the page size of the document is smaller 
than the paper size you are printing on. Many high resolution printers support an 
"extra" setting. If you are printing a letter sized page (8.5x11 inches) choose "letter 
extra" (9.5x12 inches) to leave room for the printer's references. To choose "letter 
extra" from the Paper Size box, click Setup in the Print dialog box.
If both the File and the printable page size are 8.5x11 inches, choosing Within Page will
print the File information (file name, date, time and color separation information) inside
the top and bottom margins of your document. Other printer's references will not print.

6. To avoid printing spot color plates when you are preparing a four-color separation, 
enable Convert Spot Colors to CMYK.
Note: Because a specified Pantone color may not be matchable with a CMYK 
separation, work with a CMYK palette when creating files for output to four-color 
devices.

7. To adjust the screen angle and frequency for each of the four process colors, enable 
Use Custom Halftone and click the Edit button
Note: It's best not to change the screen settings unless your service bureau or 
commercial printer advises otherwise to avoid moire patterns.

8. To print only certain colors (by default, Corel VENTURA prints a page for each of the 
process colors and an additional page for each spot color used in the document), click 
the colors you want to print.



9. Select any other options you want and choose OK to return to the Print dialog box.
10. Choose OK to begin printing the separations.

See also:
Using unsupported colors in EPS files 
Printing Spot colors as separations



Using unsupported colors in EPS files
To color separate encapsulated PostScript files for PostScript output devices, Corel VENTURA 
parses EPS files for color comments using Adobe Document Structuring Conventions (DSC). 
This process identifies what Spot and Process colors the files use. 
Where EPS files use Spot or user-defined colors that are not supported by Corel applications 
(including abbreviated Pantone color names, e.g., PANTONE Wm Red), the string "unknown 
PANTONE color" appears in the Colors list box of the Print Options--Separations dialog box. 
That color's separation will fail, resulting in an empty separation output. 
To eliminate this problem, do one of the following:
· Deselect the unknown color on the Separations tab in the Print Options dialog box 

before printing separations, 
or,

· Recreate the EPS file using only colors recognized by Corel applications.



Printing Spot colors as separations
Normally, when you print two or more spot colors to a desktop color printer, the colors are 
described with CMYK inks. For example, if you print a two-color fountain fill using spot colors, 
Corel VENTURA automatically converts the colors to CMYK. However, when you are color 
separating so that your art can be printed on a press, a two-color fountain fill will print as a 
four-color separation. 
If you are printing to a press and you've specified spot colors in your design, and you wish to
use effects in which one color prints into another (like fountain fills), or in which two colors 
overlap (like transparencies), you have two choices:

· Use Process Colors to create your final color separations. This allows you to globally 
control line screen angles. When you send your film to the printer, for example, you 
can specify the Cyan plate to be Pantone 286 blue, the Magenta plate to be Warm Red,
and the Black plate as black.

· Use PostScript Options to set line screen angles on each object as you fill it. Then, edit 
your CORELPRN.INI file, as described below.

If you're going to create a complex spot color document, it would be easier to use Process 
Colors. For simpler documents, setting Postscript Options for your fills and outlines works 
well.
First-time users may wish to stick with unblended Spot colors and screens. In this case, 
printing Spot colors as separations is simple. 
To print spot colors as separations to film:

1. Choose the colors you want to separate.
2. Create your separations. See Printing color separations.
3. The name of the Spot color will appear on the film.

To print blended spot colors as separations to film:
1. Convert the spot color to a Process color. If the original object is Pantone 286 Blue with 

a 20% screen, specify Cyan with a 20% screen.
2. Create your separations. See Printing color separations.
3. Tell the printer which Process color plate should be which Spot or Pantone color. In this 

case, the Cyan plate will print as Pantone 286 Blue.
Blended or transparent colors will print with appropriate line screen angles, avoiding 
moiré patterns and muddy colors. Using the above method is best for complex 
documents, since it gives you more global control over the colors.

Spot colors in Corel VENTURA print with a 45-degree screen angle (the angle set for Black). 
This will not result in quality color separations if you are blending one spot color into 
another. You can override this conversion process by editing your CORELPRN.INI file. This 
technique requires you to set your line screen angles on each object before printing. Set 
your spot colors with line angles of 15 and 75 degrees so that if you have black in the 
document, it can default to 45 degrees without interfering with your spot colors.
This technique will work well if you have only a few objects that blend colors.
To print blended Spot colors as separations to film by editing your CORELPRN.INI 
file:

1. Open your CORELPRN.INI file in a text editor such as Notepad.
2. Change the setting PSSpotFountainsAs Process=1 to PSSpotFountainsAs Process=0.



3. Create your separations. See Printing color separations.
Note:    This technique only applies if you are printing directly from a Corel application. 
If you create an EPS file, it will convert the spot blend to process colors.



Setting Dot Gain
The default Dot Gain is calculated by the ink model being used by Color Manager. This 
calculation sets an average dot gain value that Color Manager uses. We recommend that 
you use this dot gain value unless your printer asks for a different one. If you need to reset 
Dot Gain for a specific job, you can set a constant dot gain level. (Consult your printer before
setting a constant dot gain level.)
To set a constant Dot Gain level:

1. Choose Color Manager from the File menu.
2. Click the Printer Edit button.
3. Change your Dot Gain setting to the printer-recommended level in the Printer 

Calibration dialog box.
4. Click OK.

Your dot gain level is now set to a constant dot gain level.
5. Click Generate at the System Color Profile dialog box. (You need to generate a new 

System Color Profile to change the Dot Gain.)
6. Enter a new name for the System Color Profile.

In the Notes section, you may want to specify the Dot Gain value and printer type for 
the System Color Profile you just built.

To reset the default Dot Gain:
1. Choose Color Manager from the File menu.
2. Choose your default System Color Profile from the System Color Profile list.
3. Click OK.

Your dot gain level is now reset to the default dot gain level.



More about Color Manager
Color Manager is a sophisticated color management system that provides three levels of 
color support.
Calibration

Color Manager creates a "linearized" standard against which it can calibrate image 
acquisition, viewing and reproduction devices. These devices include scanners, monitors, 
hard copy printers, film recorders and image setters.

Characterization 
Characterization establishes a normalized color relationship between your device and the 
CIE based reference Color System. This characterization may be based on 
spectrophotometric measurements or visual methods.

Gamut Mapping
Gamut Mapping provides a method of mapping colors to and from different devices. 
Gamut mapping enhances the accuracy of colors displayed on your monitor and the color 
and tonal ranges printed by your output device. Corel VENTURA uses two types of color 
mapping: Illustration for illustrations and Photographic for photographs. 
In Corel VENTURA, gamut mapping is applied automatically according to the image. If 
CorelDRAW is printing a vector-based image, it applies colorimetric gamut mapping. If 
Corel VENTURA is printing a photograph it will automatically use Photographic gamut 
mapping. Even if both types of images are on the same page, Corel VENTURA will use the 
gamut mapping appropriate for that image.



Color Manager command (File menu)
Color Manager creates a System Color Profile by learning about your monitor, scanner 
and printers. The profiles help Corel VENTURA more accurately capture, display and print 
color.
This System Color Profile helps ensure:

· colors that you view on your monitor closely resemble the colors that your printer can 
print

· the images and colors that you include in your drawings will be accurately described to
your printer

· colors from your scanner are adjusted to accurately reflect the colors of the image 
being scanned

Note:    The defaults built into the Color Manager are pre-tested settings; use them 
whenever possible.



Querying databases

Making data query tables
Opening data queries
Adding Data Sources

See also:
· CorelQUERY Online Help
· ODBC Help



Making queries--Overview
Using Corel VENTURA 5's add-on database viewer, CorelQUERY, you have a quick and easy 
way to gather database information and build query tables. CorelQUERY can view files from 
database application files which use Microsoft's Open Database Connectivity, such as 
dBASE, Paradox, FoxPro and SQL Server. 
Using CorelQUERY, you can query database files directly from Corel VENTURA and insert the 
data in an autoformatted table directly into your document. Another advantage of 
CorelQUERY is that you need not own a database program to view files--all you require is 
Corel VENTURA and a database file from a third party.
If CorelQUERY is installed on your system, you are ready to make your first database query. 
To install CorelQUERY, run Corel Setup from the Windows Program Manager (e.g., File, Run 
b:\setup). Consult the Corel VENTURA Installation Guide for further details.

See also:
· Making data query tables 
· Opening data queries
· Adding Data Sources



Making data query tables
When you create a data query in Corel VENTURA, the data is entered as a table into your 
document. See also Querying databases
1. Place the text cursor where you want your query table to appear. 
2. Choose Create from Database from the Table menu. 
3. Choose new from the flyout menu. The Data Source dialog box appears. 
4. Double-click the ODBC folder. A list of available data sources will appear (see 

also Adding Data Sources).
5. Double-click a data source.

A CorelQUERY window and the Query Builder dialog box open.
6. In the Relations list box, double-click the data table(s) you want to use. Note:    

Until you are familiar with making complex queries, we recommend that you 
select only one table for each query.

7. In the Fields list box, double-click the data fields you want to include in your 
query.

8. Select Criteria and Order/Group choices as required. For example, if you want to 
change the sort order from Ascending to Descending, click the Order/Group tab, 
select the relevant fields, and click Descending.

9. Click the SQL tab and click Build. 
CorelQUERY automatically writes your query in Structured Query Language.

10. Click OK. CorelQUERY generates a query table in a small application window.
If you want to save your query file in CorelQUERY, choose Save Copy As... from 
the CorelQUERY File Menu and give your query table a name. 
The .dsq extension is automatically appended. If you don't want to save the 
query table, go to step 11.

11. Choose Exit and Return to [Corel VENTURA filename]. The data will flow into 
Corel VENTURA in a table from text cursor downward and left to right. Edit the 
data as required.



Adding Data Sources
The Add ODBC Data Source dialog box appears when you click the Add button in 
CorelQUERY's Data Source dialog box.
To add an ODBC Data Source:
1. Choose a driver name (e.g., dBase Files (*.dbf)) from the Add ODBC Data Source 

dialog box.
2. Click OK.

When the resulting dialog box appears, key in the required data source 
information, i.e., name, version, number or location.



Adding Data Sources
The Add ODBC Data Source dialog box appears when you click the Add button in 
CorelQUERY's Data Source dialog box.
To add an ODBC Data Source:
1. Choose a driver name (e.g., dBase Files (*.dbf)) from the Add ODBC Data Source 

dialog box.
2. Click OK.

When the resulting dialog box appears, key in the required data source 
information, i.e., name, version, number or location.



Opening data queries
1. Place the text cursor on the Corel VENTURA page where you want the data to 

appear. 
2. Choose Create from Database from the Table menu, 
3. Click Open... from the flyout menu.
4. Choose any .dsq file from the Load Data Query dialog box and click OK. The data 

will flow into the spreadsheet from the active cell downward and left to right.



Opening data queries
1. Place the text cursor on the Corel VENTURA page where you want the data to 

appear. 
2. Choose Create from Database from the Table menu, 
3. Click Open... from the flyout menu.
4. Choose any .dsq file from the Load Data Query dialog box and click OK. The data 

will flow into the spreadsheet from the active cell downward and left to right.





Use the Quick Format Roll-Up

Table formats
Paragraph formats
Ruling line formats
Column formats
Page layout
Header format
Footer format



The Quick Format Roll-Up

Table formats
Paragraph formats
Ruling line formats
Column formats
Page layout
Header format
Footer format



Quick Format Roll-Up--Overview
The Quick Format Roll-Up provides templates for formatting tables, paragraph, rules, 
columns, page layout, headers and footers. 



Table formats
1. Create a new table
2. Choose the Pick tool and select the first cell.
3. Choose Layout, Quick Format Roll-Up. The Quick Format Roll-Up opens.
4. Choose Table from the drop-down list box. A preview of the available table formats is 

displayed in the Select Format window.
5. Double-click on the format you want to use.



Paragraph formats
1. Click  or 

 and position the cursor in a frame, on the base page or in 
an existing paragraph.

Note: If you use the Tagged Text tool and select an existing paragraph, the paragraph 
format selected in the Quick Format Roll-Up is applied to all paragraphs with that tag. 

2. Choose Layout, Quick Format Roll-Up. The Quick Format Roll-Up opens.
3. Choose Paragraph from the drop-down list box. A preview of the available formats is 

displayed in the Select Format window.
4. Double-click on the format you want to use.



Ruling line formats
Ruling lines can only be applied to paragraph selected using the Tagged Text tool

.
You cannot select text with the Tagged Text tool and apply paragraph formats using the 
Quick Format Roll-Up. The entire paragraph must be selected by holding down the Alt key 
and clicking anywhere in the paragraph or the Tagged Text cursor must be positioned in the 
paragraph.
To apply ruling lines to a paragraph:

1. Choose the Tagged Text tool and position the cursor in a frame, on the base page or in 
an existing paragraph.

2. Choose Layout, Quick Format Roll-Up. The Quick Format Roll-Up opens.
3. Choose Ruling Lines from the drop-down list box. A preview of the available ruling line 

styles are displayed in the Select Format window.
4. Double-click on the style you want to use.

Note: If an existing paragraph is selected, the ruling lines format is applied to all the 
paragraphs with same tag.



Column formats
1. Choose the  and select a frame.

2. Choose Layout, Quick Format Roll-Up. The Quick Format Roll-Up opens.
3. Choose Columns from the drop-down list box. A preview of the available column 
formats is displayed in the Select Format window.
4. Double-click on the format you want to use.



Page layout
1. Choose Layout, Quick Format Roll-Up. The Quick Format Roll-Up opens.
2. Choose Page Layout from the drop-down list box. A preview of the available page 

layouts is displayed in the Select Format window.
3. Double-click on the layout you want to use.

If you already have frames, a dialog box is displays asking if you want to delete all 
frames on this page. 
Select yes to delete all the current frames. If you have text in the frames, the text is 
removed along with the frame, but is not removed from the chapter. You can load it 
into one of the frames in the layout. If the text is on the base page, it is not removed.
Select No to keep the current frames.



Header format
1. Choose Layout, Quick Format Roll-Up. The Quick Format Roll-Up opens.
2. Choose Header from the drop-down list box. A preview of the available header formats 

is displayed in the Select Format window.
3. Double-click on the format you want to use. The Header/Footer Text dialog box opens.
4. Enter text for the first line of the header in the First Line box.
5. Enter text for the second line of the header in the Second Line box.



Footer format
1. Choose Layout, Quick Format Roll-Up. The Quick Format Roll-Up opens.
2. Choose Footer from the drop-down list box. A preview of the available footer formats is 

displayed in the Select Format window.
3. Double-click on the format you want to use. The Header/Footer Text dialog box opens.
4. Enter text for the first line of the footer in the First Line box.
5. Enter text for the second line of the footer in the Second Line box.



Control menu box 

Located at the left end of the Title Bar in the Corel VENTURA window.
Clicking on the Control Menu box displays commands for sizing and positioning the window.



Maximize button 

Located in the upper-right corner of the Corel VENTURA window. Clicking on the Maximize 
button expands the window to fill the entire screen. 
After you expand a window, the button changes to the Restore button . Use this button to 
return the window to its former size.
· You can also maximize a window by choosing Maximize from it's Control menu or 

restore it to its original size by choosing Restore.

Shortcut

Double-clicking a window's Title Bar expands the window to full size.



Title Bar
The top line of the Corel VENTURA window, the Title Bar displays the program and 
publication or document name. Roll-up windows, the floating Toolbox and some dialog boxes 
also have Title Bars, which display their names.
The Title Bar offers the following buttons for controlling the size of the document window:

 Maximize button
 Minimize button
 Restore button
 Control Menu box



Menu Bar

The horizontal bar near the top of the Corel VENTURA window contains the names of the 
available pull-down menus. See the Menu Section to find information regarding the menu 
commands.



Minimize button 

Located in the upper-right corner of the Corel VENTURA window. Clicking on the minimize 
button shrinks the window to an icon at the bottom of the screen.
· As an icon, the application stays in memory, but its window does not take up space on 

your screen.
· To restore the window, double-click on its icon or click once on the icon and choose 

Restore from its Control menu.



Rulers

Displayed across the top and along the left side of the document area. You'll find the rulers 
helpful for sizing and positioning elements in your documents.
Choosing Rulers from the View menu turns the rulers on and off. The Rulers Setup command,
in the Tools menu, lets you change the units of measurement the rulers use and the location 
of the zero points. Note that the rulers are not displayed when you select the Copy Editor 
view in the View menu. 
Holding the mouse button down on the box where the rulers meet and dragging on the page
brings out a set of crosshairs. This allows you to relocate the zero points anywhere on the 
page. Crosshairs are also helpful to check the alignment of frames and other elements on 
the page.
By default, the crosshairs snap to the tick marks on the rulers. Hold down the Ctrl key as you
drag to override the snapping. 
Double-clicking the box where the rulers meet resets the zero point to the original location. 



Restore button 

The Corel VENTURA window, when enlarged to full size, has a Restore button located on the 
right end of the Title Bar.
Clicking on the Restore button returns the window to its previous size and location.
· You can also restore a window by choosing Restore from its Control menu.
· Using the Restore button does not affect a window moved or resized with the Move or 

Size commands in its Control menu.

Shortcut

Double-clicking on the window's Title Bar restores the window to its former size and 
location.



Scroll Bars

Bars located along the bottom and right side of the document area or roll-up.

Click to
An arrow move the current view a few lines at a time in selected the direction
An elevator move the view by one full window
A thumb and drag move the view an arbitrary amount in any direction



Scroll Bars

Bars located along the bottom and right side of document area or roll-up.

Click to
An arrow move the current view a few lines at a time in selected the direction
An elevator move the view by one full window
A thumb and drag move the view an arbitrary amount in any direction



Text Ribbon Bar

Located below the Title Bar, between the Ribbon bar and the horizontal ruler, the Text 
Ribbon Bar includes drop-down lists and buttons for editing text in your document. It 
provides controls for font, type face, alignment and tag selection.
A paragraph or a section of a paragraph of text must be selected to apply the Text Ribbon 
Bar attributes. If you select the Freeform Text tool, the changes applied affect only the 
paragraph or selected text. If you use the Tagged Text tool, the changes are applied to the 
paragraph and are also included in the style tag associated with the paragraph.
See the Tools section for descriptions of lists and buttons.



Ribbon Bar

Located immediately below the menu bar, the Ribbon Bar includes buttons that perform 
various menu commands such as Open, Save, Undo, Spell Check among others.
You can hide the Ribbon Bar by using the Preferences command (Tools menu) and clearing 
the corresponding check mark in the User Interface tab.
See the Tools section for information about each button.



Toolbox

The Toolbox includes eight main tools and numerous flyouts for selecting frames, adding and
editing text, zooming in and out from your document, drawing objects and more. 
The Toolbox command (View menu) allows you to switch the display of the Toolbox on and 
off as well as make the Toolbox "float" so that you can relocate it anywhere on the Corel 
VENTURA screen. 
To reanchor the Toolbox to its original location, you can again use the Toolbox command 
(View menu) or clear the floating option listed in the Toolbox control menu. 

Shortcuts:
To Do this
Dock a Floating Toolbox Double-click anywhere in its Title bar. 
Tear-off an anchored Toolbox Hold down the Shift key and double-click anywhere inside or below the 

Toolbox.
Hide a Floating Toolbox Double-click its Control menu box.

See also:

Tools section



Status Line

Located at the bottom left hand corner of the Corel VENTURA screen, the Status Line 
provides information about tools and commands when you rest the mouse cursor over that 
tool or menu command. 
When you are moving the insertion point through text, the status line indicates the presence
of special items such as frame anchors and cross references, and other useful information 
about the text.
You can hide the status line by using the Preferences command (Tools menu) and clearing 
the Status Line check box in the User Interface tab.



Document Area

The Document Area is where the document you are creating or editing is displayed. 
The document can be displayed differently according to the option you select in the View 
menu: Copy Editor, Draft or Page Layout. You can also display facing pages in the document 
area when you are working in Draft or Page Layout view.
You may also use the Pasteboard area--the white space to the right of the document area--as
extra work space for frames or drawing objects. Objects in the Pasteboard area do not print. 
The Zoom tool lets you see your document up close or move away from it.



Page Counter

The Page Counter indicates the current page number and whether it is a right (R) or left (L) 
page. When working in Facing Pages view, the page number of both pages is displayed. 

The scroll buttons  are used to move to the next or previous page within the current 
chapter.
To move to the next or previous chapter in a publication, use the chapter scrolling buttons 
located in the Ribbon Bar.



Tab Bar

Gray rectangular area located immediately below the horizontal ruler, the Tab Bar is used to 
set tab stops. Tab stops are inserted by choosing the Set Tab Stop button that corresponds to
the type of tab required and clicking the Tab Bar at the location where you want to set the 
tab. The Rulers command (View menu), used to hide or display the rulers, also switches the 
display of the Tab Bar on and off, and sets margins, indents and column widths.



Maximize  /Restore 

 button 
Located in the upper-right corner of the Corel VENTURA window. Clicking on the Maximize 
button expands the window to fill the entire screen. 
After you expand a window, the button changes to the Restore button . Use this button to 
return the window to its former size.
· You can also maximize a window by choosing Maximize from it's Control menu or 

restore it to its original size by choosing Restore.

Shortcut

Double-clicking on a window's Title Bar expands the window to full size.



Window borders

The Window borders are used to size the Corel VENTURA screen, roll-ups and Floating 
Toolbox. When the cursor is over one of the borders, it changes to a sizing cursor allowing 
you to make the window either larger or smaller. If the cursor is placed on the corner of the 
window, the window is sized proportionally.



Shortcuts
Tag\Text formatting
Selecting text
Text ribbon keys
Moving through a document
Toolbox shortcuts
Document views
Roll-up keys
Right-mouse-button menus
The Quick Format Roll-Up
Dialog box keys
File menu keys
Edit menu keys
Help shortcuts
How to use Context-sensitive Help
Using accelerator keys
Special characters
Graphics keys



File menu keys
New Ctrl+N
Open Ctrl+O
Save Ctrl+S
Load Text F9
Load Graphic F10
Print Ctrl+P
Exit Alt+F4



Edit menu keys
Undo Ctrl+Z, Alt+Bksp
Redo Alt+Return
Cut Ctrl+X, Shift+Del
Copy Ctrl+C, Ctrl+Ins
Paste Ctrl+V, Shift+Ins
Delete Del



Help menu keys
Help Contents F1
Help Screen/Menu Help Shift+F1
Search for Help On Ctrl+F1



Tag\Text formatting
Insert Soft Return Shift+Enter
Paragraph Settings Dialog Ctrl+T
Selected Text Ctrl+Shift+Y
Manage Overrides Shift+F10
Manage Tag List Shift+F9
Update Auto-Numbering Ctrl+F2
Edit Marker Ctrl+D
Refresh Window Ctrl+W
Show/Hide Tabs & Returns Ctrl+H
Snap To Grid Ctrl+Y
Increase Point Size of 

Selected Text Ctrl+Alt+U
Decrease Point Size of 

Selected Text Ctrl+Alt+J
Increase Kerning Space of

Selected Text Ctrl+Alt+I
Decrease Kerning Space of 

Selected Text Ctrl+Alt+K
Increase Interline Spacing 

(1/2 pt each time) Ctrl+Alt+0
Decrease Interline Spacing 

(1/2 pt each time) Ctrl+Alt+9
Extend Selection by 1 Page/

Screen Up (Only with Text tool
and in the Copy Editor) Shift+PgUp

Extend Selection by 1 Page
/Screen Down (Only with Text
 tool and in the Copy Editor) Shift+PgDn



Moving though a document
Home Move to beginning of current line of text (Text tools only)
End Move to end of current line of text (Text tools only)
Ctrl+Right or Left Arrow Move one word right or left
Ctrl+Up or Down Arrow Move one sentence forward or back
Ctrl+Home Go to First Page
Ctrl+End Go to Last Page
PgDn Go to Next Page/Screen
PgUp Go to Previous Page/Screen
Ctrl+G Go to Page
Shift+PgUp To Front (Pick tool only)
Shift+PgDn To Back (Pick tool only)
Alt+PgDn Go to Next Chapter
Alt+PgUp Go to Previous Chapter



Toolbox shortcuts
To: Do this:
Change from Text tool to Pick tool Ctrl+Space
Zoom In F2
Zoom Out F3
Zoom To Whole Page Shift+F4
Open the Zoom dialog box Shift+F2
Select the Freeform Text tool F8
Tagged Text tool Shift+F8
Select the Outline tool 
(Line Attributes--graphic selected) F12
Outline tool (Line Color--
graphic line selected) Shift+F12
Select the Fill tool (Uniform Fill) Shift+F11
Select the Fill tool (Fountain Fill) F11
Dock a Floating Toolbox Double-click anywhere in its Title bar. 
Tear-off an anchored Toolbox Hold down the Shift key and double-click anywhere 

inside or below the Toolbox.
Hide a Floating Toolbox Double-click its Control menu box.
Change the current tool to the last 
Text tool selected (Freeform or Tagged) Double-click inside a frame with Pick tool 

activated 
Select objects in the background With the Pick tool enabled, hold down the Alt key and 

click the mouse button
Change the current tool to the 
last Text tool selected 
(Freeform or Tagged) With the Pick tool activated, double-click inside a table. 
Note: The cursor becomes a cross when over a table with Pick tool selected.



Document views
Copy Editor Alt+F10
Draft Alt+F11
Page Layout Alt+F12
Hide Frame Borders Ctrl+K
Refresh Window Ctrl+W
Hide/Show Column Guides Ctrl+Alt+G



Roll-up keys
Mosaic Roll-Up Alt+F1
Files Roll-Up Alt+F2
Tags Roll-Up Alt+F3
Character Roll-Up Alt+F5
Cross References Roll-UpAlt+F6
Index Entries Roll-Up Alt+F7
Placement Roll-Up Alt+F8
Node Edit Roll-Up Alt+F9
Table Settings Ctrl+F9
Quick Format Roll-Up Ctrl+Q



Dialog box keys
Chapter Settings Dialog F5
Frame Settings Dialog F6
Recall Last Dialog or 
      Last menu selection F7
Find & Replace Ctrl+F3
Spell Check Ctrl+F5
Load Text F9
Preferences Ctrl+J
Ruling Lines Ctrl+F8
Align Dialog Ctrl+A
Load Graphics F10



Special characters
Copyright mark Ctrl+Shift+C
Discretionary Hyphen Ctrl+Shift+H
Em Dash Ctrl+Alt+M
Em Space Ctrl+Shift+M
En Dash Ctrl+Alt+N
En Space Ctrl+Shift+N
Figure Space Ctrl+Shift+F
Non-breaking Space Ctrl+Shift+Spacebar
Quote (Open) Ctrl+Alt+Q
Quote (Closed) Ctrl+Alt+C
Registered Trademark Ctrl+Shift+R
Thin Space Ctrl+Shift+T
Trademark Ctrl+Shift+2
Line Break Ctrl+Enter
Select underlying objects Ctrl+Mouse+Select



Text ribbon keys
Font Selection Ctrl+F
Point Size Ctrl+Shift+P
Bold Ctrl+B
Italic Ctrl+I
Underline Ctrl+U
Normal Ctrl+M
Left Align Ctrl+L
Center Align Ctrl+E
Right Align Ctrl+R
Tag Selection Ctrl+Alt+T



Selecting text
With either the Freeform or Tagged Text tools activated:
Keyboard+mouse click Result
Alt+click in a paragraph Selects the paragraph. Hold the Alt key and click to select 

several consecutive or non-consecutive paragraphs. Note: This 
operation is used for tagging purposes only (the pointer 
changes to a paragraph icon) and cannot be used for cut and 
paste operations.

Ctrl+click in a sentence Selects the sentence and period from the previous sentence. 
Only one sentence is selected at a time; if you click a second 
sentence, the first one is deselected. To select additional text 
before or after the currently selected sentence, use 
Shift+Ctrl+click.

Ctrl+click+drag Selects multiple sentences
Ctrl+Shift+click+
    drag in paragraph(s) Selects all text from original insertion point to the end of the 

mouse movement and release of the mouse button or next 
mouse click (current frame only). 

Shift+right or left arrow Selects or deselects a character at a time.
Ctrl+Shift+Right or Left arrow Selects or deselects a word at a time, beginning at the 

insertion point.
Ctrl+Shift+Down arrow 
    or Up arrow Selects or deselects a sentence at a time.
Double-click any word Selects the entire word



Graphics keys
· Holding down the Ctrl key while drawing graphics constrains the graphic.
· Pressing the Ctrl key and clicking the mouse button pans a graphic in a frame.
· Holding down the Shift key while drawing frames or graphics draws multiple objects.



Create Table command (Table menu)
Opens the Table Settings dialog box with the General tab displayed.
Creates a new table and defines its parameters. The Create Table command becomes 
available only when you place the insertion point on the base page or frame.



How to...
· Insert a new table
· Work with dialog boxes



Create from Database command (Table menu)
Opens CorelQUERY within Corel VENTURA. Open CorelQUERY Online Help for information 
about querying databases.
Creates a table by extracting information from a database.



How to...
· Make data query tables
· Open data queries
· Work with dialog boxes



Insert Row command (Table menu)
Opens the Insert Row(s) dialog box. This dialog box inserts row(s) before or after the cursor 
position.



How to...
· Add rows or columns
· Work with dialog boxes



Insert Column command (Table menu)
Opens the Insert Column(s) dialog box. This dialog box inserts column(s) before or after the 
cursor position.



How to...
· Add rows or columns
· Work with dialog boxes



Select command (Table menu)
The Select flyout enables you to select a row, column or entire table.



Delete command (Table menu)
The Delete flyout enables you to delete a row, column or entire table.



How to...
· Deleting row(s), columns(s) or table



Merge Cells command (Table menu)
Combines selected cells into one.    The combined width and height of the original cells are 
maintained.



How to...
· Merge and split cells
· Work with dialog boxes



Split Cells command (Table menu)
The Split Cells command restores selected cells that have been previously merged to their 
original state.



How to...
· Merge and split cells
· Work with dialog boxes



Cell Color command (Table menu)
Opens the Cell Color dialog box.
Enables you to choose colors to be applied to the background of selected cells.



How to...
· Apply color to cells
· Work with dialog boxes





Corel VENTURA Technical Support
Corel support services
If Corel VENTURA will not run
Common error messages
Troubleshooting tips
Bitstream facelift fonts
Printing information
Import file filters--Technical notes
Exporting to different word processor formats
Color management
CORELVP.INI
CORELDRW.DOT file
Size limitations



Corel support services
Corel recognizes that support needs vary from user to user, and we offer you a wide range of
choices when you need answers to your technical queries in using Corel VENTURA.
If you have a question about Corel VENTURA features and functions, first look in the Corel 
VENTURA User's Guide or consult online Help. 
You can also find late-breaking updates and technical information by double-clicking the 
Readme Icon in the Corel VENTURA program group.
If you cannot find the answer, you can speak to a Technical Support Representative located 
in North America or in Europe.
If you encounter problems after hours or on weekends or holidays, you can contact IVAN,our 
Interactive Voice Answering Network.
We also offer Electronic Support Services in the form of a Compuserve forum and a bulletin 
board.
How to reach Corel in North America
How to reach Corel worldwide
Interactive Voice Answering Network (IVAN)
Electronic support options
How to use the Automated Fax System



Common error messages
General Protection Faults (GPFs), application errors and system lockups
1000 series errors
2000 series errors
5000 series errors
Other memory-related errors
OLE problems



Troubleshooting tips
Enhancing system performance
Troubleshooting techniques
Tips & tricks for troubleshooting
Having memory problems?



Printing information
What to do if your print job doesn't print
Working with service bureaus
Color separations
Line Attributes
PostScript printing errors
Troubleshooting printing problems



Import/Export--file transfer information
Import filters
Exporting to different word processor formats
OLE 
Clipboard limitations



How to reach Corel in North America
Technical Support

Corel is committed to providing customers with high quality, timely technical support. 
Technical Support Representatives are available, on an 1-800 line, to answer your technical 
questions. A fee will be charged for the technical support, but there will be no additional 
charge to your telephone bill. Also, you may opt to call on a 1-900 line. You will not be 
charged by Corel for this support option, but a charge will appear on your telephone bill. We 
also offer a number of Free Support options which you can access at any time.
Free Support Services
These services include IVAN, our Interactive Voice Answering Network and the Automated 
Fax System.
Calling 1-800-818-1848 (U.S. and Canada)
Corel VENTURA includes one free technical support credit in the box. This credit will be valid 
for one (15-minute) technical support call. The technician answering the call will not use 
your credit if the issue which you are calling about is a known or documented problem, with 
the software, which does not have a fix. 
After you have used your free credit, you will have the option of buying additional credits as 
follows:

One credit--$25.00US/$30.00CDN. 
A five pack of credits--$100.00US/$120.00CDN 
A ten-pack    of credits-- $175.00US/$240.00CDN

If you do not have any remaining credits when you place your call, the technical support 
representative you reach will be able to sell one of the above options.
You can reach a representative Monday to Friday, excluding holidays.
Calling 1-900-896-8880 (U.S. only)
If you do not wish to purchase these credits, you have the option of calling the 1-900 
number at a rate of $2.00 per minute. This option can benefit you if you have a question you
believe can be answered briefly, or if you are an occasional user of technical support. 
You can reach a representative Monday to Friday, excluding holidays.
Before You Call
Before calling Technical Support, please have the following information available. It will 
assist the Technical Support Representative in helping you with your problem more quickly 
and efficiently:
· A brief description of the problem including the exact text of any error messages 

received, and the steps to recreate it.
· Type of computer, monitor and video card (display adapter) you are using.
· Type of pointing device in use (i.e., mouse, tablet).
· Type of printer that you are using to print your files.
· The version of Corel VENTURA, DOS and Microsoft Windows you are running.
· A list of any programs loaded into RAM (i.e., TSRs).
· The contents of the AUTOEXEC.BAT and CONFIG.SYS files.



Corel's Address
Corel Corporation
1600 Carling Avenue
Ottawa, Ontario, Canada
K1Z 8R7
Customer Service
Customer Service Representatives answer questions about specifications and pricing, and 
sell all of the Corel products. They can also issue replacement disks. There is no charge for 
calling Customer Service. Please note that Customer Service Representatives cannot 
transfer you to a Technical Support Representative.
Telephone Numbers
800-77-COREL    (U.S. and Canada)
800-836-3729    (U.S. only)
613-728-3733 (outside U.S. and Canada)



How to reach Corel worldwide
Corel European Technical Support
Corel is committed to providing customers with high quality, timely technical support. Corel 
VENTURA customers residing outside North America can contact Corel Technical Support 
Representatives in Dublin, Ireland These representatives handle calls in the following 
languages: German, French, Spanish, Italian, Dutch and of course English. Calls are handled 
on toll lines. A charge will appear on your telephone bill, but there is no additional charge by 
Corel for the technical support.
Telephone Number

353-1-4781900
Before You Call
Before calling Technical Support, please have the following information available. It will 
assist the Technical Support Representative in helping you with your problem more quickly 
and efficiently:
· A brief description of the problem including the exact text of any error messages 

received, and the steps to recreate it.
· Type of computer, monitor and video card (display adapter) you are using.
· Type of pointing device in use (i.e., mouse, tablet).
· Type of printer that you are using to print your files.
· The version of Corel VENTURA, DOS and Microsoft Windows you are running.
· A list of any programs loaded into RAM (i.e., TSRs).
· The contents of the AUTOEXEC.BAT and CONFIG.SYS files.

Corel's Addresses
Canada Ireland
Corel Corporation Corel Corporation Limited
1600 Carling Avenue Europa House, 3rd Floor
Ottawa, Ontario, Canada Dublin 2, Ireland
K1Z 8R7
Third-Party Worldwide Support
Corel has developed a working partnership with the following organizations who will also 
provide technical support to customers residing out of North America:
Country Company Phone & Fax
Australia Webster & Associates Pty Ltd., 

Unit 2, 25 Frenchs Forest Road, 
Frenchs Forest, NSW 2086

Phone:
011 612 975 3182
Fax: 
011 612 975 4273

Benelux Brightware Solutions B.V., 
Postbus, 3620 AD Breukelen

Phone:
011 31 3462 611 23
Fax:
011 31 3462 654 09

Denmark DTP Service, Bymestervej 2, DK-
2400 Copenhagen

Phone:
011 45 35 82 82 66



Fax:
011 45 35 82 82 23

Finland Subroutine OY, Harakanite 18, 
Sähkötalo, 02600 Espoo, Finland

Phone:
011 358 0 512 1491
Fax:
011 358 0 516 365

Germany EDCON Computer Gmbh, 
Ennsstr. 17, 47809 Krefeld

Phone:
011 49 2151 91 96 
30
Fax:
011 49 2151 91 96 
51

Germany DTP Partner Gmbh, 
Kredenburgstr.44, 22041 
Hamburg

Phone:
011 49 40 65 737 
456
Fax:
011 49 40 65 737 
441

UK Channel Market Makers, The Old
Bank, School Grounds, 
Southampton Road, Cadnam, 
Southampton SO4 2NF, UK

Phone:
011 44 703 812 755 
or
703 814 142
Fax:
011 44 703 813 830

Japan Sumitomo Metal Industries, LTD.
Mita Nittodai Building 11-36 
Mita, 3-Chome, Minato-ku, Tokyo
108, Japan

Phone:
011 81 354 769 816
Fax:
011 81 354 769 886

Austria Update EDV, Landstrasser 
Hauptstr. 146/8, A-1030 Wien

Phone:
011 43 1 718 02 76
Fax:
011 43 1715 41 41 
99

Customer Service
Customer Service Representatives answer questions about specifications and pricing, and 
sell all of the Corel products. They can also issue replacement disks. There is no charge for 
calling Customer Service. Please note that Customer Service Representatives cannot 
transfer you to a Technical Support Representative.
Customer Service worldwide for the UK, France and Germany is handled by Alexander and 
Lord, Dublin, on behalf of Corel Corporation. Customer Service for all other countries is 
handled by Corel in Canada.
Telephone Numbers
UK 0800-58-1028
France 0590-6512
Germany 0130-815074



Other Countries 613-728-3733 (Customer Service in Canada)

See also
Interactive Voice Answering Network (IVAN)
Electronic Support Options
How to use Automated Fax System



How to use the Automated Fax System
Technical Support maintains an automated fax system where up-to-date information about 
common issues and tips and tricks is stored in numbered documents. If you have a fax 
machine, you have access to this service 24 hours a day, 365 days a year. There is a 
catalogue of documents available. You can fax this catalogue to yourself and then order any 
document at your convenience.
Calling the Automated Fax System
To access the automated fax system, dial 613-728-0826 and request extension 3080. You
will then be prompted for a document number and your own fax number. The document you 
request will be automatically sent to you.
To Obtain a Catalogue of Document Numbers:
· Call the Automated Fax System number and request document 2000.



Electronic support options
BBS
Technical Support operates a BBS service, where customers are able to download any 
available program files that have been modified by our engineers, between releases. Also, 
during the process of providing technical support, an agent may request that you upload 
troublesome files to the BBS.
Calling the BBS

(613) 728-4752 or
(613) 761-7798 
Both lines are set for 8 bit word, 1 stop bit, no parity. The supported speeds on these 
Hayes 288 modems are 2400-28,800 baud

COMPUSERVE
Technical Support operates a forum on Compuserve. Any available program files that have 
been modified between releases will be available via Compuserve. As well, you will often 
find utilities and interesting information that have been made available by forum members. 
Corel sysops provide technical support to Compuserve users wishing to request support in 
this manner for Corel VENTURA.
Compuserve Command

GO COREL--to access the Corel VENTURA forums
Joining Compuserve
As a Corel customer, you are entitled to a free introductory Membership to CompuServe, 
including:
· a FREE one-month membership to access all of CompuServe's Basic Services,
· a $15 introductory-usage credit to explore the Corel Forum and CompuServe's other 

Extended and Premium Service Offerings,
· a private-user ID number and password,
· a complimentary subscription to CompuServe Magazine, CompuServe's monthly 

computing publication.
Start connecting with Corel and other CompuServe members by calling:
U.S. and Canada 1 (800) 524-3388 and asking for representative #369
United Kingdom 0800-289-378
Germany 0130-37-32
Rest of Europe ask for representative #369



Interactive Voice Answering Network (IVAN)
IVAN is our Interactive Voice Answering Network. This system contains answers to 
commonly-asked Corel VENTURA questions, and allows customers to solve their own 
problems 24 hours a day, 7 days a week. It is regularly updated with the latest information, 
tips, and tricks, and also provides a feature whereby customers can request that IVANs 
solutions are faxed to them.
Calling IVAN
Dial (613) 728-1990. There is no charge for the IVAN service beyond the cost of the 
telephone call. IVAN will not transfer callers to a technical support representative.



General Protection Faults (GPFs), application errors and system 
lockups.
General Protection Faults, Application Errors and system lockups generally indicate memory 
problems. These problems can include memory shortages, memory conflicts, and sometimes
corrupted files. Unless an error or lockup becomes predictable, it is often difficult to pinpoint 
the exact cause of the problem. The following lists a number of steps that should be followed
when dealing with random and predictable system problems. If the problem can be re-
created, then follow the steps one at a time in order to determine which step 'cures' the 
problem.
After any GPF, application error or lockup:

1. Save files that are open, if possible.
2. Exit from all applications including Windows.
3. Reboot the system. In the case of repeatable problems, you should reboot the system 

using a bootable floppy disk with a minimal system configuration. Here are the steps 
for creating that disk:
Format a diskette for the A: drive, using the following DOS command:
FORMAT A: /S (NOTE:        /S copies system files)
Copy the AUTOEXEC.BAT and CONFIG.SYS files to the diskette
Edit them so they contain the following lines, only:
Autoexec.bat 
@ECHO OFF
PROMPT $P$G
PATH=C:\;C:\DOS;C:\WINDOWS

Config.sys 
DEVICE=C:\WINDOWS\HIMEM.SYS
FILES=40
BUFFERS=30
***Add any other drivers that are necessary for the system to operate, for example a 
CDROM driver, if you are running Corel VENTURA directly from the CD***

6. Run the SET command from a DOS prompt to determine the location of the TEMP 
directory. Change to that directory and delete any *.TMP files. Ensure that the TMP 
files are being created on an UNCOMPRESSED drive.
If the GPF, Application Error or lockup becomes predictable, follow the above steps, 
then continue with steps 7-20

7. Run either Checkdisk with the fix parameter, i.e., CHKDSK /F or SCANDISK /ALL (if 
using DOS 6.2) to locate any possible disk errors (e.g., lost clusters, lost allocation 
units, cross-linked files) Ensure that the bytes total memory    line reads    655,360. Any
other number could indicate a virus.

8. Check for viruses using the DOS virus checker MSAV.EXE and run VSAFE.COM for 
constant monitoring of file writes/loading.

9. Before restarting Windows, open the WIN.INI file in a DOS editor and ensure that there 
is nothing after the Load= and Run= statements. If there are entries on those lines, 
insert a semi-colon (;) in front of the 'L' in Load and the 'R' in Run. This will prevent the



applications from loading. Check to make sure that the WIN.INI does not exceed 64KB 
in size.

10. Restart Windows. Try adding the following parameters to the WIN command, if 
necessary, to determine where the problem lies:
Win /3    /D:FSVX      /B
/3 -> forces 386 enhanced mode
/D:F -> turns off 32-bit disk access.
/D:S -> specifies that windows should not use ROM address space between F000:0000
and 1 MB for a break point.
/D:V -> specifies that the ROM routine handles interrupts from the hard drive 
controller instead of using Windows internal code.
/D: X ->Excludes all of the adapter area from the range of memory Windows scans to 
find unused space.
/B -> Starts Windows bootlog, for diagnosing why Windows won't start. Creates a 
file called BOOTLOG.TXT in the Windows directory.

11. Disable or uninstall alternative window shells to the Program Manager (i.e., Norton 
Desktop, DashBoard, Central Point's PC Tools for Windows...)

12. Turn off all TSRs (Screen savers, Disk cache displayers, Mouse watchers, etc.)
13. Change video to the standard Windows VGA driver (16 colors 640x480 resolution). 

Other graphic cards using comparable VGA resolutions may be accessing different 
memory addresses and may be causing a memory problem (Video or GPF related). To 
reload the Windows VGA driver, try the following:
From a DOS prompt (make sure Windows is shut down) change to the Windows 
directory.
Type SETUP and change the Video to VGA. Restart windows.

If you are already running the Windows VGA driver and wish to reload it because you 
suspect that it may be corrupted:
From a DOS prompt (make sure Windows is shut down) change to the Windows 
directory.
Type SETUP and change the Video to something other than VGA. Restart windows.    
Repeat the setup procedure, but select VGA. This will reload the original driver files 
from the Window 3.1 diskettes.
***If the video or GPF problem goes away, when running VGA, then contact the Video 
Manufacturer for updated drivers.***
Note: If you are running a video manufacturers driver and are trying the VGA test, 
please make sure you have the install diskette from the manufacturer. This may be 
required to set your video back to the original state after the test.

14. Recreate the windows SWAP file with the following procedure;
Control Panel -> 386 Enhanced -> Virtual Memory -> Change.
Set the SWAP file size to NONE, then restart Windows.
Repeat this procedure, then set the SWAP file size to 10 MB Permanent (preferred by 
Windows).
You may have to run an OPTIMIZER (e.g., Norton SpeedDisk, PC Tools Optimize, etc.) to
access a larger continuous section of disk space. Make sure that the swap file is 



located on an UNCOMPRESSED drive.
15. Reload any device or file causing the problem from diskettes or CD-ROM. This may 

involve a setup or an unarcing procedure.
***Please contact the manufacturer if you are unsure of the proper procedures***
A font file may have to be re-added or re-loaded from disk or CD-ROM. To check and 
see if the font is the problem use this test;
Control Panel -> Fonts, highlight the font thought to be causing the problem. Check 
the preview window, if there is no display then the .FOT file is probably corrupted, also
if the number of bytes displays 0 (zero) then it is also likely that the font file is 
corrupted.

16. Try reloading the printer driver. Verify with Microsoft that you have the most up-to-
date Postscript or Non-Postscript drivers.

17. Check the Properties of the designated program's icon. Are the Command line and 
Working directory correct?    Try re-establishing the Command line and/or Working 
directory.

18. Try executing the program directly from File Manager.
19. Check BIOS date;

AMI BIOS:
1987 causes system reboot when a floppy is accessed through File Manager.
1989 causes intermittent system hangs.
1991 causes serial port problem; mouse or modem stops working.
PHOENIX:
Any BIOS dated 1988 or earlier should be upgraded.
AWARD:
Should be version 3.1 or higher.

20. If none of these steps resolve the problem, please contact Technical Support for 
further assistance.



1000 Series Errors
The error messages listed below are the result of memory shortages or memory conflicts on 
your system. Usually, you can bypass these messages and continue working. However, you 
should always:
1. Save your file immediately, if possible.
2. Exit Windows.
3. Reboot your system.

Since these memory problems are often intermittent, you should save your work at regular 
intervals during your Corel VENTURA session.
The 1000 series of error messages:

1000 Allocate memory failed
1001 Lock memory failed
1002 Reallocate memory failed
1010 Memory block exceeded length limits

See the steps below on dealing with memory error messages. The tips and information are 
quite generic because, though the errors have different numbers and different causes, the 
troubleshooting steps are identical. These error messages are often intermittent, making 
troubleshooting difficult. If they become persistent and predictable, treat them like General 
Protection Faults.
Restoring files after a memory error or system lockup
There are 2 possible sources of backup files you can access after a memory error or system 
lockup. You have a 50-100% chance of restoring lost data by accessing these files.
Backup files--When you save a file, a backup file is created, provided the Make Backup on 
Save option in the Preferences, General dialog box is enabled. These files are copies of the 
current CHP file as it was last saved. The backup files uses the same file name, but uses the 
$HP extension. You will only find a $HP file if you have saved the file more than once. These 
files are stored in the same subdirectory as the CHP file and with the same name. Rename 
the files to a different name with a CHP extension to open them in Corel VENTURA.
TMP files--created by Windows as you work in Corel applications. They are saved only if the 
system crashes or locks up. If you cannot open the file or did not have a chance to save the 
file before the crash, you may be able to restore some the information by renaming the TMP 
file to a Corel VENTURA extension. The TMP files will be stored in a subdirectory determined 
by a line in the AUTOEXEC.BAT file. To determine where these files are, run the SET 
command at the DOS prompt and to look the line TEMP=. Check this subdirectory for any 
files with a TMP extension, a byte size other than zero (0), and a date and time that match 
when the crash occurred. Rename the file(s) and try to open them in Corel VENTURA. There 
is approximately a 50% chance of success with this process. 
Windows requires 5-10 MB of free disk space on the drive where TMP files will be created.
What to do after a memory error has appeared
1. Try to clear the error message. If possible, exit from the application and exit and re-start

Windows. If it isnt possible to clear the message, re-boot the system.
2. Try opening the CDR file, if you had saved the file. If that is not possible, try importing it.
3. Search for an ABK file and rename it.



4. Search for a TMP file and rename it.
5. Search for a BAK file and rename it.
6. At the DOS prompt, change to the directory where TMP files are stored and delete any 

remaining TMP files. 
After a lockup or crash
Reboot the system and follow steps 2-6 above.



2000 Series Errors
Errors numbered 2000-2013 are all disk errors based on read, write, create, seek and open 
file problems. They usually occur because the drive where Windows TMP files are stored is 
full.
TMP files--created by Windows as you work in Corel applications. TMP files are stored in a 
subdirectory determined by a line in the AUTOEXEC.BAT file. To determine where these files 
are stored, run the SET command at the DOS prompt and to look for the line TEMP=... 
Check this directory for TMP files and delete any that exist from the DOS prompt, rather than
through Windows. Windows requires 5-10 MB of free disk space on the drive where TMP files 
are created and stored.
Troubleshooting 2000 Series Errors

1. Exit Windows.
2. At the DOS prompt, change to the directory where TMP files are stored and delete any 

files with the .TMP extension.
3. Make sure you have 5-10 MB of free disk space to accommodate future TMP files. If 

not, clear space on the hard disk or redirect the SET TEMP statement in AUTOEXEC.BAT
to another drive.



5000 Series Errors
The 5000 series of error messages occur as a direct result of a memory conflict in your 
system. Usually such conflicts are object or file specific and can be easily isolated. When 
such an error occurs, and Corel VENTURA will allow, save your work and exit from Corel 
VENTURA and Windows.
In all cases, another contributing factor to the generation of 5000 series errors is inadequate
space for Windows to create temporary files. These files are created by Windows as you 
work in Corel applications. The TMP files will be stored in a subdirectory determined by a line
in the AUTOEXEC.BAT file. To determine where these files are stored, run the SET command 
at the DOS prompt and to look for the line TEMP=. Check this directory for TMP files and 
delete any that exist from the DOS prompt, not through Windows. 
Windows requires 5-10 MB of free disk space on the drive where TMP files will be created.
5000
These errors occur as a direct result of a memory conflict on your system. Fault can be easily
isolated because the message is either file or object specific. If the error message returns, 
follow the instructions below to isolate the offending object and delete it. Check if you have 
adequate Temp space. If not, delete .TMP files. (TMP files are created on your system while 
you work in Corel VENTURA.)



Other memory-related errors
The common troubleshooting steps associated with handling memory errors are:

1. Save the file immediately.
2. Exit the application and Windows.
3. Reboot the system.
4. At the DOS prompt, type SET. The screen will display the directory where Windows 

temp files (*.TMP) are saved. (e.g., TEMP=C:\WINDOWS\TEMP.)
5. Change to that directory and delete any files with the .TMP extension. Note:    any TMP 

files created by Corel will automatically be deleted. Any TMP files you find will be files 
created by other Windows applications and can be safely deleted.

6. Make sure you have 5-10 MB of free disk space to accommodate future TMP file 
creation.

If the messages become persistent and predictable, treat them like General Protection 
Faults.



OLE Problems
1. Sometimes the REG.DAT file becomes damaged, generating OLE Error Messages in the 

Corel applications. If you encounter these error messages, close the Corel application 
and open the Windows File Manager. Double click on REGEDIT.EXE. If this file opens, 
you will see the Registration Information Editor. Locate the Corel application which had 
the OLE problem and delete it from the list. You can do this by highlighting the item, 
then clicking on Edit and Delete File Type. Then, exit from the Registration Information 
Editor and exit and restart Windows. When you open and close the Corel application, it 
will re-register itself in REG.DAT.

2. If you cannot open the Registration Information Editor, rename REG.DAT to REG.OLD, 
then exit and restart Windows, and open and close Corel VENTURA.

3. Another requirement for OLE to function properly is having SHARE.EXE loaded in the 
AUTOEXEC.BAT file. By default, the SHARE statement is placed at the end of the 
AUTOEXEC.BAT file. This means that it may not execute properly if you have a batch 
file that starts Windows listed before this reference. If so, move the SHARE statement 
up under the PATH and PROMPT statements.



Enhancing system performance
Following are a number of considerations for improving the performance of Corel VENTURA:
· the microprocessor and clock speed are important, i.e., a 486-50 will run Corel VENTURA

more quickly than a 386-33
· a math co-processor will enhance the performance of some functions
· ensure that you have at least 10 megabytes of free disk space on the drive where 

Window *.TMP files will be created ( you can determine the location of this directory by 
running the SET command at the DOS prompt)

· ensure that you have 10-20 megabytes of free disk space on the drive where you store 
your Corel VENTURA files

· Follow the suggestions in the chapter on 'Optimizing Windows' in your Window's User's 
Guide

· consider establishing a Swap file to provide Windows with 'extra memory'. See your 
Windows User's Guide for more details.

· you may want to consider an accelerated video card. Unfortunately, we cannot make 
recommendations on any hardware.



Troubleshooting techniques
While working in Corel VENTURA, you may encounter problems printing, saving files, opening
files, importing, exporting, etc. Though each problem may have a different cause, there are 
some general steps you can follow in attempting to troubleshoot your problem. It may save 
you a call to Technical Support.

1. Can you duplicate the problem?
Try performing the same function again. This is the first step in troubleshooting. 
Occasionally, a temporary memory problem will interrupt a function, and simply trying 
again will allow you to complete that task.
No
Problems that can't be reproduced are difficult to explain. Continue working, but note 
details of the circumstances if the problem does occur again. That will enable Technical
Support to assist you more effectively if you decide to call.
Yes
If you can duplicate the problem, it may be file, program or system specific. Proceed to
the next step.

2. Is the problem system-specific?
This step is sometimes appropriate at the beginning of a troubleshooting session and is
sometimes left to the end. Before spending a lot of time analyzing the causes of a 
problem, it is often a good idea to    determine if the problems occur only on one 
system. This is easy to do, if you have access to another computer and can try your 
function or file here. Or, if the problems are printing related, try using a different 
printer. If the problems persist on more than one system, zero in on file specific issues. 
If not, concentrate on the system settings, installation and finally hardware issues.
If you do not have access to another system running Corel VENTURA, proceed to the 
next step.

3. Is the problem file-specific?
If you can reproduce the problem, the culprit may be the file itself, the Corel program 
or something about this particular system. This step attempts to determine if the 
problem is unique to this file or if it may be caused by a program or system issue.
If you are having problems saving, printing or exporting, etc., try opening another file 
of the same type and perform the same function. If subsequent file works properly, you
are most likely dealing with a file that contains a corrupted object(s) or may too 
complex for the particular function you are trying to perform. If so, see the notes below
on Dealing With Complexity Issues or Dealing With Corrupted Objects or Files.
If you are having problems opening or importing, try opening or importing other files 
into the same application. Or, try importing the problem file into other applications. For
example, if you have trouble importing a CGM file into Corel VENTURA, try importing it 
into a different Windows application. This should tell you whether problems are 
contained in the file or are caused by something else. 

4. Is the problem software-specific?
If a problem is reproducible but not limited to just one file, then problems are being 
caused by the Corel program, other software on the system, i.e., drivers, Windows, 
etc., by hardware. If it is possible to try the same files and functions on another system
running Corel VENTURA, you can determine whether the root of the problem is based 
on one system as opposed to being software generated. If this test is not possible, try 



to collect as much information as possible about whether the problem occurs only in 
Corel applications. You can do this by trying to perform similar functions, i.e., printing 
or importing, into other Windows applications. If problems appear in other applications,
then the cause is at a more basic level than Corel. Sometimes video or printer drivers 
can cause problems. Sometimes there are even problems with a particular Windows 
setup. 

If following the above steps do not allow you to resolve the problem you are encountering, 
you may wish to contact Technical Support.



Tips & tricks for troubleshooting
Problems Caused by Windows TMP files
Windows generates temporary files as you work in Corel applications. Many functions such 
as printing, saving, importing and exporting can be affected by a shortage of temp space. It 
is recommended that you have at least 10 MB of free disk space on the drive where TMP 
files will be written. You can identify that location by running the SET command at the DOS 
prompt. Reference will be made to TEMP=... Delete any TMP files from the DOS prompt that 
you find in this subdirectory. In Corel VENTURA, Corel will automatically delete its own TMP 
files when you restart the application after a crash. Note also, that rather than being limited 
by amount of free disk space on the drive identified in the TEMP= statement, you now have 
the ability to direct Corel to send an overflow of TMP files to a different drive(s). This can be 
done in the CORELAPP.INI file as follows:
[TempPaths] these two lines already exist
Cleanup=1 >
0=D:\TEMP add statements such as these
1=E:\MYSTUFF starting with 0= and adding a drive and subdirectory. You can 

add references to floppy drives, network drives, etc.
Damaged Program Files
If you suspect problems with program files including import and export filters, you may want
to consider running the SETUP program again, and re-installing the portions of the program 
that may be causing problems.

See also
What To Do If Your Print Job Doesn't Print



Having memory problems?
The common troubleshooting steps associated with handling memory errors are:

1. Save the file immediately.
2. Exit the application and Windows.
3. Reboot the system.
4. At the DOS prompt, type SET. The screen will display the directory where Windows 

temp files (*.TMP) are saved. (e.g., TEMP=C:\WINDOWS\TEMP.)
5. Change to that directory and delete any files with the .TMP extension. Note:    any TMP 

files created by Corel will automatically be deleted. Any TMP files you find will be files 
created by other Windows applications and can be safely deleted.

6. Make sure you have 5-10 MB of free disk space to accommodate future TMP file 
creation.

If the messages become persistent and predictable, treat them like General Protection 
Faults.



What to do if your print job doesn't print
When you print a file through a Corel application:

1. Corel processes the information. You will see a percentage bar increase to 100% or a 
band count.

2. If the process is completed successfully, the print job will be passed to the Windows 
Print Manager. You can watch the job progress by clicking on the Print Manager icon.

3. If everything runs smoothly, the print job will then be passed to the printer.
At any one of these stages, the process may break down. The first step in determining where
the problem lies is to identify at which of the above three steps printing stopped.
If you encounter problems while printing a file, consider the following troubleshooting tips in 
an attempt to determine where the problem lies and how to resolve it
Printing Stops in the Corel Application 
· Exit and re-start the Corel application.
· Has the file printed before? Is this a repeatable problem?
· Is it one file or all files which are having print problems?
· Ensure that the default printer is correct.
· While working in Corel VENTURA, temporary files are created and placed on your 

system. Exit Windows completely delete any .TMP files found in the Windows temp 
directory. While here, ensure that you have at least 5-10 MB of free disk space. 

· Check System Resources and Free Memory in the Help menu of the Windows Program 
Manager. If these values are low, exit and re-start Windows.    Also make sure you do not
have other Windows applications running.

· Is the Print Manager on?    Try disabling it.
Printing Stops in the Print Manager 
· Open the WIN.INI file. Find the reference to TransmissionRetryTimeout=45. Set this 

value to 999 (this sets the time that Windows waits for the printer to report that it is 
ready to receive more data). A value of 999 is equal to an infinite amount of time. Once 
changed, exit from Windows and then start it again.

· Check Load and Run statements in WIN.INI. Programs and utilities can be set to run 
automatically when Windows is started by adding references to these lines. Type a semi-
colon (;) in front of either line if there is anything referenced. Remember to save, exit 
and restart Windows after making changes to the WIN.INI.

· Move any icons found in the Windows Startup group to another icon group.
· While working in Corel VENTURA, temporary files are created and placed on your 

system. Exit Windows completely delete any .TMP files found in the Windows temp 
directory. While here, ensure that you have at least 5-10 MB of free disk space. 

· Is fast printing direct to port on? Try disabling it.
· Make sure you are using an up to date printer driver. 
· Will other Windows applications print? If not, look at Windows setup or configuration 

issues as the problem will be occurring at a more basic level than Corel VENTURA
Printing Stops in the Printer



· Maximize time-outs on the printer if possible. Refer to your printer documentation for 
instructions.

· Check time-outs on the network, if applicable.
· Check to see how much RAM is resident in the printer. A minimum of 1.5 megabytes is 

required to print a full page of graphics to a 300dpi device. To print fairly complex files, 
we recommend a minimum of 4 megabytes of RAM in the printer. (Note: some files may 
require more than 4 megabytes).

· Do you print directly or through a switchbox or network. If possible,    try connecting 
directly.

· Make sure you are using an up to date printer driver.
· What port is being used? If you're using LPT1, try LPT1.DOS. 

Printing tips and tricks
If you send a file to print and receive no output or partial output, try the following 
suggestions:
Finding and dealing with a corrupted object
If your file prints to a certain point and then stops, you may have a corrupted object in the 
file. The output is created in the same order as the objects were created and therefore 
finding the offending object is as simple as locating the object created after the last printed 
one. To do this select the last printed object, and press the tab key once. The object 
currently selected is most likely the source of the problem.
A second possibility exists to isolate the offending object. Split the graphic into four 
quadrants and "print selected only" each quadrant. By process of elimination you should be 
able to find which quadrants do not print until you have split the sections up leaving only 
one object unprintable. If in fact this object does not print by itself, you can delete and re-
create it or reduce its complexity as follows.
Reducing the complexity of the graphic
If the printing problems doesn't seem to be caused by a corrupted object, but a complex 
object, the following steps will be helpful in reducing the complexity of a single object
· Reduce the number of nodes on the path. Control points and nodes each add 1 byte to 

the objects size. This is easiest to do using the Auto Reduce feature on the Node Edit 
rollup

· If the object has a fountain fill, reduce the number of fountain stripes 
· Avoid combining text with other objects (for example, to create clipping holes or masks).
· Break the object up into smaller less complex objects
· Remove any extraneous outlines
· If a text wrap path has been applied to an imported graphic and you're printing to a 

PostScript Level 1 printer, disable the Clip Graphic option (it's on the menu displayed by 
clicking the graphic with the right mouse button.) Text will still flow around the path as 
intended unless the path clips the graphic. If the graphic is clipped, the text will flow 
across or underneath it rather than around it. In order to have text flow around the 
graphic use CorelDRAW or Corel PHOTO-PAINT to clip the graphic and then reload it into 
Corel VENTURA. Then, use the AutoWrap command to apply a path around the graphic 
making sure that the graphic lies completely inside the path.

If, for any reason, these steps cannot be taken or do not work, you can take a more global 
approach to the problem. The following steps will be helpful in reducing the overall 



complexity of the file.
Postscript Specific Checklist:
Download the Postscript Error Handler under the Windows Control Panel; Printers icon; 
Setup; Options; Advanced. If Postscript is having difficulty interpreting the file, an error code 
will be produced.

See also
PostScript Printing Errors
Troubleshooting Techniques
Color Management



Working with service bureaus
When working with a service bureau for high resolution reproduction of your documents, it 
cannot be stressed enough that you need to talk to the person who will be managing your 
job. Too many times, files are handed, or sent by modem, to a service bureau without key 
information.
The more interaction between the user and the service bureau, the faster and subsequently,
less expensive a job is. If you do not have all the necessary information to complete the 
steps below, contact the service bureau.
Although a service bureau could accept your documents in PUB form with all of the 
associated files, using PRN (Print) files is much more convenient. PRNs condense your data 
and, so long as you identify all typefaces used for the bureau, enable printing from output 
devices even if the computer they are sent from doesn't have Corel VENTURA installed. 
Using PUB files would require the bureau to have Corel VENTURA and all the typefaces you 
used in your original document on the system they were copied to.
Preparing a Print File (PRN) For a Service Bureau
· Set up a printer driver for the device the bureau will be using, e.g., Linotronic 330, in the

Windows Control Panel, under Printers. Set this device up on a port such as LPT1 or 
LPT2. Make it your default printer.

· Set the correct resolution in the Control Panel Advanced Printer options.
· Set the correct paper size in the Control Panel under Printer Setup. If you are setting a 

Custom Page Size, ensure that the Width is always the smaller value and that values are
entered in hundredths of an inch, i.e., 10 inches would be entered as 1000. Then set the
Orientation. If cross hairs, crop marks or file information is required on your Linotronic 
file output, choose a page size in Corel VENTURA which is smaller than the size the 
output device will use. For instance, if the final size of your file is to be 8.5" by 11", then 
choose A3, Tabloid or 10"x14" as your printing size in the Printer Setup menu, provided 
the printer can handle these sizes.

· In the Corel application, choose File, Print. Verify that the printer reference is correct.
· Choose Print to File, and For Mac, if the service bureau uses a Mac front-end.
· From the Options button; Options tab choose any desired icons to set Crop Marks, Cross 

Hairs, Film Negative, Emulsion, etc.
· If you desire color separations, choose the Options button; Separations tab and check 

Print Separations.
· Click on OK, then give the file a name. A PRN extension will automatically be added.

See also
Color Separations



Color separations
When a document is output professionally by a service bureau, each color has to be printed 
separately on the printing press. Therefore, a multicolor image requires each color to be 
output on a separate sheet of paper, film or metal plate. In the final stage of a print job, 
these separate plates are recombined to generate the final product. This process is referred 
to as color separation.
Another scenario that would require color separation would be the creation of a color proof. 
Each of the colors in the document are output on a separate piece of acetate and in color. By
laying the sheets of acetate on top of each other and lining them up exactly, a color proof 
can be created of the final product.
Pantone vs. Process Separations
If you create a document using Pantone colors, each Pantone color will be placed on an 
individual sheet of film during the color separation process. Each Pantone color is unique and
can be thought of like the paint chips you see at a decorating store.
Process colors are mixtures of the four basic inks, Cyan, Magenta, Yellow and Black. An 
infinite number of colors can be created by mixing these four colors in different 
combinations. When your document has been created using process colors, your color 
separated output will contain a maximum of four sheets of film. In many cases, the process 
color method is most cost effective, since each extra sheet of film adds significant cost to 
your service bureau print job.
Fountain fills
If you design a file containing fountain fills that blend one color to another, create those fills 
using process vs. Pantone spot colors. Color separated fountain fills often produce incorrect 
results. The exception to this rule is if you create a fountain fill blending one tint of a 
Pantone color to another tint of the same color.
Film Negative and Emulsion Down
There are two other options that are associated with printing as separations: Film Negative 
and Emulsion Down. These settings control whether your film will produce a positive or 
negative image, and what side of the film the image will go onto. It is not always necessary 
to have these options selected. It is dependent upon the type of output you are doing. Also, 
the only time you would set these options is if you create a PRN file rather than giving a PUB
file to the service bureau. Talk to your service bureau before creating the PRN file to see 
what they require. Often the service bureau will create the film negative for you. Select 
these marks by clicking on the icons found under the Separations tab in Print Options. 
Emulsion is represented by an E, and Film Negative by an icon that looks like a strip of photo
film.
Crop Marks and Cross Hairs
When you choose to print crop marks and cross hairs, they will be created right on the 
corners of your Corel Page setup. You must define a larger page in the print driver, than in 
Corel page setup in order to have room for these marks to be printed. Select these marks by
clicking on the icons found under the Separations tab in Print Options.

See also

Working with Service Bureaus



Line Attributes
Line attributes will differ slightly between Version 4.2 and Version 5.0 of Corel VENTURA due 
to the change from the VENTURA graphics engine to the CorelDRAW graphics engine. For 
example, arrowhead sizes may differ between the two versions. Also, rounded line endings 
in version 4.2 will look slightly different and will appear on both ends of the line in version 
5.0. The spacing between dashes on dashed lines will also different slightly.



PostScript printing errors
In the Windows Control Panel, you can enable a Postscript Error Handler under the Printers 
icon; Setup; Options; Advanced. This error handler defines the errors that the Postscript 
language encounters when processing a file. Listed below are some of the common 
Postscript error codes, their definitions, and solutions where applicable.
Offending Command:    OB
The likely cause of this error is choosing Negative in the Postscript driver options in the 
Control Panel; Printer; Setup; Options: Advanced, and choosing the Film Negative icon in 
Corel's Print; Options dialog box. 
Error:    Limitcheck. Offending Command=Nametype:    EOCLIP
This message indicates a path implementation error, usually where Postscript is unable to 
complete the clipping routine for filled objects. Try these suggestions:

1. Simplify the offending object by reducing the number of nodes or increasing the 
flatness in the originating application.

2. Remove any extraneous outlines from objects.
3. If printing separations, try printing just one separation at a time.
4. Consider substituting solid color fills for gradients or pattern fills in irregularly-shaped 

objects.
Error:    Limitcheck. Offending Command=Nametype:    EOFILL
This message indicates a path implementation error when Postscript is completing a fill 
routine. Set Number of Points in Curves value to 300, under the File; Print; Options; Options 
tab.
Error:    Stack Overflow
The stack limit has been exceeded, often indicating embedded EPS files, too many nodes on 
a path, or complex fill patterns and bitmap fill patterns in complex shapes. Try the 
suggestions for EOCLIP.
Offending Command:    Stack Underflow
The stack does not have enough objects for the requested operation. Again, try the 
suggestions given for EOCLIP.
Error: Invalid restore
This message may appear after canceling a print job. Try clearing the Print Manager and 
repeating the printing process.
Error:    invalid font
This error message may appear if the file requires a font that has become corrupted. Try re-
installing the font.



Troubleshooting printing problems
Printer Drivers
Corel does not develop or distribute printer drivers. We rely on the printer manufacturer or 
Microsoft to provide drivers that are supported in the Windows environment. If you can print 
in Windows, you should be able to print from Corel applications. 
Printed Output Is Incorrect
· If you print a file from Corel and the output is incorrect:
· Check the print preview. The print preview displays the file exactly as it should print out.

If this screen does not look correct, the print-out will not be correct either. 
· Check cables and connections for potential communication problems. A telltale sign of 

communication problems are ASCII characters appearing on your page where graphics 
should be appearing, i.e. happy faces, stars, etc.

· If printing Postscript, are you using genuine Adobe Postscript or an emulation?    You will 
sometimes encounter problems with Postscript emulation, especially when printing 
fonts.

· Make sure you are using the most up to date printer driver.
· Try changing your video driver to plain VGA.
· Check the Automated Fax System catalogue for topics dealing with specific printing 

problems.



OLE
OLE stands for Object Linking and Embedding. Designed by Microsoft and first introduced in 
Windows 3.1, OLE allows you to easily move information from one application into another. 
Then you can edit this information from within the second application, meaning you no 
longer have to delete and re-copy. Embedding means that information from one application 
resides in a second application and is stored with it. Linking means that information from 
one application is tied to a second application and can be updated when changes are made 
in the first application, but that information is not actually stored with the second file.
Drag and Drop
This OLE feature allows you to click on an image in one Windows application, and drag it into
Corel VENTURA.
OLE Registration--REGEDIT.EXE and REG.DAT

1. During the installation of Corel VENTURA, OLE files are installed into the WINDOWS\
SYSTEM directory.

2. To have OLE function correctly, Windows registers all applications with OLE capabilities 
in a file called REG.DAT. You can modify the registration information by opening a file 
called REGEDIT.EXE. Both files are found in the WINDOWS\SYSTEM subdirectory.

For more information on using OLE functionality in your files, refer to the Corel VENTURA 
User's Guide.



Clipboard: General pasting limitations
Unsupported Metafile Features
The following Windows Metafile features cut/copied to the clipboard from other programs 
cannot be pasted into Corel VENTURA:
· Background commands ( SetBkMode and SetBkColor)
· Pattern fills (only uniform fills are currently supported)
· Clipping regions
· Flood fills
· Individual pixel manipulations
· No ROP2 modes, other than R2_COPYPEN (i.e., no combining of pen colors)
· WINDING polygon fill mode (ALTERNATE mode is supported)

Pasting Text
Only text can be cut or copied to the clipboard in Corel VENTURA and pasted into other 
applications.
The amount of text, plus the spacing and text attributes Corel VENTURA assigns to text 
pasted from other applications, varies depending on the font chosen and the available 
memory on the system.



Color management
You may have experienced the frustration of creating a file in Corel VENTURA and having 
colors in the printed output appear radically different than what you saw on the monitor. The
same discrepancies can occur when scanning. Many factors are responsible for the wide 
variation in color that you may encounter when comparing monitors, printed and scanned 
output. Manufacturers are different, drivers are different, lighting conditions are different, 
etc. It is difficult to accurately predict what your color output will look like. The new color 
management system in Corel VENTURA addresses many of the inherent problems associated
with artificial color reproduction. The key issues that need to be overcome to achieve 
consistent and reliable color results (scanning, viewing and printing) are:
· improper calibration of equipment
· inaccurate color mapping from one device to another (assuming both use the same 

color model)
· inaccurate color mapping from one color space to another (e.g., from scanning to 

display to output)
· accommodating hardware limitations and the inability to map colors from one color 

space to another.
The intention of a color management system is to provide a mechanism for consistently and 
reliably specifying colors, as well as for transferring colors accurately from one device to 
another.
Using Color Management in Corel VENTURA
Click on Color Manager under the File menu. Refer to the Corel VENTURA User Guide for 
detailed instructions on creating a Basic System Profile    and setting Calibration options..
Disabling Color Management
To disable the effects of Color Management on the monitor, click on View; Color Correction 
and choose None. To disable the effects of Color Management when printing, uncheck the 
box next to Color Profile on the Print screen.

See also
What To Do If Your Print Job Doesn't Print



CORELVP.INI
You can change the behavior of the discretionary hyphen by changing the following line in 
the CORELVP.INI:
Discretion=0
A word containing a discretionary hyphen can be hyphenated at either the discretionary 
hyphen point, or a point determined by the hyphenation algorithm. This is the default 
setting.
Discretion=1
A word containing a discretionary hyphen will be hyphenated ONLY at the discretionary 
hyphen point.
Note:    This setting is not document-specific, but user-specific. Therefore, you don't need to 
carry the setting along with the document.



CORELDRW.DOT
Contains rows of numbers which define the Dashed and Dotted line styles available in the 
Outline Pen dialog box. By editing these definitions you can change the appearance of the 
corresponding line style. You can also add up to 25 definitions of your own for a total of 40 
line styles. Before editing this file, make a backup copy of it somewhere, just in case you 
need to access the original default values.
Defining a Dashed and Dotted line style
When you open up the CORELDRW.DOT file in your ASCII editor, you will see rows of 
numbers. Each row represents a line definition, and contains anywhere from 3 to 11 
numbers.
nNumbers    n,1DotLength    n1,SpaceLength    n2,DotLength    n2SpaceLength..... 
n5DotLength    n5SpaceLength
where:

n Numbers the number of elements (both 
dots/dashes and spaces) that define the 
line style. This must be a value between 
2 and 10

nxDotLength the length of the dot/dash. A value of 1 
yields a dot, anything greater yields a 
dash

nxSpaceLength the length of the spaces between the 
dots/dashes

To create a line style, specify the length of the dots/dashes and the gaps between them. 
Dots are created by defining short dashes (one unit wide) and then specifying Round as their
Line Cap style in the Outline Pen dialog box. Perfectly-round dots are not currently available 
in Corel VENTURA. However, unless your line is quite heavy, the dots should appear round. 
Definitions consisting of more than three numbers in a row, define lines made up of dots, 
spaces and dashes of varying lengths. You can define lines with up to 10 elements 
(dot/dashes and spaces). When these lines are used in a document, the line pattern is 
followed left to right through the definition, and then repeated through the length of the line.
Example
2 1 5
Defines a line consisting of are 2 elements. The first element is a dot (since it is only one 
unit wide) followed by a five unit-wide space. These units are relative to the line's width, 
which is considered to be 1.
To alter the spacing between the dots in this example, change the number 5. Similarly, to 
create a dashed line with equal dash and space widths, change the 1 to a 5 in this example.



If Corel VENTURA will not run
Check the following:

1. Either Adobe Type Manager (ATM) or TrueType (TT) fonts have been installed on your 
computer.

2. Corel VENTURA is not running in Windows Standard Mode.
Try running setup again and if you still can't get Corel VENTURA to run, contact Corel support
services.>main



Bitstream facelift fonts
Corel has been advised that the Bitstream Facelift product is no longer being sold. Bitstream 
still supports the current user base of the product. Facelift fonts are therefore no longer 
supported in Corel VENTURA; they may not display or print properly.



Size limitations
While Corel VENTURA is designed to handle vast amounts of data, the following limitations 
do apply:
Maximum number of files per chapter: 128
Maximum number of pages per chapter:9,999
Maximum number of tags per style sheet:128
Maximum number of chapters per document: 128
Maximum point size: 254
These are operational limits of Corel VENTURA itself. Your document and chapter size may be
further limited by the amount of memory and speed of your computer.



Create indexes and tables of contents
Creating an index
Deleting an index entry
Changing the order of entries in an index
Generating an index
Adding an index file to your document
Editing index entries
Updating an index
Creating a table of contents
Adding a table of contents file to your document
Updating a table of contents



Creating an index
The first step in creating an index is inserting the index markers and the text you want to 
appear in the index itself. You can insert markers anywhere in the document except headers,
footers and footnotes. When you create index entries, you can have Corel VENTURA indicate 
a range of pages by inserting the same entry on the first and last pages on which a 
particular topic is covered.
To insert an index reference:

1. Choose Tools, Index Entries Roll-Up. The Index Entries Roll-Up opens.
2. Do one of the following:

· Select the text in the document that you want to mark as an index entry.
· Position the insertion point where you want to insert an index entry in the document.

3. Do one or more of the following:
· If you selected text, specify whether the entry is a main entry or a sub-entry by 

clicking the corresponding button. The text will then appear in the Main Entry or 
Sub-Entry box so that you can edit it.

· If you positioned the insertion point where you want to insert the index entry, 
specify whether the entry is a main entry or a sub-entry by clicking the 
corresponding button. Then, type the text for the entry in the appropriate entry box.

· If you want to cross-reference the entry to another entry, choose either See or See 
Also Prefix from the Type of Entry list or type your own prefix in the box.

· If you want to override the normal alphabetical order for the entry, see Changing the
order of entries in an index.

6. Click the Add to Index List button to insert an index marker in the text.
The entry is added to the preview box in the roll-up. The location of the marker is 
indicated by a degree symbol which doesn't print and appears on-screen only when the
Tabs and Returns option is selected in the Options dialog box (View menu).

7. Repeat steps 2 to 6 for each additional entry you want to create.
The document must be saved before the index is generated. To generate the index, 
see Generating an index.



Deleting an index entry
To delete index entries:

1. Click the  to display returns and codes.
2. Do one of the following:

If you are in Page Layout or Draft view, position the cursor at the start of the word with 
the index entry you want to delete. Using the arrow keys, move the cursor until the 
status line reads "index entry". Press the delete key.
If you are in Copy Editor view, select the index code (<$IMain entry;Sub entry[]>) at 
the start of the word and press delete.



Changing the order of entries in an index
For each main and sub-entry, you have the option of specifying a sort key. Sort keys allow 
you to change the usual order for certain entries such as those beginning with numbers so 
that they appear in a logical place in the index. For example, by typing three in a Sort Key 
box, you can have an entry starting with the number 3 listed under "T" rather than the 
exclamation mark heading under which non-alphabetic entries are normally listed.
You can also use sort keys to ignore articles of speech (e.g., a, an, the) when they appear at 
the beginning of an entry. For instance, if the main entry is "The Maltese Falcon," and you 
want to alphabetize it under Maltese rather than "The," enter Maltese Falcon as the sort key 
for the main entry. Sort keys work with cross-reference entries too.
Note:    The sort keys do not affect the preview window of the Index Entries Roll-Up. When 
the index is generated and loaded into the file, the index entries are ordered according the 
sort key specification if one has been made.



Generating an index
You can generate a partial index at any time and then update it as new entries are added.
To generate an index:

1. If you've made any changes to the document which you haven't yet saved, choose 
Save from the File menu to save them.

2. Click the Generate Index button in the Index Entries Roll-Up or choose Format, TOC & 
Index and click the Index tab. The Index dialog box opens. 

3. In the Title box, type the title you want to appear at the beginning of the index.
4. From the Delimiter list box, choose the separators (spaces, tabs or punctuation) you 

want to use to separate the main entry text from the page numbers, and the page 
numbers from one another.

5. Choose a format for the main entry from the Preset Format list box.
6. If you want to apply text attributes to any of the elements in the index entry, drag to 

select the element in the Index Text box and apply the required attributes using the 
Text Attributes button ( ). The Selected Text Attributes.

7. If you want letter headings to appear in the index, select Letter Headings.
8. If you want to replace the cross reference text, change the contents of the See and 

See also text boxes in the Cross Reference Prefix section of the dialog box.
9. Choose the Generate List button. The File Save As dialog box opens.

To name the index file, type a name in the File Name box (a .GEN extension is added 
automatically) and then choose OK. After naming the file, use the Load File command 
in the File menu to place it in your document (see Adding an index file to your 
document).



Adding an index file to your document
1. Choose File, Load Text. The Load Text opens.
2. From the List Files of Type box, choose Generated Text
3. In the File Name box, type the name of the list file or select it from the list.
4. If the file is not listed, use the Drives and Directories list to locate it. 

If you selected the page frame before choosing the Open command, Corel VENTURA 
places the list file in the document. If you did not select the page frame, click the file's 
name in the Files List.



Editing index entries
To edit index entries in the document:

1. Choose Tools, Index Entries Roll-Up. The Index Entries Roll-Up opens.
2. Position the Freeform Text or Tagged Text cursor at the start of the word that has the 

index entry you want to edit.
3. Use the arrow keys to move the cursor over the index entry marker (degree symbol "").

The status line reads "Index Entry" when the cursor is over the symbol.
4. Click the corresponding entry in the Index Entries Roll-Up. The text is displayed in the 

Main Entry or Sub Entry boxes depending on the type of entry.
5. Edit the entry text in the roll-up.

When you finish editing entries, update the index so that it reflects the changes (see 
Updating an index).



Updating an index
Whenever you make changes to a document that affect the contents of the index you should
generate it again so that it's up to date. For example, if you add more index entries to the 
document, you need to re-generate the index to include the additional entries.
To update the index:

1. Open the document containing the index you want to update.
2. Choose Format, TOC & Index and click the Index tab.
3. Click Generate. The File Save As dialog box opens.
4. Enter a name and storage location for the file. Overwrite the existing file to update the 

index.



Creating a table of contents
Corel VENTURA generates a table of contents by searching your document for paragraphs 
(usually headings) formatted with a certain tag. It then copies the text from the paragraphs 
to a new text file. You can have the file added to a new chapter at the beginning of your 
document. Or, you can load the file into a new or existing chapter yourself.
To create a table of contents:

1. Save your document and then choose Format, TOC & Index.
2. Click the Table of Contents tab. The Table of Contents dialog box is displayed.
3. Enter the number of levels in the # of Levels box.

The # of Levels setting can also be used to suppress levels. For example, if you 
defined five levels but only want three to appear in the list, set # of Levels to three.

4. In the Title box, type the title you want to appear at the beginning of the Table of 
Contents.

5. Enter the first level of the Table of Contents that you want to format in the Level box.
6. From the Reference Tag list, choose the paragraph tag assigned to the paragraph you 

want as the first level entry in the list.
7. Choose a numbering format for the first level from the Preset Formats list box.
8. If you want to apply text attributes to the chapter or page number, click and drag to 

select the [C#] or [P#] codes in the Table of Contents Text box and apply the required 
attributes using the Text Attributes button ( ). The 
Selected Text Attributes.

9. For each additional level, increment the number in the Level box and then repeat 
steps 6 to 8.
10. Choose the Generate button.
11. The File Save As dialog box opens. Enter a new name and storage location for the file 
being generated. 

To name the table of contents    file, type a name in the File Name box (a .GEN 
extension is added automatically) and choose OK. After naming the file, use the Load 
File command in the File menu to place it in your document (see Adding a table of 
contents file to your document).

12. Load the text file into the document.
You can format the file once it has been loaded into the document.



Adding a table of contents file to your document
1. Choose File, Load Text.
2. From the List Files of Type box, choose Generated Text
3. In the File Name box, type the name of the table of contents file or select it from the 

list.
If the file is not listed, use the Drives and Directories list to locate it. 
If you selected the page frame before choosing the Open command, Corel VENTURA 
places the list file in the document. If you did not select the page frame, click the file's 
name in the Files List.



Adding a table of contents file to your document
1. Choose File, Load Text.
2. From the List Files of Type box, choose Generated Text
3. In the File Name box, type the name of the table of contents file or select it from the 

list.
If the file is not listed, use the Drives and Directories list to locate it. 
If you selected the page frame before choosing the Open command, Corel VENTURA 
places the list file in the document. If you did not select the page frame, click the file's 
name in the Files List.



Updating a table of contents
Whenever you make changes to a document that affect the table of contents you should 
regenerate it so that it's up to date. For example, if you add a section to a document, you 
need to regenerate the table of contents so that it contains the section's heading.
To update the table of contents or list:

1. Open the document containing the table or contents or list you want to update.
2. Choose Format, TOC & Index. The Table of Contents dialog box is displayed.
2. Click Generate. The File Save As dialog box opens.
3. Use the same name and location for the table of contents file and overwrite the 

existing file to update the table of contents.
4. Choose the Close button.



Spell Check command (Tools menu)
Opens the Spell Check dialog box.
Enables you to spell check an entire chapter, untitled elements, modified files, captions, 
selected text and selected files.



How to
· Check spelling
· Adding words to dictionaries
· Install a foreign-language dictionary
· Use the appropriate hyphenation dictionary for previous versions of VENTURA
· Work with dialog boxes



Thesaurus command (Tools menu)
Opens the Thesaurus dialog box which enables you to search for alternative words.



How to
· Use the Thesaurus
· Install a foreign-language thesaurus
· Work with dialog boxes



Type Assist command (Tools menu)
Opens the Type Assist dialog box.
Controls the capitalization of text and enables you to build quick shortcut words when 
entering repetitive information. All correction takes place after the word is complete as 
indicated by either a punctuation mark or a space.



How to
· Use Type Assist
· Work with dialog boxes



Files Roll-Up command (Tools menu)
Opens the Files Roll-Up.
Displays only the text and graphics files included in the current chapter.



Tags Roll-Up command (Tools menu)
Displays the Tags Roll-Up. It lists all tags in the style sheet(s) used in current chapter.



How to
· Add paragraph tags
· Delete paragraph tags
· Rename paragraph tags
· Use roll-up windows



Character Roll-Up command
(Tools menu)
Opens the Character Set Roll-Up.
Enables you to visually select any character from all the fonts, or character sets, installed on
your system for placement at the insertion point.



How to
· Enter special characters
· Use roll-up windows



Cross-Ref Roll-Up command (Tools menu)
Opens the Cross-Refs Roll-Up.
Reconciles cross-references and markers in current publication.



How to...
· Insert cross references
· Mark text
· Generate and update cross references
· Use roll-up windows



Index Entries Roll-Up command
(Tools menu)
Opens the Index Entries Roll-Up.
Creates index entries in current chapter or lists all index entries in the current publication.



How to
· Create an index
· Delete an index entry
· Change the order of entries in an index
· Generate an index
· Edit index entries
· Use roll-up windows



Placement Roll-Up command (Tools menu)
Opens the Placement Roll-Up.
Offers precise control of the locations of frames and the graphics they contain, plus graphic 
objects created with the drawing tools within the current page. Coordinates, relative to the 
position of the origin on the rulers, are set for the top left corner of the frame. This command
also enables you to rotate and resize the frame. 



Node Edit Roll-Up command
(Tools menu)
Opens the Node Edit Roll-Up.
Used to edit text wrap paths.



How to
· Draw a text wrap path around a graphic
· Edit a text wrap path
· Use roll-up windows



Align command (Tools menu)
Opens the Align dialog box, which enables you to align graphic objects and frames vertically 
and horizontally to the grid and to the center of the page.



Grid Setup command (Tools menu)
Opens the Grid Setup dialog box. 
Enables you to set the grid frequency and origin as well as enable show grid and snap to 
grid, for the current frame. 
Note:    You must also turn on Snap to Grid in the Layout menu.



How to
· Use measurement controls
· Snap to Grid
· Snap to Inter-Line
· Snap to columns



Ruler Setup command (Tools menu)
Opens the Set Ruler dialog box. This dialog sets the following options: horizontal units, 
vertical units and ruler origin.



How to
· Use the rulers
· Use measurement controls



Preferences command (Tools menu)
Opens the Preferences, General dialog box.
Provides access to user interface controls. 



How to
· Set general preferences
· Set display preferences
· Set text preferences
· Work with dialog boxes



Extensions (Tools menu)
Displays a list of up to 20 application names in a flyout menu. Selecting one of the 
applications launches it. When you exit the application, you are back in Corel VENTURA.
Note: The application names must be inserted in the CORELVP.INI file to appear. For 
example:
[Extension APPS]
Corel PHOTO-PAINT=Corel PHOTO-PAINT,C:\COREL50\PROGRAMS\CORELPNT.EXE
CVPFIX=CVPFIX,C:\COREL50\PROGRAMS\CVPFIX.EXE
CorelKERN=CorelKERN,C:\COREL50\PROGRAMS\CORELKRN.EXE
Corel MOSAIC=Corel MOSAIC,C:\COREL50\PROGRAMS\CORELMOS.EXE





Pick tool    
The Pick tool allows you to select, re-size and move elements, such as frames, graphics and 
tables, around on a page.



Zoom tool    
Displays a menu with six viewing icons.

(Zoom In) Magnifies an area of the screen. After clicking
the icon, hold down the mouse button and drag a box around the area you want to magnify.

(Zoom Out) Zooms out by a factor of two each time you
click or returns to the view you were at before the last zoom-in.

(Actual Size) Displays the page at the size at which it 
will print.

(Fit In Window) Adjusts the magnification as to display 
the full page

(Full Width) Adjusts the magnification factor so that the
full width of the page is displayed.

(Full Height) Adjusts the magnification factor so that 
the full height of the page is displayed.
 



Frame tool     and Node Edit tool 

The Frame tool allows you to create frames on the page. Text and graphics can then be 
inserted into those frames by using the commands found in the File menu.
The Node Edit tool allows you to draw a path around a graphic, or a portion of it, so that text 
will flow around the graphic rather than the frame. You can also edit individual nodes within 
a path using the Node Edit tool. 
Corel VENTURA also offers preset wrap shapes (trapezoid and oval among others) that you 
can apply to your graphic, as well as an autowrap feature that will apply a path around the 
graphic's contours. These two options can be accessed using the right mouse button menu 
on a selected frame.
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Text tools: Freeform  and Tagged 

Holding the mouse button on the text tool icon displays the flyout menu from which you 
choose either the Freeform or Tagged Text tool. Both text tools can be used to select, enter 
and edit text as well as change text attributes (type face or font, style, size, shift, kerning 
and color). Both behave in the same manner when you select text; the formatting changes 
are applied only to the highlighted text.
They behave differently when you click a paragraph. If you use the Tagged Text tool

, the formatting changes you make are applied globally 
which means that all paragraphs using same tag as the selected paragraph are also 
modified. If you use the Freeform Text tool 

, the changes are applied locally; only the selected 
paragraph is modified, the paragraph tag remains unchanged. 

See also:
Freeform Text tool and Tagged Text tool--Overview
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Drawing tools
The Drawing tool displays a flyout menu which includes five tools for creating graphic 
objects directly in Corel VENTURA. 
Use: To draw:

squares and rectangles
straight lines
squares and rectangles with rounded corners
ellipses and circles
box text which consists of a rectangle (box) and text 

enclosed in it. This tool is used to first create the rectangle and then the corresponding text 
which must be typed using the Freeform Text tool. 

The text can be formatted and the box can be filled and outlined like any other 
graphic object. 

Both the text and the box move together. Box text is useful when creating callouts for
illustrations.
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Outline tool    
Displays the Outline tool flyout menu which is used to define the outline attributes for 
selected graphic objects. The attributes include thickness, color and style among others.
Note: When a frame is selected and you choose an option from the Outline tool flyout 
menu, the Ruling Lines dialog box will open.
 



Fill tool    
Displays the Fill tool flyout menu which is used to define the fill attributes for selected 
objects. Fill options include, among others, uniform fill colors, fountain fills, patterns and 
bitmap textures. 



New publication button 
Clicking this button is a quick method for starting a new publication. It opens the New 
Publication dialog box. 



Open file button 
This button performs the same task as the Open command in the File menu. It is used to 
open an existing publication or chapter by displaying the File Open dialog box.



Save button 
This button performs the same task as the Save command in the File menu, saving the 
current chapter in a multi-chapter document.
· If you have not saved the publication yet, the File Save As appears prompting you to enter

a name.
· If you are altering an existing document, clicking the save button automatically saves the 

document using its current name and path (i.e., drive and directory).
· If you are altering an existing document, but want to keep the original version, use the 

Save As command to give it a different name and/or save it in a different drive or 
directory. 
NB: Save As copies and renames the entire document structure--the publication--not the 
content of the text files. If you make changes to a text file but don't want the changes 
saved to the original files, use the Rename File command to create a new text file to 
contain your changes.



Print button    
Displays the Print dialog box and set the options and choose a range of pages to print.



Cut button    
This button provides quick access to the Cut command (Edit menu). Clicking it removes the 
selected text or graphic from the current page and places it onto the Clipboard. You can then
paste the cut text or graphic onto another page, document or Windows application.



Copy button 
This button provides quick access to the Copy command (Edit menu). Clicking it places a 
copy of the selected text or graphic onto the Clipboard. You can then paste the copied text 
or graphic into another page, document or Windows application.



Paste button    
This button provides quick access to the Paste command (Edit menu). Clicking it places a 
copy of the text or graphic that has previously been cut or copied to the Clipboard, onto the 
current page. The object(s) remains on the Clipboard until you copy or cut another object or 
end the current Windows session.



Undo button    
The Undo button performs the same task as the Undo command in the Edit menu. It 
reverses the last operation performed and returns the current file to its previous state. 
Note: Not all operations can be reversed using the Undo command or button.



Zoom list box    
This drop-down list offers various magnification factors to choose from to change the view of
the current page. A factor of 100% displays the page at full size; factors above 100% zoom 
in closer to the page and factors below 100% zoom away allowing you to view a larger 
section of the page.



Go to previous/next chapter buttons    
These buttons are functional only when working with a multi-chapter publication file. They 
are used to display the previous or next chapter in the document area.



Go to previous/next chapter buttons    
These buttons are functional only when working with a multi-chapter publication file. They 
are used to display the previous or next chapter in the document area.



Insert break button    
Inserts a page break before the Tagged Text tool or Freeform Text tool cursor's position. 



Place side-by-side button    
The Place side-by-side feature places selected consecutive paragraphs in a horizontal 
sequence across the page by adjusting the In from Left and In from Right values for the 
paragraphs. It also sets the line breaks so that each paragraph in the sequence starts at the 
same vertical position, the Y position. At the end of the side-by-side sequence, the Y position
of the next line will be determined by the longest paragraph in the sequence.
Select one or more consecutive paragraphs by choosing a Text tool and holding down the Alt
key and clicking each one in succession. Once the Place side-by-side button is used, all 
paragraphs having the same tags as the selected paragraphs will be placed side by side. 
Therefore, it is recommended that you create new tags when using the side-by-side feature. 
If you use the Freeform Text tool, only the two selected paragraphs are placed side-by-side. 
It is not necessary to create new paragraph tags when using the Freeform Text tool. The 
side-by-side formatting is an override.
This button is available when two or more paragraphs are selected. 



Spell check button    
Opens the Spell Check dialog box. Allows you to spell check an entire chapter, untitled 
elements (such as text entered directly into frames or box text objects), modified files, 
captions, selected text and selected files.



Insert table button    
This button is used to insert a table on the page. Note that you must choose the insertion 
point where the table is to be located for the button to be functional. 

Clicking this button displays the General tab of the Table Settings dialog box in which you set
the number of rows and columns for the table and other attributes. 



Set Tab Stop buttons 
These buttons are used to insert tab stops on the tab bar located immediately below the 
horizontal ruler.
Click: To set this type of tab stop:

Text is left aligned at the tab stop location.
Text is centered at the tab stop    location.
Text is right aligned at the tab stop location.
Decimal point in numeric values align at the tab stop location.

If you have clicked the right mouse button on the ruler, the Ruler menu is displayed. The Left
Align, Center Align, Right Align and Decimal Align commands correspond to the above tab 
stop buttons.
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Corel MOSAIC button    
Launches the Corel MOSAIC file management application in a roll-up window.



 Help button    
This button displays the Screen/menu help cursor . Click a 
screen item or an available menu command to see specific information about it. 



Tag list    
The drop-down tag list displays the tag associated with the selected text or frame and allows
you to choose a different tag for the selected element.
If the Pick tool is activated, the tag list includes all frame tags found in the current chapter. If
either one of the text tools is activated, the tag list includes all style tags for the current 
style sheet. 



Font and file list    
The items shown in this drop-down list depend on the mode you are working in. 
If the Pick tool is activated, the list includes all graphic and text filenames used in the 
current chapter. When working in Text mode (i.e., either one of the text tools is activated), 
the list shows all available fonts that can be applied to the selected text or paragraph.



Font size list box    
Drop-down list box of various point sizes to apply to text. The desired font size can be typed 
directly or selected from the list.



Normal button    
Cancels bold, italic and underline formatting attributes and resets the selected text to 
normal. 



Bold button    
Makes the selected text bold. To remove the bold attribute, click the Normal button.



Italic button    
Italicizes selected text. To cancel the italic attribute, click the Normal button.



Underline button    
Underlines selected text. To remove the underline, click the Normal button.



Alignment buttons
The five alignment buttons are used to set the alignment of text. 
If the Freeform Text tool is activated when you click an alignment button, the selected 
alignment is applied to the selected paragraph without changing the current style tag.
If the Tagged Text tool is activated, clicking an alignment button modifies the selected 
paragraph's tag. The alignment is also applied to the selected paragraph.
Click: To:

Align the text to the left.
Center the text.
Align the text to the right.
To fully justify the text i.e., align it to both the left and the right.
Align the decimal point in numerical values. You can choose an alignment character 

other than the period by using the Alignment tab of the Paragraph Settings dialog box.
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Show/Hide returns button    
Toggles the display of the elements listed below: 
·    paragraph returns
·    end of text file symbols
·    forced line breaks
·    tabs
·    discretionary hyphens
·    non-breaking and other fixed-width spaces
·    markers for hidden items, and 
·    override symbols (a diamond-shaped symbol best viewed in Copy Editor mode) on and 
off. 
When working in Copy Editor view, the Show/Hide Returns button also displays or hides text 
attributes codes such as bold and italic as well as other symbols . 



Quick Format button    
Displays the Quick Format roll-up window which includes collections of ready-made formats 
to apply to various elements in your chapter. The categories include: tables, paragraphs, 
ruling lines, columns and page layout, headers and footers.





Copy Editor command (View menu)
The Copy Editor command displays only the text in a chapter using a single proportional font
for faster editing. 



How to...
·   Use the Preferences, Text dialog box  

· Work with text--Overview



Draft command (View menu)
Draft view hides imported graphics and displays the entire document, including non-graphic 
elements, in black and white. The text remains formatted giving you an accurate 
representation of your document except for the graphics. Editing and formatting is faster 
because it takes less time to redraw the screen. 



How to...
· Work with Text--Overview



Page Layout command (View menu)
Page Layout, the default setting, displays the document the way it looks when printed, 
including text layout and formatting, and graphics. 



How to...
· Work with Text--Overview



Zoom command (View menu)
The Zoom command opens the Zoom dialog box, where you can enter a zoom percentage or
click on one of the following icons:

Zoom In:    Magnifies an area of the screen. After 
clicking the icon, hold down the mouse button and drag a box around the area you want to 
magnify.

Zoom Out:  Zooms out by a factor of two each time you
click or returns to the view you were at before the last zoom-in.

Actual Size:    Displays the page at the size at which it 
will print.

Fit In Window:  Adjusts the magnification to display the
full page

Full Width:  Adjusts the magnification factor so that the
full width of the page is displayed.

Full Height:    Adjusts the magnification factor so that 
the full height of the page is displayed.



Facing Pages Preview command (View menu)
Displays opposing left and right pages simultaneously, as would be visible in an open book 
or magazine.



Go to Page command (View menu)
Opens the Go to Page dialog box, which enables you to select a specific page to move to 
within the current chapter.
You can also go to a specific page of a text file. Text files are sometimes laid out on non-
sequential pages because the text starts on one page of the document then continues on a 
much later page like newspaper articles or, because pages of illustrations are inserted 
between pages of text. The Go to Page command enables you to go to a specific page of 
text files. 



Go to Chapter command (View menu)
Opens the Go to Chapter dialog box.
When working on a publication, enables you to display the next or previous chapter.



Hide Frame Borders (View menu)
Hides all borders applied to frames in the current chapter.



Hide All Graphics (View menu)
Replaces graphics by rectangles with an X across each one.    Non-graphic elements remain 
on screen and are displayed in color if applicable. Text remains formatted. Editing and 
formatting is faster because it takes less time to redraw the screen.



Graphics Resolution command (View menu)
When you click the Graphics Resolution command, a pop-up menu appears. Enabling Low 
Resolution displays bitmaps at a low resolution in the editing window. Making them low 
resolution increases the screen redraw speed when you're working with large documents. 
Enabling High Resolution causes bitmaps to be displayed at high resolution in the editing 
window, which decreases screen redraw speed. If you disable High Resolution, bitmaps are 
displayed at a lower resolution, which increases screen redraw speed. Changing bitmap 
resolution using the Graphics Resolution command only affects the way bitmaps are 
displayed on screen; it does not affect the way they display in the print preview or how they 
are printed.
With High Resolution selected, Corel 5 vector formats such as CDR (from CorelDRAW) and 
CCH (from CorelCHART), will display using the actual vector image. With Low Resolution 
selected, the image header displays instead of the vector image.



Graphics Resolution command (View menu)
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CCH (from CorelCHART), will display using the actual vector image. With Low Resolution 
selected, the image header displays instead of the vector image.



Show Hidden Frames command (View menu)
Displays frames that have been hidden using the Hide All Graphics command or the Hide on 
Current Page option for Repeating Frames in the Frames Settings dialog box.



Rulers command (View menu)
Toggles the display of the rulers on and off.



How to...
· Use the rulers



Color Correction command (View menu)
Use the Color Correction flyout menu to improve / optimize the linearity of your monitor so 
that pictures appear as similar on-screen as possible to a white-balanced photograph. The 
options are:
None No color correction
Fast General approximation
Accurate Best screen colors
Simulate Printer Displays screen colors as they would appear when printed
Apply to text Color correction applied only to text



Toolbox (View menu)
The Toolbox box flyout menu has the following options:
Visible The visible command displays the toolbox.
Floating The Floating command detaches the toolbox, enabling you to place it 

anywhere on the screen.



Refresh Window (View menu)
This command redraws the entire chapter on screen, removing screen "dirt" left by earlier 
manipulations.
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Accelerator keys
Also known as speed keys and hotkeys, accelerator keys execute menu commands when 
pressed in combination. Some people prefer to use speed keys rather than reach away from 
the keyboard for the mouse and click two or more menu items or a tool button



Active window
The active window is the one in which you are working.



Anchors
Anchoring a frame links it to a particular location in the text. Corel VENTURA provides both 
an automatic anchor, which instantly moves the frame whenever the text containing the 
anchor is moved, and a manual anchor, which moves the referenced frame only when you 
choose the Re-Anchor Frames command from the Format menu.



ANSI text
American National Standards Institute. At 256 characters, the ANSI character set offers 
twice as many characters as ASCII text, including the paragraph symbol. Many typefaces are
derived from the ANSI character set.



ASCII text
American Standard Code For Information Interchange. The 128-character ASCII-text 
character set is stored in exactly the same order as you see it on a printed page, with no 
additional hidden characters added or deleted. ASCII files are often called "text" or "print" 
files.



Ascender
The part of a lower case character that rises above the height of the lower case "x."



Aspect ratio
The ratio of the width of an image to its height. You can change the aspect ratio of an object 
in Corel VENTURA by stretching it in one direction.



Attribute
Any style used to enhance readability of text. Typical attributes include boldface, underline, 
and italic. Font changes assigned to selected text are also considered attributes.
Attributes are assigned to selected text by assigning an attribute from the Text menu using 
the Text tool.



Baseline
An imaginary line on which type rests. Some characters have "descenders" that hang below 
the baseline (e.g., the letter "g").



Base page frame
The page frame defined using the Chapter Settings command in the Layout menu. For long 
documents, this is the frame in which you place the main text. Corel VENTURA creates 
additional pages until all the text in the file is placed on pages. Additional frames, called free
frames, can be placed on top of the base page.



Batch Operations
A task performed on several consecutive graphic files. Batch printing, importing, 
exporting/converting and extract/merge-back text are available in Corel MOSAIC 
(standalone).



Binding Margin
The additional space added to the inside edge of pages to allow for drilling or punching 
before binding. Use different margins for left and right pages to create binding margins.



Black point
A color printing term specifying the blackness level relative to a 4-color and a 3-color black. 
A 4-color black is produced by printing 100% cyan, 100% magenta, 100% yellow and 100% 
black. A 3-color black is produced using full amounts of the CMY inks only, and is therefore 
not as dark.



Bleed
Part of a printed document that extends beyond the edge of the page.



Bitmap
An image composed of a series of pixels or dots. Scanners and paint programs such as Corel 
PHOTO-PAINT generate this type of image. By contrast, a drawing program such as 
CorelDRAW creates images using vector objects--shapes stored internally as mathematical 
equations.



Bitmap texture
Variable fills that look like clouds, water, gravel, minerals and dozens of other natural and 
created substances. Bitmap textures display on your screen and print to any printer.



Body Text
The text of the main part of your document.
Body Text is also the name of the default tag in a Corel VENTURA style sheet(s). All text in a 
Corel VENTURA chapter is automatically formatted with this Body Text tag unless you assign 
other tags to specific paragraphs using the Paragraph tool.



Bold
A darker, heavier version of normal type often used for headlines and text emphasis.



Box Text
Text contained in a box created using the Box Text Graphic tool. Box text does not flow 
around frames. Use box text for figure callouts and other non-repetitive applications.



Break
The interruption in the flow of text from one paragraph to the next. Normally each paragraph
continues directly below the previous paragraph or, if no more room is left on the current 
column or page, it continues at the top of the next column or page. This is called a normal 
Line Break.
If you want a paragraph to always begin at the top of a new column, you set a Column 
Break. If you want a paragraph to always begin at the top of a new page, you set a Page 
Break.
Any two paragraphs that contain no break of any kind between them will print on top of each
other, unless you use the paragraph Spacing options to move one paragraph to the left and 
the other paragraph to the right.



Brightness
In the HSB color model, the component that determines the amount of black in a color. See 
also Hue and Saturation.



Bullet
A dot or other symbol used to differentiate items in a list or for adding emphasis. You can 
add bullets to paragraphs using the Paragraph command in the Format menu or the Quick 
Format Roll-up which is also available in the Format menu.



Calibration
Adjusting a monitor, printer or scanner to more accurately display, print and capture colors.



Calibration bar
Strips of color printed with an illustration. Used as a reference for calibrating a monitor so 
that it displays colors as they appear in the printed output.



Callout
Box text tied to a frame that identifies ("calls out") an item shown in the frame. A callout 
often includes an arrow drawn with the Line tool to point to a specific item. Several callouts 
can be anchored to one frame.



Cap Height
The distance from the baseline to the top of an upper case character.



Caption
Text added to a frame, usually to identify or explain its contents.



Carding
Spacing added in multiples of the Body Text tag's inter-line spacing setting. Used to 
vertically align adjacent columns by their baselines.



Catalog
A collection type in which thumbnails of your files, along with keywords and pointers 
indicating the location of your files are stored. A catalog does not contain the actual files. It 
is used to visually group files that are saved in different directories yet are of related subject 
matter. 



CIE
CIE (Commission Internationale de l'Eclairage) is a color space chart widely used to describe 
the range of color seen by the human eye.



Chapter
A combination of text and graphics files, formatted with a style sheet(s).
A chapter file consists of pointers to each of these files, along with instructions on how to 
combine them together on the page. All Corel VENTURA 5.0 documents are saved as 
publications consisting of at least one chapter.



Check Box
An option box that is enabled by clicking on it. A check mark appears to show that it's 
enabled.



Choke
A type of trap created by extending the background object into the foreground object. See 
also Spreads



Clip
In Corel VENTURA, clip means to mask out portions of a graphic by applying a path to it. The 
path acts as a window through which the remainder of the graphic shows. Text on the same 
page as the graphic flows around the path.



Clipart
Images that can be brought into Corel VENTURA and edited or used as is. Corel VENTURA 
offers a large selection of clipart in vector format. 



Clipboard
A temporary, invisible holding place for text, pictures, and graphics. Any text or picture 
placed on the clipboard using a cut or copy operation can be placed anywhere else in the 
chapter. Clipboard contents can also be placed in another chapter by cutting or copying to 
the clipboard, immediately saving the chapter, opening a second chapter, and immediately 
pasting the clipboard contents where desired.



Close Box
The box located at the top left corner of the Corel VENTURA window. Double-clicking on the 
box exits Corel VENTURA.



CMYK
The four letters represent Cyan, Magenta, Yellow, and Black, the ink colors used in four-color 
process printing. Corel VENTURA allows you to specify colors using CMYK values. 



Collection
A general term referring to master files which contain thumbnails. The thumbnails are 
associated with files and are displayed in a single window in the display screen. A collection 
can be a library, a catalog or a directory. 
A library contains the actual files it shows as thumbnails in a compressed format. A directory
contains the files in an uncompressed format. A catalog contains only references pointing to 
files located in various directories and keywords associated them. 



Colorimetric
Colorimetric refers to the colorimetric chroma mapping necessary for the reproduction of 
spot colors. Corel VENTURA remaps colors outside of the printer's gamut to the edge of the 
gamut, preserving colors inside the gamut to ensure more accurate spot color reproduction. 
See also Photographic and Gamut Mapping



Color Manager
Color Manager is a tool that learns about your monitor, scanner and printers to create a 
System Color Profile. This profile helps Corel VENTURA more accurately capture, display and 
print color across different devices.



Color separation
The process of separating the colors in an image into the primary printing colors: cyan, 
magenta, yellow and black.



Column Balance
The method of making the text in adjacent multiple columns end evenly across a page.



Column Guides
An option that shows faint dashed lines on the screen to show the outline of each column.



Corel MOSAIC
A versatile file management utility included with Corel VENTURA 5. Corel MOSAIC works in 
one of two modes; standalone or roll-up. The standalone mode, accessed by double-clicking 
the Corel MOSAIC icon in the Corel Applications group, provides full functionality. It allows 
you to create collections, perform batch operations to graphics files, export files, to name 
just few. 
The roll-up mode displays MOSAIC as a roll-up window within another Corel application. It 
provides basic functionality by giving you quick access to graphic files and allows you to use 
drag and drop to import or open files within the application.



CORELPRN.INI
A text file with printing-related information shared by all installed Corel applications. This file
is in the CORELDRW\CONFIG subdirectory and can be edited by double-clicking on it in the 
Windows File Manager. Changes you can make to this file include disabling the message box 
that warns when the printer and page orientation in a Corel application do not match.



Corel Presentation Exchange (CMX)
New to version 5 of Corel VENTURA, CMX is a binary file format Corel applications use 
internally to render files on an output device such as a monitor or printer. 



Crop
Eliminate unwanted portions of a picture. The portions not displayed in the document are 
still stored in the original picture file.



Crop Marks
Alignment marks that delineate the outside edges of the printed page. Also called trim 
marks or registration marks. Crop marks can be automatically added at print time or you can
draw your own using the Graphic Line tool. 



Crosshairs
A pair of intersecting lines which replace the usual mouse pointer. Crosshairs can be 
dragged from the spot where the rulers meet.



Cross reference
A coded reference to another part of a document which Corel VENTURA automatically 
updates when you choose Renumber Publication from the Format menu or Cross-Refs Roll-
up. Cross references are generated from a cross-refererence source, cross-reference marker 
and cross-reference format



Cross-reference source
A location to which you want to refer the reader--on a page, in a chapter or table, a figure in 
a caption or its label, or a section number generated with the Chapter Auto-Numbering 
feature.



Cross-reference marker
A code placed in a paragraph which identifies the location of the cross-reference source. You 
may assign any name you choose to the marker from the Edit menu's Insert Special Item, 
Marker flyout.



Cross-reference format
Determines the numbering style of cross references--Arabic, Roman and so on, and whether 
it includes prefixes denoting Page, Chapter, Figure, Table, Section, or Chapter and Page 
numbers.



Current Selection Indicator
The long box at the bottom of the Corel VENTURA screen that shows the currently selected 
item.



Cursor
Also called the" mouse pointer." Used to indicate the object, command, tool or other screen 
item you want to select. The shape of the cursor changes depending on the tool or 
command selected.



Database
A tool for storing and organizing information. 



Default printer
The device that Corel VENTURA automatically uses to print a document when you choose 
the Print command from the File menu. You can have only one default printer selected using 
the Print Setup command in the File menu.



Descender
The portion of a letter that extends below the baseline, for example, the tail on the lower 
case "y."



Densitometer scale
Printed on each page of a color-separated image for the purposes of gauging the accuracy, 
quality and consistency of the output. You can print these scales by choosing an option in 
the Print Options dialog box.



Destination file
The file into which an embedded or linked object is being inserted. See also Embedded 
object and Linked object



Device driver
A program through which a computer and devices such as a mouse or printer communicate. 
A mouse driver, for example, displays a pointer on the screen and translates clicks into 
actions.



Dialog box
The set of choices presented in a window for a menu option that requires you to specify 
more information.



Direction keys
Direction keys are the arrow keys and the HOME, END, PgUp and PgDn keys on the numeric 
keypad.
The arrow keys move the insertion point when you enter or edit text on-screen or in a dialog 
box.



Directory
A directory is part of a structure used to organize files on a disk like a drawer in a filing 
cabinet. Directories have names and can be divided into subdirectories. For example, you 
could create a directory called LOGOS for storing logo designs.



Discretionary hyphen

A hyphen code placed in a word at the user's discretion by pressing Ctrl+Shift+H. Ordinarily,
when hyphenation is turned on and a hyphenation dictionary chosen from the Paragraph 
Settings, Typography dialog box, Corel VENTURA hyphenates your text automatically. 
Discretionary hyphens give you the choice of adding additional hyphens as desired.

Unlike hyphens inserted with the dash key, discretionary hyphens print only in words 
appearing at the end of a line. Where a discretionary hyphen and automatic hyphen occur in
the same word, VENTURA uses either one. 

When you have automatic hyphenation turned on but want only discretionary hyphens to 
appear in words containing both types of hyphenation codes, choose Only use Discretionary 
Hyphens if present from the Chapter Settings, Typography dialog box. 

Note: When automatic hyphenation is turned off discretionary hyphenation is also turned 
off. 



Dithered color
Color simulated by putting dots of another color very close together. Windows uses dithering
to display colors that the graphics adapter is unable to display. See also Pure color



Dot gain
Enlargement of the dots that make up an image causing colors to print darker than 
intended. Corel VENTURA's Color Manager automatically compensates for dot gain.



DPI
A measure of a printer's resolution in dots per inch. Typical desktop laser printers print at 
300 dpi, while image setters are capable of printing at resolutions of 1270 or 2540 dpi. The 
more dots per inch, the smoother the output.



Drag
To move the mouse while holding down the left mouse button. Releasing the button 
completes the action.



Drive
A device in a computer that spins disks used to store information. Personal computers 
normally have a fixed disk drive labeled C and one or two floppy disk drives labeled A and B.



Drop-Down List Box

A list box that appears in dialog boxes and opens to display a list of choices when you click 
on the arrow. If the list cannot accommodate all available options, scroll bars are provided. 
See also List box



Em
A unit of measure that is exactly as wide as the point size being used. Em units are often 
used to specify the width of a column or the amount of indentation.



Em dash
An em dash is one em long and is used to separate parenthetical statements from the 
surrounding text. To create an em dash, press Ctrl+Alt+M.



Em space
An em space is exactly as wide as the point size of the font. To create an em space press 
Ctrl+Shift+M



Embedded object
An object that is embedded within a Corel VENTURA chapter such that it is isolated from the 
source application (the "server"). For example, any changes you make with a paint program 
to the original graphic will not be applied to the graphic within Corel VENTURA.
However, you can double-click on an embedded object while in Corel VENTURA to 
immediately run the server application and edit the object. In this case the object will be 
updated. See also Linked Object



Emulsion
The light-sensitive coating material on a piece of film.



En
A unit of measure that equals one-half the width of an em.



En dash
An en dash is used between numbers (e.g., Figure 3-15). The en dash is also used in place of
a hyphen in a compound adjective one element of which consists of two words or a 
hyphenated word. To create an en dash, press: Ctrl+Alt+N.



En space
An en space equals one-half the width of an em space. To create an en space, press: 
Ctrl+Shift+N



Feathering
Adds the exact amount of space needed between paragraphs and frames to align the last 
element with the bottom of the page.



Figure Space
A figure space equals the width of a number in the current point size. Since all numbers in a 
given point size have the same width--even in a proportionally spaced font--you can use 
figure spaces between numbers in tables to keep tabular information aligned properly. To 
create a figure space, press: Ctrl+Shift+F



File List
The list in the Ribbon Bar of all text and graphics files in the current chapter. The current file 
name is shown if a frame or paragraph is selected. Click the scroll button and box to the 
right to display and scroll through the list. There's also a Files Roll-Up opened by choosing 
the corresponding command from the Tools menu.



Filter
A program that translates information from one format to another. Corel VENTURA's import 
filters, for example, allow you to open graphics created in CorelPHOTO-PAINT, Adobe 
Illustrator and many other applications.



Film Recorder
Device that reproduces images from a computer screen on film. The film can then be 
developed into slides or prints using conventional photographic processes. 



Flyout
One or more additional tools which appear when you press and hold down the mouse button 
on a tool. To quickly view all the tools available in a given application, try selecting Toolbox, 
Floating from the View menu and then deselect Grouped from the Toolbox Control menu. 
This will display all available tools in a large, rectangular Toolbox.



FOCOLTONE
A color system which provides a range of spot colors built with process colors, cyan, 
magenta, yellow and black (CMYK). The FOCOLTONE colors are organized so that you can 
choose FOCOLTONE colors with at least 10% of one process color in common with another 
FOCOLTONE color. This minimizes the need for trap and makes it an ideal color palette to use 
for color separating. 



Font
A unique combination of typeface, type size, type style, and type weight. For instance, Swiss
(typeface), 12 point (type size), roman (type style), bold (type weight) is one font; Swiss, 14 
point, italic, bold is another. Available point sizes in Corel VENTURA 5.0 range from 1 to 254.



Footer
Text that appears at the bottom of every page in the document.



Footnote
Explanatory text at the bottom of a page that is referenced to the pertinent location on the 
page by a number or symbol.



Fountain fill
A fill that fades gradually from one color to another. Also called a "gradient" or "graduated" 
fill. Corel VENTURA lets you create linear, radial, conical and square fountains using the 
Fountain Fill icon in the Fill tool menu and the Fill Roll-up.



Four-color process
The four-color printing process or "process color" reproduces all color artwork with just four 
colors: Cyan, Magenta, Yellow and Black, often referred to as CMYK. 



Frame
A rectangular box used to hold text or pictures. You create frames by using the Frame tool, 
and then modify their attributes using the options in the Frame Settings dialog box.
Each page is also a frame (see Base Page). Frames that you create using the Frame tool are 
called free frames. When you enter text into the base page frame, Corel VENTURA 
automatically creates new pages to accommodate all text in a file. The attributes of page 
frames can also be modified using the Frame command in the Format menu.



Frame Anchors
Anchoring a frame links it to a particular location in the text. Corel VENTURA provides both 
an automatic anchor, which instantly moves the frame whenever the text containing the 
anchor is moved, and a manual anchor, which moves the referenced frame only when you 
choose the Re-Anchor Frames command from the Format menu.



Free frame
A frame you create yourself. Unlike the base page frame, free frames can be moved 
anywhere on the page. They can also be anchored to text so that they move with the 
surrounding text when you edit the document. Use free frames for documents like 
newsletters and magazines to begin an article on one page and continue it on another. A 
free frame can have its own margin and column settings.



Gamut
A gamut is the range of colors a device can reproduce. The human eye has a very large color
gamut. Photographs have a large gamut as well. A monitor, with its RGB gamut, can also 
display many colors. Gamut mapping becomes important with printers and output devices, 
since these gamuts can be very limited. If you use colors outside of the printer's gamut, 
Corel VENTURA's Color Manager ensures that those colors are mapped into the printer's 
gamut as accurately as possible. See also Colorimetric, Photographic and Gamut Mapping



Gamut Mapping
Gamut Mapping is the reassigning of colors outside of the range of colors a device is capable
of reproducing. The range of colors you can specify from a palette or capture with a scanner 
can be larger than a printer can reproduce. Corel VENTURA uses two kinds of gamut 
mapping: Colorimetric for spot colors and vector-based art and Photographic for bitmap art. 
See also Gamut



Generated Tag
A tag created automatically for text that Corel VENTURA generates (e.g., figure numbers, 
section numbers). All generated tag names begin with the characters Z_ (Z + underscore).



Graphic
A graphic is a picture or a piece of artwork created in a drawing or paint program or 
generated using a scanner.



Graphic object
A frame or graphic created using the drawing tools.



Gray component replacement (GCR)
A technique in which equal amounts of cyan, magenta and yellow are removed and replaced
with black ink. This produces better color saturation and contrast as well as saving on ink 
costs. Corel VENTURA's Color Manager controls GCR according to the output device. 



Greeking
The act of representing text by dummy type which has no meaning, or by a series of straight
lines. Within Corel VENTURA, greeking is used to increase screen drawing speed when the 
text is too small to be legible. Does not affect what gets printed.



Grid
A series of evenly spaced horizontal and vertical lines used to align objects. The spacing is 
specified through the Grid Setup command in the Tools menu. You can also display the grid 
using this command and have objects snap to the grid by turning on Snap to Grid in the 
Layout menu.



Gutter
The blank space between columns. The term is sometimes used for the blank space on the 
inside of two facing pages in a bound document (also called binding margin).



Halftone
A picture in which shades of gray are represented by numerous black dots of different size. 
The bigger the dots, the darker the shade of gray. On printers that cannot print different 
sizes of dots (e.g., a laser printer), the halftone is produced by printing different numbers of 
dots in a given area.
The Frame Settings, Graphic dialog box lets you control the way in which halftones are 
created.



Halftone screen
In photography, a sheet of glass or film with a grid pattern of lines used to convert a 
continuous tone image into dots of various sizes. In Corel VENTURA, halftone screens are 
specified for Spot Colors by choosing PostScript from the Outline Color, Uniform Fill or 
Fountain Fill dialog boxes. Process color screens are set in the Print Separations dialog box 
under Custom Halftone. 



Handles
Small squares that appear on the corners and sides of an object's (i.e., a frame or a graphic 
created with the drawing tools) highlighting box when the object is selected. Dragging the 
handles resizes the object.



HPGL
The acronym for the Hewlett-Packard Graphics Language, a file format created by programs 
such as AutoCAD for printing drawings on plotters.



HSB
The initial letters in Hue, Saturation and Brightness are the components in the HSB color 
model. HSB is one of three color models Corel VENTURA provides for creating process colors.



Hue
In the HSB color model, hue is the main attribute in a color that distinguishes it from other 
colors. Blue, green and red, for example, are all hues. See also Saturation and Brightness



Image
A picture that is composed of individual dots created with a "paint" program or with a 
scanner. See also Line Art



Indent
The blank space between the margins and the text. Normally, only the first line in a 
paragraph is indented, but you can indent any number of lines.



Insertion Point
A vertical bar that indicates where text will be inserted when you type. The insertion point 
appears when you click on a text block with the Text tool and in dialog boxes that require 
you to type information.



Interactive
A mode of Corel VENTURA operation that allows you to bypass the menus and use the cursor
and keyboard to do certain functions, e.g., font size selection, kerning/tracking, frame 
sizing/moving, etc.



Inter-character spacing
The amount of spacing between characters of text. It is also called "letter spacing" and 
kerning. 



Inter-Line Spacing
The vertical space between lines in a paragraph.



Italic
Type where characters are slanted to the right. Typically used for emphasis or for 
distinguishing titles of books.



Justification
A text alignment which lines text evenly along both the left and right margins.



Kerning
Horizontal space reduction between specific letter pairs. Certain letter pairs should be 
placed more closely together to eliminate excessive white space that appears even in fonts 
which are proportionally spaced. For instance, an upper case V that follows an upper case A 
should be moved closer to the A.
You can manually change spacing between letters by selecting those letters using the Text 
tool and then using the Text menu's Set Font Attributes option
The space between all letters in a paragraph will be automatically adjusted if you select 
Automatic Pair Kerning: On in the Paragraph Typography option of the Paragraph menu.
Shortcuts:

Ctrl+Alt+I Increases kerning space of selected text
Ctrl+Alt+K Decreases kerning space of selected text



Knockout
When printing a color publication, a knockout occurs when the background color is not 
printed and the text or object over the background is printed in place of the background 
color. The opposite of knockout is overprint.



Landscape
A page printed so that as you read it, the width of the page is greater than its height.



Layout
The arrangement of text, pictures, and other elements on the pages of a document.



Leaders
Characters placed in the blank space between items in a list. For example, the periods in the
following:
Table Head 1 . . . . . . Head 2 . . . . Head 3

Item 1 . . . . . . Item 2 . . . . Item 3



Leading
The distance in points between the baseline of one line of type to the ascender of the next. 
In Corel VENTURA, leading is adjusted using the Inter-Line spacing setting which is found in 
the Paragraph Settings dialog box. Pronounced "ledding."



Letter Spacing
The process whereby the visual impact of loose lines (lines with too much space between 
words) is reduced by adding space between letters.



Library
A type of collection in which individual graphics files are stored in a compressed format.



Limitcheck error
A PostScript printing error that occurs when a document contains too many line segments 
for the printer to reproduce. Corel VENTURA provides a Flatness control in the Print Options 
dialog box that helps to overcome this problem.



Line Art
A picture that is produced on a computer and stored as mathematically defined objects. In 
traditional typesetting, line art refers to illustrations containing only black or white, with no 
shades of gray.



Line Break
When text reaches the right margin Corel VENTURA "breaks" the line and continues the text 
on the next line. To enter a manual line break, use the Text tool to move the text cursor 
where you wish the line to end and then press Ctrl+Enter



Line Length
The length of a line of type. Usually expressed in picas and points.



Linked object
An object that is linked to a Corel VENTURA chapter such that the source application (the 
"server") maintains control over the object. For example, any changes you make with a paint
program to a linked graphic will also be applied to the graphic within Corel VENTURA.
Also, you can double-click on a linked object while in Corel VENTURA to immediately run the 
server application and edit the object. See also Embedded Object



List Box

List boxes appear in dialog boxes and display a choice of options. If the list cannot 
accommodate all available options, scroll bars are provided. See also Drop-down list box



LPI
Lines per inch. The screen frequency used for photos and tints is described in lpi. 



Loose lines
A loose line of text contains too much space between words because the first word of the 
next line could not be hyphenated during the justification process. You can manually 
hyphenate this word by inserting a discretionary hyphen. Unlike a normal hyphen, a 
discretionary hyphen only appears if the word is at the end of a line.



Marquee Box
The dashed box created by dragging around nodes on a text wrap path with the Node Edit 
tool.



Maximum Space Width
The largest space between words that Corel VENTURA will allow in a justified line of text. 
This maximum is specified in the Paragraph Settings, Typography dialog box. If more space 
than this maximum is required, the line is flagged as a loose line. If Letter Spacing is turned 
on in the Paragraph Typography option, additional space is added between letters, and the 
space between words is not allowed to exceed the maximum.



Measurement Controls
Numerical settings in dialog boxes. You may choose from inches, centimeters, picas & 
points, and points. To change a unit of measure, click the unit button one or more times until
the desired unit displays.



Mechanical
A finished "camera-ready" layout.



Menu Bar
The line below the title bar at the top of the Corel VENTURA window showing the names of 
the main menus.



Minimum Space Width
The smallest space between words that Corel VENTURA will allow in a justified line of text. 
This minimum is specified in the Paragraph Settings, Typography dialog box. If less space 
than this minimum is required, the last word on this line is moved to the next line.



Moiré pattern
Undesirable wave patterns in an image printed from color separations with incorrect halftone
screen angles.



Monospacing
Type that has an equal amount of horizontal space allotted for each character, regardless of 
its width (an i is given as much space as a w). Typewriters use monospaced type. Laser 
printers and typesetters adjust the space proportionally to the character width (an i is given 
less space than a w), resulting in a more readable appearance. See also Proportional Spacing



Mouse Cursor
The screen cursor that moves when you move the mouse. Its shape depends on the function
selected and the action being performed.



Negative
An image in which the values in the original are reversed so that black areas appear white, 
white appears black and colors are represented by their complements. Corel VENTURA can 
print color separations as negatives if Film Negative is selected in the Print Options dialog 
box.



Non-Breaking Space
A special space used to keep words from being separated at the end of a line.
To create a non-breaking space press Ctrl+Shift+space.



Normal Space Width
The space between words in an unjustified line of text.



Object
A frame or graphic created using the drawing tools.



OLE (Object Linking and Embedding)
A function that allows Windows applications to share common data by establishing a link 
between the applications. See also Embedded object and Linked object



Orphan
A single line of text from a previous paragraph at the top the next column or page. See also 
Widow



Outdent
A typographical effect where text is placed to the left of the paragraph margin. The first line 
of a paragraph or a specified number of lines can be outdented.



Overprint
Printing over an area that has already been printed. Overprinting is used in Corel VENTURA 
to create traps in color separated documents. You can also use it to overprint selected Spot 
colors for certain visual effects. See also Trap



Override
Format changes applied using the Freeform Text tool which affect only the paragraph that 
has been selected or in which the cursor is placed. These format changes overrule the 
settings for the paragraph tag. When the Show/Hide returns button is enabled on the Ribbon
Bar, a small diamond symbol appears at the start of the paragraph when an override has 
been applied.



Page
Each page or Base Page is a frame defined using the Chapter Settings command in the 
Format menu. For long documents, this is the frame in which you place the main text. Corel 
VENTURA creates additional pages until all the text in the file is placed on pages. Additional 
frames can be placed on top of the base page.



Page Number Indicator
The box in the lower right corner of the screen that shows the currently displayed page 
number and indicates whether it is a right or left page.



PANTONE
A standard color matching system in which solid (spot) colors are specified using color 
sample books. You can use this system in Corel VENTURA to specify colors.
PANTONE also has a similar system for specifying process colors. It too, is available in Corel 
VENTURA.



Paragraph
A character, line, or block of text ended by pressing the Enter key. Any time you press the 
Enter key while using the Text tool, you create a new paragraph.



Paste
The act of copying text or a picture from the clipboard to the page.



Pasteboard
The area to the right and below the base page acts as a worktable on which you can set 
your document. You can place elements such as frames containing imported graphics on the
Pasteboard and move them onto the base page when you need them.



Path name
Directions to a directory or file on your system. For example, C:\WINDOWS\CORELDRW\
LOGO.CDR is the path name for the LOGO.CDR file which is stored on drive C in a subdirectory 
of the Windows directory called CORELDRW.



Photographic
The mapping necessary for the reproduction of photographs. Corel VENTURA uses a 
photographic color mapping to compress colors into your printer's gamut of colors. This 
technique preserves the tonal characteristics and relationships of colors in the photographs 
you print. This way, photographs reproduce with enhanced contrast and color variation. See 
also Colorimetric and Gamut Mapping



Pica
A typographic unit of measurement equal to 1/6 inch. Twelve points equal one pica.



Picture
Any illustration placed in a frame. A picture can be either an Image or Line Art.



Point
Typographic unit of measurement equal to 1/72 inch. Available point sizes in Corel VENTURA 
5.0 range from 1 to 254.

10 pts      18 pts      36 pts



Pop-Up Help
Shows the names of tools and Ribbon Bar buttons in a yellow callout or balloon.
To display Pop-Up Help, rest the mouse pointer over any button on the Toolbox, Ribbon Bar 
or Text Ribbon Bar. The item's name appears. Pop-up Help is enabled by default; you can 
disable it using the Preferences command in the Tools menu.



Portrait
A page printed so that, as you read it, the width of the page is less than its height.



PostScript
A proprietary page description language used to instruct an output device how to place text 
and graphics on a page. PostScript was first designed for laser printers. Now a document file 
formatted with PostScript can also be printed by professional typesetting machines.



Printable Page

The area in the document window that prints. Also called the "Page border," the Printable 
page corresponds to the paper size not the printer's "image area" which includes margins. 
The width of the margins varies depending on the printer.



Printers' references
The series of buttons, described below, under the Preview area of the Print Options dialog 
box.

Information button: Prints the filename of the publication, the current date and 
time, Tile and Plate number outside the top and bottom margins of the printable page. Also 
includes the color profile, color name, the screen frequency and screen angle when you print
color separations at the bottom of the printable page.

If the size of the printable page (as set in the Page Setup dialog box) exceeds the size
of the paper you are printing on, file info will not appear. Use the File info within page option 
if your Printable Page is the same size as your page setup.

For larger page sizes, use the Page Setup command in the Layout menu to define a 
custom page size smaller than the printer paper. You may have to resize your publication to 
fit on the new page size.

Crop marks button: Prints crop marks applied to the current page. 

Registration marks button: Prints registration marks of a color-separated 
publication on each page so the printer can line up the colors properly.

Calibration bar button: Prints a calibration bar of the six basic colors (RGB and 
CMYK).

Densitometer scale button: Prints a densitometer scale on each page of a color-
separated publication.

Negative button: Creates a reverse image of the publication that images directly 
on film. Check with your service bureau--many bureaus prefer to set negative images on 
their imagesetter.

Emulsion button: Choose when printing to film to print the publication emulsion 
side down. Check with your printer as to whether they prefer the emulsion side up or down.



Process color
The primary colors used in four-color process printing: Cyan, Magenta, Yellow and Black. See 
also Four-color process



Proof
To print a trial version of a graphic to see how it will look when output in its final form. Laser 
printers are commonly used to proof monochrome artwork while color artwork is often 
proofed on thermal color printers. High-quality proofing systems such as Chromalin (Du 
Pont) or Matchprint (3M) can be used to proof color separations.



Proportional Spacing
Type that has the space given to individual letters allotted proportionally to the character 
width (an i is given less space than a w), resulting in less space between characters and a 
more readable appearance. See also Monospacing



Publication
The name Corel VENTURA gives to its documents. A publication links chapters and enables 
Ventura to manage documents consisting of many files from word processing and graphics 
applications as individual units. Every publication includes at least one chapter (.CHP), text 
(.TXT) and style sheets file (.STY); chapters may also include graphics 
(.CDR, .BMP, .EPS, .GIF, etc.),and caption (.CAP) files. 
The publication file structure also makes it easy to edit text or graphics files in their original 
applications after loading and editing them into Corel VENTURA.
Note: Because of the way Corel VENTURA associates files in publications, you must use the 
Publication Manager, found on Corel VENTURA's File menu, to reorganize or copy chapters or
publications. Using DOS and Windows File Manager copying operations will not maintain 
Corel VENTURA file links.



Pure color
Any color that individual pixels on a computer screen can assume. On a monochrome 
screen, there are only two pure colors, black and white. Color screens typically display 16 or 
256 pure colors. Newer video cards will display 32 or 64 thousand colors, and 24-bit cards 
display 16.7 million colors. See also Dithered color



Radio Button
An option button that is enabled by clicking on it. A dot appears to show that it's enabled.



Ragged-Right Text
Text that is left-justified but has an unjustified right margin. Generally thought to be more 
readable than justified text for lines longer than 4 inches.



Reflect
Reflect means to place a mirrored image of selected options or settings on alternate pages. 
For example, a Repeating Frame placed flush with the left margin of a left page can be 
placed flush with the right margin of a right page using the For All Pages Left & Right option.



Registration mark
Crosshairs or other marks on paper or film used for aligning color separations. Corel 
VENTURA automatically adds registration marks when printing color separations to a 
PostScript printer. Registration marks can be printed on non-PostScript printers.



Repeating Frame
A frame which, with its contents, background, and ruling lines, is duplicated on every page.



Resolution
In printing, a term referring to the number of dots per inch (dpi) the printer is capable of 
printing. Typical laser printers have resolutions of 300 dpi, while image setters have 
resolutions of approximately 1200 or 2400 dpi. The more dots per inch, the smoother the 
output and the greater the number of grayscales the device can describe.



RGB
The initial letters in Red, Green and Blue, the component colors in one of three color models 
Corel VENTURA applications provide for creating Process colors.



Ribbon bars
Corel VENTURA's Ribbon bars, located at the top of the document window under the Menu 
bar, contain buttons designed to speed up your work. To open a file, for example, you may 
prefer to click the Open button  rather than open the File 
menu and click Open. Hold the mouse pointer over a button to see its name or right-click for 
Context-sensitive Help. See also Tools



Rulers
Corel VENTURA gives you the option of displaying a vertical and horizontal ruler at the top 
and left edges of the document window. In the Set Ruler dialog box, you can set the 
measurement units for each ruler and define how far from the top-left corner you want the 
rulers to start. To access the dialog box, double-click the ruler with the Pick tool or choose 
Ruler Setup from the Tools menu. 



Ruling Line
Any horizontal or vertical line used to separate text or frames from the surrounding layout. 
Use the Frame Settings dialog box to place ruling lines around frames, and the Paragraph 
Settings dialog box to place lines above, below, or around paragraphs. You can also draw 
ruling lines using the Graphic Line tool. These lines can be attached to frames and will move 
whenever the frame moves.



Run around
Text on a page that flows around a smaller frame. You can also create a text run around that 
follows the outline of an irregular object by using a series of frames.



Sans Serif
A type design such as Helvetica, which does not have small horizontal strokes at the top and
bottom of letters. Often used for headlines and headings. See also Serif



Saturation
In the HSB color model, the component that determines the purity or intensity of a color. See
also Hue and Brightness



Scale
Increase or decrease the size of an image.



Scanner
An input device that converts text and/or graphics on paper into a computer-readable file.



Screen angles
When printing color separations, the angles at which each of the four process colors are 
printed to avoid undesirable moiré patterns. See also Halftone screen



Screen frequency
Screen frequency is measured in lines per inch (lpi). Screen frequency affects images such 
as photographs and tints of color. A laser printer might produce an acceptable screen at 60 
lpi. A high resolution image setter may be capable of producing a 150-line screen. Screen 
frequency can be set in the Print Options - Options dialog box. See also Halftone screen



Scroll Arrows
Located at the bottom and right sides of a window. Scroll arrows represent the current 
page's location in the window. Click on either the horizontal or vertical scroll arrow to move 
the page into or out of the viewing area in small increments.



Scroll Boxes
Located at the bottom and right sides of a window. The scroll box on the right represents the
current page's location in the entire file. Click on and slide the scroll box to move a large 
distance in the file. The bottom scroll box represents the current page's horizontal location in
the window. Click on and slide it to move horizontally.



Serif
A type design such as Times Roman, which has small horizontal strokes at the top and 
bottom of letters. Often used for body text, Serif is considered more readable than sans serif
type. See also Sans Serif



Service bureau
A commercial business that prints customer-provided documents or artwork, usually on high-
resolution PostScript devices.



Source file
The file that contains information being embedded or linked. See also Embedded object and 
Linked object



Speed keys
Also known as accelerator keys, speed keys execute menu commands when pressed in 
combination. Some people prefer to use speed keys rather than reach away from the 
keyboard for the mouse and click two or more menu items or a tool button



Spot color
In offset printing, solid colors commonly specified using the PANTONE color matching 
system. Spot color is used whenever exact colors are required. 



Spreads
A type of trap created by extending the foreground object into the background object. See 
also Chokes



Status Line
Located in the bottom left hand corner of the Corel VENTURA screen, the status line displays 
a description of the selected tool/button or highlighted menu command.



Style sheet
A style sheet is a Corel VENTURA file that controls the typographic format of your 
documents. It is stored separately from the text in your documents. When you design a style
sheet, you give each set of typographic attributes a name. Each name is called a Tag. You 
assign attributes from the style sheet to each paragraph in the document by first selecting a
paragraph and then selecting the appropriate tag from the Tag List.



Subscript
A character that prints partly below the baseline.



Superscript
A character that prints partly above the x-height.



Swiped Text
Text selected with the mouse. To swipe text, you must hold the mouse button and drag the 
mouse over the text you want to select. As you drag over the text, it becomes highlighted. 
You can apply formatting attributes and editing changes to selected text using either Text 
tool without affecting the current tag.



Tabs and Returns

A tab stop is a location identified on the horizontal ruler where the insertion point or cursor 
automatically goes to when the tab key is pressed. Many user-definable tab stops can be set 
to help to ensure proper alignment when typing text. Tabs are included in paragraph tags.
Returns, also called paragraph returns or end of paragraph marks, are inserted by pressing 
the Return or Enter key on your keyboard. They end the current paragraph. 

The  button in the Text Ribbon Bar switches the display of 
tab stop symbols 

 and paragraph returns 



Tag
Tag is the name you give to each set of formatting attributes applied to a particular 
paragraph. For example, you might have a tag called "Heading" which centers text on the 
page and gives it a large, bold type style. Each paragraph that has the same tag will also 
have the same appearance. A collection of tags, along with the page layout settings, makes 
up a style sheet. The Tag List in the ribbon and the Tags Roll-Up window shows all tags 
available in the currently loaded style sheet.



Tags List
The list in the Ribbon Bar of all tags available to be assigned to paragraphs in the chapter. 
The current tag name is shown if a paragraph is selected. Click on the scroll button and box 
to the right to display and scroll through the list. You can also assign tags to paragraphs 
using the Tags Roll-Up which is opened by choosing the corresponding command in the Tools
menu.



Template
Corel VENTURA creates a template from the chapter settings, chapter files, graphic and text 
files of an existing publication. When you create a new publication and specify Base on 
Template in the New Publication dialog box, the Base on Template dialog box opens, allowing
you to select chapter, graphic and text files. The new publication is modeled on the selected 
files from the previous publication.



Text Cursor
The vertical line cursor that indicates the current location in the text. The text cursor is 
always placed between characters, and is active only when the Text Tool is selected.



Thin Space
A thin space is the width of a period. To create a thin space, press: Ctrl+Shift+T



Thumbnails
Small visual representations of graphic files created and saved with original drawing files. 
Thumbnails are used within Corel MOSAIC as a way of organizing, displaying, and selecting 
graphics files visually rather than by filename. 



Tiling
If you want to print 11 x 17 inch or broad sheet size pages, but your printer can only print 8 
1/2 x 11, you can use tiling to print smaller pages that can be pasted together to create the 
larger page.



Title Bar    
The top line of the Corel VENTURA window, the Title Bar displays the program and 
publication or document name. Roll-up windows, the floating toolbox and some dialog boxes 
also have Title Bars, which display their names.
The Title Bar offers the following buttons for controlling the size of the document window:

 Maximize button
 Minimize button
 Restore button
 Control Menu box



Toolbox, Floating Toolbox

The collection of icons on the left side of the Corel VENTURA screen used to perform tasks 
from selecting objects to choosing outline and fill attributes. Toolbox options can be toggled 
from the Preferences dialog box, available from the Tools menu. The Toolbox flyout menu has
the following options:
Visible The visible command displays the toolbox.
Floating The Floating command makes the toolbox freely moveable.This checkbox is 

only available if Visible has been enabled.
Control Menu
The Toolbox Control menu contains the following options for controlling the toolbox layout.
Floating Toggle the Toolbox between floating and anchored modes.
Grouped Choosing this option groups the tools. When deselected, all tools, including 

flyouts, are displayed in a large rectangular shape. 
Close Hides the toolbox. To display it, choose Toolbox, Visible from the View menu.
See also Tools



Tracking
The adjustment of letter-spacing throughout a paragraph.



Trap
Also referred to as chokes or spreads. The process of adding a slight overlap between 
adjacent areas of color to avoid gaps caused by registration errors. You can create trap in 
Corel VENTURA if you are printing color separations.



TRUMATCH
A color matching system for specifying process colors. You can use this system in Corel 
VENTURA to specify colors.



Typeface
A type design, e.g., Bookman, Palatino, Avant Garde, Zapf Chancery (usually proprietary and
copyrighted). Typeface is the main attribute that defines a font. The others are size, weight 
and color. Available point sizes in Corel VENTURA 5.0 range from 1 to 254.



Typeset
A document that has been produced on a professional typesetting machine. Corel VENTURA 
allows your computer and laser printer to produce near-typeset-quality documents.



Undercolor removal (UCR)
In color printing, a technique for reducing the amount of cyan, magenta and yellow ink in 
shadows and neutral areas of an image and replacing them with an appropriate amount of 
black. Another technique called Gray Component Replacement (GCR), also substitutes 
amounts of CMY ink with black but over a greater color range.



Uniform color
A solid color, black, white or shade of gray used to outline or fill objects. You can select 
uniform colors from the Outline and Fill tool menus, uniform outline colors from the Outline 
Roll-Up, uniform fill colors from the Fill Roll-Up, or from the Outline Color and Uniform Fill 
dialog boxes.



Variable marker
A placeholder for text or numbers used in cross-references that changes according to the 
variable's current definition. When you update the document, Corel VENTURA inserts the 
variable's updated information at all specified locations in the document.



Vector graphics
Also referred to as object-based graphics. Graphics in which shapes are represented as a 
series of lines or bezier curves and fills. These contrast with bitmap or raster graphics which 
are created pixel by pixel in paint programs such as Corel PHOTO-PAINT, and by scanners.



Verbose save
You can use the Verbose Save option in the Preferences, General dialog box to save the 
publication, chapter and the style sheet(s) with separate names. When you save, the Save 
Publication As dialog box, Save Chapter As dialog box and the Save Stylesheet As dialog box 
open consecutively allowing you to enter names for each.



Vertical Justification
The process that forces text to reach the exact bottom of each column or page by adding 
vertical space between paragraphs and lines of text plus above and below free frames and 
tables.



Weight
The relative thickness of the strokes of a character in a typeface. For example, a pale 
typeface has a light weight and a bold typeface has a heavy weight. In addition, some 
typeface designs use heavy left-leaning strokes, and light right-leaning strokes to add 
readability or creativity to the designs.



White Space
Areas of a page that contain no text or graphics. Used to aid in design clarity and text 
readability.



Widow
A line of text left at the bottom of a column or page. To prevent widows and orphans, choose
a minimum setting of two in the Chapter Settings, Typography dialog box. 



Width Table
A file used in previous versions of Ventura, which contains information about the height and 
width of each character--in each size and weight--for every typeface you might want to use 
in a document. Corel VENTURA no longer uses width tables, so you'll only see them in 
documents created in earlier versions. Once such documents are saved in version 5, the 
width table becomes superfluous and thus information about it is no longer displayed.



WYSIWYG
What You See Is What You Get (printed.) Refers to Corel VENTURA's ability to display on the
computer screen a close representation of what will be printed, including the typeface, size, 
attributes, rules, layout, etc.



X-Height
The size of the lower case "x" in a particular font. The larger the x-height, the shorter the 
ascenders and descenders.



Zero Box
The box where Corel VENTURA's horizontal and vertical rulers meet, so named because the 
default value is 0,0. You can click on this box and drag the ruler cross-hairs onto the screen 
to change the vertical and/or horizontal location of the zero point.





Working with other applications

Exporting selected text files
Importing graphics in other formats
Embedding new objects from within Corel VENTURA
Pasting an embedded object from the server application
Embedding existing files in your publication
Editing an embedded object
Creating a link from Corel VENTURA
Linking an object from the server application
Editing a linked object from Corel VENTURA
Editing linked information in the source file
Updating links manually
Updating links automatically
Jumping from a destination file to its source file
Changing a link
Breaking a link
Restoring linked or embedded objects to their original size
Cutting and copying objects using the Clipboard
Displaying the contents of the Clipboard
Querying databases



Working with other applications--Overview
Importing and Exporting

Corel VENTURA includes a wide variety of file format filters which allow you to exchange 
graphics and text between Corel VENTURA and other applications.
Importing gives you access to graphics created in other illustration programs and 
presentation packages as well as clipart and scanned images. Once a graphic has been 
imported, you can modify it using Corel VENTURA's tools and features. A single chapter can 
consist of any number of imported graphics in any of the supported formats. You can even 
import objects from other Corel VENTURA files.
Exporting saves Corel VENTURA text files in formats used by programs.
Linking

Linking lets you include information from a file created in another application. The linked 
object is referenced to, not actually stored with your Corel VENTURA file. The two files are 
linked together by copying an object from the source file (for example, a Corel PHOTO-PAINT 
image) and pasting the object into a destination file (for example, a Corel VENTURA 
chapter), Corel VENTURA will update the destination file any time the information changes in
the source file. The key to linking is that you make changes to the linked file in the original 
application. So if you wanted to modify the linked photo you would edit it with Corel PHOTO-
PAINT.
You can specify when updates occur, or update the information automatically whenever the 
source file changes.
Embedding

Embedded objects become part of the Corel VENTURA file. Embedding is used instead of 
linking when you want to make changes to the embedded information from within Corel 
VENTURA. Suppose you embedded a graph from CorelCHART and decide you want to change
it. To do this, double-click on the graph. Corel VENTURA opens CorelCHART where you make 
the changes you want. When you return to Corel VENTURA, the chart is updated with the 
changes you made.
Charts, graphics and spreadsheet data are examples of information you can embed. Only 
Windows applications that support object embedding can supply embedded information.
Using the Clipboard

The Clipboard is a temporary storage area used to transfer text and other information 
between Windows applications. In Corel VENTURA, the Clipboard is a convenient way to 
move objects from one publication to another.
You transfer information to the Clipboard using the Cut, Copy and Paste commands in the 
Edit menu.
The information you place on the Clipboard remains on the Clipboard until you exit Windows 
or replace it with other information.
Information placed on the clipboard by other applications can be linked or embedded into 
your Corel VENTURA file.

See also:
OLE Objects--Limitations on transformations and effects
Importing objects into Corel VENTURA 5.0





Tip
To use your Corel VENTURA graphic in an application that supports "Object Linking", consider
linking the graphic to that application instead of exporting it. This way, if you change the 
graphic, Corel VENTURA will automatically update the graphic in the other application. For 
more information, see Exchanging Information with Other Applications.



Exporting selected text files
You can export text from a publication that you want to use in another application. Exporting
is only necessary when the other application is unable to read the text file in its present 
format. 

To export selected objects only:

1. Open the Corel VENTURA file which contains the text you want to export.
2. Choose the text file you want to rename.
3. Choose Rename File from the File menu.
4. Choose the file format and name for the file . Corel VENTURA adds the extension that 

corresponds to the export format you chose.
5. To save the file in a different drive or directory, select the drive from the Drives box 

and the directory from the Directories box.
6. Click OK. Depending on the format selected, another dialog box may appear. Choose 

any option, then click OK.



Importing graphics in other formats
To import graphics in other formats:

1. Choose Load Graphic from the File menu.
2. From the List Files of Type box, choose an import format .

The File Name box shows files in the current directory with the chosen format's 
extension. If the file you want is another drive or directory, select the drive from the 
Drives box and the directory from the Directories box.

3. In the File Name box, type the name of the file you want to import.
4. Click OK.



Embedding new objects from within Corel VENTURA
Embedding lets you include new information in your publication from other Windows 
applications. Charts, graphics and spreadsheet data are examples of the types of objects 
you can embed. You can edit an embedded object by double-clicking the object in Corel 
VENTURA. This launches the server application and allows you to edit the information. When 
you exit and return to Corel VENTURA the changes will be reflected in your publication.
You can insert an embedded object either by opening the source file from Corel VENTURA. 
You can also embed objects by dragging them directly from the server application or the 
Windows File Manager.    
To embed an new object in your publication starting from Corel VENTURA:

1. Choose Insert Object from the Edit menu.

2. Choose Create New.
3. In the Object Type box, choose the application you will use to create the object.

The list includes items from applications on your system that support object linking 
and embedding. You need to install these applications using their Setup programs for 
them to appear on the list.

4. Click OK to open the source application.
5. Create the object or select the information you want to embed in your Corel VENTURA 

file.
6. Once the information is created/selected, do one of the following:

· From the source application's File menu, choose Update, Exit or Exit and Return.
· In some applications, a dialog box appears prompting you to update. Choose Yes or 

OK.
7. The Corel VENTURA screen appears and the embedded object appears in the center of 

your page. Select the object and move it to any position.



Embedding existing files in your publication
To embed an existing file in your publication:

1. Choose Insert Object from the File menu.

2. Select Create from File.
3. Type the name, including the path and extension, of the file you want to embed. If you 

don't know the name of the file or its location, click the Browse button to display the 
Browse dialog box.

4. Click OK.
The embedded object appears in the center of your publication. Select the object and 
move it to wherever you want.



Pasting an embedded object from the server application
You can embed objects created in an OLE server application in your Corel VENTURA 
publication by copying them to the Clipboard in the server application and using the Paste 
Special command in Corel VENTURA's Edit menu.

To paste an embedded object from the source application:

1. Open the application in which you want to create the object to embed in Corel 
VENTURA.

2. Create or choose the desired information and copy it to the Clipboard.
3. Open Corel VENTURA.
4. Choose Paste Special from the Edit menu.
5. From the As box choose the format in which you want to embed the object.
6. Click OK.



Pasting an embedded object from the server application
You can embed objects created in an OLE server application in your Corel VENTURA 
publication by copying them to the Clipboard in the server application and using the Past 
Special command in Corel VENTURA's Edit menu.

To paste an embedded object from the source application:

1. Open the application in which you want to create the object to embed in Corel 
VENTURA.

2. Create or choose the desired information and copy it to the Clipboard.
3. Open Corel VENTURA.
4. Choose Paste Special from the Edit menu.
5. From the As box choose the format in which you want to embed the object.
6. Click OK.



Editing an embedded object
You can edit an embedded object by opening the application that created it from within Corel
VENTURA.

To edit an embedded object:

1. Do one of the following:
· Double-click the embedded object to open the server application.
· Select the embedded object then choose Edit "name of the object" from the Edit 

menu.
The server application in which the object was created opens.

2. Make the changes you want.
3. From the server application's File menu, choose Update, Exit or Exit and Return.

In some applications, a dialog box appears prompting you to update. Choose Yes or OK.

See also:
Editing CorelDRAW 3 and 4 OLE objects in Corel VENTURA 5 documents



Editing an embedded object
You can edit an embedded object by opening the application that created it from within Corel
VENTURA.

To edit an embedded object:

1. Do one of the following:
· Double-click the embedded object to open the server application.
· Select the embedded object then choose Edit "name of the object" from the Edit 

menu.
The server application in which the object was created opens.

2. Make the changes you want.
3. From the server application's File menu, choose Update, Exit or Exit and Return.

In some applications, a dialog box appears prompting you to update. Choose Yes or OK.

See also:
Editing CorelDRAW 3 and 4 OLE objects in Corel VENTURA 5 documents



Creating a link from Corel VENTURA
You can add information to your publication created in another application and then link the 
two files. Any changes you make to the information in the source file is reflected in your 
publication through this link.
Save the source file before starting this procedure.
To link an object from Corel VENTURA:

1. Choose Insert Object from the File menu.

2. Choose Create from File.
3. Check the Link box.
4. Type the name, including the path and extension, of the file you want to link. If you 

don't know the name of the file or its location, click the Browse button to display the 
Browse dialog box.

5. Click OK.
The linked object appears in the center of your publication. You may now move or resize 

the object.



Linking an object from the source application
You can add information to your publication from another file and then link the two files. Any 
changes you make to the information in the source file is reflected in your publication 
through this link.
You can insert a linked object by opening the source file from Corel VENTURA.
To link an object from the source application:

1. Start the application used to create the information you want to add to your Corel 
VENTURA file.

2. Open the file with the information you want to add to your Corel VENTURA file.
3. Select the required information.
4. Choose Copy from the application's Edit menu.
5. Open Corel VENTURA and choose Paste Special from the Edit menu.
6. From the Data Type box, select the type of information you want to add to your Corel 

VENTURA file. 
7. Choose the Paste Link button.
Corel VENTURA positions the linked object in the center of your page. Select the object 

and move it to any position.



Updating a link automatically
Updating links automatically between Corel VENTURA document files and the source files 
ensures that the destination file is updated whenever a change is made to the source file 
without any action on your part.
To specify automatic or manual link updating:

1. Select the linked information in the destination file you want to update.
2. Choose Links from the Edit menu. The Links dialog box appears.
3. Choose automatic.
4. Click OK. 

The link will now update the destination file whenever a change is made to the source 
file.



Updating links manually
Updating links between Corel VENTURA document files and the source files ensures that the 
destination file includes and displays the last changes made to the source file and that both 
are identical. You can choose to have the link updated manually or automatically.
To update a link manually:

Use this procedure to update the destination file located in the Corel VENTURA document.
1. Select the linked information in the destination file you want to update.

If you have more than one link in the file that you want updated, hold down the SHIFT 
key as you select the linked information.

2. Choose Links from the Edit menu. The Links dialog box appears.
Select any other links in the Links box you want updated.

3. Choose the Update Now button.
Corel VENTURA reflects any changes made in the source file since the last update in the 

destination file for each selected link.



Editing linked information in the source file
You can edit a source file created in Corel VENTURA at any time. The changes you make are 
reflected in the destination file (i.e. Corel VENTURA document) if you have set the link to be 
updated automatically.    If you have set it to manual update, you should use the Updating a 
link manually procedure after changing the linked information in the source file. 

To edit linked information in the source file:

1. Open the source file.
2. Make the changes you want to the linked information.
3. Choose Save from the File menu.



Editing a linked object from Corel VENTURA
There are three procedures that you can use to edit a linked object inserted in a Corel 
VENTURA publication.    The following procedure uses the Object command in the Edit menu. 
See Jumping from a destination file to its source file for the other two methods.

To edit a linked object from Corel VENTURA:

1. Select the linked object or file in the Corel VENTURA document.
2. From the Edit menu, choose the Linked [Application Name] Object command.    
3. From the flyout menu, choose Edit. The OLE server application in which the linked 

object or file was created appears with the file loaded.
4. Make the changes required to the source file.
5. Choose Save from the File menu.
6 If you want, you can close the file and exit the source application.

The destination file displayed in your Corel VENTURA document will show the changes 
made to the source file if the link has been set to automatic.    If the changes do not 
appear, choose Links from the Edit menu and click Update Now to update the 
destination file.



Jumping from a destination file to its source file
To change the contents of linked information in a destination file,, modify the source file. If 
you make the changes in the destination file, Corel VENTURA will ignore them when it 
updates the link.    See also Editing CorelDRAW 3 and 4 OLE objects in Corel VENTURA 5 
documents.
To jump from a destination file to its source file:

1. Double-click the linked object. The OLE server application opens.
2. Make the changes in the source file.
3. Choose Save from the File menu.
4. If you want, you can close the file and exit the source application.

Or

To jump from a destination file to its source file:

1. Select the linked information you want to edit in the destination file.
2. Choose Links from the Edit menu.
3. Choose the Open Source button.
4. Make the changes in the source file.
5. Choose Save from the File menu.
6. If you want, you can close the file and exit the source application.
If you don't need further updates from the source file, you can break the link. See also 

Breaking a link



Changing a link
You can change the source file name and type for any link in your Corel VENTURA file.

To change a link:

1. Select the linked information in your Corel VENTURA file.
2. Choose Links from the Edit menu.
3. Choose the Change Link button.
4. Type a new name for the source file in the Source box.
5. Click OK.



Breaking a link
If you break a link, Corel VENTURA no longer updates the information in the destination file. 
The information becomes embedded. You can still edit the object in the OLE server 
application by double-clicking it in your Corel VENTURA document but the changes are made
independently from the original source file.

To break a link:

1. Select the linked information.
2. Choose Links from the Edit menu.
3. Choose the Break Link button.



Restoring linked or embedded objects to their original size
You can quickly restore a linked or embedded object to the size it was in the originating 
application. You might use the following procedure after editing an equation to have it 
display at the proper size.
To restore linked or embedded objects to their original size:

1. Click the frame containing the linked or embedded object with the right mouse button.
2. Choose Size Frame to OLE Object.



Cutting and copying objects using the Clipboard
To place a copy of an object on the Clipboard:

1. Select the object you want to copy. 
2. Choose Copy from the Edit menu.
3. Open the Corel VENTURA file or other application into which you want the object 

copied.
4. Choose Paste from the Edit menu.

If the application supplying the object is an OLE server, this procedure will embed the object.
If you don't want the object embedded, you must use the Paste Special command and select
a format other than the first one listed in the Paste Special dialog box.

To cut an object from a publication and place it on the Clipboard:

1. Select the object you want to cut.
2. Choose Cut from the Edit menu.
3. Open the Corel VENTURA file or other application into which you want the object 

placed.
4. Choose Paste from the Edit menu.

Shortcut:
Pressing CTRL+C copies selected object to the Clipboard.
Pressing CTRL+V pastes the object on the Clipboard. 



Displaying the contents of the Clipboard
To display the Clipboard:

1. Open the Windows Program Manager.
2. In the Main program group, double-click on the Clipboard Viewer icon

To close the Clipboard:

· Press ALT+F4.



OLE objects--limitations on transformations and effects
Linked or embedded objects inserted with the Paste Special or Insert Object commands in 
the Edit menu can be resized, moved, cut or copied.

Limitations:

· OLE objects cannot be rotated. You can rotate a OLE object if you have another non-OLE 
object selected at the same time. This may produce unexpected results and is not 
recommended.

· Irregular text wrap cannot be performed around an OLE object.
· OLE objects cannot be pasted in a frame which has been rotated.
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object selected at the same time. This may produce unexpected results and is not 
recommended.

· Irregular text wrap cannot be performed around an OLE object.
· OLE objects cannot be pasted in a frame which has been rotated.



Importing objects into Corel VENTURA 5.0
These tables explains the creation of articles in Corel VENTURA 5.0 through File Import, 
Clipboard and launching other applications and through drag and drop.

Through file import, clipboard and launching other 
applications:

Source Frame Selected Frame not Selected
Pasting from clipboard Inserts the object in the middle

of selected frame, but 
maintains the aspect ratio of 
the object.

Creates a new frame the size of the 
object at the top left of the window.

Inserting a new OLE 
object

Same as above Same as above

Importing a single 
graphic file

Same as above, but adds the 
file name to the list.

Same as above, but adds the file 
name to the list.

Importing a text file Loads the file in the frame and 
adds the file to the list.

Only adds the file to the list.

Importing multiple text or
graphic files

Only adds the file names to the
file list.

Only adds the file names to the file 
list.

Through drag and drop:

Source Inside Base Frame (Page) Inside a Frame
OLE drag and drop Creates a new frame the size 

of the object with the top left 
corner of the frame being the 
point where the object is 
dropped.

Places the object in the middle of 
the frame under the cursor while 
maintaining the aspect ratio of the 
object. After dropping the object, the
frame is selected.

Mosaic single file dropped Same as above, but adds the 
file name to the list.

Same as above, but adds the file 
name to the list.

Mosaic multiple files 
dropped

Adds the valid (filtered) files to 
the list. No frame is created.

Adds the valid (filtered) files to the 
list. Nothing is put in the frame.



Work with frames
Drawing free frames
Selecting free frames
Moving and resizing frames
Rotating frames
Repeating frames
Applying ruling lines to frames
Using frame tags
Using anchors and captions



Using frame tags
Applying frame tags
Adding frame tags
Deleting frame tags
Renaming frame tags
Merging frame tags



Use anchors and captions
Anchoring frames
Re-anchoring frames
Attaching a caption to the free frame
Removing a caption
Creating long captions



 
Drawing free frames
You can draw free frame for text and graphic files with the Frame tool.
To draw a frame:

1. Click the Frame tool from the Toolbox.
2. Point where you want the frame to be.
3. Hold down the mouse button and drag diagonally.
4. When the frame is the size and shape you want, release the mouse button.

Note: Text containing tabs may not completely flow around frames.



Selecting free frames
When you draw a free frame Corel VENTURA selects it so that you can begin working with it 
right away. To work with an existing free frame, however, you must first select it with the 
Pick tool. A selected frame displays on-screen with handles used for resizing. Once a frame 
is selected, you can format it, resize it, cut or copy it, move it and change its fill and borders.
To select a free frame:

1. Click the Pick tool.
2. Place the mouse pointer over the frame and click.

Handles appear around the frame. To select several objects, hold the Shift key down 
while clicking on each object.

To select several free frames:
· Hold the Shift key down while clicking on each frame.

To select all free frames on the current page:
· Click one of the frames with the right mouse button and choose Select All from the 

pop-up menu that appears.



Moving and resizing frames
To move a frame:

1. Choose the Pick tool.
2. Click anywhere in the free frame to select it.
3. Drag the selected frame to the desired location on the page.

To move a frame to a specific location:
1. Choose the Pick tool.
2. Click anywhere in the frame to select it.
3. Choose Format, Frame.
4. In the Frame Settings dialog box, click the General tab.
5. Under Frame Origin, enter the measurements to specify where the top left-hand corner 

of the frame should be in relation to the top left corner of the base page.
To resize a frame:

1. Choose the Pick tool
2. Click anywhere in the frame to select it.
3. Move the cursor over one of the frame handles. The cursor becomes a resizing arrow.
4. Drag the handle to resize the frame.
Note: To resize both the frame width and height, use the corner handles. Use the side, 

top or bottom handles to stretch the frame.
To resize a frame to precise measurements:

1. Choose the Pick tool.
2. Click anywhere in the frame to select it.
3. Choose Format, Frame.
4. In the Frame Settings dialog box, click the General tab.
5. Under Dimensions, enter the width and the height values for the selected frame.
Note: You can also set the width and height of the selected frame in the Placement Roll-

Up (Tools menu).



Moving and resizing frames
To move a frame:

1. Choose the Pick tool.
2. Click anywhere in the free frame to select it.
3. Click and drag the selected frame to the desired location on the page.

To move a frame to a specific location:
1. Choose the Pick tool.
2. Click anywhere in the frame to select it.
3. Choose Format, Frame.
4. In the Frame Settings dialog box, click the General tab.
5. Under Frame Origin, enter the measurements to specify where the top left-hand corner 

of the frame should be in relation to the top left corner of the base page.
To resize a frame:

1. Choose the Pick tool
2. Click anywhere in the frame to select it.
3. Move the cursor over one of the frame handles. The cursor becomes a resizing arrow.
4. Click and drag the handle to resize the frame.
Note: To resize both the frame width and height, use the corner handles. Use the side, 

top or bottom handles to stretch the frame.
To resize a frame to precise measurements:

1. Choose the Pick tool.
2. Click anywhere in the frame to select it.
3. Choose Format, Frame.
4. In the Frame Settings dialog box, click the General tab.
5. Under Dimensions, enter the width and the height values for the selected frame.
Note: You can also set the width and height of the selected frame in the Placement Roll-

Up (Tools menu).



Anchoring frames
Free frame can be anchored to a particular location in the text so that when you move the 
text, the frame moves along with it.
To anchor a frame:

1. Select the free frame you wish to anchor with the Pick tool.
2. Choose Format, Frames.
3. In the Frame Settings dialog box, click the General tab.
4. In the Frame Anchor box, type the anchor name you wish to assign to the frame. This 

name must exactly match the anchor name you will be inserting in the following steps. 
Choose OK.

5. Select a text tool.
6. Click the text where you want the frame anchored.
7. From the Edit menu, choose Insert Special Item, Frame Anchor. The Insert Frame 

Anchor dialog box appears.
8. In the Name box, select the frame anchor name typed in step 4 from the drop-down 

list.
9. Select an anchor position and choose OK.

Whenever the Re-Anchor Frames command (Format menu) is executed, this frame will be 
moved to the position indicated by the corresponding anchor reference in the text.
Note:    To anchor a frame to a spot on a particular page there must be room on the page for
both the frame and the line of text in which the anchor is inserted. If you make changes to a 
document causing the frame and its anchor not to fit on the same page, that frame will 
move to the end of the chapter when you re-anchor the frames. The easiest way to fix this 
problem is to make the frame in question smaller.



Re-anchoring frames
After editing text, you can reposition free frame on the page or throughout the chapter using
the Re-Anchor Frame command. The frames will be moved to the pages that contain their 
corresponding anchor references in the text. Frames anchored using the At Anchor option 
are updated automatically as the frame anchors move.

1. Choose Format, Re-Anchor Frames.
2. From the dialog box, click This Page to re-anchor frames on the current page only; click

All Pages to re-anchor all frames throughout the current chapter.
3. A dialog box will appear when an unresolved reference is encountered. Select Ignore, 

Rename or Delete to continue re-anchoring.



Re-anchoring frames
After editing text, you can reposition free frame on the page or throughout the chapter using
the Re-Anchor Frame command. The frames will be moved to the pages that contain their 
corresponding anchor references in the text. Frames anchored using the At Anchor option 
are updated automatically as the frame anchors move.

1. Choose Format , Re-Anchor Frames.
2. From the dialog box, click This Page to re-anchor frames on the current page only; click

All Pages to re-anchor all frames throughout the current chapter.
3. A dialog box will appear when an unresolved reference is encountered. Select Ignore, 

Rename or Delete to continue re-anchoring.



Attaching a caption to the free frame
You can attach a caption to any free frame in the chapter. A caption consists of two parts. 
The first part is entered from the Frame Settings dialog box. This part of the caption contains
text automatically generated by Corel VENTURA, including the chapter, table, and figure 
counters. This text is stored in the chapter (*.CHP) file. The second part can contain any text.
The Caption Format option automatically creates and attaches a caption frame. It also 
creates the generated portion of the caption. You create the rest of the caption by resizing 
the caption frame and typing directly into it.
To attach a caption to the selected frame:

1. Select the frame you wish to caption.
2. From the Format, Frame.
3. In the Frame Settings dialog box, click the General tab.
4. In the Caption list box under Caption Format, choose the location where the caption will

appear: above, below, left or right.
5. In the Reference list box, choose the Table #, Figure #, or Chapter # as desired. 

Selecting these options places the following codes on the label line:
This label Creates a caption like this
Figure [F#] Figure 1
Figure [C#] - [F#] Figure 1 - 1
Table [T#] Table 1
Table [C#] - [F#] Table 1 - 1
If you do not require the accompanying text, such as Figure or Table, highlight that 
portion of the text in the Reference box and delete it.
You can also type any text, up to 20 characters, to label the frame.
You can change the font, size and style of the caption text by swiping the text in the 
Reference box and clicking the text attributes button to open the Selected Text 
Attributes dialog box.



Attaching a caption to the free frame
You can attach a caption to any free frame in the chapter. A caption consists of two parts. 
The first part is entered from the Frame Settings dialog box. This part of the caption contains
text automatically generated by Corel VENTURA, including the chapter, table, and figure 
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Removing a caption
1. Select the frame where you wish to remove the caption.
2. From the Format, Frame.
3. In the Frame Settings dialog box, click the General tab.
4. In the Caption box in the Caption Format section, choose None.



Creating long captions
1. Attach a caption to the selected frame.
2. Place the text cursor immediately before the end of file mark (small square) which is 

located to the right of the generated caption.
3. Type additional text directly into the caption frame. Use the mouse to resize the 

caption frame if necessary.



Rotating frames
1. Select the frame you want to rotate.
2. Choose Format, Frame.

The Frame Settings, General dialog box appears.
3. In the Rotation box, enter a value from 0° to 360°.

Text can be rotated in 90° increments independently of its frame.

See also:
Rotating paragraphs



Applying ruling lines to frames
1. Select the frame to which you want to add ruling lines.
2. Choose Format, Ruling Lines. The Ruling Lines dialog box opens.
3. In the Rule Style list box, choose a type of ruling lines to apply to the selected frame. 

The options include: Above, Below, Above & Below, or Around. The tab corresponding 
to the selected rule style becomes available. If you have selected Above & Below, both 
Above and Below are available.
Note: When adding a new ruling line to a frame that has an existing ruling line in 
either the above or below position, choose Above & Below option from the Rule Style 
list. If you do not use this option and choose either Above or Below, the existing ruling 
line is removed. For example, if you have a ruling line above and you want to apply a 
ruling line below, choose Above & Below and add the ruling line below. 

4. Enter the line thickness as well as spacing, if more than one ruling line is used. Rule 1 
will appear on the edge of the frame while Rules 2 and 3 will appear inside the frame.
Note: Ruling Lines can also be accessed by clicking a frame with the right mouse 
button and choosing Ruling Lines or clicking any of the buttons on the Outline tool 
flyout menu.



Applying frame tags
Frame tags allow you to save and apply frame formatting information in the same way that 
paragraph tags work. This ensures consistency among frames of the same type throughout a
chapter or document.
For example, you might want all frames to have the same size, border, and background. In 
addition, you might want consecutively numbered caption. Giving this frame a frame tag 
saves the size, border, background, and label information. The next time you tag a frame 
with that frame tag, the characteristics are automatically set, and the caption is 
automatically generated with the next sequential number.
When you make changes to a tagged frame the changes will affect all frames that share the 
tag. 
To apply a frame tag:

1. Draw a new frame or select an existing frame.
2. In the Text Ribbon Bar, choose a tag from the Tag list.

Note: If you use both frame captions and frame tags, don't use the Captions option to 
enter label text, or the text entered in the first label will be repeated in all frames 
tagged with the same tag. Instead, use the Text tool to type individual text in each 
frame's caption area.



Deleting frame tags
1. Choose Format, Manage Tag List.
2. Choose the Frame Tags tab.
3. Choose a tag from the Tag list.
4. Click the Delete Tag button.
5. Under Reformat Frames As, select <No Tag>, Default, or any other tag name.

Note: Selecting <None> both deletes the tag name from the list, and untags the 
selected frame. To delete the tag name but tag the frame with another name, select 
another tag name from the list box.



Rename frame tags
1. Choose Format, Manage Tag List.
2. Choose the Frame Tags tab.
3. Choose a tag from the Tag List.
4. Click the Rename Tag button.
5. Type the desired name in the New Name field.



Adding frame tags
1. Choose Format, Manage Tag List.
2. Choose the Frame Tags tab.
3. Click the Add Tag button.
4. Type the name you want for the new tag in the Tag Name field.



Repeating frames
Suppose you're working on a proposal and want your company's logo to appear on every 
page. Rather than pasting a copy of the logo on each page, you can repeat the frame 
containing it, making the logo appear in the same spot on every other page in the proposal. 
Not only is this faster, but any changes you make to the logo on one page, such as moving 
it, are automatically reflected on the other pages.
To create repeating frame:

1. Load a graphic into a selected free frame.
2. Choose Format, Frame.
3. In the Repeating Frame group, choose an option in the Repeat on drop-down list box. 

The options are: All Pages, Left Pages, Right Pages and No Other Pages.
All Pages: same position on all document pages.
Right Pages: same position on only right pages.
Left Pages: same position on only left pages.
No other pages: to turn off repeat options

4. Select Hide on Current Page checkbox to disable Repeating Frame on the current page 
only.



Merging frame tags
If you're working on a chapter and want to use a frame tag from another chapter or 
document, access the Manage Tag list dialog box, select the tags and merge them into your 
chapter. Unlike paragraph tags which are stored in style sheet(s), frame tags are stored in 
the chapter files.
To merge frame tags:

1. Choose Format, Manage Tag List. The Manage Tag List dialog box opens.
2. Click the Frame tab. The Frame dialog box is displayed.
3. Click Merge. The Open Style Sheet dialog box opens. 
4. Enter the name of the style sheet or click on the style sheet that has the tags you want

and click OK. The Merge Tag dialog box is displayed.
5. Click the tag names in the Tag List box.

If you want to copy all of the tags, click Select All to select all of the tags in the Tag 
List.

6. Click Merge.



Work with imported graphics

Loading graphics
Working with clipart
Sizing graphics
Adding space around a graphic
Cropping a graphic
Wrapping text around graphics
Showing and hiding graphics
Repeating graphics
Specifying halftone screen settings for grayscale images
Understanding the halftoning process
Anchoring graphics to text
Adding captions
Generating a list of figures
Taking a screen grab
Scanning a graphic



Sizing graphics

Sizing graphics using the Graphic command
Sizing graphics with the Pick tool



Loading graphics
Loading graphics using the Load Graphic command
Loading graphics using Corel MOSAIC
Drag and drop graphics



Draw and edit objects in Corel VENTURA

Setting up the drawing environment
Setting up the drawing grid
Selecting a drawing tool
Attaching objects to frames
Drawing rectangles, ellipses and lines
Using the Box Text tool
Selecting graphic objects
Selecting multiple objects
Selecting superimposed objects
Resizing and moving objects
Cutting, copying, pasting or deleting objects
Repeating objects
Stacking objects
Applying outlines and fills
Setting default outline and fill attributes



Working with clipart
Corel VENTURA comes with libraries of ready-to-use clipart images and symbols. The entire 
collection of 15,000 vector and 1,000 bitmap clipart images is provided in uncompressed 
format on CD ROM disk #1. Another easy way to find the clipart if you have the CorelDRAW 
application suite diskettes is to run the CorelDRAW 5 Custom Setup and choose only the 
Install Clipart option. For more information on running the Setup, see the Installation Guide.

See also:
Loading Graphics



Working with Graphics--Overview
Corel VENTURA's extensive importing capabilities provide access to graphics created with 
many popular painting, drawing, charting and scanning programs as well as the huge 
collection of clip art that comes with Corel VENTURA. You can also incorporate graphics 
created in other Windows applications into your document by linking or embedding them or 
by pasting them from the Clipboard.
Since the base page can only hold one file, you usually place imported graphics in frames 
created with the Frame tool. That way, you can add as many frames and graphics as you 
need and position them wherever you like. You can also add a caption to the frame and 
anchor it to text in the base frame so that the graphic moves with the text when the text is 
edited. In addition, you can resize the graphic, crop it and have it appear on other pages by 
repeating the frame it's in.
Simple graphics lines, rectangles and circles etc. can be created using Corel VENTURA's 
drawing tools. If you need to annotate illustrations, you can use the Box Text tool to draw a 
box and then type text into it. Just as you can anchor frames to text, you can also anchor 
graphic objects to frames so that they move together. Once you've drawn a graphic object 
you can resize it, copy it and outline and fill it using the same outline and fill types that are 
available in CorelDRAW.

See also:
Graphic formats
Import file filters - technical notes



Graphic formats
There are many file formats in which graphics can be saved. There are however, only two 
types of graphics: vectors and bitmaps.    
A vector graphic (also called an object-based graphic), uses mathematical equations to 
represent the shapes that make up the image. As a result, the graphic always prints at the 
maximum resolution of the output device. Moreover, no matter how much you resize the 
graphic, it retains its crisp, smooth lines.
A bitmap image is composed of a series of dots. Because the number of dots is fixed, the 
quality of the image degrades when it's resized. Also bitmaps can't take advantage of higher
resolution printers a bitmap scanned at 300 dots per inch (dpi) prints with the same quality 
on a 1200 dpi imagesetter as on a 300 dpi desktop printer.



Loading graphics using the Load Graphic command
When you use the Load Graphic command you can specify whether you want the graphic 
added to the current chapter only.
To import a graphic using the Load Graphic command:

1. Choose Load Graphic from the File menu. The Load Graphic dialog box appears.
2. From the List Files of Type box, select the format of the file you want to import.
3. Use the Drives and Directories list boxes to locate the file you want to import. When 

the name of the file appears in the File Name list box, either select the file name and 
choose OK, or double-click the file name.

4. If you want to import several files (text and graphic files), hold down the Shift key and 
click the name of each file. Use the Ctrl key instead to select non-consecutive files.
The file is placed in the selected frame or in a frame Corel VENTURA created. If you 
imported more than one file, the names of the files are added to the Files list. You can 
then place the files in frames by selecting the frame and clicking the file name.
You won't see the graphic when you're working in Draft view nor when the Hide 
Graphics option in the Frame Settings dialog box is turned on for the selected frame.

Notes:

1. With all multi-selection imports, the files are automatically placed in the Files list.
2. With single selection imports one of the following occurs.

· If the Pick tool is active and an empty frame is selected, the graphic or text file is 
inserted in it.

· If no frame is selected (i.e., the Pick tool is not selected) a frame is created for the 
graphic (text files are always added to the file list).



Loading graphics 
When you use the Load Graphic command you can specify whether you want the graphic 
added to the current chapter only.
To import a graphic using the Load Graphic command:

1. Choose Load Graphic from the File menu. The Load Graphic dialog box appears.
2. From the List Files of Type box, select the format of the file you want to import.
3. Use the Drives and Directories list boxes to locate the file you want to import. When 

the name of the file appears in the File Name list box, either select the file name and 
choose OK, or double-click the file name.

4. If you want to import several files (text and graphic files), hold down the Shift key and 
click the name of each file. Use the Ctrl key instead to select non-consecutive files.
The file is placed in the selected frame or in a frame Corel VENTURA created. If you 
imported more than one file, the names of the files are added to the Files list. You can 
then place the files in frames by selecting the frame and clicking the file name.
You won't see the graphic when you're working in Draft view nor when the Hide 
Graphics option in the Frame Settings dialog box is turned on for the selected frame.

Notes:

1. With all multi-selection imports, the files are automatically placed in the Files list.
2. With single selection imports one of the following occurs.

· If the Pick tool is active and an empty frame is selected, the graphic or text file is 
inserted in it.

· If no frame is selected (i.e., the Pick tool is not selected) a frame is created for the 
graphic (text files are always added to the file list).



Loading graphics using Corel MOSAIC
1. Select the frame into which you want to place the graphic and then from the File menu,

choose Mosaic Roll-Up or click the corresponding button in the ribbon.
The Mosaic Roll-Up opens showing thumbnails of the graphics in the current directory.
If the graphic you want to load is in another directory, click one of the icons at the top 
of the roll-up and locate the directory.

2.  When you find the graphic you want to load, drag it onto the page and then release 
the mouse button to drop it into the selected frame. To import several files, hold down 
the Shift key, click to select each file then drag them onto the page. 

Note:    The files are loaded into the Files list and do not appear on the page. Select a frame 
and click on the file in the Files List to place the graphic on the page.



Sizing graphics--Overview
The size at which a graphic appears in a document (as opposed to its actual size established
at the time of its creation) is initially determined by the size of the frame that contains it. If 
you make the frame larger or smaller, the graphic grows or shrinks by a proportionate 
amount. And no matter which direction you resize the frame, the graphic's original aspect 
ratio (the ratio of the graphic's width to its height) is maintained by default.
In certain situations you may want to use the Graphic command (Format menu) to resize a 
graphic independently of its frame. This enables you to specify precise dimensions for the 
graphic which won't change even if you resize the frame. You can also use the Graphic 
command to alter the graphic's aspect ratio. As with size, you can make the aspect ratio 
either dependent on, or independent of, the frame size. 



Sizing graphics using the Frame command
1. Select the frame containing the graphic you want to resize and then choose Graphic 

from the Format menu.
2. Set the following options depending on how you want the graphic to appear.

If you... Graphic size...
Enable both Fit in Frame and
Maintain Aspect Ratio changes with the frame's size while the graphic's aspect ratio stays

the same.
Enable Fit in Frame but
Disable Maintain Aspect Ratio changes with the frame's size even if this distorts the image
Disable Fit in Frame, but
Enable Maintain Aspect Ratio is determined by the width or height you specify. You only need

to specify one dimension; Corel VENTURA automatically adjusts the
other to maintain the graphic's original aspect ratio.

Disable both Fit in Frame and
Maintain Aspect Ratio is determined by the width and height you specify.



Sizing graphics with the Pick tool
Unlike previous versions of VENTURA where vector and bitmap graphics must be resized 
differently, in VENTURA 5.0 all graphics are scaled from their centers.
To scale a graphic using the Pick tool:

1. If required, draw a frame using the Frame tool, 
or 
Choose a frame with the Pick tool.

2. Load a graphic into the frame by choosing Load Graphic from the File menu.
3. Click and drag any of the object's handles to manually resize it. 

Note:    You may also load graphics to the Font and file list by choosing Add to 
File List from the Options section of the Load Graphic dialog box.



Adding space around a graphic
There are several ways to increase the amount of space between a graphic and the 
surrounding text. You can:

· insert empty paragraphs above and below the frame
· add additional frames above and below the frame containing the graphic
· increase the margins around the frame using the Outside Margins settings in Margins 

section of the Frame Settings dialog box (Format menu).
· make the graphic smaller inside the frame by using the Frame command.
· add space between the frame and the graphic as described below

To reduce the size of a graphic within its frame:
1. Select the frame and choose Frame from the Format menu.
2. Click the Margins tab and enter values in the Inside Margins boxes to add the required 

amount of space between the graphic and the sides of the frame.
Since this reduces the size of the graphic you may need to increase the size of the 
frame to compensate.

3. Choose OK. 



Cropping a graphic
To crop a graphic in Corel VENTURA, you scale it within its frame, and then pan it until only 
the portion of the graphic you want to show remains.
To crop a graphic:

1. Select the frame which contains the graphic you want to crop.
2. From the Format menu, choose Graphic. The Graphic command also appears in the 

pop-up menu displayed by clicking with the right mouse button.
3. Disable the Fit in Frame option under Dimensions.
4. Enter a value in the Width box to increase the size of the graphic by the required 

amount.
5. Choose OK.

With the Maintain Aspect Ration option enabled, Corel VENTURA will adjust the height 
automatically to maintain the graphic's original proportions.



Wrapping text around graphics

Applying an autowrap or preset wrap shape
Drawing a text wrap path around a graphic
Editing a text wrap path



Wrapping text around graphics--Overview
Corel VENTURA offers three ways to control how text flows around the graphics in your 
documents.

· Draw a path around the graphic using the Node Edit tool. 
· Choose Autowrap to automatically apply a path around the contours of the graphic by 

clicking the right mouse button on the selected frame and choosing Autowrap from the
menu.

· Apply a Preset wrap shape, such as rectangle or oval, by clicking the right mouse 
button, choosing Preset Wrap shape, then selecting one of the shapes.

Each method involves creating a path around the graphic which causes the text to flow 
around the path rather than the frame. Once you've applied a path around the graphic, you 
can edit the segments or nodes within the path using the Node Edit tool. See Editing text 
wrap paths.
Notes:
· To get text to flow around a free frame, the frame containing the text must be below the 

other frame in the stacking order. Since the base page frame is always at the bottom of 
the stack, text in it will always flow around a free frame unless the Flow Text Around 
Frame option is turned off for that free frame. If you have overlapping free frames and 
you want text in one of them to flow around a graphic in one of the others, the one 
containing the graphic must be first in the stacking order. To move a frame to the top of 
the stack, cut and paste it.

· Text wrap (preset wrap shapes or autowrapping) is not supported for OLE objects.
· When wrapping text around graphics saved in Encapsulated PostScript file format (EPS), 

the text wrap is performed on the image header. Therefore, there may be discrepancies 
between screen representations and printed output.



Applying an autowrap or preset wrap shape
Corel VENTURA's autowrap feature automatically applies a path around the contours of a 
graphic. Text in your document will then flow around the path rather than the frame. You can
also choose one of the preset wrap shapes that will apply a chosen shape, for instance oval 
or diamond,    to your graphic. Only the portion of the graphic that appears inside the shape 
will show. Both of these text wrapping features are available in the menu that appears when 
you click the right mouse button on a selected frame.
To apply an autowrap to a graphic:

1. Select the graphic's frame with the Pick tool.
2. Click the right mouse button to access the pop-up menu.
3. Choose Autowrap. A text wrap path consisting of line segments and nodes is applied 

around the contours of the graphic. 
To apply a preset wrap shape:

1. Select the graphic's frame with the Pick tool.
2. Click the right mouse button to access the pop-up menu.
3. Choose Preset Wrap Shape from the menu. A flyout menu containing a list of shapes 

opens.
4. Click the shape you want to apply to your graphic. The shape consisting of line 

segments and nodes is applied to the graphic.
You can adjust the shape of the path you applied by clicking and dragging the nodes and 
segments within the path. See Editing text wrap paths.
Note: When applying an autowrap or preset wrap shape to graphics saved in Encapsulated 
PostScript file format (EPS), the application of the path is performed on the image header. 
Therefore, there may be discrepancies between screen representations and printed output.



Drawing a text wrap path around a graphic
Using the Node Edit tool, you can draw a path around a graphic so that text will flow around 
the path rather than the frame.
To draw a text wrap path:

1. Select the graphic's frame using the Pick tool.
2. Choose the Node Edit tool from the Frame tool flyout. 
3. Click and drag the tool around the contours of the graphic or click to create points as 

you draw the path.
4. Release the mouse button when the two ends of the path are joined.
5. Reselect the Frame tool to refresh the text wrap.

Once the path has been applied, you can edit the segments and nodes to change the shape 
of it using the Node Edit tool. See Editing text wrap paths.
Note: When drawing a text wrap path around graphics saved in Encapsulated PostScript file 
format (EPS), the application of the path is performed on the image header. Therefore, there 
may be discrepancies between screen representations and printed output.



Editing a text wrap path
You can adjust the path around a graphic by clicking and dragging the segments that 
connect the nodes or by dragging the nodes themselves.
To edit the path:

1. Do one of the following:
· To select a single node or segment, click the node or segment using the Node Edit 

tool in the Frame tool flyout menu. 
· To select multiple nodes or segments, hold down the Shift key and click the nodes 

you want to select. You can also drag a box (marquee) around the nodes you want to
select. 

Once you've selected multiple nodes or segments, you can move or edit them as if 
they were a single node.

2. Hold down the left mouse button on the selected node or segment and drag it until its 
the shape you want. When you move a node or segment, its control points move along 
with it.

3. Double-click a node or choose Tools, Node Edit Roll-Up (Alt+F9) to add/delete nodes 
along the path you just drew.

4. Reselect the Frame tool to refresh the new text wrap.
Note: When editing text wrap paths of graphics saved in Encapsulated PostScript file format
(EPS), the editing is performed on the image header. Therefore, there may be discrepancies 
between screen representations and printed output.
For more detailed information on editing paths, refer to Chapter 5, Adding Graphics, of the 
Corel VENTURA User's Manual.



Editing text wrap paths
You can adjust the path around a graphic by clicking and dragging the segments that 
connect the nodes or by dragging the nodes themselves.
To edit the path:

1. Do one of the following:
· To select a single node or segment, click the node or segment using the Node Edit 

tool in the Frame tool flyout menu. 
· To select multiple nodes or segments, hold down the Shift key and click the nodes 

you want to select. You can also drag a box (marquee) around the nodes you want to
select. 

Once you've selected multiple nodes or segments, you can move or edit them as if 
they were a single node.

2. Hold down the left mouse button on the selected node or segment and drag it until its 
the shape you want. When you move a node or segment, its control points move along 
with it.

3. Double-click a node or choose Tools, Node Edit Roll-Up (Alt+F9) to add/delete nodes 
along the path you just drew.

4. Reselect the Frame tool to refresh the new text wrap.
Note: When editing text wrap paths of graphics saved in Encapsulated PostScript file format
(EPS), the editing is performed on the image header. Therefore, there may be discrepancies 
between screen representations and printed output.
For more detailed information on editing paths, refer to Chapter 5, Adding Graphics, of the 
Corel VENTURA User's Manual.



Wrapping text across graphics
To wrap text across graphics:

1. Click the frame containing the text you want to wrap from left to right. 
2. Turn off Flow Text Around Frame in the Frame Settings dialog box. 

The text will flow through the frame.
3. For each line you want to force around the frame, draw a frame less than the average 

interline height for the paragraph text you are working with, as shown below.

Note:    When wrapping text across encapsulated PostScript files, the text wrap is 
performed on the image header. Therefore, there may be discrepancies between screen 
representation and printed output. Autowrap is not supported for OLE objects.



Showing and hiding graphics
As you add graphics to a page, you'll probably notice the page takes longer to redraw on the
screen. Since this slows down editing and formatting you may want to keep the graphics 
hidden while you're working. Hiding graphics is also useful when you want to print a 
document quickly and don't need to see the graphics. Hiding the graphic replaces the image
with a large "X".
While graphics are hidden, the frame and the graphic it contains can still be moved, sized, 
cut, copied and pasted. You can hide all graphics in a document or selected graphics only. 
You can also enable or disable the printing of hidden graphics.
To hide all graphics in a chapter:

· Choose Hide All Graphics, View menu.
A large "X" displays in each frame.
To show hidden graphics, choose the Hide All Graphics, View menu. If the graphics are 
hidden, choosing the command again shows them.

To hide only selected graphics:
1.  Select the frame containing the graphic you want to hide.
2. Choose Graphic, Format menu. The Frame Settings opens.
3. Click Graphics. The Graphics dialog box opens.
4. Check Hide Graphic and then choose OK.



Repeating graphics
Suppose you're working on a proposal and want your company's logo to appear on every 
page. Rather than pasting a copy of the logo on each page, you can repeat the frame 
containing it, making the logo appear in the same spot on every other page in the proposal. 
Not only is this faster, but any changes you make to the logo on one page, such as moving 
it, are automatically reflected on the other pages.
To create repeating graphics:

1. Load a graphic into a free selected frame.
2. Choose Frame, Format menu.
3. Choose an option from the Repeat on drop-down list box. The options are: All Pages, 

Left Pages, Right Pages and No Other Pages.
All Pages: same position on all document pages.
Right Pages: same position on right pages only.
Left Pages: same position on left pages only.
No other pages: to turn off repeat options.

4. Select Hide on Current Page checkbox to disable repeat on the current page only.



Specifying halftone screen settings for grayscale images
Halftoning is the process of modifying a grayscale image so that it can be printed by a 
device that is capable of producing only black dots. Halftoning converts each gray dot within
an image into a pattern of black dots: light shades are represented by sparsely spaced dots, 
while dark shades are represented by densely spaced dots.
Corel VENTURA enables you to control the halftone processing for images which contain 
shades of gray. These settings are available only for grayscale TIFF images and apply only 
when printing to a PostScript printer. When you print a document containing a TIFF image to 
a non-PostScript printer, Corel VENTURA substitutes the low resolution preview image that is 
incorporated into the document.
To change the halftone image settings:

1. Select the frame which contains the gray-scale image.
2. Choose Graphic, Format menu.
3. Set the Halftone Screen Type, Halftone Screen Angle and Frequency options as desired 

and then choose OK.
Halftone screens don't display on your screen; you must print to see their effect on the 
image.

See also:
Recommended settings for halftone screening
Halftoning guidelines
Understanding the Halftoning process



Recommended settings for halftone screening
Set the Dot Shape option to Default for most work. This option uses the screen type stored in
your printer and is optimized for your hardware. The screen angle is normally 45 degrees. 
Set the Lines Per Inch option to 60 for laser printers, 90 for 1200 dot per inch typesetters, 
and 150 for 2540 dot per inch typesetters. These settings will work for most situations. 
However, you may be able to dramatically reduce the size of grayscale images, and also 
obtain better results if you understand the halftone process which is described in 
Understanding the Halftoning process.



Understanding the halftoning process
The Halftone Screen settings is but one control in the process which starts with scanning a 
photograph into the computer, and ends with the printing of that photograph from Corel 
VENTURA. 
A number of parameters in this process interact to produce various levels of image quality. 
What follows is a definition of each parameter along with recommended ranges. Use these 
formulas and ranges to decide the trade-off that is best for your particular situation.

· Printer resolution:    The number of dots that the printer can place within a square 
inch of paper or film. Laser printers usually print at 240, 300, 400, or 600 dots per inch.
Most print at 300 dots per inch.

· Gray levels:    Each dot which a printer or typesetting machine puts on paper or film is
black, not a shade of gray. Therefore, gray must be approximated by a group of dots. 
For instance, you can print a small square which is five dots wide and five dots high. If 
you print all the dots in this little square, then the square looks totally black. If you 
print every other dot, then the square looks 50% gray. If you print only every fifth dot, 
then the square looks 20% gray. Thus, this little square in essence becomes a gray dot 
which can have 5 x 5 = 25 shades of gray. However, instead of being able to print 300 
dots per inch, you can only print 60 gray dots per inch.

· Screen frequency:    The screen frequency refers to how many gray dots you place on
the page per square inch. The screen is set in lines per inch.

· Screen type and angle:    The screen produces a regular pattern through the image. 
To make this pattern less noticeable, the screen is normally rotated at an angle with 
respect to the image. Also, to create special effects, you can use screens made up of 
patterns other than circular dots.

· Scanner controls:    If you use a scanner to create an image, you can usually vary the
number of gray levels stored with each image, as well as the resolution. Scanners 
which recognize and store gray information usually let you vary the number of gray 
levels stored with every dot in a picture. The more gray levels per dot, the bigger the 
resulting file. Typical values are 16 levels (4 bits per dot), 64 levels (6 bits per dot), and
256 levels (8 bits per dot). Most scanners for desktop publishing can create images at 
300 dots per inch, but let you scan at lower resolutions in order to create smaller files.
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Halftoning guidelines
You can trade resolution for levels of gray. Therefore, before you scan an image, you should 
decide on the number of gray levels and the screen frequency you want. The relationship 
between these two is:
Screen Frequency = Printer Resolution

Gray Levels
Thus, if you want to print 25 levels of gray on a 300 dot per inch printer, you should select a 
screen frequency of 60 lines per inch.
Typical screen frequencies and gray levels are as follows:

· Screen frequency:    Newspaper picture quality is created with screen frequencies of 
65 to 75 line per inch. Magazine picture quality is created with screen frequencies of 
120 to 150 lines per inch. 60, 75, 120, 133, and 150 are typical values.

· Gray levels:    The eye cannot discern 256 different gray levels. Therefore, storing 
more than 256 levels of gray is a waste of space. At the other end of the spectrum, 32 
gray levels is coarse, but adequate for many uses.

You can significantly decrease the size of scanned image files without degrading image 
quality by limiting scanner resolution to roughly the screen frequency, and by limiting the 
number of gray levels stored to just slightly more than the screen frequency and printer 
resolution allow. Restating the formula given earlier:
Gray Levels = Printer Resolution

Screen Frequency
For instance, if you intend to print with a 60 line per inch screen to a 300 dot per inch 
printer, you should scan the image at only 20% more than 60 dots per inch, which is roughly
75 dots per inch. Also, you should scan for just a little more than 25 levels of gray, which 
translates to 32 or 64 gray levels on most scanners. You will need to experiment with your 
particular setup to find values that produce pleasing results with the smallest possible 
numbers.
The scanner resolution you use also depends on the enlargement done in Corel VENTURA. 
The general formula is:
Scanner Resolution is approximately 1.2 x Screen Frequency x Magnification
Thus, if you plan to double the size of the image using the Sizing & Scaling option, and you 
have set screen frequency to 60 lines per inch, you should scan the image at 1.2 x 60 x 2 
which is approximately 150 dots per inch. The factor of 1.2 is based on experience. You 
should experiment to see what works for you.
Finally, if you want to create special effects, you can try changing the Halftone Screen Angle 
and Halftone Screen Type options.



Anchoring graphics to text
Anchoring a frame containing a graphic ensures that the graphic moves with the 
surrounding text when the text is edited. When you anchor a frame you specify where you 
want the frame to appear in relation to anchor location in the text for instance, below the 
line or in the line containing the anchor. You can only anchor free frames to text in the base 
frame.
To anchor graphics to text:

1. Select the free frame you wish to anchor.
2. Choose Format Menu, Frame.
3. In the Frame Settings dialog box, click the General tab.
4. In the Frame Anchor box, type the anchor name you wish to assign to the frame. This 

name must exactly match the anchor name you insert into the text in steps 6 through 
9.

5. Choose OK.
6. Select either text tool or double-click the text where you want to plant the text cursor. 

This will determine the frame anchor position.
7. From the Edit menu, choose Insert Special Item, Frame Anchor.
8. In the Frame Anchor Name box, type the exact same name you assigned to the frame, 

or select it from the list.
9. Select an anchor position and choose OK.

Whenever the Re-Anchor Frames command is executed, this frame will be moved to the 
page that contains the corresponding anchor reference in the text. Frames anchored using 
the At Anchor option are update automatically as the frame anchor moves.
Note:    To anchor a frame to a spot on a particular page there must be room on the page for
both the frame and the line of text in which the anchor is inserted. If you make changes to a 
document causing the frame and its anchor not to fit on the same page, that frame will 
move to the end of the chapter when you re-anchor the frames. The easiest way to fix this 
problem is to make the frame in question smaller.



Adding captions
You can easily create captions for graphics in your document by attaching another frame to 
the one containing the graphic. Text in the caption can consist of a label made up of 
descriptive text such as "Table" or "Figure" and a counter which automatically numbers the 
captions as Figure 1, Figure 2 and so on. After adding the caption you can type additional 
text in whatever amount you want directly into the caption frame. 
The label portion of the caption is automatically tagged with a tag named Z_LABEL_FIG, 
Z_LABEL_TBL or Z_LABEL_CAP . Text typed into the caption frame is tagged with a tag 
named Z_CAPTION.
To attach a caption to the selected frame:

1. Select the frame you wish to caption.
2. From the Format menu, choose Frame.
3. In the Frame Settings dialog box, click the General tab.
4. In the Caption list box in the Caption Format section, choose the location where the 

caption will appear: above, below, left or right.
5. In the Reference box, choose the label. Selecting these options places the following 

codes on the label line:
This label: Creates the caption:
Figure [F#] Figure 1
Figure [C#] - [F#] Figure 1 - 1
Table [T#] Table 1
Figure [C#] - [T#] Table 1 - 1
If you do not require the accompanying text, such as Figure, highlight that portion of 
the text in the Reference box and delete it.
You can also type any text, up to 20 characters, to label the frame.
You can change the font, size and style of the caption text by swiping the text in the 
Reference box and clicking the text attributes button to open the Selected Text 
Attributes dialog box.



Generating a list of figures
You can have Corel VENTURA generate a list of figures for inclusion at the beginning of our 
document. Generating a list involves specifying the following information:

· Title you want to appear at the beginning of the list
· Tags assigned to paragraphs you want in the list
· Number of levels in the list
· Numbering format (chapter and page, or page only)
· Tags you want to use to format entries in the list

The tags you choose to format the list apply not only to the text but to the page numbers as 
well. If you like, you can use text attributes to format the page number differently from the 
text. For example, you might make the page number bold or set it in a larger font. Although 
you can apply the text attributes manually after generating the list, it's much easier to apply
them when you are setting up the list.
To generate a list:

1. Save your document and then choose TOC and Index, Format menu. The Table of 
Contents & Index dialog box opens.

2. Click the Table of Contents tab.
3. In the Title box, type the title you want to appear at the beginning of the Table of 

Contents.
4. From the Reference Tag list, choose the style tag assigned to the graphics.
5. Choose a numbering format for the first level from the Numbers list box.
6. If you want to apply text attributes to the chapter or page number, drag to select the 

[C#] or [P#] codes in the Sample box and apply the required attributes using the Text 
Attributes button or the bold, italic and underline buttons.

7. Click Generate. The File Save As dialog box opens.
8. Enter a new name and storage location for the file being generated. 

To name the list file, type a name in the File Name box (a .GEN extension is added 
automatically) and choose OK. After naming the file, use the Load File command in the
File menu to place it in your document (see Adding the table of contents file to your 
document).

9. Load the text file into the document.
You can typeset the file once it has been loaded into the document.



Using the drawing tools--Overview
Corel VENTURA provides several drawing tools for creating graphic objects such as lines, 
rectangles, and ellipses. Using the Box Text tool, you can draw a box, type text in it and then
move the box anywhere on the page. Among other things, you can use box text to create 
annotations or callouts for illustrations.
Once you've drawn an object, you can manipulate in a variety of ways: for example, you can
move it, resize it, cut or copy it, and apply outlines and fills to it.
When you draw an object, Corel VENTURA attaches it to the currently selected frame. By 
attaching the object to an anchored frame, the object will move with the surrounding text as 
the text is edited.
To help you position objects, Corel VENTURA provides a grid. You can use it as a reference for
positioning objects by eye, or have objects snap to it for precise alignment.

See also:

Drawing tools



Setting up the drawing environment
Corel VENTURA provides a pair of adjustable rulers and a grid to help you draw and position 
objects.
Using the rulers
Rulers at the edges of the page provide visual references for sizing and positioning objects. 
Corel VENTURA is preset to display the rulers, but you can turn them off using the Options 
command in the View menu. The Ruler Set-up command in the Tools menu determines the 
measurement system (inches, points, picas etc.) the rulers use and the location of the zero 
points on the rulers. You can also drag a set of crosshairs from the rulers and use them to 
check the alignment of objects. 
Using the drawing grid
The drawing grid is a network of horizontal and vertical lines that covers the entire page. You
cannot see the gridlines on-screen but you can display markers showing where they 
intersect and use them as reference points for positioning objects created with the drawing 
tools. 
The grid settings you define apply to the currently selected frame. All graphics attached to 
that frame will then snap to the gridlines when drawn or moved. You can define a different 
grid for each frame one each page.
The grid also has a snap feature which pulls objects into alignment with the markers. You 
use the Grid Set-up command in the Tools menu to turn the markers and the snap feature on
and off. You also use the Grid Set-up command to set the spacing between gridlines and the 
point where the grid begins.



Setting up the drawing grid
1. From the Tools menu, choose Grid Setup. The Grid Setup dialog box opens.
2. Show or hide the grid by turning the Show Grid option on or off.

Every frame in Corel VENTURA has a grid associated with it. The grid origin is always 
the top-left corner of the base page.

3.  Enter values in the Grid Frequency boxes to set the spacing between the gridlines.
Typing fractional values lets you space the gridlines more than one unit of 
measurement apart. For example, if the unit is inches, typing 0.50 sets the distance 
between gridlines to two inches.
The maximum number of gridlines is 72 lines per inch or the equivalent in other 
measurement systems. Although you can have up to 72 gridline per inch, a grid 
marker may not display for each gridline. To avoid cluttering the screen, Corel 
VENTURA bases the frequency of the grid markers on the current view. When you 
change views by magnifying an area of the page with the Zoom tool, for example the 
frequency of the grid marks increases.
Note:    The Grid Frequency values are not recalculated when you change the unit of 
measurement. Each time you change units, you must specify the Grid Frequency you 
want based on that unit.

4.  Choose OK.
Corel VENTURA saves the grid settings with the document, ensuring that objects 
maintain their alignment the next time the document is opened. Changing the grid 
settings doesn't affect objects already on the page; they maintain their positions even 
if they don't line up with the new gridline positions.



Selecting a drawing tool
Before you can draw an object, you must select a drawing tool from the toolbox.
To select a drawing tool:

1. Click the drawing tool icon in the toolbox. The drawing tool flyout menu appears.
2. Click the tool you want to draw with.

When you select a tool, the mouse pointer changes to a cross (+).



Attaching objects to frames
Corel VENTURA attaches objects you create with the drawing tools either to the base page or
to a free frame you select before choosing a drawing tool. If you attach an object to a free 
frame, the object will move with the frame when that frame is moved, cut, copied or 
repeated. Also, since frames can be anchored to the text, tying objects to frames allows you 
to anchor objects to a specific location in the text.
To attach a object to a frame:

· Use the Pick tool to select the frame, and then use the drawing tools to draw objects.
To attach existing objects to a different frame:

· Cut the object, select the frame and then paste the object back onto the page.



Drawing rectangles, ellipses and lines
The technique you use to draw rectangles, ellipses and lines is essentially the same: select 
the appropriate tool, click anywhere on the page, and drag the mouse. If you hold down the 
Ctrl key as you drag, you can constrain the motion of the mouse to draw perfect squares, 
circles or straight lines.
To draw a rectangle, square, ellipse, circle or line:

1. Using the Pick tool, select the frame to which the object should be attached.
2. Select the appropriate drawing tool from the flyout menu.
3. Place the mouse pointer where you want the object to begin and drag.

To draw a square, circle or a line that is vertical, horizontal or at a 45 angle, hold down 
the Ctrl key while dragging.

4. Release the mouse button when the object is the desired size and shape.
To draw several objects of the same type without having to select the appropriate tool after 
each object is drawn, hold down the Shift key as you draw.



Using the Box Text tool
Using the Box Text tool, you can draw a box, type text in it and then move the box anywhere
on the page. Like other graphic objects, box text moves with the frame it's attached to 
making it ideal for creating callouts for illustrations.
Text typed in a box text object is initially formatted with the BOXTEXT style tag. As with other
text in Corel VENTURA, you can change the format of box text using either Text tool.
You can also use the outline and fill tools to apply outlines and fills to box text objects as you
would any other graphic object.
To create a box text object:

1. Use the Pick tool to select the frame to which you want the box text object attached.
2. Click the Drawing tool to display the flyout menu then click the Box Text tool

.
3. Point where you want the box text object to appear, then drag diagonally from one 
corner of the object to the other.

When you release the mouse button, an end of file marker appears inside the box text 
object. You will see the marker even if the Tabs and Returns option on the ribbon bar

 is turned off.
4. Select either Text tool and type text into the box.

Text wraps between the sides of the box. If necessary, use the Pick tool to make the 
box larger so that all the text is visible.



Selecting graphic objects
When you create an object with drawing tools Corel VENTURA selects it so that you can 
begin working with it right away. To work with an existing    object, however, you must first 
select it with the Pick tool. A selected    object displays on-screen with handles used for 
resizing. The frame to which the    object is attached also displays handles, but they appear 
gray rather than black. Once an object is selected, you can resize it, cut or copy it, move it 
and change its outline and fill.
To select a graphic object:

1. Click the Pick tool.
2. Place the mouse pointer over the object and click.

Handles appear around the graphic and the frame to which it is attached. The object's 
type (ellipse, rectangle, line, or box text) displays in the Status Line. 

To select several graphic objects:
· Hold the Shift key down while clicking on each object. (You can only select objects 

attached to the same frame.)
To select all graphic objects attached to a frame:

· Click one of the objects with the right mouse button and choose Select All from the 
pop-up menu that appears.



Selecting multiple objects
You can select multiple objects attached to the same frame and then move, resize, cut or 
copy them as a group. If the objects were drawn with the same tool, you can apply an 
outline and fill to all of them in one step.
To select multiple objects attached to the same frame:

1. Click the Pick tool.
2. Do one of the following:

· Hold down the Shift key and click the objects you want to select.
· Select one object, click the right mouse button and then choose Select All to select 

all objects attached to the same frame.
To deselect an object in a group of selected objects:

· Point to the object, hold down the Shift key, then click.



Selecting superimposed objects
When one object is completely covered by another, it sometimes seems impossible to select 
the one on the bottom. 
To select an object covered by other objects:
Do one of the following:

· Press the Tab key repeatedly until the object is selected.
· Select the Pick tool, hold down the Alt key and click the object that's on top of the one 

you want to select. Keep clicking until the object's sizing handles appear.



Resizing and moving objects
You can resize and move objects on the same page by dragging them with the mouse or by 
specifying values in the Placement Roll-Up.
To resize an object by dragging:

1. Select the object (or objects) you want to resize.
2. Point to one of the object's sizing handles. When the mouse pointer changes to a two-

headed arrow, drag the handle until the object is the size you want.
The handles at the corners resize the object vertically and horizontally. Those between 
the corners resize the object in one direction only.
When resizing multiple objects, each is resized proportionally.

To move an object by dragging:
1. Select the object (or objects) you want to move.
2. Point on the graphic (away from the handles) and drag the object to the new location.

If more than one object is selected, drag any one of them and the others will follow.
To resize or move an object using the Placement Roll-Up:

1. Select the object(s) and then choose Placement from the Tools menu. The Placement 
Roll-Up opens.

2. Do one of the following:
· To move the object, enter values in the Position boxes to specify where you want the

upper-left corner of the object to be relative to the upper-left corner of the base 
page frame.

· To resize the object, enter measurements in the Size boxes.
3. Click the Apply button.



Cutting, copying, pasting or deleting objects
You can move or duplicate objects using the Cut, Copy and Paste commands in the Edit 
menu. When you cut or copy an object, Corel VENTURA places it on the Clipboard. From 
there you can paste the object elsewhere in the same document or in another document. 
The object remains on the Clipboard until you cut or copy another object or end the current 
Windows session.
To cut or copy an object to the Clipboard:

1. Select the graphic.
2. Choose Cut or Copy from the Edit menu.

Choosing Cut, removes the original object from the page. Choosing Copy leaves the 
original object unchanged.

To paste an object:
1. Select the frame to which you want the object attached.
2. Choose Paste, Edit menu.

The pasted object appears at the same location on the page as the original. If 
necessary, select it and move it to a new location.

To delete an object:
· Select it and press Delete.

If you change your mind after deleting an object, choose Undo from the Edit menu to 
restore it to the page.



Repeating objects
Normally, objects tied to a particular page (as opposed to a free frame) show on that page 
only. You can, however, repeat the object making it appear on every page. When you repeat 
an object, changes you make to it on one page, are automatically reflected on the other 
pages.
To repeat objects on every page:

1. Select the object you want to appear on all pages.
2. Click with the right mouse button and from the pop-up menu that appears, choose 

Show On All Pages.
If you no longer want an object to repeat, select it on any page and choose the Show 
On All Pages command. Note that the object will display on the current page which 
may or may not be the page it was initially drawn on.



Stacking objects
If objects are placed on top of one another, the last graphic drawn (or pasted) is always 
placed on top. You can control how objects overlap by moving them in front of or in back of 
other objects.
To move an object in front of or in back of other objects:

1. Select the object and click the right mouse button.
If the object is completely obscured by another object, hold down the Alt key and click 
the object on top of the one you want to select. Keep clicking until the object's 
selection handles appear. You may need to move the mouse since the pointer must be 
over some part of the object in order to select it.

2. From the pop-up menu that appears, choose either To Front or To Back depending on 
where you want the object placed.



Applying outlines and fills
When you add an object to a document, Corel VENTURA gives it a default outline and fill 
which you can change using the Outline and Fill tools. 
Objects drawn with the Line tool have outlines with attributes that determine their width, 
color, line style and line ending shape. Closed objects, such as rectangles and ellipses can 
have an outline and a fill which can be a color, fountain, pattern or texture.
You can apply the same outline and fill to several objects at once; however, they must all be 
selected and they must be attached to the same frame.
To outline or fill an object:

1. Select the object you want to outline or fill.
2. Click the Outline or Fill tools and make the appropriate selections from the flyout 

menus. 



Setting default outline and fill attributes
You can change the default outline and fill attributes applied to new objects you create.
To change the default outline or fill:

1. Make sure there isn't anything selected on the page, including the base frame.
2. Choose any icon from the Outline or Fill flyout menu except the Pen or Fill roll-up icons. 

A dialog box opens asking whether you want the outline or fill you selected or will 
select to be the new default.

3. Choose Yes.
4. Select new outline and fill attributes to be the new default.



Scanning a graphic

Using Corel PHOTO-PAINT
Selecting a source device
Acquiring an image



Scanning--Overview
You can scan graphics into Corel VENTURA using Corel PHOTO-PAINT's Acquire Image 
command. On the Tools menu, the Extensions flyout allows you to load Corel PHOTO-PAINT 
and scan an image while still running Corel VENTURA. 
When you have scanned the image, saved it (as a Corel PHOTO-PAINT file) and exited Corel 
PHOTO-PAINT, you can load the graphic into your publication using the Load Graphic 
command.



Using Corel PHOTO-PAINT
1. Choose Tools menu, Extensions. A flyout appears.
2. Choose Corel PHOTO-PAINT from the Extensions flyout.
3. Edit, create or scan an image.

For information on Corel PHOTO-PAINT, see the Corel PHOTO-PAINT User Manual or the 
online help .

4. When you have finished and saved your work, choose Exit, File menu. Corel PHOTO-
PAINT closes and you are returned to Corel VENTURA.



Selecting a source device
The Select Source command in Corel PHOTO-PAINT lets you choose a standard image input 
driver (scanner) such as Corel Image Source. The sources that appear in the Select Source 
dialog box depend on the scanner driver(s) installed on your computer.
To select a source device:

1. Choose Extensions, Tools.
2. Choose Corel PHOTO-PAINT from the Extensions flyout. Corel PHOTO-PAINT launches.
3. Choose Select Source from the Acquire Image flyout menu. The Select Source dialog 

box opens.
4. Click a device name. The default is Corel Image Source.
5. Click Select.



Acquiring an image
The Acquire command lets you control your scanner. The dialog box displayed depends on 
the type of scanner in use.
To acquire an image:

1. Choose Acquire from the Acquire Image flyout menu to access your scanner.
The Corel Image Source dialog box that opens depends on the type of scanner in use. 
Some scanners provide more options that can be accessed by clicking the Settings 
button. 

2. Click Prescan to perform a preliminary scan of the entire image. 
3. Select an area by dragging on the corner handles of the marquee. 
4. Click Scan to perform a final scan.
5. Save the file to disk.



Corel Image Source dialog box
This dialog box is displayed when the Corel Image Source is selected in the Acquire Image 
command. This dialog box may be different if you chose another source in the Select Source 
dialog box.

Dialog Box Options

View Area
The View Area represents the scanner bed.    It includes rulers which display the width and 
height of the View Area. The units of measurement can be changed in the Units box. 

Scan Area box
Rectangular area with control points at each corner located inside the View Area. Marks the
scanner bed area to be scanned. If your scanner driver allows you to set a Custom paper 
size, you can drag the square control points to resize the scan area box. The Location 
boxes are also used to resize the Scan Area box.

Image Information
Image Information displays the image size and available memory in bytes. The image size 
is estimated on the basis of the size of the Scan Area, the chosen scanning resolution and 
other parameters described below.

Scanner list
On the right hand side, it displays a list of installed scanners for you to select one.

Location selection boxes
The Left and Top boxes display the distance between the rulers and the top left corner of 
the Scan Area box.    You can change the location of the Scan Area box by changing the 
values in those boxes.
The Width and Height boxes display the size of the Scan Area box. You can change its 
size by using those boxes.

Resolution box
Allows you to set the resolution to be used to scan the image.    The top box is a drop-down
list of available resolutions for the selected scanner.    If your scanner offers a "custom" 
resolution, use the second box to precisely set the desired resolution.
Note that a higher resolution gives a produces a more accurate and detailed image but 
requires more time and increases the file size. 

Units box
Lets you select the units of measurement for the rulers. The current selection appears at 
the top left corner of the View Area.

Colors box
Lets you select the maximum number of colors or levels of gray to be used in scanning the
image when using a color scanner.    The options listed in the box are: 16 million colors, 256
levels of gray and black and white. To use the Prescan button, grayscale must be the color 
setting.

Halftones box



Lets you select a halftone pattern for images if you are working in black and white.    The 
options displayed in the list box are scanner specific and are used to control the dithering 
produced by scanning in black and white.

Paper Size box
Lets you select a paper size which is used by the Scan Area. The options displayed in the 
box are scanner specific. If a "custom" option is listed, use the Scan Area box control point 
to set its size.

Settings
Displays the Scanner Setup dialog box which offers scanner specific options.    Controls 
most often listed here include the brightness and sharpness levels to be applied when 
scanning the image.

Progress Meter
Provides a visual progress report while the image is being scanned.

Prescan
Displays the document placed on the scanner bed in the View Area. Prescan resets the 
color setting to grayscale and uses the scanner's lowest resolution.    Use to precisely size 
and position the Scan Area box.

Scan
Starts the scanning process.



How to...
· Scan a graphic
· Work with dialog boxes



Dragging and dropping graphics
You can drag and drop a bitmap or other supported graphic images directly from other 
applications or from a Windows file manager into Corel VENTURA. You do not need to drag 
the graphic into a frame, Corel VENTURA will create a frame when the graphic is dropped.
Note: The application supplying the graphic must support OLE (Object Linking and 
Embedding).
To drag and drop a bitmap into Corel VENTURA:

1. Size the windows of Corel VENTURA and the other application or file manager so 
that both are visible.

2. Click and hold down the mouse pointer on the bitmap file or image in an 
application window or a Windows file manager.

3. Drag the bitmap file or image into Corel VENTURA.



Taking a screen grab
Corel VENTURA allows you to print a page of a document to a file and then incorporate that 
page back into a document as a picture. 
The advantages of printing the page to a file rather than using the Windows built-in screen 
grab are:
· The files generated by Windows PostScript are EPS format files, and thus can be 

scaled to any size without losing resolution.
· Only the document page is printed. The menus, toolbox, and other program 

screen items are not printed.
The disadvantages are:
· Documents using this file, as with any other EPS file, can only be printed on 

PostScript or PostScript-compatible printers or typesetters.
· The EPS picture files will not display on the screen unless a TIFF or Windows 

metafile image can be incorporated into the EPS file.
Installing a PostScript printer driver
Printing a page of your document to a file requires that a PostScript printer driver be 
installed in Windows prior to printing to a file. Installing this driver will allow you to access 
the PostScript printer driver from Corel VENTURA and does not require you to have a 
PostScript printer connected to your computer.
To configure a PostScript printer driver:

1. If you don't already have a PostScript printer driver installed in Windows, refer to the 
Windows documentation for instructions on installing a PostScript driver using the 
Windows Control Panel. The Apple LaserWriter NTX printer driver can be used for this 
purpose.

2. Open the Windows Control Panel and double-click on the Printer icon.
3. In the Installed Printers list, select the PostScript printer driver, then click on the 

Connect button.
4. Click the Setup button. The PostScript printer properties dialog box opens.
5. Click on the Options button to open the Options dialog box, then set the Print To option 

to Encapsulated PostScript File. Leave the File entry field blank.
6. Click OK in each dialog box until you return to the Printers dialog box.
7. Set the Status option to Active.
8. Click OK to exit the Printers dialog box and save your settings. Close the Windows 

Control Panel.
To print a screen grab:

1. Open Corel VENTURA and load the chapter containing the page you want to print to a 
screen grab file.

2. Use the page buttons to display the page you want printed.
3. Choose Print from the File menu.
4. If the printer name displayed in the Print dialog box is not the one set up for printing to

COM4, click on the Setup button and select the printer from the Specific Printer list 



box, then click OK..
5. Set the Page Range option to Current. Do not check the Print to File box.

Make sure that only a single page is being printed to a file. If multiple pages are 
printed to a file, that file will not display more than the first page.

6. Click OK to begin printing the page to a file. The Print to File dialog box opens.
7. Enter the path and file name to which you want the page printed in the Filename box.

Files created using this procedure can be imported into a document as a graphic using 
the Load Graphic commands in the File menu. Choose the Placeable EPS option from 
the List files of type box. The PostScript graphic will be displayed in your document as 
a large X in the frame. The full size of this X represents the image area of the graphic.



Dragging and dropping files
Drag and drop allows you to open files by dragging and dropping them onto the page in 
Corel VENTURA.
To open a file using drag and drop:

1. Choose Tile from the Program Manager's Window menu.
2. Click and hold down the mouse pointer on the file in your Windows file manager.
3. Drag the file into Corel VENTURA and release the button when the pointer is at 

the location where you want the file to appear.



Work with styles

Creating a style sheet
Using paragraph tags
Customizing a style sheet
Managing styles
Using ruling lines



Customizing a style sheet
Modifying paragraph tags
Setting fonts
Setting tabs
Setting indents
Setting hanging indents
Setting margins
Setting columns
Setting tracking and kerning
Setting spacing
Rotating paragraphs
Aligning paragraphs
Setting breaks
Setting ruling lines
Creating drop caps
Creating bullets



Use paragraph tags

Applying paragraph tags
Applying formatting changes to paragraph tags
Applying overrides
Locating paragraphs formatted with selected tags



Managing styles
Adding paragraph tags
Deleting paragraph tags
Renaming paragraph tags
Finding and replacing paragraph tags
Printing a style sheet
Setting hotkeys
Loading a new style sheet
Copying paragraph tags



Style sheets and paragraph tags--Overview
Corel VENTURA style sheets, collections of tags saved in files with the .STY extension, 
contain formatting attributes you can apply to paragraphs in a document. These attributes 
range from font selections to tab locations. Paragraph tags are used to globally format 
paragraphs which you want to appear the same.
Although paragraph tags are used to give your documents a consistent look, Corel VENTURA 
lets you make adjustments to paragraphs without creating a separate tag. This is called an 
"override." Overrides are not transferred when tags are copied to another style sheet.
In addition to the formatting attributes, a style sheet also stores information about the 
document's basic layout including the number of columns, page orientation, margin settings 
and so on.

See also:
Paragraph tags Corel VENTURA applies automatically



Creating a style sheet
A style sheet is a Corel VENTURA file that controls the typographic format of your 
documents. It is stored separately from the text in your documents.and contains page layout
information such as margin and column settings as well as typographic attributes called 
tags. When you create a publication from scratch, the default style sheet is loaded. Once 
you create new tags, it's a good idea to save the style sheet under a new name, which 
creates a new style sheet. Existing style sheets can also be modified and saved under a new
name. The same style sheet can be used by several chapters and/or publications.
To create a new style sheet:

1. Choose Layout, Save Style Sheet As.
2. A prompt appears asking whether you want to save changes to the existing style 

sheet. Choose Yes or No. The Open Style Sheet dialog box opens.
3. Type in the name of the new style sheet in the File Name box, or if you want to save 

the style sheet in a different location, choose a new drive and directory, then type the 
style sheet name in the File Name box.



Applying paragraph tags
You can apply paragraph tags in any of the three ways shown below. First, choose the 
Tagged Text tool and place the cursor inside the paragraph.
To apply a tag from the Tags Roll-Up:

1. Choose Tools, Tags Roll-Up. The Tags Roll-Up is displayed.
2. In the Tags Roll-Up, double-click the tag name to apply the tag to the selected 

paragraph.
To apply a tag from the Tag list on the Ribbon Bar:
· Click the tag name you want to apply.

To apply a tag using a function key:
· Press the hotkey associated with the tag.

To see the hotkeys associated with each tag, open the Tags Roll-Up.

See also:
Setting hotkeys



Locating paragraphs formatted with selected tags
To find paragraphs formatted with a particular tag:

1. Choose Edit, Find and Replace. The Find and Replace dialog box opens.
2. Click Paragraph Tag.
3. From the drop-down list box, choose the tag you want to find.
4. Click Find Next. Corel VENTURA highlights the first paragraph formatted with the 

selected tag.



Modifying paragraph tags
To modify an existing paragraph tag:

1. Select a paragraph tagged with the tag you want to modify using the Tagged Text tool.
2. Choose Format, Paragraph. The Paragraph Settings dialog box opens.
3. Choose the group of attributes you want to set by clicking the tab: Character, 

Alignment, Spacing, Defaults or Typography.
4. Change the settings as required.

To create a new tag based on an existing one:
1. Select the paragraph to which you want to apply the new tag using the Tagged Text 

tool.
2. Choose Tools, Tags Roll-Up. The Tags Roll-Up is displayed.
3. From the Tags Roll-Up, choose Add Tag from the flyout menu. The Add Paragraph Tag 

dialog box opens.
4. From the Copy Attributes From list, choose the tag upon which you want to base the 

new tag.
5. In the Tag Name box, type a name for the new tag.
6. To assign the tag to a pre-defined category, for instance Body Text or Heading, select a 

tag type from the Tag Type drop-down list box. 
Categorizing tags makes them easier to find in the Tags Roll-Up. To display the tags by 
category in the Tags list of the Roll-Up, click the right arrow to open the flyout menu, 
choose Sort Tags By, then choose Tag Type from the secondary flyout menu.

7. Click OK.
8. Set the attributes for the new tag by following the method to modify an existing 

paragraph tag described above.



Modifying paragraph tags
To modify an existing paragraph tag:

1. Select a paragraph tagged with the paragraph tag you want to modify using the 
Tagged Text tool.

2. Choose Format, Paragraph. The Paragraph Settings dialog box opens.
3. Choose the group of attributes you want to set by clicking its tab: Character, 

Alignment, Spacing, Defaults, Typography.
4. Change the settings as required.
5. Choose OK.

To create a new tag based on an existing one:
1. Select the paragraph to which you want to apply the new tag using the Tagged Text 

tool.
2. Choose Tools, Tags Roll-Up. The Tags Roll-Up is displayed.
3. From the Tags Roll-Up, choose Add Tag from the flyout menu. The Add Paragraph Tag 

dialog box opens.
4. From the Copy Attributes From list, choose the tag upon which you want to base the 

new tag.
5. In the Tag Name box, type a name for the new tag.
6. To assign the tag to a pre-defined category, for instance Body Text or Heading, select a 

tag type from the Tag Type drop-down list box. 
Categorizing tags makes them easier to find in the Tags Roll-Up. To display the tags by 
category in the Tags list of the Roll-Up, click the right arrow to open the flyout menu, 
choose Sort Tags By, then choose Tag Type from the secondary flyout menu.

7. Choose OK.
8. Set the attributes for the new tag by following the method to modify an existing 

paragraph tag described above.



Setting fonts
To set font characteristics for a paragraph tag:

1. Using the Tagged Text tool, select a paragraph tagged with a tag you want to edit.
2. Choose Format, Paragraph. The Paragraph Settings dialog box opens.
3. In the Paragraph Settings dialog box, click the Character tab.
4. Click the Paragraph Text radio button.
5. Select the font you want to apply from the Font list box.
6. Choose a style, size and color.
7. Apply attributes such as underline, overscore, and strike-thru as required.
8. Choose OK.



Setting tabs
1. Select the paragraph you want to format.
2. Choose Format, Paragraph.
3. In the Paragraph Settings dialog box, click the Alignment tab.
4. Use the Default Tab Every list box to set default tab stops at regular intervals. Type the 

distance you want between the tabs. Use the adjacent list box to set the unit of 
measure.

5. Choose an alignment from the Tab Positions section by clicking on one of the alignment
buttons..

6. To change the alignment of an existing tab, select it first, then click an alignment 
button.

7. To fill the space between a tab stop and the character following it, turn on the Leadered
option and select a leader character. Choose Auto-Leader to insert leader characters 
between the end of the last line of the paragraph and the right margin, even if you 
insert no tab at the end of the paragraph.

Note: You can also set tabs on the ruler by selecting a tab button (left, center, right, 
decimal) from the Ribbon Bar, then clicking the ruler at the point where you want the tab to 
appear. For more detailed instruction on setting tabs, refer to Chapter 5, Adding and Editing 
Text, of Corel VENTURA's User Manual.
To delete a tab stop:

1. Select the paragraph you want to format.
2. Choose Format, Paragraph.
3. In the Paragraph Settings dialog box, click the Alignment tab.
4. Choose the tab stop you want to delete from the Tab Positions list.
5. Click Delete.

Note:  Tabs do not work on justified text, and they cannot be set for headers or footers 
created with the Headers and Footers commands in the Layout Menu.



Setting tracking and kerning
To set automatic kerning and tracking on a tag:

1. Select the paragraph you want to format.
2. Choose Format, Paragraph.
3. In the Paragraph Settings dialog box, click the Typography tab.
4. To have Corel VENTURA kern text in the selected paragraph or for all paragraphs with 

the selected tag, click Automatic Kerning.
5. To adjust character tracking, enter the value, in ems, you want to add or subtract. Type

a minus sign if needed.
To set manual kerning or tracking:

1. Choose the FreeformText    or Tagged Text tool.
2. To kern, select the letter you want to move either closer to or further from the 

surrounding letters. To adjust tracking, select the range of text you want to adjust.
3. While holding down the Ctrl+ALT keys, press "i" to increase or "k" to decrease the 

kerning or tracking. The text following the selected letter will move closer to or farther 
from the selected letter. 
If you have selected a word, line or paragraph, the selected text is moved closer 
together or farther apart.



Setting spacing
To set line and paragraph spacing for tags:

1. Select the paragraph you want to format.
2. Choose Format, Paragraph.
3. In the Paragraph Settings dialog box, click the Spacing tab.
4. Enter values in the Above and Below boxes to define the space above the first line and 

below the last line of the selected paragraph.
5. Enter the space between lines in the Inter-Line box. Inter-line spacing is calculated 

from baseline to baseline.
Note:    The spacing between two paragraphs with different tags will be either the space 
below the first tag or the space above the next tag, whichever is greater.



Rotating paragraphs
Corel VENTURA enables you to rotate paragraphs in increments of 90, 180 and 270 degrees. 
You cannot select or edit rotated text unless you return to 0 degrees rotation.
To rotate a paragraph:

1. Select the paragraph you want to rotate.
2. Choose Format, Paragraph.
3. In the Paragraph Settings dialog box, click the Spacing tab.
4. Select an angle from the Angle list box.
5. Enter the maximum amount of space, measured in inches, you want the rotated text to

occupy in the Maximum Height box. When the text reaches the limit, Corel VENTURA 
wraps the text to the next line.



Rotating paragraphs
Corel VENTURA enables you to rotate paragraphs in increments of 90, 180 and 270 degrees. 
You cannot select or edit rotated text unless you return to 0 degrees rotation.
To rotate a paragraph:

1. Select the paragraph you want to rotate.
2. Choose Format, Paragraph.
3. In the Paragraph Settings dialog box, click the Spacing tab.
4. Select an angle from the Angle list box.
5. Enter the maximum amount of space, measured in inches, you want the rotated text to

occupy in the Maximum Height box. When the text reaches the limit, Corel VENTURA 
wraps the text to the next line.



Setting indents
To set indents for a paragraph tag:

1. Select the paragraph you want to indent.
2. Choose Format, Paragraph.
3. In the Paragraph Settings dialog box, click the Spacing tab.
4. Choose the page(s) where you want the paragraph indents to appear. The options are: 

all, left or right.
5. In the Paragraph Indents section, set the distance from the left or right column that you

want to indent the paragraph. A positive value creates an indent. A negative value 
creates an outdent.

6. To indent just some of the lines in the paragraph, set the number of lines you want to 
indent in the Lines to Indent box and the distance from the beginning of the paragraph 
in the Indent Amount box.
Note:    The margin boundary markers snap to the tick marks on the ruler. To override 
snapping, hold down the Ctrl key as you drag. Also, the left-margin boundary marker is 
divided has two halves--top and bottom. The top half of the marker moves 
independently while dragging the bottom half moves both at once.

See also:
Setting hanging indents



Setting hanging indents
Hanging indents, paragraphs whose first line extends past the left side of the rest of the 
paragraph, are frequently used for numbered steps, such as these procedures. You may 
create a hanging indent using the Freeform Text tool, as an override, by creating a new tag 
or by changing the properties of an existing tag.
To create a hanging indent using the ruler:

1. Drag the left-margin boundary to the right, where you want to align the body of the 
paragraph.

2. Drag the top part of the marker back to where you want the first line to align.
3. Click anywhere on the ruler to add a tab marker.
4. Drag the tab marker to align with the bottom half of the margin boundary marker.

Note: The margin boundary markers snap to the tick marks on the ruler. To override 
snapping, hold down the Ctrl key as you drag. Also, the left-margin boundary marker is 
divided has two halves--top and bottom. The top half of the marker moves 
independently, while dragging the bottom half moves both at once.

See also:
Adding paragraph tags



Setting hanging indents
Hanging indents, paragraphs whose first line extends to the left of the rest of the paragraph,
are frequently used for numbered steps, such as these procedures. You may create a 
hanging indent using the Freeform Text tool, as an override, by creating a new tag or by 
changing the properties of an existing tag.
To create a hanging indent using the ruler:

1. Drag the left-margin boundary to the right where you want to align the body of the 
paragraph.

2. Drag the top part of the marker back to where you want the left side of to align.
3. Click anywhere on the ruler to add a tab marker.
4. Drag the tab marker to align with the bottom half of the margin boundary marker.

Note:    The margin boundary markers snap to the tick marks on the ruler. To override 
snapping, hold down the Ctrl key as you drag. Also, the left-margin boundary marker is 
divided has two halves--top and bottom. The top half of the marker moves 
independently while dragging the bottom half moves both at once.

See also:
Adding paragraph tags



Aligning paragraphs
To set vertical and horizontal alignment in a paragraph:

1. Select the paragraph you want to align.
2. Choose Format, Paragraph.
3. In the Paragraph Settings dialog box, click the Alignment tab.
4. Click the horizontal alignment button for left, center, right, justified, or decimal 

alignment. 
If you clicked the Decimal Alignment button, you can set the In From Right value to 
specify where you want the decimal point to be relative to the right margin. You can 
also specify an alignment character. 

5. Click the vertical alignment button for top, middle, or bottom alignment.
6. If you have columns set up, click Frame Wide Text if you want the selected paragraph 

to print across the width of the frame instead of the width of the column.



Setting breaks
To set page breaks:

1. Select the paragraph to which you want to assign a break.
2. Choose Format, Paragraph.
3. In the Paragraph Settings dialog box, click the Alignment tab.
4. Click the Breaks button. The Breaks dialog box opens.
5. Choose a page break option from the list.

Choose To
None remove the current page break.
Before force the selected paragraph to the top of the next page or frame.
After force the next paragraph to the top of the next page or frame.
Before & After force the selected paragraph to the top of the next page or frame 

and force the following paragraph to the next page or frame.
Before/Until Left force the selected paragraph to a left page, inserting a blank right 

page if necessary.
Before/Until Right force the selected paragraph to a right page, inserting a blank left 

page if necessary.
6. Choose a column break option from the list.

The Column Break options work the same way as the Page Break options except the 
paragraph is placed at the top of a new column instead of a new page or frame.

7. Choose a Line Break option from the list.
Choose To
None force the paragraph to rely on the preceding and next paragraphs for 

line break options. If two consecutive paragraphs have line break 
options set to None, the second paragraph will begin on the same 
line as the first line of the preceding paragraph.

Before force a line break before the selected paragraph. No line break will 
follow the selected paragraph.

After force a line break after the selected paragraph. No line break will 
precede the selected paragraph.

Before & After force a line break before and after the selected paragraph.
Note:  The None option is best used to create side-by-side paragraphs by applying In From 
Right spacing on the first paragraph and In From Left spacing on the second paragraph. The 
same effect can also be achieved by selecting the two paragraphs and clicking the Place 
Side by Side button on the ribbon bar.



Setting ruling lines
To add ruling lines to a paragraph style:

1. Using the Tagged Text tool select the paragraph to which you want to add ruling lines.
2. Choose Format, Ruling Lines. The Ruling Lines dialog box opens.
3. From the Rule Style drop-down list box, choose a rule style. The rule style controls the 

placement of the ruling lines. The options are: none, above, below, above & below and 
around. 
If you select above, below or around, the tab corresponding to the rule style is 
displayed. If you choose above & below, both the above tab and the below tab are 
available.

4. Specify the number of lines you want in the rule style.
5. Select a thickness and the amount of space above and below each rule as required. 

The Total Rule Thickness shows the height occupied by all ruling lines.
6. To set the style and color, click the Outline pen button.
7. Choose a border width from the Border Width drop-down list box.

Choosing Sets ruling line width to:
Text the width of the first line of text.
Margin the width of the column minus the paragraph's In From Left and In From 

Right spacing.
Column the width of the column.
Frame the width of the base page, frame or box of box text.
Custom the width you specify in the Custom Width box. Enter positive or 

negative values in Custom Indent box to specify where the line starts 
relative to the left margin.

9. Repeat steps 3 through 7 for each ruling line as required.
10. Choose OK.

Note:    You cannot apply ruling lines as an override.



Creating drop caps
To add a drop cap:

1. Select the paragraph to which you want to add a drop cap.
2. Choose Format, Paragraph. The Paragraph Settings, Character dialog box is displayed.
3. Click Drop Cap Character.
4. Choose a font from the Font list and a style from the Style list.
5. Choose a size and color for the drop cap.
6. If you want the drop cap to print over the background, click Overprint. 
7. Choose DropCap from the Apply Effect drop-down list box to enable the drop cap.

Note: If you do not choose DropCap from the Apply Effect drop-down list box, the drop 
cap is not applied to the paragraph.

8. Select the style attributes you want for the drop cap.
9. To change the number of lines you want the character to drop, select Custom Spacing 

and enter a value in the Lines box. Entering a value of 1 will create a raised cap.
10. To shift the drop cap up or down, enter the amount in the Shift Up box. A negative 

value will shift the drop cap down.

Shortcut:
You may also choose preformatted drop cap styles from the Quick Format Roll-up.



Creating bullets
To add a bullet:

1. Select the paragraph to which you want to add a bullet.
2. Choose Format, Paragraph. The Paragraph Settings, Character dialog box is displayed.
3. Click Bullet Character.
4. Choose a font from the Font list and a style from the Style list.
5. Choose a size and color for the bullet.
6. If you want the bullet to print over the background, click Overprint. 
7. Choose Bullet from the Apply Effect drop-down list box to enable the bullet.

Note: If you do not choose Bullet from the Apply Effect drop-down list box, the bullet is
not applied to the paragraph.

8. Select the style attributes you want for the bullet.
9. Under the Bullet options, select the bullet character you want by entering its 

equivalent ANSI code number (minus the zero at the beginning of the digit) in the 
Bullet Character box. Refer to Appendix A of Corel VENTURA's User Manual for a 
complete listing of the ANSI codes. You can also use the arrow buttons to scroll through
the options.

10. In the Indent box, set the space between the beginning of the bullet and the text 
following the bullet.

11. To shift the bullet up or down enter the amount in the Shift Up box. A negative value 
will shift the bullet down.

12. Choose OK.

Shortcut:
You may also choose preformatted bullet styles from the Quick Format Roll-up.



Adding paragraph tags
To add tags to a style sheet:

1. Select the paragraph to which you want to apply the new tag with the Tagged Text tool.
2. Choose Format, Manage Tag List. The Manage Tag List dialog box is displayed.
3. Click Add Tag. The Add Paragraph Tag dialog box opens.
4. Type a name in the Tag Name box.
5. Choose the tag from you which you want to copy the attributes from the Copy 

Attributes From: box.
6. To assign the tag to a pre-defined category, for instance Body Text or Heading, select a 

tag type from the Tag Type drop-down list box. 
Categorizing tags makes them easier to find in the Tags Roll-Up. To display the tags by 
category in the Tags list of the Roll-Up, click the right arrow to open the flyout menu, 
choose Sort Tags By, then choose Tag Type from the secondary flyout menu.

7. Choose the tag to follow the new tag from the Next Tag box. When you press Enter, the
next paragraph uses the tag selected in this box.

8. Choose OK.
Note:  You can also add paragraph tags by choosing Format, Tag Roll-Up.



Adding paragraph tags
To add tags to a style sheet:

1. Select the paragraph to which you want to apply the new tag with the Tagged Text tool.
2. Choose Format, Manage Tag List. The Manage Tag List dialog box is displayed.
3. Click Add Tag. The Add Paragraph Tag dialog box opens.
4. Type a name in the Tag Name box.
5. Choose the tag from you which you want to copy the attributes from the Copy 

Attributes From: box.
6. To assign the tag to a pre-defined category, for instance Body Text or Heading, select a 

tag type from the Tag Type drop-down list box. 
Categorizing tags makes them easier to find in the Tags Roll-Up. To display the tags by 
category in the Tags list of the Roll-Up, click the right arrow to open the flyout menu, 
choose Sort Tags By, then choose Tag Type from the secondary flyout menu.

7. Choose the tag to follow the new tag from the Next Tag box. When you press Enter, the
next paragraph uses the tag selected in this box.

8. Choose OK.
Note:  You can also add paragraph tags by choosing Format, Tag Roll-Up.



Deleting paragraph tags
To delete a paragraph tag:

1. From the Tags Roll-Up, select the tag you want to delete.
2. Click the flyout button near the top of the Tags Roll-up and choose Delete Tag. The 

Delete Paragraph Tag dialog box opens with the selected tag displayed in the Delete 
box.

3. From the Reformat Text As list box, select the tag you want to use to format any 
paragraphs assigned the deleted tag.

Note:  You can also delete paragraph tags by choosing Format,    Manage Tag List.



Deleting paragraph tags
To delete a paragraph tag:

1. From the Tags Roll-Up, select the tag you want to delete.
2. Click the flyout button near the top of the Tags Roll-up and choose Delete Tag. The 

Delete Paragraph Tag dialog box opens with the selected tag displayed in the Delete 
box.

3. From the Reformat Text As list box, select the tag you want to use to format any 
paragraphs assigned the deleted tag.

Note:  You can also delete paragraph tags by choosing Format,    Manage Tag List.



Renaming paragraph tags
To rename a paragraph tag:

1. From the Tags Roll-Up, select the tag you want to rename.
2. Click the flyout button near the top of the Tags Roll-up and choose Rename Tag. The 

Rename Paragraph Tag dialog box is displayed with the selected tag displayed in the 
From box.

3. If you wish to rename a tag other than the one that was selected, choose a tag from 
the From drop-down list box.

4. Type a new tag name in the To box.
Note:  You can also rename paragraph tags by choosing Format,    Manage Tag List.



Printing a style sheet
To print a style sheet:

1. Choose Manage Tag List, Format menu. The    Manage Tag List dialog box is displayed.
2. Click Print Style Sheet. The File Save As dialog box opens.
3. Choose Generated (*.gen) from the Save File as Type box.    
4. Enter a name for the file.

Note:    The file extension must be *.gen.
5. Choose a drive and a directory, click OK, then choose Close in the Manage Tag List 

dialog box. The file will be saved to the location you specified.
6. Choose Load Text, File menu. The Load Text dialog box opens.
7. Select the generated file from File Name box and click OK. The file will display on the 

page. You can format the text using stylog.sty, a style sheet designed to format style 
sheet descriptions, or any other style sheet in the Typeset directory.

8. Choose Print, File menu. The Print dialog box opens.
9. Choose the required printing options and click OK.



Setting hotkeys
Hotkeys provide quick access to frequently used tags. They are assigned to function keys on 
your keyboard. You can assign up to 10 hotkeys in each style sheet.
To assign hotkeys to tags:

1. Choose Tools, Tags Roll-Up. The Tags Roll-Up opens.
2. In the Tags Roll-up, click the flyout button near the top of the roll-up and choose Set 

Hotkeys. The Set Hotkeys dialog box opens.
3. Select a tag and then select the hotkey radio button you want to assign to it, or choose

Auto-Assign to assign hotkeys to the first ten tags listed in the Name box.



Setting hotkeys
Hotkeys provide quick access to frequently used tags. They are assigned to function keys on 
your keyboard. You can assign up to ten hotkeys in each style sheet(s).
To assign hotkeys to tags:

1. Choose Tools, Tags Roll-Up. The Tags Roll-Up opens.
2. In the Tags Roll-up, click the flyout button near the top of the roll-up and choose Set 

Hotkeys. The Set Hotkeys dialog box opens.
3. Select a tag and then select the hotkey radio button you want to assign to it, or choose

Auto-Assign to assign hotkeys to the first ten tags listed in the Name box.



Loading a new style sheet
Although a chapter can only use one style sheet at a time, you can change style sheets at 
any time. Paragraph tags in the new style sheet override tags in the chapter that use the 
same name. Paragraphs formatted with conflicting tags are automatically changed to reflect 
the new formatting. Paragraphs formatted with unique paragraph tags are not affected, 
however, the tag names are added to the new style sheet.
To change style sheets:

1. Choose Format, Load Style Sheet. The Open Style Sheet dialog box opens.
2. In the File Name box, type the name of the style sheet you want to load or select it 

from the list.



Copying paragraph tags
Tags can be copied from one style sheet to another using the Merge command on the 
Manage Tag dialog box. If there are tags of the same name in both style sheets, the tags 
from the style sheet selected with the Merge command overwrites the tag in the current 
style sheet.
To copy paragraph tags:

1. Choose Manage Tag List, Format menu. The Manage Tag List dialog box opens.
2. Click Merge. The Open Style Sheet dialog box opens. 
3. Enter the name of the style sheet or click on the style sheet that has the tags you want

and click OK. The Merge Tags dialog box is displayed.
4. Click the tag names in the Tag List box.

If you want to copy all of the tags, click Select All to select all of the tags in the Tag 
List.

5. Click Merge.



Applying formatting changes to paragraph tags
The Tagged Text tool applies formatting changes to all paragraphs with the same tag as the 
one applied to the selected paragraph.    
To apply formatting changes to paragraph tags:

1. Choose the Tagged Text tool .
2. Place the cursor inside the paragraph or select the paragraph.
3. Do one of the following to open the Paragraph Settings dialog box:

· Choose Paragraph from the Format menu. The Paragraph Settings dialog box opens.
· Click the paragraph with the right mouse menu and choose Format from the Inserted

Text menu. A flyout menu appears. Choose one of the options: Character, Alignment,
Spacing, Defaults or Typography.

4. Apply the formatting changes required by choosing the appropriate dialog box, tab or 
flyout menu command.    They provide options for controlling many text formatting 
attributes: alignment, spacing, indents, font, size, style and color, tabs, drop caps or 
bullets, breaks and typography.
You can also use the Quick Format Roll-Up to add formatting attributes such as bullets, 
indents or drop caps to the selected paragraph tag.



Applying formatting changes to paragraph tags
The Tagged Text tool applies formatting changes to all paragraphs with the same tag as the 
one applied to the selected paragraph.    
To apply formatting changes to paragraph tags:

1. Choose the Tagged Text tool .
2. Place the cursor in the paragraph or select the paragraph.
3. Do one of the following to open the Paragraph Settings dialog box:

· Choose Paragraph from the Format menu. 
· Click the paragraph with the right mouse button and choose Format from the flyout 

menu. Choose one of the options: Character, Alignment, Spacing, Defaults or 
Typography.

4. Apply the required formatting changes from the dialog box. 
You can also use the Quick Format Roll-Up to add formatting attributes such as bullets, 
indents or drop caps to the selected paragraph tag.



Applying overrides
You can apply formatting changes to a paragraph without affecting all the paragraphs with 
the same tag. These local changes are called overrides. Overrides are used when you don't 
want to change a paragraph without affecting the paragraph tag.
If you want the formatting change to apply to all paragraphs using the current paragraph, 
use the Tagged Text tool. See also Modifying paragraph tags
To apply overrides:

1. Choose the Freeform Text tool by holding down the mouse button on the Text Tool icon 
until the flyout opens and then clicking on the tool.

2. Place the Freeform Text cursor in the paragraph or select the paragraph.
3. Choose Format, Paragraph. The Paragraph Settings dialog box opens:
4. Choose the formatting options you want.

5. Click  to show returns and codes. The overrides 
diamond is displayed at the beginning of the affected paragraph.

You can also use the Quick Format Roll-Up to add formatting attributes such as 
bullets, indents or drop caps to the selected paragraph tag.

Note: If you want to apply the formatting changes to the selected paragraph tag, use
the Manage Overrides dialog box.



Freeform Text tool and Tagged Text tool--Overview
Corel VENTURA includes two text tools:

Freeform Text tool 
Use the Freeform Text tool to enter text, change text attributes and apply overrides to a 
paragraph. 

To enter text, choose the Freeform Text tool, place the cursor on the base page, in a 
frame or paragraph and type.

You can change text attributes by selecting text and using the right mouse button 
menu, icons on the ribbon bar or the Selected Text command on the Format menu. Select 
text using one of the following methods:

· Click and drag the mouse to highlight the text.
· Double-click the mouse to highlight a word.
· Click once to determine a start point, hold down the Shift key and click to determine 

an end point.
If the cursor is placed into the paragraph without selecting text or the entire paragraph is
selected using ALT + mouse click, the Freeform Text tool applies formatting changes to 
the paragraph. This process is called an override. because the formatting changes 
override the current paragraph tag. 

Tagged Text tool  
Use the Tagged Text tool to enter text, change text attributes and apply formatting 
changes to paragraph tags.

Enter text by choosing the Tagged Text tool, placing the cursor on the base page, in a
frame or in a paragraph, and then typing.

Change text attributes by selecting text and using the right mouse button menu, 
icons on the ribbon bar or the Selected Text command on the Format menu. Select text using
one of the following methods:

· Click and drag the mouse to highlight the text.
· Double-click the mouse to highlight a word.
· Click once to determine a start point, hold down the Shift key and click to determine 

an end point.
The Tagged Text tool applies formatting changes to the paragraph tag when you place 
the cursor anywhere inside a paragraph without selecting text, or it the entire paragraph 
is selected. All paragraphs tagged with the same paragraph tag will be affected by the 
change.

See also:
Typing text
Changing text attributes
Paragraph tags Corel VENTURA applies automatically



Using ruling lines
1. Choose the Tagged Text tool .

2. Select the paragraph to which you want to add ruling lines.
3. Choose Format, Ruling Lines. The Ruling Lines dialog box appears.
4. In the Rule Style list box, choose a type of ruling lines to apply to the selected frame. 
The options includes: Above, Below, Above & Below, or Around. The tab corresponding to the
selected rule style becomes available. If you have selected Above & Below, both Above and 
Below are available.
5. Enter the line thickness as well as spacing, if more than one ruling line is used. Rule 1
will appear on the edge of the frame while Rules 2 and 3 will appear inside the frame.



Paragraph tags Corel VENTURA applies automatically
Corel applies some paragraph tags automatically as you use certain features. For example, 
when you create a header, Corel VENTURA applies a tag with the name Z_HEADER to the 
header text. The initial tag attributes for these generated tags are based on those defined in
the Body Text paragraph tag. However, you can modify the generated tags just as you would
any other tag.
Aside from the TABLE TEXT tag, generated tags, are always preceded by the letter Z and an 
underscore (_). You won't see the generated tags in the Tags list unless the Generated Tags 
option in the Preferences dialog box (Tools menu) is turned on.The following table lists the 
generated tags applied by Corel VENTURA.

This tag is 
applied

To this element

Z_HEADER Header text entered using the Headers 
and Footers command.

Z_FOOTER Footer text entered using the Headers and 
Footers command.

Z_SEC1 thru 10 Automatic section numbers generated 
using the Auto-Numbering feature.

TABLE TEXT Text entered into table cells.
Z_LABEL FIG Automatic figure numbers inserted using 

the Frame command.
Z_LABEL TBL Automatic table numbers inserted using 

the Frame command.
Z_CAPTION Text entered directly into a caption frame.
Z_LABEL_CAP Caption text inserted using the Frame 

command.
Z_TOC TITLE
Z_TOC LVL 1 thru 
10

Entries for table of contents created using 
the TOC & Index command.

Z_INDEX LTR
Z_INDEX MAIN
Z_INDEX SUB
Z_INDEX TITLE

Entries for an index created using the TOC 
& Index command.

Z_FNOT #
Z_FNOT ENTRY

Footnote numbers and footnote text 
inserted using the Insert Special Item 
command.

Z_BOXTEXT Text entered into Box text objects.



Work with tables
Inserting a new table
Adding rows or columns
Deleting row(s), columns(s) or tables
Merging and splitting cells
Applying color to cells
Setting the width and position of a table
Creating custom cell borders
Changing cell borders
Resizing columns
Making data query tables



Inserting a new table
You can insert a table directly on the base page or in a frame. Putting the table in a frame 
lets you add a caption such as "Table 1", or "Table 1: Monthly Sales." Or using a counter, 
Corel VENTURA can number tables for you and update the numbering as necessary--for 
example when you add or delete a table.
To insert a table:

1. Select either Text tool and click the text cursor where you want the table to appear.
2. Do one of the following 

· Click the Table button . 
· Choose Create Table, Table menu. 

3. Enter the number of rows and columns you want in your table. You can add or delete 
rows and columns after you insert the table.

4. If you want to keep the table together within the same column or page, disable Auto-
Flow Table. Otherwise, a table too large to fit the current page or column will 
automatically continue to the next page or column. 
If you allow tables to span page or column boundaries, you can have Corel VENTURA 
repeat the table's top rows on the next page or in the next column. Enter how many 
rows you want to repeat in the Header Rows box.

5. If you want to change the default borders Corel VENTURA applies to the table, select 
them from the Table Border list boxes. The preview window shows a visual 
representation of the current selections.

6. Change other settings as required. Refer to the following sections for information about
the settings.
Setting See
Column Widths Resizing columns
Positioning Setting the width and position of a table
Cell Borders Creating custom cell borders



Changing cell borders
You can modify border rules between and around individual columns, rows and cells. You can
also change the border rules around the entire table and all the vertical and horizontal rules 
at the same time.
To change the border rules between columns, rows or cells:

1. Select the Pick tool and place the mouse pointer at the beginning of the ruling line 
segment you want to change.

2. Do one of the following:
· To change the border above or below a single cell, simply click it. To change the 

border above or below a range of adjacent cells, click the border of the first cell in 
the range and drag to the end of the last cell in the range.

· To change a column (vertical) borders, click at the beginning of the border and drag 
to select each segment.

3. From the Format menu, choose Table. The Table Settings dialog box opens.
4. Click the Cell Borders tab. The Cell Borders dialog box appears.
5. Choose the border style you want to apply.

To reset the borders to the default settings:
1. Select the Pick tool and place the mouse pointer at the beginning of the ruling line 

segment you want to change.
2. Do one of the following:

· To change the border above or below a single cell, simply click it. To change the 
border above or below a range of adjacent cells, click the border of the first cell in 
the range and drag to the end of the last cell in the range.

· To change a column (vertical) borders, click at the beginning of the border and drag 
to select each segment.

3. Click the right mouse button. The Table menu appears.
The Normal Rules option resets the borders to the original rules of the table when it 
was created.

To change borders for the entire table:
1. Select the Pick tool and then click anywhere in the table.
2. Choose Table in the Format menu and click the General tab.
3. Select the border styles you want from the list boxes under Table Border.
4. Choose OK.

To change the borders around selected cells:
1. Point to the upper-left corner of the first cell, press the mouse button, and then drag to 

the lower-right corner of the last cell.
2. Click the right mouse button and choose Border Settings. The Table Settings, Cell 

Borders dialog box opens.
3. Choose the ruling style you want.



Resizing columns
When you first create a table, every cell in the table is the same width and height. You can 
change the width of any column of cells after the table is created. The height of a row can 
only be adjusted by adding or deleting lines of text from the cells of that row or by changing 
the text's formatting (for example, adding more space above or below the text or changing 
the size of the font).
You can resize columns in one of two ways:
· By using the Table command in the Format menu to set exact widths
· By using the mouse with the Ctrl key to drag the column boundaries to a new location
To resize columns using the Table command:

1. Select the Pick tool and click anywhere in the table.
2. Choose Table in the Format menu.
3. In Column Widths, enter the number of the column you want to resize in the Column 

Number box .
4. Choose the way you want to resize the column by selecting Fixed or Proportional. 
5. If all columns are to have the same width, set them all to the same number and click 

OK.
Note: A fixed-width column sets the width to the value you enter in the text box. A 
proportional-width column takes a proportional share of whatever space is left after all 
fixed-width columns have been set. The value you enter in the text box determines the 
portion of the space allocated to each variable column.
The proportional width value is a dimensionless number which is compared to the other 
proportional width settings for every other column in the table. A column with a 
proportional width of 2 gets twice as much space as a column with a proportional width of 
1. 

To resize columns by dragging:
1. Select the Pick tool.
2. Move the mouse pointer to the right boundary of the column you want to resize until 

the mouse cursor becomes a double sided arrow.
3. Hold down the Ctrl key and mouse button and drag the right column boundary to 

change the column width.
4. When the column is the desired width, release the Ctrl key and the mouse button.
The width of all columns to the right of the adjusted column will be resized proportionately.
If you indented the table and it shifts to the left, it's because the table no longer fits 
between the indent and the right margin. To restore the table to its previous position, 
reduce the width of one or more of the columns.
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Setting the width and position of a table
Ordinarily you set the width and position of the table when you first insert it, but you can 
change settings afterwards using the Table command in the Format menu.
To set the width and position of a table:

1. Do one of the following:
· If you're inserting a new table, place the text cursor in the frame and choose Create 

Table in the Table menu.
· If you're editing an existing table, click anywhere in the table with the Pick tool, then

choose Table in the Format menu.
4. Click the Positioning tab.
5. Enable the Custom Width option if you want to set a width different from the column 

width of the column or frame containing the table.
6. Type a value in the Custom Width box to specify the width of the table.
7. Choose an Alignment option to set the alignment of the entire table relative to the 

column or frame in which it's inserted.
8. In the Indent box, type the amount of space you want between the table and the left 

side of the column or frame containing the table.
Make sure the total width of the table doesn't exceed the width of the column minus 
the indent value; otherwise Corel VENTURA won't be able to indent the table by the 
amount you specify.

9. In the Cell Spacing boxes, type the amount of space you want between each table cell 
and the paragraphs before and after it.

10. In the Vertical Justification boxes, type the maximum amount of space that Corel 
VENTURA can add when vertically justifying columns or pages. For information about 
Vertical Justification, see "Using Vertical Justification" in Chapter 3 of your Corel 
VENTURA User's Guide and click OK.
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Creating custom cell borders
Corel VENTURA provides four preset ruling styles for table borders which are stored in 
generated tags. These tags, called HIDDEN, SINGLE, DOUBLE and THICK are added to the 
tags list when you first create the table. If you need other line widths or colors (the preset 
styles use black) you can modify the preset styles or define new ones.
To create a custom border style:

1. Choose Table, Format menu and click the Cell Borders tab.
2. Do one of the following:

· To modify a preset ruling style, select the style name from the Border Tag box.
· To create a new border style, click the + button next to the Border Tag box. Type a 

name in the dialog box that appears and then choose OK.
3. Specify how many rules you want in the border style by enabling/disabling the check 

boxes under Rule Settings.
4. Enter a thickness for each ruling line you want in the style and the amount of space 

above each line.

5. Click . The Outline Pen dialog box opens.
6. Choose a line pattern and color and click OK.
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Applying color to cells
Shading cells is an effective way to draw the readers attention to information in a particular 
row, column or cell. You might also shade the row and column headers to make your table 
more visually appealing.
To shade a table:

1. Select the cells you want to shade.
2. Choose Cell Color, Table menu.
3. Choose a predefined color or create a custom one and then choose OK.

Note:  You can only apply uniform colors to Table cells (i.e. no fountain fills, texture fills
or bitmap fills).



Adding rows or columns
You can add rows and columns by inserting new ones or copying and pasting existing ones.
When inserting a row, the inserted row inherits the table attributes (ruling style, shading and
spacing) and paragraph tags of the row below it. When inserting a column, the inserted 
column inherits the attributes specified in the Table Settings dialog box and the generated 
Table Text paragraph tag.
To add a new row to an existing table:

1. Using the Pick tool, select a cell next to where you want to insert the rows. 
2. Choose Table, Insert Row. The Insert Row dialog box opens.
3. Enter the number of rows in the Number box. 
4. Click Before or After to specify where the new rows are inserted.

To add a new column to an existing table:
1. Using the Pick tool, select a cell next to where you want to insert the rows. 
2. Choose Table, Insert Row. The Insert Column dialog box opens.
3. Enter the number of column in the Number box. 
4. Click Before or After to specify where the new columns are inserted.



Merging and splitting cells
Merging adjacent cells is useful for creating headers that span two or more rows or columns.
When you join cells, the contents of the upper-left cell in the selected group remains in the 
resulting larger cell. Text in the other cells is not immediately lost; it is just hidden from view.
It will be lost, however, when the document is closed.
Splitting a joined cell divides it into individual cells, Any text in the joined cell remains in the 
topmost or leftmost cell.
To merge cells:
· With the Pick tool, select the range of cells you want to merge with and choose Table 

menu, Merge Cells.

To split merged cells:
· With the Pick tool, select the merged cell and choose Table menu, Split Cells.



Deleting row(s), column(s) or tables
To delete row(s) and column(s):

1. Choose the Pick tool.
2. Select the row(s) or column(s) you want to delete.
3. Press the Delete key. The Delete Table dialog box opens.
4. Click Row(s) or Column(s).

To delete the entire table:
1. Choose the Pick tool.
2. Click anywhere in the table.
3. Press the Delete key. The Delete Table dialog box opens.
4. Click Table.
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Loading text
When you load text, you can specify whether the text is placed in the selected frame, the 
File list or after the insertion point. Placing the text after the insertion point enables you to 
merge the loaded text file with existing text. You can also load several text files in any 
supported format (for example, Word, WordPerfect) provided they are in the same directory.
To load a text file:

1. Do one of the following:
· If you want the file placed in the base page frame or in a free frame, click inside the 

frame with the Freeform Text tool or Tagged Text, or select it with the Pick tool.
· If you want the file added to the Files List, make sure no frames are selected. To 

place the file into a frame, select the frame and click the file name in the Files List 
on the ribbon bar.

· If you want the text inserted at a particular location in the document, place the 
insertion point at that spot.

2. Choose File, Load Text.
3. From the List Files of Type box, choose the format of the text file.
4. If you want to place the text after the insertion point, enable the Insert at Cursor check 

box. This option is only available if you placed the cursor before opening the dialog 
box.

5. Use the Drives and Directories list boxes to locate the desired file name. 
Note: If you want to load a range of listed files, hold down the Shift key and click the 
first and last file in the range. Use the Ctrl key instead to select non-consecutive files.

6. To add the file to the list of available files for the current chapter without automatically 
replacing text in a selected frame, choose the Options button, then enable the Add to 
File List check box. Choose the file from the File List to load it into a frame.

7. Choose OK or double-click on the file name.

See also:
Using text from other programs



Saving text files under a different name or format
You can save text typed or imported into Corel VENTURA under different names or in other 
text formats. Corel VENTURA actually creates a new file under the specified name or in the 
chosen format and places it in the specified directory. The original file is also removed from 
the chapter and replaced by the new file. The next time you open the document, Corel 
VENTURA loads the new file in place of the original. The file with the original name remains 
intact, but no longer appears in the files list or on the ribbon bar.
Note: The new file is not created until the document is saved.
To save text under a different name or in another format:

1. Select the page or frame containing the text file you want to save under another name 
or in another format.

2. Choose File, Rename File.
3. Do one or more of the following:

· To save the file in a different format, choose the format from the List Files of Type 
box.

· To save the file under a different name, type the name in the File Name box or 
choose Browse to save the file in a new location. 

Note:    Pending the release of the appropriate export filter, Corel VENTURA saves Microsoft 
Word for Windows 6.0 files in Word for Windows 2.0 format. When you return to Word for 
Windows 6.0 to open and resave files saved earlier in Corel VENTURA, a prompt will appear 
stating that the file was last saved in Word 2.0. You may then save the file in either Word 
format.



Entering special characters
In addition to the characters shown on the keyboard, many fonts include other characters 
and symbols such as , or 

. Most fonts also contain accented characters commonly found in languages other than 
English.
You can enter these characters by selecting them from a roll-up window or by typing codes 
listed in Appendix A of the Corel VENTURA User's Guide. Some of the more frequently used 
symbols such as and 

 can also be entered using keyboard shortcuts.
To insert special characters using the Character Roll-Up:

1. Position the insertion point where you want the character to appear.
2. Choose Tools, Character Roll-Up, or Edit, Insert Special Item, Character. The Character 

Set roll-up appears.
3. From the font box, choose a font that contains the symbol you want.
4. From the style box, choose a style.
5. Select the character by double-clicking it.

To insert a special character by typing codes:
1. Position the insertion point where you want the character to appear.
2. Hold down the Alt key and then using the numeric keypad, type the ANSI code for the 

character you want to insert.
See also Appendix A in the Corel VENTURA User's Guide for a list of the ANSI character 
codes.



Keys for special characters
Corel VENTURA provides key combinations for some of the more commonly used special 
characters such as , or 

. There are also key combinations for various types of typographic spaces including non-
breaking spaces. To use the key combinations you need to press the Ctrl key together with 
one or more keys. For example, to type an em space, press and hold both the Ctrl and Shift 
keys and then type M.

To insert Press
Copyright mark Ctrl+Shift+C
Discretionary hyphen Ctrl+Shift+H
Em dash Ctrl+ALT+M
Em space Ctrl+Shift+M
En space Ctrl+Shift+N
En dash Ctrl+ALT+N
Figure space Ctrl+Shift+F
Non-breaking space Ctrl+Shift+space

bar
"Curly" Quote, open Ctrl+ALT+Q
"Curly" Quote, closed Ctrl+ALT+C
Registered trademark Ctrl+Shift+R
Thin space Ctrl+Shift+T
Trademark Ctrl+Shift+2



Checking spelling
Corel VENTURA's spelling checker compares each word in a document against the words in 
its dictionary. It stops on words it does not recognize, such as misspelled words. Words that 
are not misspelled, but are also not in the spell checker dictionary can be added to a 
personal dictionary so that future occurrences of the word are not questioned.
To check and correct spelling:

1. Choose Tools, Spell Check. The Spell Check dialog box opens.
2. If you don't want to check the entire document choose the Range button and select the

text files you want checked. If you choose Selected Files, select the files you want to 
check from the Files list.

3. Choose the Begin Check button.
Corel VENTURA begins spell-checking. When it finds an unrecognized word it displays 
the word in the Unknown Word box. It also displays the text surrounding the word in 
the Context box to help you decide whether the word in question is indeed a 
misspelled word or one that's correctly spelled but not in the dictionary.

4. Do any of the following:
· Correct the spelling if the word is misspelled.

To accept the correction displayed in the Change To box, choose Change. To change 
all further occurrences of the same word, choose Change All. 
To select another correction, click on the word in the list below the Change To box.
If Corel VENTURA cannot suggest any corrections, the questionable word will display 
in Change To box so that you can correct its spelling.

· Leave the word unchanged and continue the spell check.
To leave the current occurrence of the word unchanged choose Skip. 
To bypass all further occurrences of the word choose Skip All.

· Add the word to a personal dictionary.
To add the word to the personal dictionary selected in the Personal Dictionary box, 
choose Add. 
To add it to another dictionary, choose the dictionary from the list then choose Add 
Word. For information about adding words to dictionaries, see Adding words to 
dictionaries.

· Stop spell checking
Choosing Close will stop the spell checker and close the Spell Check dialog box. 
Corrections made up to the point Close is chosen cannot be undone.

5. When the spelling check has been completed a message box appears. Choose OK to 
return to your document.



Adding words to dictionaries
You can add words to the spell checker that are not already in the standard look-up 
dictionary. When the spell checker identifies a correctly spelled word as a possible 
misspelling, you can add the word to a personal dictionary. After the word has been added, 
Corel VENTURA won't question those words during spelling checks. 
To add words to a dictionary:

1. Choose Tools, Spell Check. The Spell Check dialog box opens.
2. Click Begin Check.

When the Spell Checker finds a word that is not in the current dictionary, it is treated 
as an unknown word and displayed in the Unknown Word box. 

3. Click Add Word.
To specify which dictionary Corel VENTURA consults during a spelling check:
· Choose Tools, Spell Check. Select the dictionary you want to use from the Dictionaries 

list box then choose Begin Checking.



Using Type Assist
With Type Assist, you can correct misspelled words and capitalization errors automatically. 
For example, you can replace "teh" with "the" and "RObert" with "Robert." You can also use 
Type Assist to automatically insert frequently used words and phrases. For instance, you can 
store the phrase "as soon as possible" under the name "asap." Then, whenever you type 
asap followed by a space, Corel VENTURA replaces it with "as soon as possible." 
Type Assist can also automatically convert straight quotes to typesetter's or "curly" 
quotation marks, capitalize the days of the week and the first word of a sentence.
To use Type Assist:

1. Choose Tools, Type Assist. The Type Assist dialog box opens.
2. Select the items you want Type Assist to correct.
3. To store text that you want Type Assist to insert automatically, make sure Replace Text 

While You Type is selected.
4. In the Replace box, type a name for the replacement text for example asap.

You can type up to 64 characters but no spaces. Be sure to use names that aren't 
actual words. For example, don't name an entry company because Corel VENTURA will 
substitute the replacement text every time you type the word company.

5. In the With box, type the text that will replace the text in the Replace box.
You can type up to 255 characters including spaces and punctuation. To insert 
characters not on your keyboard, hold down the Alt key and type the character's ANSI 
code (see Appendix A in the Corel VENTURA User's Guide for a list of codes).

6. Choose the Add button and then choose OK.
You can remove entries you no longer need by selecting them and then choosing the 
Delete button.



Using the Thesaurus
You can use Corel VENTURA's built-in thesaurus to look up synonyms (words with a similar 
meaning) for a selected word or any other word. 
To look up words in the thesaurus:

1. Do one of the following:
· Choose Tools, Thesaurus. The Thesaurus dialog box opens.
· Select a word and choose, Tools, Thesaurus. The selected word is displayed in the 

Synonym For box. If the word is in Corel VENTURA's dictionary, its primary definition 
appears first in the Definition box followed by other definitions (if any). The Replace 
With lists shows alternatives to the selected word.

2. Do one or more of the following:
· If you did not select a word before choosing the Thesaurus command, type the word 

you want to look up in the Looked Up box, then click Look Up to display a list of 
definitions. 

· Select other definitions from the Definitions list to see their synonyms.
· Choose a synonym to replace the selected word, then choose the Replace button.
· Choose the Close button to close the Thesaurus dialog box without changing the 

selected word.



Finding and replacing text and text attributes
The Find and Replace command can locate and optionally replace text and character 
attributes (bold, italic, underline etc.) in a document including text and character attributes 
in footnotes, captions and headers and footers.
To find and replace text and character attributes:

1. Choose Edit, Find & Replace. The Find and Replace dialog box opens.
2. Select the Text radio button.
3. In the Find What box, type the text you want to find. 

You can type up 60 characters; the text scrolls horizontally as you type.
Note: To find typographic quotes ("curly" quotes) and apostrophes, hold down the Alt 
key and using the numeric keypad type 0147 (open quote), 0148 (close quote) or 0146
(apostrophe).

4. To find text formatted with character attributes (bold, italic, underline and so on), 
choose the Attributes button and select the attributes.

5. To find all occurrences of the Search For text regardless of the font assigned to that 
text, choose the Attributes button and select Ignore from the Font list box.

6. To search the entire chapter enable Search Chapter; otherwise Corel VENTURA begins 
searching from the location of the text insertion point forward. 

7. Check Match Case to search for text with the same capitalization as the Search For 
text. 

8. Check Match Whole Word to limit the search for complete words, not characters in 
other words. For example, check this option to find "place" but not "replace" or 
"placement".

9. Type any replacement text in the Replace With box.
You can type up to 60 characters; the text scrolls horizontally as you type. 
By leaving the Replace With box empty you can delete occurrences of the Find What 
text. 
NOTE: To replace what you typed in the Find What box with typographic quotes ("curly"
quotes) and apostrophes, hold down the Alt key and using the numeric keypad type 
0147 (open quote), 0148 (close quote) or 0146 (apostrophe).

10. Choose the Attributes button and select any attributes you want applied to the 
replacement text. 
Selecting the Revert Text option clears all other Replace Attributes check boxes and 
converts any text matching the specified Find What options to the style attributes of 
the paragraph tag in which the text resides. The font of the replacement text, however,
will be the font selected from the Font list in the Find and Replace dialog box. 

11. Choose the Find Next button to begin searching and when Corel VENTURA finds the 
first occurrence of the Search For text, do one of the following:
· Choose the Replace button to change the text and resume the search.



· Choose the Find Next button to continue searching without changing this 
occurrence. 

· Choose Replace All to change all occurrences of the Find What text without 
confirmation.

· To stop searching at any point, choose the Esc button.



Finding and replacing paragraph tags
You can use the Find and Replace command to find text assigned a specific paragraph tag 
and change it to another tag. Character attributes applied to selected text in a paragraph 
will not be affected by changing the paragraph tag. 
To search for and replace paragraph tags:

1. Choose Edit, Find & Replace. The Find and Replace dialog box opens.
2. Select the Paragraph tag radio button.
3. From the Find What list select the name of the tag you want to find.
4. If you want to replace the tag you are searching for with another one, select the 

replacement tag from the Replace With box.
5. To search the entire chapter check Search Chapter, otherwise Corel VENTURA begins 

searching from the location of the insertion point forward.
6. Choose the Find Next button to begin searching.
7. When Corel VENTURA finds the first paragraph formatted with the tag you are 

searching for, do one of the following:
· If you're only searching for tags, choose Find Next to find the next occurrence. 
· If you're replacing tags, choose the Replace button to change the tag or the Find 

Next button to resume the search without changing this occurrence. 
· If you want to replace all occurrences of the tag without confirmation, choose the 

Replace All button.
To stop searching at any point, choose the Esc button.



Finding and replacing special items
You can use the Find & Replace command to locate the following special items inserted with 
the Insert Special Item command in the Edit menu: 
· Box Characters · Equations
· Index Entries · Cross-References
· Frame Anchors · Variable Markers
· Markers · Overrides
· Footnotes

To search for special items:
1. Choose Edit, Find & Replace. The Find and Replace dialog box opens.
2. Select the Special Item radio button.
3. From the Find What list box select the type of item you want to find.
4. From the Item Name list box select the specific item you want to find.

The Item Name list box is available for all special items except special characters, 
footnotes, and equations.

5. To search the entire chapter enable Search Chapter, otherwise Corel VENTURA begins 
searching from the location of the text insertion point.

6. Choose the Find Next button to begin searching.
Corel VENTURA highlights the first occurrence of the item you are searching for. 
Choose Find Next to find the next occurrence. To edit the found item, choose Cancel. To
resume the search, press F7 or choose Find & Replace from the Edit menu again and 
then choose the Find Next button.
To stop searching at any point, choose the Esc button.



Changing the case of characters
You can use the Character Case commands to change the case of selected characters, words
or entire paragraphs. For example, you can change all selected characters from lowercase to
uppercase, or capitalize the first letter of each word that's in lowercase.
To change the case of characters:

1. Using either the Freeform Text tool or the Tagged Text tool, select the characters whose
case you want to change.

2. Press the right mouse button menu opens.
3. Choose Uppercase, Lowercase, or Capitalize.



Kerning letters manually
You can have Corel VENTURA kern automatically or you can do it manually by using the 
keyboard or by entering values in a dialog box. 
Note:  Manual kerning overrides automatic kerning specified in the paragraph tag.
To kern letters using the keyboard:

1. Select either the Freeform Text tool or the Tagged Text tool.
2. Select the letter you want to move either closer to, or further from the surrounding 

letters.
3. Do one of the following:

· To increase kerning space, use Ctrl+ALT+I.
· To decrease kerning space, use Ctrl+ALT+K.

To kern by specify values in a dialog box:
1. Select the letters you want to kern and click the right mouse button. The Selected Text 

menu opens.
2. Choose Selected Text. The Selected Text Attributes dialog box opens.
3. Specify a kerning value in the kerning box. A positive value will add space while a 

negative value will subtract space between each character.



Hyphenating text automatically
Corel VENTURA automatically hyphenates text whenever Hyphenation is turned on. The 
placement of hyphens within a word is determined by the built-in dictionary, plus a small 
exception dictionary which you can edit in Corel VENTURA or a word processor. 
If you want to always add additional hyphens within a word, or always suppress hyphenation
for certain words, you need to edit the exception dictionary (see Adding words to the 
hyphenation dictionary), To override or suppress hyphenation for just one word, use a 
discretionary hyphen instead (see Inserting discretionary hyphens as you type.)
To turn hyphenation on or off for individual paragraphs:

1. Select the paragraph with the Freeform Text tool.
2. Choose Format, Paragraph and click the Typography tab. 
3. Select Automatic Hyphenation to turn it on or off.

To turn hyphenation on or off for all paragraphs formatted with the same 
paragraph tag:

1. Select a paragraph with the Tagged Text tool.
2. Choose Format, Paragraph and click the Typography tab.
3. Select Automatic Hyphenation to turn it on or off. (It's on when a check mark appears 

in the check box.)



Inserting discretionary hyphens as you type
Corel VENTURA lets you override hyphenation points specified in the program's dictionaries 
by entering discretionary hyphens. Discretionary hyphens enable you to: 
· Add hyphenation points anywhere within a word. Manually hyphenating words helps to 

tighten loose lines of text. 
· Suppress hyphenation to prevent Corel VENTURA from breaking a word. If you enter a 

discretionary hyphen for a compound word such as Alsace-Lorraine, then that word will not
be broken, even at the normal hyphen.

To add a discretionary hyphen to any word:
1. Click where you what to insert the hyphen.
2. Press Ctrl+Shift+H.

To delete a discretionary hyphen:

· If you are Page Layout or Draft view, the code is not visible. However, the Status Line 
indicates its presence when the insertion point passes over the word. When you see 
"Disc. Hyphen" displayed in the Status Line, press the Delete key and the discretionary 
hyphen is deleted.

· If you are Copy Editor view, press  to show returns and 
codes and delete the code.
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Adding words to the hyphenation dictionary
To add words to the hyphenation dictionary, modify the HYPHUSER.DIC file (located in the 
CORELVP directory) in Corel VENTURA or your word processor. Read this file in as an ASCII 
text file. Add the words with the hyphens inserted, as shown below, and then save the file as
an ASCII text file. Words must be inserted alphabetically and in lower case. Several words 
are already included in HYPHUSER.DIC to get you started.
NOTE: Failure to store this file as an ASCII file will result in incorrect hyphenation.
Suppress hyphenation
If you want to suppress hyphenation for a particular word (perhaps your company's name) 
you can enter that word into the HYPHUSER.DIC file without hyphens.
Long words
Only the first seven characters (excluding hyphens) of each entry in the dictionary are read 
by the hyphenation algorithm. Thus, entering the following: con-sid-er-able will not produce 
a hyphen between "er" and "able" because this part of the word occurs after the seventh 
character. If you want the algorithm to read more than seven characters, place an asterisk * 
before the eighth character and each character thereafter, e.g., con-sid-e*r-*able The 
asterisk means read the next character. If you do not place an asterisk before the b, l and e 
at the end of the example word, the rest of the letters are not read. Consequently, other 
derivatives, such as consideration and considerate, will be hyphenated at the same points as
considerable, even if you do not enter them separately in the dictionary.
The following are examples of entries into the hyphenation dictionary.
in-de-fat-*i-*g*a-ble
moth-er-h*o*o*d
plu-ral-i-*t*y
corel
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Removing text files
You can remove a text file from its frame by either placing another file in the frame, or by 
using the Remove File command in the File menu. When you use the Remove File command, 
you have the option of removing the file either from the selected frame only or from both 
the frame and the Files List.
To place a different file in the frame:
· Select the frame, and then select the desired file from the Files list. 

The selected file replaces the file in the frame. The old file is not removed from the Files 
list, nor is it modified in any way.

To remove a file from the frame and/or the Files List:
1. Select the frame, and then choose File, Remove File. The Remove File dialog box opens.
2. Do one of the following

· To remove the file from the frame only, click Remove from Frame.
· To remove the file from the frame and the files list select the file, click Remove from 

Chapter.



Freeform Text tool and Tagged Text tool--Overview
Corel VENTURA features the two text tools described below:

Freeform Text tool
With the Freeform Text tool, you can enter text, change text attributes and apply overrides 
to a paragraph. 

Enter text by choosing the Freeform Text tool, placing the insertion point on the base 
page, in a frame or in a paragraph and typing.

You can edit text attributes by selecting text and clicking the right mouse button to 
open the Selected Text menu, or choosing icons on the ribbon bar or the Selected Text 
command on the Format menu. 

Tagged Text tool
With the Tagged Text tool, you can enter text, change text attributes and apply formatting 
changes to paragraph tags.

Enter text by choosing the Tagged Text tool, placing the cursor on the base page, in a
frame or in a paragraph and typing.

Change text attributes by selecting text and using the right mouse button menu, 
icons on the ribbon bar or using the Selected Text command on the Format menu. 

See also:
Selecting text
Tag\Text formatting
Applying paragraph tags
Applying overrides



Typing text
You can use either the Tagged Text tool or the Freeform Text tool to type text on the page, in 
a frame, text box or table cell.
To type text:

1. Choose either  or 

.
Note: You can edit in any of the views in the View menu: Copy Editor, Draft or Page 

Layout. 
2. Place the cursor where you want to begin typing. In Copy Editor view mode, the 
insertion point is already placed at the top of the document area.
3. Enter the text.



Changing text attributes
All text in a paragraph initially has the same font characteristics which are defined in the 
paragraph's paragraph tag. Changing the text attributes enables you to apply different font 
attributes such as bold, italics, and underlining to any amount of text in the paragraph from 
a single character to the entire paragraph. 
Text attributes can be changed using either the Freeform Text tool or the Tagged Text tool. 
Note:    Changing the text attributes does not affect the paragraph tag or create an override.
It only affects selected text.
To change text attributes:

1. Choose the Freeform Text or the Tagged Text tool.
2. Select the text you want to format.
3. Format the text using the Selected Text Attributes dialog box from the Format menu, 

the right mouse button or the buttons on the Ribbon Bar. The new font name or size 
you selected will be displayed on the Ribbon Bar as long as the text is highlighted.
Note: If you type a new font size into the list box on the Ribbon bar, the changes will 
not take effect until you press the Enter key. 



Removing applied text attributes
Do one of the following:

· Select text and click the Normal button  on the Ribbon 
Bar to remove all applied text attributes.

· Select the text and then turn off the attribute in the Selected Text Attributes dialog 
box.
· Delete the code Corel VENTURA inserts immediately before text formatted with the 
attribute.    

If you are in Page Layout or Draft view, the code is not visible. However, the Status Line 
indicates its presence when the insertion point passes over the beginning of the text. 
When you see "Attribute Setting" displayed in the information bar, press the Delete key 
and all the character attributes will be removed.
If you are in Copy Editor view, press the Show/Hide Returns button

 on the Ribbon bar to show returns and codes and delete 
the code.



Entering text
The Freeform Text tool is the recommended tool when entering, editing or applying local 
changes to a selected text string. 
To enter text:

1. Choose the Freeform Text or the Tagged Text tool.
Note: You can edit in any of the views in the View menu: Copy Editor, Draft or Page 
Layout. 

2. Place the cursor on the base page or in a frame.
3. Enter the text.



Changing text attributes
All text in a paragraph initially has the same font characteristics which are defined in the 
paragraph's paragraph tag. Changing the text attributes enables you to apply different font 
attributes such as bold, italics, and underlining to any amount of text in the paragraph from 
a single character to the entire paragraph. 
Text attributes can be changed using either the Freeform Text tool or the Tagged Text tool. 
Note:    Changing the text attributes does not affect the paragraph tag or create an override.
It only affects selected text.
To change text attributes:

1. Choose the Freeform Text or the Tagged Text tool.
2. Select the text you want to format.
3. Format the text using the Selected Text Attributes dialog box from the Format menu, 

the right mouse button or the buttons on the ribbon bar.
Note:    If you have changed the font, the changed text must be selected to display the
name of the new font in the font list. 



Removing applied text attributes
Do one of the following:
· Select the text and then turn off the attribute in the Selected Text Attributes dialog box.
· Delete the code Corel VENTURA inserts immediately before text formatted with the 

attribute. 
If you are Page Layout or Draft view, the code is not visible. However, the Status Line 
indicates its presence when the insertion point passes over the beginning of the text. When 
you see "Attribute Setting" displayed in the information bar, press the Delete key and all the
character attributes will be removed.

If you are Copy Editor view, press  to show returns and 
codes and delete the code.



Working with Text--Overview
Although Corel VENTURA is a powerful page layout program, it also has powerful text editing
capabilities. Text can be edited using either the Freeform Text tool or the Tagged Text tool. 
Text can also be entered or edited in any of the views: Copy Editor, Draft and Page Layout. 
Page Layout
The Page Layout view displays the document as it will appear when printed. All of the 
graphics and formatting are visible. This is the best view to use when formatting and laying 
out the document. However, it is the slowest view for text editing. Unlike the Copy Editor, 
the Page Layout view enables you to:
· create and edit graphics using the graphics tools on the toolbox.
· apply fills and outlines to graphics and frames.
· create frames.

Copy Editor
Although each of these views enable you to enter text, the Copy Editor view is the 
recommended method for entering text. The Copy Editor is a text editor that provides you 
with features that make entering and editing text faster and easier.
· You can set the font used to display the text in the Preferences, Text dialog box. Choose 

a font and font size that is easy to use.
· Enable the display of codes in the Preferences, Text dialog box. You can then see all of 

the codes for any of the text attributes you use and special items (cross references, 
anchors, etc.) you insert.

· In the left column, the tags used for each paragraph are displayed. 
· A small diamond is displayed before text that has had an override applied.
· Graphics are not displayed. Therefore there is no lapse in time while the graphics are 

redrawn.
· The toolbox is not available in the Copy Editor.
· You can format text using paragraph tags in the Copy Editor, although, the formatting 

will not be displayed until you return to the Page Layout view.
· You can use either of the text tools, Tagged Text tool or Freeform Text tool, in the Copy 

Editor. You can apply text attributes to selected text with both tools and only affect the 
selected text. 
You must be careful to check which tool you are using before applying text attributes if 
you have placed your cursor in the text without highlighting. If you are using the Tagged
Text tool, the attributes are automatically applied to the current paragraph tag.
The last text tool that you selected is the one that is active when you go into the Copy 
Editor even if the Pick tool or one of graphic tools was selected before entering the Copy
Editor.
You can check which text tool you are using by moving the cursor to the Ribbon bar. 
When it is over the ribbon bar, the Tagged Text tool icon is displayed. You can also check
using the right mouse button menu. The tool that is in use will have a checkmark beside
the command. Use Shift+F8 to switch tools. F8 will switch the tool back to the original.
If you have applied overrides to a paragraph while using the Freeform Text tool, you can 
use the right mouse button menu to remove the overrides. Choose Manage Overrides 
and choose Remove Overrides from the Manage Overrides dialog box.

· You cannot use ALT+Shift with the Freeform Text and Tagged Text tool to select the 



entire paragraph. If you are going to apply an override or format a paragraph tag, insert 
the cursor in the paragraph.

Draft
The Draft view is similar to page layout. The toolbox and formatting are visible, but all 
graphics are not, having been replaced by Xs in their frames. Text editing speeds up because
the graphics do not have to be redrawn each time the window is refreshed.



Selecting text (for text attribute changes)
1. Choose the Tagged Text or Freeform Text tool.
2. Place the cursor anywhere in the paragraph and do one of the following:

· Click and drag the mouse to highlight the text
· Double-click the mouse to highlight a word
· Click once to determine start point, hold down the Shift key and click to determine 

end point.
· Hold down the Ctrl key and click once anywhere in the paragraph to highlight a 

paragraph.
The Selected Text command will now be available in the Format menu. 



Selecting text (for formatting changes)
1. Choose the Tagged Text or Freeform Text tool.
2. Do one of the following:

· Click once anywhere in the paragraph.
· Hold down the Alt key and click once anywhere in the paragraph. While the Alt key is

depressed, you can select multiple paragraphs by clicking once in each paragraph. 
The cursor will change from a text cursor to a paragraph cursor.

The Paragraph Settings dialog box will now be available in the Format menu.



Inserting Special Items
1. Choose Insert Special Item from the Edit menu. 
2. Choose from the range of special items listed--character, footnote, equation, frame 

anchor, cross reference, marker, variable marker or date and time. 
A dialog box or application window will appear.

3. Make the relevant selections as required.



Editing Special Items
To edit a special item, place the text cursor to the left of the special item and choose Edit 
Special Item from the Edit menu. Corel VENTURA will select the special item and display the 
relevant dialog box or application as described below:
To edit a cross reference:

1. Click the Text tool. 
2. Choose Copy Editor as your viewing mode and place the cursor to the left of the cross-

reference code. 
3. Choose Edit Special Item from the Edit menu. The Insert Cross Reference dialog box 

appears.
4. Change the cross-reference as required and click OK. 




